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Kata Pengantar

Kurikulum 2013 dirancang untuk memperkuat kompetensi peserta didik dari sisi
pengetahuan, keterampilan, dan sikap secara utuh. Keutuhan tersebut menjadi
dasar dalam perumusan kompetensi dasar tiap mata pelajaran, sehingga
kompetensi dasar tiap mata pelajaran mencakup kompetensi dasar kelompok
sikap, kompetensi dasar kelompok pengetahuan, dan kompetensi dasar kelompok
keterampilan. Semua mata pelajaran dirancang mengikuti rumusan tersebut.

Pembelajaran Dasar-dasar Perbankan untuk Kelas X jenjang SMK Program
Keahlian Keuangan yang disajikan dalam buku ini juga tunduk pada ketentuan
tersebut. Dasar-dasar Perbankan bukan berisi materi pembelajaran yang
dirancang hanya untuk mengasah kompetensi pengetahuan peserta didik. Dasar-
dasar Perbankan adalah mata pelajaran yang membekali peserta didik dengan
pengetahuan tentang dunia perbankan di Indonesia, keterampilan dalam
menyajikan pengetahuan yang dikuasainya secara konkret dan abstrak, serta
dunia perbankan sebagai usaha berdasarkan kepercayaan masyarakat menuntut
sikap hemat, cermat, disiplin dan jujur. Sehingga dengan belajar dasar-dasar
perbankan diharapkan terbentuk pola pikir peserta didik yang hemat, cermat,
disiplin dan jujur.
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Akun (account)
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Glosarium

Disebut juga rekening atau perkiraan adalah
formulir untuk mencatat secara indivual tentang
penambahan atau pengurangan tiap jenis harta,
kewajiban, dan ekuitas.

Account
Receivable (Trade
Debtor)

Account Payable
(Trade Creditor)

Akuntansi

Aplikasi Komputer
Akuntansi

Asset

Bagan akun (chart
of account)
Balance Sheet
Building

Buku besar
(ledger)

Cash Flow
Statement

Cash on Hand
Card File

Cheque Book

Current Asset

Piutang Dagang, vyaitu tagihan kepada para
pelanggan karena adanya trasaksi penjualan

Utang Dagang, yaitu kewajiban perusahaan yang
harus dibayar perusahaan karena danya transaksi
pembelian.

Suatu proses yang meliputi kegiatan
pengidentifikasian, pencatatan, pengikhtisaran dan
pelaporan data keuangan.

Program terintegrasi yang disusun untuk penerapan
sistem komputerisasi di bidang akuntansi.

Aset atau Aktiva, yaitu seluruh kekayaan yang
dimiliki oleh perusahaan

Daftar akun dan nomor kodenya yang
mengidentifikasi tempatnya dalam buku besar.
Neraca, yaitu merupakan salah satu laporan

keuangan yang memberikan informasi mengenai
aset, kewajiban dan ekuitas.

Gedung (Bangunan), yaitu salah satu aset tetap
yang dimiliki oleh perusahaan.

Buku yang berisi akun-akun harta, kewajiban, dan
ekuitas atau kumpulan dari kartu-kartu akun.
Laporan Arus Kas, yaitu salah satu laporan
keuangan yang memberikan informasi tentang
aliran kas masuk dan kas keluar dari kegiatan
operasi, investasi dan pendanaan.

Jumlah kas yang dimiliki oleh perusahaan.

File Kartu, yaitu kartu untuk mencatat informasi
setiap pelanggan dan pemasok (Customers and
Suppliers)

Buku Cek, kumpulan cek yang siap untuk diisi dan
digunakan untuk pembayaran.

Aktiva Lancar, vyaitu kelompok aset yang
perputarannya dalam jangka pendek (kurang dari

Direktorat Pembinaan SMK (2013)
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Current Liabilities

Command Centre
Account

Command Centre
Banking

Command Centre
Sales

Command Centre
Purchases

Command Centre
Inventory

Command Centre
Card

Debit
Deposit paid

Double entry
system

Electric Expense
Equipment
Equity

Expenses

Kewajiban Lancar (Utang Lancar), yaitu salah satu
bentuk kewajiban yang harus dituaikan dalam waktu
satu tahun atau kurang.

Pusat kendali pada MYOB yang berfungsi untuk
pembuatan daftar akun, pencatatan saldo awal
buku besar, pembuatan jurnal umum, posting dan
laporan keuangan.

Pusat kendali pada MYOB yang berfungsi untuk
mencatat penerimaan uang yang bukan bersumber
dari pelunasan piutang dan pengeluaran cek yang
bukan untuk pembayaran utang.

Pusat kendali pada MYOB yang berfungsi untuk
mencatat, menampilkan/mencetak transaksi
penjualan, retur penjualan dan pelunasan piutang
serta menyajikan laporan yang berhubungan
dengan penjualan, misalnya rekap penjualan per
item atau per costumer, analisis piutang dan
sebagainya.

Pusat kendali pada MYOB yang berfungsi untuk
mencatat, menampilkan/mencetak transaksi
pembelian, retur pembelian dan pembayaran utang
serta menyajikan laporan yang berhubungan
dengan pembelian, misalnya rekap pembelian per
item atau per supplier.

Pusat kendali pada MYOB yang berfungsi untuk
mencatat item barang yang dibeli untuk dijual,
penggabungan komponen menjadi satu unit barang
baru atau sebaliknya, menyajikan laporan yang
berkaitan dengan persediaan.

Pusat kendali pada MYOB yang berfungsi untuk
mencatat data pelanggan (customer) dan pemasok
(supplier) baik yang berkaiatan dengan nama,
alamat, saldo awal piutang, utang, dan informasi
lainnya.

Sisi sebelah kiri suatu akun.

Uang Muka atau uang panjar yang dibayarkan
kepada supplier

Sistem pencatatan dari efek ganda (dual effect) dari
tiap transaksi secara tepat.

Beban Listrik

Peralatan, salah satu jenis aset tetap.

Ekuitas atau modal

Beban-beban operasi atau non operasi perusahaan.

Direktorat Pembinaan SMK (2013)
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Fixed Asset
Furniture
General Ledger

General Journal
Entry

Income
Interest Expense
Interest Revenue

Jurnal

Jurnal umum
Kredit (credit)
Laporan Keuangan
Liability

MYOB

Neraca saldo (trial
balance)

Motor vehicle
Office supplies
Other Expense
Payroll Check

Periode Akuntansi

Perusahaan Jasa

Aktiva Tetap, yaitu aset yang umurn pemakaiannya
lebih dari satu tahun.

Meubel, yaitu termasuk salah satu jenis aset tetap
perusahaan.

Buku Besar, yaitu kumpulan akun-akun.
Formulir untuk mencatat Jurnal Umum

Penghasilan (Pendapatan)

Beban Bunga, yaitu beban non operasi perusahaan
Pendapatan Bunga, salah satu pendapatan yang
termasuk dalam non operasi

Buku catatan akuntansi yang digunakan untuk
mencatat transaksi-transaksi keuangan yang terjadi
setiap hari.

Bentuk jurnal yang paling umum dipakai untuk
mencatat semua jenis transaksi.

Sisi kanan suatu akun.
Merupakan ringkasan
keuangan yang terjadi
akuntansi tertentu
Kewajiban, yaitu sesuatu yang harus ditunaikan
perusahaan.

Salah satu aplikasi komputer akuntansi yang dibuat
olen salah satu perusahaan di Australia yang
merupakan singkatan dari Mind on Your Own
Business.

Daftar akun-akun buku-buku dan saldo-saldonya
pada saat tertentu.

dari transaksi-transaksi
selama satu periode

Kendaraan Bermotor, yaitu salah satu jenis aset
tetap

Suplies Kantor atau Bahan Habis Pakai (BHP)
Beban lain-lain di luar opersai perusahaan.

Cek Gaji, yaitu cek yang khusus untuk pembayaran
gaji.

Rentangan waktu akuntansi yang dimulai pada saat
pembuatan neraca awal sampai dengan saat
pembuatan laporan keuangan, biasanya selama
satu tahun.

Entitas bisnis yang usaha pokoknya memperoleh
pendapatan dengan memberikan layanan jasa

Direktorat Pembinaan SMK (2013)
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Posting

Profit and Loss
Report

Provision for
doubtful debt

Telephone
Expense

Transaksi
Keuangan
Transaction
Journal

Trial Balance
Other Income
Rent Expense
Retained Earning
Salaries and Wage

Expenses
Water Expense

Prosedur memasukkan/memindahkan data dari
jurnal ke buku besar.

Laporan Laba Rugi, salah satu jenis laporan yang
memberikan  informasi  tentang  pendapatan
dibandingkan dengan beban-beban perusahaan.
Cadangan kerugian piutang, dana yang disediakan
untuk menutup kerugian akibat piutang yang tidak
tertagih.

Beban Telepon, yaitu pembayaran tagihan rekening
telkom.

Kegiatan ekonomis yang dilakukan oleh
perusahaan yang secara financial berdampak pada
perubahan posisi keuangannya.

Jurnal Transaksi, yaitu catatan hasil pemrosesan
jurnal transaksi keuangan tertentu.

Neraca Saldo, yaitu selisih antara jumlah debit dan
jumlah kredit akun-akun yang ada dalanm buku
besar.

Penghasilan Lain-lain di luar usaha pokok
perusahaan.

Beban Sewa, yaitu pembayaran sewa
gedung/peralatan.

Laba Ditahan, yaitu sebagian laba yang tidak
dibagikan kepada pemilik perusahaan.

Beban Gaji dan Upah, yaitu pembayaran gaji/upah
pegawai bulanan.

Beban air, yaitu pembayaran tagihan rekening PAM

Xii
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Pendahuluan

ﬁ A. Deskripsi

Perkembangan teknologi komputer telah memicu lembaga bisnis untuk
menerapkan sistem informasi di segala bidang, termasuk bidang akuntansi.
Penerapan komputer di bidang akuntansi ini semakin luas berkembang
dikarenakan banyaknya software aplikasi komputer akuntansi yang tersedia di
masyarakat. Justru permasalahan pokok yang dihadapi oleh lembaga bisnis
adalah kurang tersedianya tenaga kerja yang kompeten dalam pengoperasian
komputerisasi akuntansi.

Gambar 1. 1 Operator komputer akuntansi

Tidak jarang lembaga bisnis harus mengeluarkan biaya pelatihan yang cukup
besar untuk menyiapkan tenaga operator komputer akuntansi. Sekolah Menengah
Kejuru-an (SMK) sebagai salah satu lembaga penyedia calon tenaga kerja tingkat
menengah tanggap terha-dap tuntutan industri. Dalam kurikulum 2013 khususnya
untuk paket keahlian akuntansi peserta didik dituntut memiliki kemampuan
menerapkan pengetahuan, keterampilan dan sikap yang konsisten dari waktu ke
waktu dalam pengoperasian aplikasi komputer akuntansi.

Sebagian kompetensi dasar dalam mata pelajaran Komputer Akuntansi menuntut
peserta diklat untuk menguasai kompetensi secara utuh mengoperasikan aplikasi
komputer akuntansi pada perusahaan dagang. Apakah perusahaan dagang itu?
Perusahaan dagang adalah perusahaan yang usaha pokoknya memperoleh
pendapatan/penghasilan dengan membeli barang dagangan dan menjualnya
kembali tanpa merubah bentuk barang dagangan tersebut.

Keuntungan menerapkan komputer akuntansi pada perusahaan dagang
diantaranya adalah mengurangi penggunaan kertas-kertas (paperless) sehingga
pada gilirannya akan mengurangi beban alat tulis kantor (ATK) atau beban

Direktorat Pembinaan SMK (2013)
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perlengkapan (supplies). Disamping itu keuntungan penerapan komputer di
bidang akuntansi adalah jaminan untuk kecepatan dan ketepatan.

Gambar 1. 2 Paperless

Kecepatan karena sebagian besar pekerjaan akuntansi diambil alih oleh komputer
dan dikerjakan dengan cepat.

KOMPUTER AKUNTAN:SI
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Gambar 1. 3 Proses komputer akuntansi

Tugas operator hanyalah sebatas data entri, sementara tugas selanjutnya
termasuk penyusunan laporan keuangan dikerjakan oleh komputer. Selama data
yang dientri ke komputer data yang benar maka maka hasilnyapun akan benar
atau tepat.

Aktivitas komputer akuntansi perusahaan dagang mengarah pada data entri
transaksi keuangan yang terjadi pada perusahaan dagang sejak awal periode
sampai dengan proses penyiapan laporan keuangan pada akhir periode
akuntansi.

Direktorat Pembinaan SMK (2013)
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Aktivitas ini secara keseluruhan meliputi:
Menyiapkan data awal;
Membuat daftar akun;
Menyesuaikan pajak;

Membuat Buku Pembantu
Meng-entry saldo awal;
Mencatat Transaksi Penjualan;
Mencatat Transaksi Pembelian;
Mencatat Transaksi Kas-Bank;
Mencatat entri penyesuaian;
Menampilkan laporan keuangan.
Membuat backup file.

PFoooNoOrWNE

R

)

B. Prasyarat

Untuk memudahkan peserta didik dalam mempelajari buku ini, maka terlebih
dahulu dipersyaratkan telah menguasai kompetensi dasar yang ada dalam mata
pelajaran:

1. Pengantar Akuntansi dan Keuangan
2. Akuntansi Perusahaan Jasa.
3. Komputer Akuntansi (untuk Perusahaan Jasa).

Ao

|5

E) C. Petunjuk Penggunaan Buku Siswa

Buku Komputer Akuntansi 2 disusun untuk peserta didik, guna mendukung mata
pelajaran Komputer Akuntansi di kelas XI semester Il pada paket keahlian
Akuntansi.

Dalam buku ini terdapat 11 (sebelas) kegiatan belajar. Disarankan kepada peserta
didik untuk mempelajari buku ini secara urut agar lebih mudah memahaminya.

Agar aktivitas peserta didik lebih terarah dan lebih lancar dalam pencapaian
kompetensi maka disarankan untuk mengikuti petunjuk-petunjuk berikut ini:

1. Bacalah dengan cermat peta kedudukan modul, prasyarat dan pengertian
dari istilah-istilah penting dalam buku ini.

2. Untuk setiap kegiatan belajar, bacalah dengan cermat rumusan tujuan
pembelajaran yang memuat pengetahuan dan kinerja yang diharapkan
dalam rangka membentuk kompetensi kerja yang akan dicapai melalui
modul ini.

3. Pahami dengan baik uraian materi pada setiap kegiatan belajar termasuk
kasus yang diberikan. Diskusikan dengan sesama peserta didik, uraian atau
bagian dari kasus yang sulit dipahami. Bila masih ragu, maka tanyakanlah
pada guru sampai paham.

Direktorat Pembinaan SMK (2013) 3
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4.

Ikuti langkah-langkah pemecahan kasus seperti yang tertulis di setiap
kegiatan belajar. Lakukan ini bersama-sama dalam kelompok kecil. Bila
mengalami kesulitan diskusikan dengan anggota kelompok. Jika masih ragu,
maka tanyakanlah pada guru sampaijelas.

Kerjakan tugas-tugas, dan jawablah pertanyaan tes, kemudian cocokkan
dengan kunci jawaban. Lakukan kegiatan ini sampai peserta didik tuntas
menguasai hasil belajar yang diharapkan.

. Setelah kamu menuntaskan satu kegiatan belajar selanjutnya pelajari

kegiatan belajar berikutnya secara urut.

Peserta didik tidak dibenarkan melanjutkan pada kegiatan belajar
berikutnya, bila belum menguasai secara tuntas materi pada kegiatan
belajar sebelumnya.

Setelah semua kegiatan belajar tuntas dipelajari maka ajukan diri untuk
melaksanakan evaluasi penyelesaian buku 1. Pelaksanaan evaluasi ini bisa
dikerjakan secara individu atau klasikal. Jika hasilnya memuaskan dapat
melanjutkan kegiatan belajar di buku 2.

D. Tujuan Akhir

Spesifikasi kompetensi yang diharapkan dikuasai setelah menyelesaikan kegiatan
belajar ini adalah dengan diberikan kasus-kasus akuntansi perusahaan dagang
peserta didik dapat menyelesaikan proses komputer akuntansi sampai dengan
akhir periode, sehingga dapat menghasilkan laporan keuangan.

K

E. Kompetensi Inti dan Kompetensi Dasar

Tabel berikut ini menyajikan kompetensi inti dan kompetensi dasar untuk mata
pelajaran Komputer Akuntansi di kelas XI.

KOMPETENSI INTI KOMPETENSI DASAR

1. Menghayati dan 1.1 Mensyukuri karunia Tuhan Yang Maha
mengamalkan ajaran agama Esa, atas pemberian amanah untuk
yang dianutnya mengelola administrasi keuangan entitas.

1.2 Mengamalkan ajaran agama dalam
memanfaatkan ilmu pengetahuan dan
teknologi untuk menghasilkan informasi
keuangan yang mudah dipahami,
relevan, andal dan dapat
diperbandingkan.
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KOMPETENSI INTI KOMPETENSI DASAR

2. Menghayati dan 2.1. Memiliki motivasi internal dan

mengamalkan perilaku jujur,
disiplin, tanggungjawab,
peduli (gotong royong,
kerjasama, toleran, damai),
santun, responsif dan pro-
aktif dan menunjukkan sikap
sebagai bagian dari solusi
atas berbagai permasalahan
dalam berinteraksi secara
efektif dengan lingkungan
sosial dan alam serta dalam
menempatkan diri sebagai
cerminan bangsa dalam
pergaulan dunia

2.2.

2.3.

menunjukkan rasa ingin tahu dalam
menemukan dan memahami
pengetahuan dasar tentang komputer
akuntansi.

Menunjukkan perilaku jujur, disiplin,
tanggungjawab, santun, responsif dan
pro-aktif dalam berinteraksi secara efektif
dalam lingkungan sosial sesuai dengan
prinsip etika profesi bidang komputer
akuntansi.

Menghargai kerja individu dan kelompok
serta mempunyai kepedulian yang tinggi
dalam menjaga keselarasan lingkungan
sosial, lingkungan kerja dan alam.

3.8.

3.9.

. Memahami dan menerapkan | 3.1. Mendeskripsikan spesifikasi sistem
pengetahuan faktual, komputer yang diperlukan untuk
konseptual, dan prosedural, menginstal program aplikasi komputer
berdasarkan rasa ingin akuntansi yang dipilih.
tahunya tentang ilmu 3.2. Mendeskripsikan proses pembuatan file
pengetahuan, teknologi, data akuntansi baru untuk perusahaan
seni, budaya, dan humaniora jasa
dengan wawasan 3.3. Menganalisis susunan daftar akun dan
kemanusiaan, kebangsaan, hubungan akun (link accounts) untuk
kenegaraan, dan peradaban komputerisasi akuntansi perusahaan
terkait penyebab fenomena jasa
dan kejadian dalam bidang | 3.4, Mendeskripsikan cara penyesuaian
kerja yang spesifik untuk pajak pertambahan nilai (PPN) untuk
memecahkan masalah. perusahaan jasa

3.5. Mendeskripsikan cara pengisian saldo
awal akun buku besar perusahaan jasa

3.6. Menganalisis transaksi-transaksi
pengeluaran kas/bank pada perusahaan
jasa dan cara pengentriannya.

3.7. Menganalisis transaksi-transaksi

penerimaan kas/bank pada perusahaan
jasa dan cara pengentriannya.
Menjelaskan penyelesaian rekonsiliasi
bank untuk perusahaan jasa
Menganalisis transaksi umum termasuk
transaksi penyesuaian dan cara
pengentriannya ke dalam buku jurnal
umum perusahaan jasa

3.10.Mendeskripsikan cara penyusunan

laporan keuangan untuk perusahaan

Direktorat Pembinaan SMK (2013)
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KOMPETENSI INTI

KOMPETENSI DASAR

jasa

3.11.Mendeskripsikan cara pembuatan file
backup untuk perusahaan jasa

3.12.Mendeskripsikan proses pembuatan file
data akuntansi baru untuk perusahaan
dagang

3.13.Menganalisis susunan daftar akun dan
hubungan akun (link accounts) untuk
komputerisasi akuntansi perusahaan
dagang

3.14.Mendeskripsikan cara penyesuaian
pajak pertambahan nilai (PPN) untuk
perusahaan dagang

3.15.Mendeskripsikan cara pengisian saldo
awal akun buku besar perusahaan
dagang

3.16.Mendeskripsikan cara pembuatan kartu
piutang dan pengisian saldonya untuk
perusahaan dagang

3.17.Mendeskripsikan cara pembuatan kartu
utang dan pengisian saldonya untuk
perusahaan dagang

3.18.Mendeskripsikan cara pembuatan kartu
perlengkapan/persediaan dan pengisian
saldonya untuk perusahaan dagang

3.19.Mendeskripsikan cara pembuatan kartu
aktiva tetap dan pengisian saldonya
untuk perusahaan jasa dan dagang

3.20.Menganalisis transaksi-transaksi
pembelian tunai dan pembelian kredit
pada perusahaan dagang serta cara
pengentriannya.

3.21.Menganalisis transaksi-transaksi
pembayaran utang bagi perusahaan
dagang dan cara pengentriannya.

3.22.Menganalisis transaksi-transaksi
penjualan bagi perusahaan dagang dan
cara pengentriannya.

3.23.Menganalisis transaksi-transaksi
pelunasan piutang bagi perusahaan
dagang dan cara pengentriannya.

3.24.Menganalisis transaksi-transaksi
pengeluaran kas/bank bagi perusahaan
dagang dan cara pengentriannya.
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KOMPETENSI DASAR

3.25.Menganalisis transaksi-transaksi
penerimaan kas/bank bagi perusahaan
dagang dan cara pengentriannya.

3.26.Mendeskripsikan cara penyelesaian
rekonsiliasi bank untuk perusahaan
dagang

3.27.Menganalisis transaksi umum termasuk
transaksi penyesuaiann dan cara
pengentriannya ke dalam buku jurnal
umum perusahaan dagang

3.28.Mendeskripsikan cara penyusunan
laporan keuangan untuk perusahaan
dagang

3.29.Mendeskripsikan cara pembuatan file
backup untuk perusahaan dagang

4. Mengolah, menalar, dan
menyaji dalam ranah konkret
dan ranah abstrak terkait
dengan pengembangan dari
yang dipelajarinya di sekolah
secara mandiri, dan mampu
melaksanakan tugas spesifik
di bawah pengawasan
langsung.

4.1. Menginstal program aplikasi komputer
akuntansi pada sistem komputer yang
telah dipersiapkan.

4.2. Membuat file data akuntansi baru untuk
perusahaan jasa

4.3. Menyusun daftar akun dan hubungan
akun (link accounts) untuk perusahaan
jasa

4.4. Menyesuaikan seting pajak
pertambahan nilai (PPN) untuk
perusahaan jasa

4.5. Mengsisi saldo awal akun buku besar
perusahaan jasa

4.6. Mengentri transaksi-transaksi
pengeluaran kas/bank pada perusahaan
jasa

4.7. Mengentri transaksi-transaksi
penerimaan kas/bank pada perusahaan
jasa

4.8. Membuat rekonsiliasi bank untuk
perusahaan jasa

4.9. Mengentri transaksi umum termasuk
transaksi penyesuaian ke dalam buku
jurnal umum perusahaan jasa

4.10. Membuat laporan keuangan untuk
perusahaan jasa

4.11. Membuat file backup untuk perusahaan
jasa

4.12. Membuat file data akuntansi baru untuk

Direktorat Pembinaan SMK (2013)
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KOMPETENSI INTI KOMPETENSI DASAR

perusahaan dagang

4.13. Membuat daftar akun dan hubungan
akun buku besar perusahaan dagang.

4.14. Menyesuaikan seting pajak
pertambahan nilai (PPN) untuk
perusahaan dagang

4.15. Mengentri saldo awal akun-akun buku
besar untuk perusahaan dagang

4.16. Membuat kartu piutang dan mengisi
saldonya untuk perusahaan dagang

4.17. Membuat kartu utang dan mengisi
saldonya perusahaan dagang

4.18. Membuat kartu perlengkapan/
persediaan dan mengisi saldonya untuk
perusahaan dagang

4.19. Membuat kartu aktiva tetap dan mengisi
saldonya untuk perusahaan dagang

4.20. Mengentri transaksi-transaksi pembelian
tunai dan kredit bagi perusahaan
dagang

4.21. Mengentri transaksi-transaksi
pembayaran utang bagi perusahaan
dagang

4.22.Mengentri transaksi-transaksi penjualan
bagi perusahaan dagang

4.23. Mengentri transaksi-transaksi pelunasan
piutang bagi perusahaan dagang

4.24. Mengentri transaksi-transaksi
pengeluaran kas/bank bagi perusahaan
dagang

4.25. Mengentri transaksi-transaksi
penerimaan kas/bank bagi perusahaan
jasa dan dagang

4.26. Membuat rekonsiliasi bank untuk
perusahaan dagang

4.27.Mengentri transaksi umum termasuk
transaksi penyesuaian ke dalam jurnal
umum perusahaan dagang

4.28. Membuat laporan keuangan untuk
perusahaan dagang

4.29. Membuat file backup untuk perusahaan
dagang

E Direktorat Pembinaan SMK (2013)
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\g F. Cek Kemampuan Awal

Sebelum kamu memelajari buku ini, kamu diminta untuk menjawab semua
pertanyaan di bawah ini dengan mencontreng kolom YA atau TIDAK.

Kemampuan
No Butir Pertanyaan Ya Tidak

Apakah kamu dapat menyiapkan data
awal?

Apakah kamu dapat membuat daftar
akun?

Apakah kamu dapat menyesuai-kan
pajak?

Apakah kamu dapat membuat buku
pembantu

Apakah kamu dapat mengentri saldo
awal?

Apakah kamu dapat mencatat transaksi
penjualan?

Apakah kamu dapat mencatat transaksi
pembelian?

Apakah kamu dapat mencatat transaksi
kas bank?

Apakah kamu dapat mencatat entri
penyesuaian?

Apakah kamu dapat menampilkan
laporan keuangan?

Apakah kamu dapat membuat file
backup?

Direktorat Pembinaan SMK (2013)
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Pembelajaran

ﬁ A. Deskripsi

Proses pembelajaran yang dirancang untuk komputer akuntansi ini, lebih
mengarah pada model pembelajaran berbasis masalah/kasus (Problem Based
Learning), dimana para peserta didik dirangsang dan dilatih untuk mampu mencari
solusi (pemecahan masalah) yang diberikan baik secara individual maupun
kelompok.

Tahapan-tahapan yang akan digunakan adalah sebagai berikut:

Fase 1. » |dentifikasi tujuan pembelajaran.

= |dentifikasi kelengkapan logistik.

= |dentifikasi kelengkapan informasi/
data dalam kasus yang diberikan.

Identifikasi Kasus.

Fase 2. = Menentukan alternatif pemecahan
kasus.

* Inventarisasi tugas.

*» Pembagian tugas.

Organisasi Tugas.

Fase 3. = Mengumpulkan informasi yang sesuai
untuk melaksanaan tugas.

Pelaksanaan tugas atau h
g Melaksanakan eksperimen

eksperimen ; .

P = Mengatasi kesulitan/kesalahan yang
terjadi dalam pelaksanaan
eksperimen

Fase 4. = Membuat laporan

Penyajian hasil tugas. * Menyajikan hasil tugas

Fase 5. » Presentasi individu/kelompok
Mengevaluasi kasus yang diberikan
Mengevaluasi proses pemecahan
kasus

Analisis dan Evaluasi
proses pemecahan
kasus.
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Banyak tersedia program aplikasi komputer akuntansi yang bisa digunakan untuk
pelatihan, namun dalam pembelajaran kali ini akan difokuskan pada program
MYOB Accounting, yang biasa digunakan di perusahaan tingkat menengah ke
bawah. Pengoperasian program MYOB relatif lebih mudah yaitu dengan memilih
menu jenis transaksi dan mengisi formulir yang terkait, sedang komputer akan
memproses jurnal dan laporan keuangannya secara otomatis. Ada beberapa jenis
program MYOB Accounting yang dijual di pasaran, tetapi yang digunakan untuk
pembelajaran kali ini adalah MYOB versi pendidikan, yaitu MYOB Accounting Plus
v18 untuk Windows, dikeluarkan di Australia, Release 12.4.0J Education Edition.

\>\/ B. Kegiatan Belajar

Penulisan buku Il Komputer Akuntansi yang diaplikasikan pada perusahaan
dagang ini dijabarkan dalam 10 (sepuluh) kegiatan belajar yaitu meliputi :

1) Kegiatan belajar 1 : Menyiapkan data awal perusahaan;
2) Kegiatan balajar 2 : Membuat daftar akun;

3) Kegiatan belajar 3 : Membuat Buku Pembantu;

4) Kegiatan belajar 4 : Mengentri Saldo Awal;

5) Kegiatan belajar 5 : Mencatat Transaksi Penjualan;

6) Kegiatan belajar 6 : Mencatat Transaksi Pembelian;

7) Kegiatan belajar 7 : Mencatat Transaksi Kas-Bank;

8) Kegiatan belajar 8 : Mencatat Entri Penyesuaian;

9) Kegiatan belajar 9 : Menampilkan laporan Keuangan;

10) Kegiatan belajar 10 : Membuat file backup.

Setiap kegiatan belajar dilengkapi dengan tujuan pembelajaran, uraian materi,
rangkuman, tugas-tugas, tes formatif, kunci jawaban tes formatif, dan lembar kerja
peserta didik.

Direktorat Pembinaan SMK (2013) 11
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(A

<>

12

Kegiatan Belajar 1
Menyiapkan Data Awal

a. Tujuan Pembelajaran

Dengan diberikan kasus akuntansi perusahaan dagang, maka pada
akhir sesi ini diharapkan peserta didik dapat: Menjelaskan persyaratan
pendirian bank

1. Membuat file data baru

2. Mengecek Informasi Perusahaan

3. Menyesuaikan format Pajak

b. Uraian Materi

Lingkup uraian materi pada kegiatan belajar 1 ini meliputi:
1. Pembuatan File Data Baru

2. Pengecekan Informasi Perusahaan

3. Penyesuaian Format Pajak

Pembuatan File Data Baru.

MYOB merupakan salah satu aplikasi komputer akuntansi yang berbasis
Windows, oleh sebab itu pastikan bahwa spesifikasi peralatan komputer
yang dituntut untuk menginstall MYOB adalah minimal sama dengan yang
dipersyaratkan oleh program Windows.

Ada beberapa versi MYOB yang tersedia di masyarakat, tetapi versi yang
digunakan dalam pembelajaran ini adalah AccountingPlus 18 versi edukasi
yang dirilis oleh MYOB Australia. Pastikan bahwa program ini telah diinstal
terlebih dahulu di komputer anda. Langkah awal sebelum mengoperasikan
MYOB, adalah pengecekan bahwa simbol mata uang dan seting tanggal
sudah sesuai dengan sistem Indonesia.

File data bisnis adalah file yang digunakan oleh MYOB untuk menyimpan
seluruh data yang dientri ke komputer. Yang perlu dingat kembali adalah
nama file tersebut harus unik (artinya tidak ada nama file yang sama
sebelumnya), baik untuk file yang sudah eksis atau yang akan dibuat.

Data yang dibutuhkan pembuatan File Data baru adalah:

a. ldentitas perusahaan, meliputi : nama perusahaan, nomor registrasi,
alamat perusahaan, nomor telepon, nomor fax dan alamat e-mail.

b. Periode akuntansi, yang meliputi: tahun periode berjalan, bulan akhir
periode, bulan konversi , dan jumlah bulan dalam periode.

Direktorat Pembinaan SMK (2013)



Identitas Perusahaan dan Usaha pokok

Komputer Akuntansi Jilid 2
c. Teknik pembuatan daftar akun. Pada tahap ini akan digunakan cara

yang kedua, yaitu mengimport daftar akun yang sudah dipersiapkan
oleh perusahaan sebelumnya:

d. Nama File dan Folder tempat penyimpanan file tersebut.

Hal-hal yang perlu diperhatikan dalam pembuatan file data baru ini adalah:
e Data input sudah diidentifikasi dan dipersiapkan.
e Pembuatan file data bisnis hanya satu kali yaitu pada saat konversi dan
akan digunakan selama perusahaan tetap beroperasi.
Jika dalam proses pembuatan data bisnis ada yang salah dan file
sudah terlanjur disimpan, maka kesalahan tidak dapat dikoreksi. Satu
solusi yang tepat yaitu membuat file data bisnis baru dari awal.
Data UD Rasela Media Mandiri:

Nama perusahaan : UD Rasela Media Mandiri

Nama Pemilik : Rasela Marta

Bidang Usaha : Computer Dealer

Alamat : JI. Pamulang Raya 17, Tangerang Selatan.
No Telepon/Faximile : 021 7434352

Alamat email : ud.rmm@yahoo.com

Bank : MANDIRI KCP Pamulang

No Rekening : 048 213 457896

Kebijakan Komputerisasi Akuntansi

1.

Menggunakan sistem berpasangan dangan dasar akrual basis.

2. Menggunakan sistem mata uang rupiah & pencatatan tanggal Indonesia.
3.
4. Pada tahap setup untuk periode akuntansi dinyatakan sebagai berikut:

Menggunakan Special Journal

e Tahun akuntansi berjalan (Current Financial year) : 2013,

e Bulan akhir tahun (Last month of the year) : December,

e Bulan pergantian (Conversion Month) : January,

e Jumlah bulan dalam speriode (Accounting Period) : Twelve.

Pada tahap pembuatan daftar akun (Build your accounts list):

e Mengimport daftar akun yang telah disediakan oleh perusahaan.
o (I would like to import a list of accounts provided by ....)

Pada tahap pembuatan dan penyimpanan file data bisnis yang baru:

e Company file name : UD-RMM

e Folder penyimpanan file : Document atau My Document

Masalah Pajak (PPN)

1.
2.

3.

Setiap pembelian/penjualan barang dagangan diperthitungkan PPN 10%

Harga-harga yang tertulis di dalam faktur pembelian dan penjualan sudah termasuk PPN
10% (tax Inclusive).

Jika terjadi retur pembelian atau retur penjualan maka PPN masukan atau PPN keluaran
akan diperhitungkan pengurangannya.

Pembayaran utang dan penerimaan pelunasan piutang dengan discount akan langsung
mengurangi nilai piutang/utang tetapi tidak mempengaruhi PPN yang telah diperhitungkan.
GST (Good Services Tax), yang akan diedit menjadi: PPN (Pajak Pertambahan Nilai) sebesar
10%.
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Komputer Akuntansi Jilid 2
Langkah membuat file data baru sebagai berikut:

1

14

Klik Create pada pilihan menu awal
Pilih Next pada window [Welcome To MYOB.....]

Masukkan data identitas perusahaan seperti pada gambar:
e Nama perush.

Alamat

No. Telepon

No Faximili.

E-mail address

NB: Kolom ABN (Australian Business Number) kosongkan.

Enter your 12 digit MYOB product Serial Number
Serial Number:

Yirar oo by 18 Beahed v s B cand and wv e back
Knw £ sheva Nof raguisd Ry 653 versiva

Introduction & Enter Information about your company

Company Information § : -
Company Name:*  UD Rasela Media Mandiri

Accounting Information £ /V
ABN:
Accounts List &
% Address:  JI. Pamulang Raya 17 PAMULANG

/v Tangerang Selatan

Phone Number: | 6221 7434352
Fax Number: 6221 7434352

/V Email Address:
? * Required field

Help F1

Company File &

Conclusion ¢

ud-rmm@amail. cor

Gambar 2. 1 Identitas Perusahaan

Klik Next untuk meneruskan, Masukkan data periode akuntansi seperti pada
gambar di bawah:
Tahun periode: 2013; Bulan akhir periode: December

Bulan konversi: Januari; Jumlah periode akuntansi: Twelve
Kemudian klik Next.
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Introduction &

Company Infarmation @
Accounting Information @
Accounts List &

Company File ©

Conclusion &

Komputer Akuntansi Jilid 2

Tell us about your accounting year

A financial year is the 12 month timeframe used to define your accounting
vear. It does not have to match the calendar year. What is your financial
year?

Current Financial Year: 2013

ad

Last Month of Financial Year:

When does your current financial year end?

December

=

MYOB Accounting requires that you choose a conmnonlh. The
conversion month is the month in which you choose to begin entering
transactions. What is your conversion month?

Conversion Mont

Most companies use 12 accounting periods for reporting purposes. 4 few use
a 13th period to record adjustments. Which do you prefer?
=

MNumber of Accounting Periods:  Twelve

Help F1

Gambar 2. 2 Periode Akuntansi

Periksa kembali kebenaran data periode akuntansi, bila ada kesalahan klik Back
dan betulkan data yang salah. Bila data sudah benar klik Next.

Untuk pembuatan daftar akun, pilih opsi nomor 2 yaitu: | would like to import a

list of account provided

(&)

Introduction

Company Infarmation g

Accounting Information g

Accounts List @
Carnpany File {}'

Conclusion £

by kemudian Klik Next untuk meneruskan

Build your accounts list

Every company file requires an accounts lizt. ou may either select one of
ours, of you can uge your own. How would you like bo build pour accounts
lizt?

Select the option that most fits your needs.

| wiould like ta stark with one of the lists provided by MY0B Accounting.

&

/

{would like to import & list of accounts provided by my accountant after !
i'm done creating my company file. i

| would like to build my own accounts list once | begin using MY 0B
Accounting,

Mo matter which selection pou choose, you will be able to add or delete
accounts later.

Gambar 2. 3 Opsi Pembuatan Daftar Akun

Direktorat Pembinaan SMK (2013)
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7 Untuk itu klik Change untuk mengubah nama file dan folder

Create your company file

Your new company file will automatically be named the zame as your company
narme. Thiz fle will be zaved in the same location as your Accounting

Introduchion & program.

Uompahilleinelon e C:\myobBE DYRASEL MEDLA MANDIRL myo
Accounting Information g

Accounts List g
Company File &

Conclusion & [ Click Change if you would like to edit the name or lacation of
pour new Accounting comparny file.

Click. the Mest button to create your company file.

Gambar 2. 4 Mengubah Nama File

8 Penyimpanan file data akuntansi: Nama file : RMM-1 dan Nama Folder
Documents atau My Documents

Klik Save untuk menyimpan file yang sudah dibuat.

_— — e

Organize ¥ New folder 2w

1 |
ents

balBakwe  *  pocuments library
> | Documents |

Jj stisreilenlic =N Includes: 6 locations
4 Music -
Name Date modified Type
J/ SMK Muh Aimas - Fapua Barat 21700/ 2012 11:43 File rolder

. SMKInvest 22/10/2012 1:02 File folder
. SMA MODEL SKM 03/08/2011 15:47 File folder
. SKKNI 09/08/2011 19:35 File folder
J, PTS-PTK 29/10/2012 13:03 File folder
) Prosedur Mutu 11/12/201210:12 File folder
. Proposal Perpustakaan 27/11/2012 22:01 File folder

I . PRAMUKA 30/06/2012 18:36 File folder
v 4|

/ File name: RMM-1

Save as type: | MYOB Data (*.MYQ)

4 Hide Folders /I' Save ] [ Cancel ]

Arrange by:  Folder ¥

> gﬂ New Library
b k= Pictures
> B8 Videos

48 Computer
» &, Local Disk (C)
b g data (E:)

» €l Network

Gambar 2. 5 Penentuan Nama File dan Folder
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9 Nama file dan folder sudah diubah

Create your company file

Your new company file will automatically be named the same as your company
name. This file will be saved in the same location as your Accounting

Introduction @ progLam.

Company Information @ | .4 jsers\ TRIAL\D ocuments\AMM-1.MYO
Accounting Information @

Accounts List @
Company File ¢

Conclusion @ Click Change if you would like to edit the name or location of
your new Accounting company file.

Click the Next button ta create your company file.

Gambar 2. 6 Nama Baru untuk file an Folder

10 Klik Next untuk meneruskan
Klik Command Centre untuk menampilkan menu utama.
Tampilan menu utama, ada 4 kelompok pilihan:

1.

2.
3.
4

Menu Bar
Command Centre
Command Button
Command Panel

CARD FILE

Accounts Banking Time Biiling Purchases Payroll Irwentony Card File

Caontact Log

®
Frint Mailing Lakels

&
Create Personalised Letters

ToDolList - Find Transactions w Reports w Analysis w

Gambar 2. 7 Tampilan Menu Utama
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2. Pengecekan Informasi Perusahaan.

File data baru yang akan digunakan sebagai tempat pencatatan data
akuntansi telah disiapkan, tapi apakah data yang telah di input itu sudah
benar? MYOB menyediakan fasilitas untuk mengecek kebenaran data,
terutama untuk identitas perusahaan dan periode akuntansi.

Langkah-langkah untuk mengecek hasil pembuatan file data baru (kasus
UD Rasela Media Mandiri.):

1 Klik menu Setup dan pilih Company Informastion.

g MYOB Accounting
File Edit Lists Cﬂmmand(entres Reports  Window Help

Easy Setup Assistant
Balances r
E] Renata Interior Designer - Cor Liilked Acoatint: » EIE
m Preferences ¥
Customise Forms 3 p o

iR SEE—— 7

Business Calendar

Accaunts W Paproll Inventary Card File
e Load Payroll Tax Tables |
General Payroll Information ' .
Send to Accountal.., 2 bovavanannns @ BASlink
.. MoneyGontroller .. &

: : Record Joumal Entry oo @ Company Data Auditor
+ Transfer Money - :

* M-powered €
@ Transaction Journal . Services
(; Centre

2  Cek kebenaran informasi perusahaan, terutama identitas perusahaan dan
periode akuntansi. Jika identitas perusahaan ada yang salah dapat diedit. Tetapi
jika ada data periode akuntansi yang salah maka proses pembuatan file data
baru harus diulang kembali. Jika keduanya benar klik OK

@ Company Information E@

Company Information

Company Mame: | D Razela Media Mandir
Address: |J1 Pamulang Raya 17 PAMULANG
Tangerang Selatan
ABMN. ar T.EM.:
ABN. Branch:
Phone Number: | E221 7434352 ALH:
Fax Number. | 6221 7434352 Sales Tax Mumber:
Email &ddress: | ud-rmmisgmail. com Payee Number: ||
Conversion Manth:  January 2013 Current Financial Year: 2013
Accounting Periods:  Twelve Last Morth in Financial Year: December

7 e =] e

7 | (o Fr

7. | ©a| i
Help F1 Licenze | BAS Info

Direktorat Pembinaan SMK (2013)
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3. Penyesuaian Jenis Pajak.

Program MYOB v18 (versi Australia) menyediakan fasilitas untuk
menghitung dan mencatat berbagai jenis pajak, yaitu:

EXP GST Free Exports Goods & Services Tax 0%
FRE GST Free Goods & Services Tax 0%
GCA | GST on Capital Aquisition | Goods & Services Tax 10%
GST | Goods & Services Tax Goods & Services Tax 10%
INP Input Taxed Purchases Input Taxed 10%
ITS Input Taxed Sales Good & Services Tax 0%
N-T Not Reportable Good & Services Tax 0%
NTD Non Tax Deductible Input Taxed 0%
PRI GST Private Use Good & Services Tax 10%

Diantara jenis-jenis pajak tersebut, ada 2 jenis yang bisa digunakan yaitu:
GST dan NT. Sedangkan jenis-jenis pajak yang lainnya tidak digunakan di
Indonesia, oleh sebab itu perlu dihapus.

Langkah-langkah untuk menghapus pajak yang tidak digunakan:

1 KiIik List, dan Tax Codes untuk menampilkan daftar pajak

= MYOB Accounting

File Edit ZEEER Command Centres  Sstup  Reports  Window — Hi

N, Accodreg
<
\N Cards N,
(B Activiies Sy
— Items .
c - \ Tax Code List (o[
Categares Il Codz Diescription Rate
Recurring Transaction GST Fr
pegroll Categories GST on Capital Acquisitions Goods & Services Taw
s ¥ o Goods & Services Tax Goods & Services Tax
uperannuation Fund

Input Tawed Purchazes Input T axed
Input Tawed Sales Goods & Services Taw
Mot Repaortable Goods & Services Taw
Mon Tax Deductible Input T axed
GST Private Use Goods & Services Tax

7. = 13
Hel;:n F: Frint Mew

2 Hapus dengan memilih satu jenis pajak misalnya PRI (GST Private Use)
dan klik kanan-mouse, kemudian klik Delete.

=3
=
=
=
=
=
=
=
=

Emplayment Classifica
Custann List & Field Me
Cuskarn Lists
Sales & Purchases Inf
Idant\Flers

‘- Transfer M

aadbosbr o b
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(&) Tox Cose L oo ) )
Diescription Type Rate

GST Free Exports Goods & Services Tax 0% =
G5T Free Goods & Services Tax 0z S
GST on Capital Acquisitions Goods & Services Tas 10% ¥ 'Y.—_B

- ] Goods & Services Tax Goods & Services Tax 10% Eqd Fil
Input Taxed Purchaszes Input T axed 10% ERlT=
Input Taxed Sales Goods & Services Tax 14
Mot Reportable Goods & Services Tax 0%

________ Mon T ax Deductible Input T axed 0% by
= = B

—'Delete Tax Code

Find Transaction

Help for This Window
Tell Me How

-

Bay Ae s A A R A, A4 sdia

tre
VOGP N TN TR OWY YO O W WV N T Y WY W S T TR Y

3 Ulangi cara yang sama untuk menghapus jenis pajak yang lainnya hingga
tersisa dua jenis pajak: GST dan N-T.

Selanjutnya jenis pajak GST (Goods and Services Tax) akan diubah
menjadi PPN (Pajak Pertambahan Nilai) dan ‘link account’ yang terkait
akan disesuaian.

1 Klik GST dan Edit untuk mengedit jenis pajak GST.

2 Kolom Tax Code diisi dengan PPN dan kolom Description diisi dengan
Pajak Pertambahan Nilai.

3 Pilih akun PPN Collected untuk Tax Collected dan PPN paid untuk Tax
Paid (linked accounts).

4 Klik OK untuk mengakhiri.

3
(&) Tax Code List o | = [ = P
Code Description Type Rate g

o N-T Mot Repartable Goaods & Services Tax [iE3 2

= PPN Pajsk Pertambahan Milai Goo X "..}:f
—

@ Tax Code Information EI@

Tax Code Information r

Enter the tax code [up to three characters). a brief description of the tak and the rate of tax. 1€

Select an appropriate tax type and complete the links as necessary. f

i

T Code: [0 ;

Description: |F'aiak Peitambahan Milai 4

7?/ i Tax Type: | Goods & Services Tax - :

v (9 -
Help F1 Rate: 10% b
Linked &ccount for Tax Collected = | 21310 || PPN Callected "
TaDaoList » =

Linked Account for Tax Paid o0 | 21330 = PPN Paid r

Linked Card for Tax Autharity | = ¥

‘

4

5 3 r

L 3

New {

LRV A Y S o X T N Sy DY TN v N i TR W S B W N T e
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4. Keluar dari Program.

Untuk keluar dari program MYOB Kklik File di Menu Bar, kemudian klik Exit.

(] MYOE i .

/E]&n < dCentres Setup Reports Window Help

New Cirb+N
Open File Ctrl+ 0
Close Window Esc
CARD FILE

Print... Ctrl-P
Print Setup... — . " 1
= s D R
Back Up... TimeBling  Puchases Payecil Irwentory
Restore...
Venfy C File...

a'_'y 3 etk e i Cards List ; ' Contact Log
Optimise Company File b Sieaaes smooccos
Purge Contact Logs o :
Start 3 New Yeor 2 Print Mailing Labels 1
Import Data » :
Export Data > P4 O s
Accountantlink ’ Creste Personalised Letters o -~
= <

Gambar 2. 8 Menu Exit

2  Pada tampilan untuk membuat file Backup, klik No untuk keluar dari MYOB tanpa
backup.

c. Rangkuman

MYOB merupakan salah satu aplikasi komputer akuntansi yang
berbasis Windows, oleh sebab itu spesifikasi peralatan komputer yang
dituntut untuk menginstall MYOB adalah minimal sama dengan yang
dipersyaratkan oleh program Windows.

Ada beberapa versi MYOB yang tersedia di masyarakat, tetapi versi
yang digunakan dalam pembelajaran ini adalah AccountingPlus 18
versi edukasi yang dirilis oleh MYOB Australia. Program ini perlu
diinstal terlebih dahulu di komputer anda. Langkah awal sebelum
mengoperasikan MYOB, anda perlu menyesuaikan simbol mata uang
dan seting tanggal sesuai dengan sistem Indonesia.

Untuk membuat file data bisnis yang baru diperlukan identitas
perusahaan, misalnya nama dan alamat perusahaan, nomor telepon,
alamat e-mail dan sebagainya. Disamping itu juga diperlukan data
periode akuntansi, bulan konversi dan rencana pembuatan daftar akun
untuk pencatatan akuntansi.

Oleh karena program MYOB yang digunakan ini adalah versi Australia
maka fasilitas perhitungan dan jenis pajaknya juga versi Australia, oleh
sebab itu perlu adanya penyesuaian jenis pajak untuk digunakan di
Indonesia.

Direktorat Pembinaan SMK (2013)




Komputer Akuntansi Jilid 2

Berdasarkan Kasus 1.1. UD Rasela Media Mandiri yang ada pada
‘Lembar Kerja Peserta Didik’, kerjakan tugas-tugas berikut ini !

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per
kelompok.

2. Setiap peserta didik mengikuti langkah-langkah yang dijabarkan
dalam KB1 ini melalui kerjasama kelompok.

. Tugas 1, cek format tanggal dan simbol mata uang di komputer
masing-masing, bila formatnya masih default atau menggunakan
format Amerika maka ubahlah ke format Indonesia.

. Tugas 2, buatlah file data bisnis baru didasarkan pada lIkuti langkah-
langkah seperti yang telah dijelaskan di dalam buku ini.

. Tugas 3, menghapus jenis pajak yang tidak sesuali.

. Tugas 4, menyesuaikan GST menjadi PPN dan linked account untuk
PPN.

A
@)™ e. Tes Formatif

1. Tes Pengetahuan.

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b,
¢, d atau e dari setiap item soal pilihan ganda di bawah ini:

1. Kolom informasi perusahaan yang harus diisi (tidak boleh kosong):
a. Serial Number
b. Company Name
c. Address
d. Phone and fax number
e. Email Address.
2. Yang dimaksudkan dengan Current Financial Year:
a. Periode akuntansi yang sedang berjalan
b. Periode akuntansi yang akan datang
c. Periode akuntansi yang lalu
d. Periode akuntansi selama perusahaan beraktivitas
e. Periode akuntansi tertentu.
3. Yang dimaksud dengan Last Month of Financial Year:
Bulan awal dari periode akuntansi
Bulan awal dan akhir dari periode akuntansi
Bulan akhir dari periode akuntansi
Akhir bulan (Desember) dari periode akuntansi
Akhir bulan (Januari) dari periode akuntansi

PooT R
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4. Yang dimaksud dengan Conversion Month:
a. Bulan saat terjadinya transaksi
b. Bulan saat terjadinya konversi dari sistem manual ke komputer
c. Bulan awal periode akuntansi
d. Bulan akhir periode akuntansi
e. Bulan pergantian periode akuntansi

5. Tarif GST atau PPN adalah:

a. 25%
b. 5%
c. 15%
d. 10%
e. 35%.
6. Jenis pajak N-T adalah singkatan dari:
a. No Tax

b. Not Tax

c. Not Reportable
d. No Traceable
e. Not Taxable

7. Jika total penjualan barang sebesar Rp. 27.500.000,- (including Tax) maka
besarnya pendapatan dari penjualan barang adalah:
a. Rp. 27.500.000,-
b. Rp.25.375.000,-
c. Rp.22.500.000,-
d. Rp. 25.000.000,-
e. Rp. 21.250.000,-

8. Jika total penjualan barang sebesar Rp. 27.500.000,- (excluding Tax) maka
besarnya PPN adalah:
a. Rp. 2.750.000,-
b. Rp.1.375.000,-
c. Rp. 2.500.000,-
d. Rp.5.000.000,-
e. Rp. 1.250.000,-
9. Menu yang digunakan untuk mengedit atau menghapus jenis-jenis pajak
adalah:
a. Setup > List > Tax Codes
b. List > Setup > Tax Codes
c. Tax Codes > List
d. List > Tax Codes
e. Setup > Tax Codes > List

10. Menu yang digunakan untuk keluar dari program MYOB adalah:

a. File > Setup > Exit
b. Exit > File

c. File > Exit

d. Setup > Exit

e. Setup > File > Exit
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2. Tes Keterampilan.

Berdasarkan Kasus 1.2. UD Riola Media Mandiri yang ada pada ‘Lembar
Kerja Peserta Didik’, kerjakan tugas-tugas berikut ini !

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh peserta
didik secara berkelompok.

2. Pada akhir waktu tes diminta setiap peserta didik menyerahkan hasil
pekerjaannya dalam bentuk file.

3. Tugas 1, buatlah file data bisnis baru didasarkan pada Kasus 1.2. tersebut
di atas.

4. Tugas 2, menghapus jenis-jenis pajak yang tidak sesuai.
5. Tugas 3, menyesuaikan GST menjadi PPN dan linked account untuk PPN.

ﬁ f. Kunci Jawaban Tes Formatif
e

1. Kunci Tes Pengetahuan

1 b 6 C
2 a 7 d
3 C 8 a
4 b 9 d
5 d 10 C
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2. Kunci Tes Keterampilan

Tugas 1, Company Information (file data bisnis baru).

@File Edit Lists Command Centres Setup Reports Window Help

Komputer Akuntansi Jilid 2

Compary Information

Company Mame

Address:

Phaone Hurmber:

Fax Mumber:
Email Address:

Cotrversion tonth:

Accounting Periods:

Help F1 Licenze

Fress F1 to get help.

=3 -T Mot FRe
= PPN Pajak Perta

’/‘?)) g

Help F1 Print

Press F1 to get help.

. [UD Ricla Media Mandii

JI Pamulang Rawa 17 PAMULANG
Tangerang Selatan
ABM. arTEMN:
&.B.M. Branch:
B221 7434352 A.CH:

G221 7434352

Sales Tax Mumber:

ud-rmm{@gmail.com

January 2013
Twelve

=l
=]
BAS Info

mbahan Nilai

Payes Humber:

Currert Financial Year:

Last Manth in Financial vear:

2013
December

Rkb-2 MY10
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Komputer Akuntansi Jilid 2
Tugas 3, Seting PPN dan linked account untuk PPN.

MYOB Accounting

File Edit Lists Command Centres Setup Reports Window Help

Tax Code |nformation

Enter the tax code [up to three characters), a brief description of the tax and the rate of tas.
Select an appropriate tax type and complete the links as necessany.

Tax Code: |[FE4

Description: | Pajak Pertambahan Milai

Taw Type: | Goods & Services Tax -

Rate: 10%

Linked Accourt for Tax Collected = | 21310 S| PPN Collected
Linked Account for Taw Paid == | 21320 =/ PPN FPaid
Linked Card for Tax Authority - |

Press F1 to get help. FibAr-2.M 70

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta
didik di komputer melalui program MYOB versi 18.

KASUS 1.1. UD RASELA MEDIA MANDIRI
Identitas Perusahaan dan Usaha pokok

Nama perusahaan : UD Rasela Media Mandiri

Nama Pemilik : Rasela Marta

Bidang Usaha : Computer Dealer

Alamat : JI. Pamulang Raya 17, Tangerang Selatan.
No Telepon/Faximile : 021 7434352

Alamat email : ud.rmm@yahoo.com

Bank : MANDIRI KCP Pamulang

No Rekening 1 048 213 457896

Keputusan Manajemen

Pada awal Januari 2013 pemilik perusahaan Rasela Marta ingin menerapkan
sistem informasi yang memproses data akuntansi untuk perusahaannya secara
otomatis. Program yang akan digunakan adalah MYOB Accounting ver 18.
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Komputer Akuntansi Jilid 2

Kebijakan Komputerisasi Akuntansi

1.

2.
3.
4

Menggunakan sistem berpasangan dangan dasar akrual basis.
Menggunakan sistem mata uang rupiah & pencatatan tanggal Indonesia.
Menggunakan Special Journal
Pada tahap setup untuk periode akuntansi dinyatakan sebagai berikut:
e Tahun akuntansi berjalan (Current Financial year) :2013,
e Bulan akhir tahun (Last month of the year) : December,
e Bulan pergantian (Conversion Month) : January,
¢ Jumlah bulan dalam speriode (Accounting Period) : Twelve.
Pada tahap pembuatan daftar akun (Build your accounts list):
e Mengimport daftar akun yang telah disediakan oleh perusahaan.
®© (Iwould like to import a list of accounts provided by ....)
Pada tahap pembuatan dan penyimpanan file data bisnis yang baru:
e Company file name :RMM-1
o Folder penyimpanan file : Document atau My Document

Masalah Pajak (PPN)

1.
2.

Setiap pembelian/penjualan barang dagangan diperthitungkan PPN 10%
Harga-harga yang tertulis di dalam faktur pembelian dan penjualan sudah
termasuk PPN 10% (tax Inclusive).

Jika terjadi retur pembelian atau retur penjualan maka PPN masukan atau
PPN keluaran akan diperhitungkan pengurangannya.

Pembayaran utang dan penerimaan pelunasan piutang dengan discount akan
langsung mengurangi nilai piutang/utang tetapi tidak mempengaruhi PPN yang
telah diperhitungkan.

GST (Good Services Tax), yang akan diedit menjadi: PPN (Pajak
Pertambahan Nilai) sebesar 10%.
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KASUS 1.2. UD RIOLA MEDIA MANDIRI
Identitas Perusahaan dan Usaha pokok

Nama perusahaan : UD Riola Media Mandiri

Nama Pemilik . Riola Marta

Bidang Usaha : Computer Dealer

Alamat . JI. Pamulang Raya 17, Tangerang Selatan.
No Telepon/Faximile : 021 7434352

Alamat email : ud.rmm@yahoo.com

Keputusan Manajemen

Pada awal Januari 2013 pemilik perusahaan Riola Marta ingin menerapkan sistem
informasi yang memproses data akuntansi untuk perusahaannya secara otomatis.
Program yang akan digunakan adalah MYOB Accounting ver 18.

Kebijakan Komputerisasi Akuntansi

1. Menggunakan sistem berpasangan dangan dasar akrual basis.
2. Menggunakan sistem mata uang rupiah & pencatatan tanggal Indonesia.
3. Menggunakan Special Journal
4. Pada tahap setup untuk periode akuntansi dinyatakan sebagai berikut:

e Tahun akuntansi berjalan (Current Financial year) :2013,

e Bulan akhir tahun (Last month of the year) : December,

e Bulan pergantian (Conversion Month) : January,

¢ Jumlah bulan dalam speriode (Accounting Period) : Twelve.
5. Pada tahap pembuatan daftar akun (Build your accounts list):

¢ Mengimport daftar akun yang telah disediakan oleh perusahaan.

®© (Iwould like to import a list of accounts provided by .... )

6. Pada tahap pembuatan dan penyimpanan file data bisnis yang baru:

e Company file name : RMM-2

o Folder penyimpanan file : Document atau My Document

Masalah Pajak (PPN)

1. Setiap pembelian/penjualan barang dagangan diperthitungkan PPN 10%

2. Harga-harga yang tertulis di dalam faktur pembelian dan penjualan sudah
termasuk PPN 10% (tax Inclusive).

3. Jika terjadi retur pembelian atau retur penjualan maka PPN masukan atau
PPN keluaran akan diperhitungkan pengurangannya.

4. Pembayaran utang dan penerimaan pelunasan piutang dengan discount akan
langsung mengurangi nilai piutang/utang tetapi tidak mempengaruhi PPN yang
telah diperhitungkan.

5. GST (Good Services Tax), yang akan diedit menjadi: PPN (Pajak
Pertambahan Nilai) sebesar 10%.
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Komputer Akuntansi Jilid 2
Kegiatan Belajar 2
Membuat Daftar Akun

/7~~& a. Tujuan Pembelajaran

Dengan diberikan kasus akuntansi perusahaan dagang, maka pada
akhir sesi ini diharapkan peserta didik dapat: Menjelaskan pengertian
sumber-sumber dana bank

1. Mengidentifikasi tipe-tipe akun

. Mengimport daftar akun

2
3. Menyesuaikan linked accounts
4

. Menghapus dan mengedit akun

\&\) b. Uraian Materi

Lingkup uraian materi pada kegiatan belajar 1 ini meliputi:
1. Tipe-tipe akun

2. Pembuatan daftar akun

3. Penyesuaian link account

4. Menghapus dan mengedit akun-akun

1. Tipe-tipe akun
Dalam MYOB, daftar akun dikelompokkan dalam 8 tipe, yaitu:

1 Asset Assets dibagi 5: Liabilities dibagi 5:

2 Liability e Bank e Credit card

3 Equity e Accounts Receivable | e Accounts Payable

4 Income e Other Current Asset | e Other Current Liability

o Fixed Asset e Long Term Liability

>  CostofSales | | Giner asset « Other Liability

6 Expense

7 Tidak ada

8 Other Income

9 Other Expense
Kode Akun
Setiap akun memiliki kode 5 digit, contoh akun Cash in Bank 1 - 1100
Digitke 1 : Kategori Akun.
Digitke 2 -5 : Nomor ID Akun (Unik, tidak boleh ada yang sama).
Kelompok Akun.
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a) Akun Header, berfungsi sebagai header, nilainya tidak dapat diposting
(Non Postable). Akun ini biasanya tercetak dengan huruf tebal.

b) Akun Detail, berfungsi sebagai child, nilainya dapat diposting (Postable).
Akun ini tercetak dengan huruf biasa.

Contoh daftar akun:

Account Mame Type

(=3 11400 Prepaid Ingurance Other Azzet
(=3 1-1500  Prepaid Bent Other Azset
(=3 11600 Depositz Paid Other Azzet
o 1-2000 Fixed Assets Azzet

(=3 1-2300 Furniture and Fixtures Agzet

(=3 1-2310  Furniture and Fistures at Cost Other fazset
(=3 1-2320  Fumitr and Fisturs Accum Dep Other Azzet
(=3 1-2500 Office Equipment Bgzet

(=3 1-2510  Office Equip at Cost Other Azzet
(=3 1-2620  Office Equip Accum Dep Other Azset
(=3 1-2600 Store Equipment Azt

(=3 1-2610  Store Equipment at Cost Dther Azset
= 1-2620  Store Equipment Accum Dep Other Azzet

Gambar 2. 9 Contoh Daftar Akun

2. Pembuatan Daftar Akun
Program MYOB menyediakan tiga pilihan untuk pembuatan daftar akun:

a) Memilih salah satu yang disediakan oleh MYOB
b) Mengimport daftar akun
¢) Membuat atau mengetik daftar akun sendiri

Dalam pembelajaran kali ini akan dipraktekkan opsi (b) yaitu mengimport
daftar akun. Untuk itu anda harus mempunyai text file yang sudah
tersimpan di folder tertentu di komputer anda.

Hal-hal yang perlu diperhatikan dalam mengimport daftar akun adalah:

a) Format file daftar akun dalam bentuk text file (tab delimeted).

b) Field-field daftar akun harus mengikuti format dalam MYOB v18.

c) Daftar akun yang digunakan oleh perusahaan yang terkait (lihat Daftar
Akun pada Lembar Kerja Peserta Didik).

Direktorat Pembinaan SMK (2013)
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Praktekkan langkah-langkah mengimpor daftar akun berikut ini:

1 Dobel Klik ikon MYOB Accounting. Kemudian klik Open pada Menu Utama
untuk membuka file.

Gambar 2. 10 Open MYOB

2 Kiik folder Documents. Klik nama file RMM-1.MYO dan klik Open
I > e » voemens s T ‘

Organize v New folder

-

W Favorites 7 D- Arrange by: Folder ¥

.a’wl.ibraries Name b N
Ml Backc g |, Bahan Ajar PRAJAB
|"5| Documents Ji Al-Quran

fb e |_] UD VIRGO MAGIC ELECTRONIC
@) New lerary/v ‘ || RMM-1.MYO No preview available.

<
3
{
i) Pictures L] RIDLMYO §
]
3

m

B videos 37 150 SEARCHING 2012

- c°’“P“*e_’ | | 4 Public Documents (Empty)
&, Local Disk (C:) C:\Users\Public
ca data (E) i

Sl m.r o i ; b
File name: RMM-1.MYO ~ [MY0B Data ("MYO) -

[ Open ] [ Cancel ]

Gambar 2. 11 Open File
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3 Membuat file daftar akun yang akan dimport dengan cara:
e Pertama, copy tabel daftar akun yang ada di lembar kerja peserta didik;
e Kedua, buka program NotePad dan paste tabel yang dicopy ke
NotePad:;
e Ketiga, file daftar akun yang ada di NotePad disimpan di folder My
Document dengan nama: Daftar-Akun-UDRMM. Tutup NotePad.
(lihat gambar berikut)

- Untitled - Notepad

File Edit Format View Help o
|Accoum: Number Account Name Header Account Type (3‘
10000  Assets H Asset

11000 Current Assets H Asset f
11100 cash on Hand H Asset %
11110 Cash In Bank Bank +
‘11120 Payroll Cheque Account Bank i
11130 <¢ash Drawer Bank

11140  Petty Cash Bank %
11150 Undeposited Funds Bank j
11160 Electronic Clearing Account Bank p-
11210  Account Receivable Accounts Receivable b
11220 Allowance for Doubtful Debts Accounts Recm’vatﬂei
11300 Merchandise Inventory H Asset

11310 Inventory - Computers other Current Asset 2
11320 Inventory - Printers other Current Assetr

11400 other Current Assets H Asset 1
11410  supplies Inventory other Current Assetr {
11420 Deposits Paid other Current Asset

11430 Prepaid Insurance other Current Assetr i
11440  Prepaid Rent other Current Asset

12000 Fixed Assets H Asset (
12100 Store Equipment H Asset

12110 Store Equip - at Cost Fixed Asset «
12120 store EQuip - Accum Dep'n Fixed Asset «
12200 Leasehold Improvements H Asset

12210  Improvements at Cost Fixed Assetr j
12220 Improvements Amortisation Fixed Asset

12300 Demonstration Equipment H Asser {
12310 Demo Equip - at Cost Fixed Asset k|
12320 Demo Equip - Accum Dep’'n Fixed Asset <

-

12802, W08T1CS EQUIPTE, o pon X a0 SESSE, s gt i, 0

Gambar 2. 12 Open File
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4  Klik menu bar File > Import Data > Account > Account Information.

P

Open File

Close Window Esc
Print... Ctrl-P
Print Setup.., 4 T
Default Fonts... ﬁ m
Back Up... Paytol “ j
Restore...
Verfy Company File... —
w ol i Cards List | Contact Log
Optimise Company File T i H
‘ Tax Code List ’ [ ) ;
Purge Contact Logs /V | Accounts ’ Account Information
Start a New Year | Rers /V Budgets
Import Data » Jobs
/V Export Data » Custom Lists (D
i M-Pow
Accountantlink » Activities owered
o [ Activity Ships €) Centre
| Timesheet
ToDolist w Find v Analysis w

al Joumal Enmes

PY G TN VSV W A}} Ao A w

Gambar 2. 13 Import Data

5 Pada box Duplicate Records ubah Reject Them ke Update Existing Record.
Kemudian klik Continue

[ Import File

Impart Accaunts

Import File Format: | Tab-delimited ]

First Record is: |Header Record hdl

Duplicate Records: | Update Exizting Record |

Gambar 2. 14 Update Existing Record
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6

EE

Libraries » Documents »

Organize «

@ Documents

J’? Music

[ Pictures

B2 videos
*@ Homegroup
L Computer

£, Local Disk (C3)

= data (E:)

“j MNetwork

7

-

MNew folder

-

Do...

Arrange by:  Felder =

MName )

J BAHAN ASISTENSI

. Al-Quran

J AJUN-PROSES nilai in-on-in
[ IS0 SEARCHING 2012
| | Daftar-Akun-UDRMM

> 4

4 Public Documents (Empty) H
Ch\Users\Public

This folder is empty.

- 4 mn

File name: Daftar-Akun-UDRMM

Pilih file: Daftar-Akun-UDRMM yang disimpan di folder Documents. Klik Open

account Number Account Name
Header Account Type
Assets H
current Assets H
Asset
cash on Hand H
Asset
cash In Bank
Bank
Payroll Cheque Account
Bank
Cash Drawer
Petty Cash
undeposited Funds
Bank
11160 Electronic Clearing
Account Bank
11210 Account Receivable

Accounts Recejvable
11220 Allowance for Doubtful
Debts Accounts Recejvable
11300 Merchandise Inventory H

Asset

7]

Cancel ]

10000
11000

11100
11110
11120
11130

11140
11150

Bank
Bank

[TextFiles r.TxT)

o] |

Open

Gambar 2. 15 Nama File untuk diimport

Pilih field-field yang akan diimpor dengan cara klik field kiri dan klik field di kanan

untuk baris yang sesuai. Klik Import untuk memproses.

[ Import Data

Ao Mmber
Aocows Namne
Heaosr

Aeceeent Taoe

First elick an Import Figld, then click the matching MYOB Field.

0B Fields
*dccount Number:
Account Marne:
Header:
Balance:
Account Type:
Last Cheque Murber:
Taw Code:
Inactive Account:
| Accountantlink Code:

Pl

Matching Import Field
Aoy Mmbar
Ao Mame
Azt

Ao Tupe

[* = Required Figld: Must Hawve a'alid Matching Impart Figld)

Cancel Unmatch All

[™ = Conditional Field: One or Mare Fieldz Must Have a % alid Matching Import Figld)

Match All

Gambar 2. 16 Pemilihan Field-field
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g Laporan hasil import akan ditampilkan setelah proses selesai. Klik OK untuk
mengakhiri.

¥~ MYOB Accounting ! |t
—

|mport Accounts

107 records imported without errors.
0 records skipped.
0 records imported with warnings.

P

Gambar 2. 17 Hasil Import
3. Penyesuaian Linked Accounts

Program MYOB sudah membuat hubungan akun (linked accounts) untuk
beberapa akun, diantaranya seperti Cheque Account dan Trade Debtors.
Fungsi akun-akun ini sudah digantikan oleh Cash In Bank dan Account
Receivable, tetapi justru belum ada linked-nya. Oleh sebab itu anda perlu
menyesuaikan hubungan akun-akun ini dan juga akun-akun lainnya.

Linked accounts untuk Banking

Klik Setup > Linked Accounts > Accounts & Banking Accounts.

Ubah link untuk Historical Balancing dari 3-0999 menjadi 3-9999, dan
Electronic Clearing Account — 1-1160 serta Undeposited Funds —1-

1150. Klik OK.
E] Accounts & Banking Linked Accounts E@
Accounts & Banking Linked dccounts
E quity Account for Curent Earnings: 3-0300 Current r'ear Eamings
E quity Account for Retained Eamings:  3-0800 Retained Earnings

E quity Account for Historical Balancing o | 3-9993 = Historical Balancing
Bank Account for Electronic Payments o {11160 |§] Electronic Clearing Account
Bank Account for Undeposited Funds = |1-1150 )| Undeposited Funds

el

4

o v

Help F1

Gambar 2. 18 Banking Linked Account

Direktorat Pembinaan SMK (2013)
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Linked account untuk Sales

1 Klik Setup > Linked Accounts > Sales. Ubah 1-0200 Trade Debtor menjadi 1-
1210 Account Receivable. Ubah 1-0100 Cheque Account menjadi 1-1110
Cash in Bank. Lengkapi data yang lainnya seperti di bawah ini. Klik OK

(] Sales Linked Accounts EI@

Sales Linked Accounts

Azzet Account for Tracking Flec:eivabl:s(% 1-1210 =/ Account Receivable
=4

Bank Account for Customer Receipf® 1-1110 F| CashlnBank

[w | charge freight on zales
Income Account for Freight o | 4-5000 & Freight Collzcted

[~ | track deposits collected fom customers

[v | give discounts for early payment
Expense or Cost of Sales Account for Discounts £ {53000 5| Sales Discounts
[v | azzess charges for late payment
Incame Accaunt for Late Charges | 4-6000 5| Late Fees Collected

7.

Help F1

Gambar 2. 19 Sales Linked Accounts

Linked Account untuk Purchase

1 Klik Setup > Linked Accounts > Purchases. Ubah 2-0200 Trade Creditor
menjadi 2-1200 Account Payable, Ubah 1-0100 Cheque Account menjadi
1-1110 Cash in Bank. Lengkapi data yang lainny kemudian klik OK.

@ Purchases Linked Accounts EI@

Purchases Linked Accounts

Liability Account for Tracking Paya?i}: 21200  §l Account Payable
Bark Account for F'ayinw o | 1-1110 F| Cazhln Bank

[ | can receive itemg without 2 Supplier bil

[v | pay freight on purchaszes

Expenze or Cost of Sales Account for Freight o | 61700 | Freight Paid
[~ | track deposits paid to suppliers

[v |take dizcounts for early payment

1 Expenze [or Contra) Account for Discounts = | 6-1600 F|| Purchase Discounts
L ¥ | pay charges for Jate payment
4 Expenze Account for Late Charges | 6-1800 Late Fees Paid

Gambar 2. 20 Purchase Linked Accounts
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Linked Account untuk Payroll

1 KIlik Setup > Linked Accounts > Payroll Accounts. Sesuaikan akun-akun seperti
gambar di samping kanan, kemudian klik OK.

@ Payroll Linked Accounts EI@

Paprall Linked Accounts

/y Bank Account for Cash Payments &+ |1-1110 | CashInBank
/V Bank &ccount for Cheque Papments =:|1-1110 &) CashInBank

Eank Account for Electronic Payments o | 1-1160 =| Electronic Clearing Account

/V Default Emplover Expenze Account | B-5140 = Other Ernployer Expenzes
Default Wages Expense Account o | B-5120 =/ wages & Salaries

Default Tax/Deductions Payable Account ©: 20300 5| Paproll Accruals Papable

Gambar 2. 21 Payroll Linked Accounts

4. Menghapus/mengedit akun-akun

Setelah penyesuaian linked accounts, maka ada beberapa akun lama (di-
create oleh MYOB) yang bisa dihapus atau diedit.

Akun-akun yang bisa dihapus

1-0100 Cheque Account 2-0200 Trade Creditor

1-0150 Provision Account 2-0300 Payroll Acrual Payable
1-0160 Investment Account 3-8000 Retained Earnings
1-0180 Undeposited Funds 3-9000 Current Year Earnings

1-0190 Electronic Clearing Account 3-0999 Historical Balancing
1-0200 Trade Debtors

Akun-akun yang harus di-edit

3-0800 Retained Earnings Diubah 3-8000 Retained Earnings
3-0900 Current Year Earnings  Diubah  3-9000 Current Year Earnings
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Langkah menghapus/mengedit akun

1 Klik Setup > Easy Setup Assisstant. Klik Accounts. Klik Next

Easy Setup Assistant E\@

Set Up MrOB

To begin setting up a particular section of MYOR, click the button below that represents the
zechion pou want to zet up,

Purchazes Payrall

Gambar 2. 22 Accounts — Easy Setup assistant

2 MYOB menyediakan fasilitas Accounts - Easy Setup Assistant untuk memu-
dahkan menghapus akun atau mengedit akun dan juga untuk menambah akun
baru.

@ Accounts Easy Setup Assistant EI@

'\ Set up the Accounts List to meet your business needs

The Accounts List you selected when creating your company file is shown below.
You can modify the list to better match the way your business operates.

If you like, you can create new accounts, edit or delete existing accounts. [f pou
make electronic payments, you can set up banking information for your bank
| 2 accounts. |f you have an existing Accounts List, you can import those accounts as
ntroduction & )
Accounts List 4 Accounts List
- -
Onshins Beaieey =3 1-0100 Cheque Account
Canclusion o 1-0150 Pravision Account
=3 1-0160 Investment Account
o> 1-0180 Undeposited Funds
=] 1-0150 Electronic Clearing Account
= 1-0200 Trade Debtors
=3 1-1000 Current Assets
= 1-1100 Cash On Hand
New Edit Delete Imnport
Ly N |/,. ot |y Do imp

Gambar 2. 23 New, Edit and Delete accounts

Klik Cheque Account dan klik Delete untuk menghapus akun tsb. Untuk mengedit
akun, misalnya akan mengubah nomor akun klik Retained Earning dan klik Edit,
kemudian ubah no akun dan klik OK untuk mengedit akun tsb.
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c. Rangkuman

MYOB memberikan kode lima digit angka untuk setiap akun. Digit
pertama untuk kategori akun, sedang digit kedua s.d. kelima
merupakan nomor ID akun. Akun dibedakan dalam delapan kategori,
yaitu: Assets (1), Liabilities (2), Equity (3), Income (4), Cost of Sales
(5), Expense (6), Other Income (8) dan Other Expense (9). Kategori
nomor 7 tidak dipergunakan. Ditinjau dari fungsi, akun dibedakan 2
kelompok, akun header dan akun detail.

+ MYOB menyediakan tiga cara dalam pembuatan daftar akun, yaitu:
pertama, menggunakan daftar akun yang disediakan oleh program;
kedua, mengimpor akun yang telah disediakan oleh teknisi akuntansi;
dan ketiga, membuat daftar akun sendiri. Dalam modul ini dijelaskan
cara yang kedua, mengimpor daftar akun.

+ Setelah berhasil mengimport daftar akun, maka tahap berikutnya
adalah menyesuaikan linked-account untuk banking accounts, sales
accounts, dan purchases accounts. Selanjutnya akun-akun yang
tidak diperlukan dapat dihapus atau diedit.

Berdasarkan Kasus Daftar Akun yang ada pada ‘Lembar Kerja Peserta

Didik’, kerjakan tugas-tugas berikut ini !

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per
kelompok.

2. Setiap peserta didik mengikuti langkah-langkah yang dijabarkan
dalam KB2 ini melalui kerjasama kelompok.

3. Tugas 1, Menyusun daftar akun dengan cara mengimport file Daftar-
Akun-UDRMM.txt

4. Tugas 3, Menyesuaikan Linked account
5. Tugas 4, Menghapus dan mengedit akun-akun tertentu
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A
Af
OJ e. Tes Formatif

v
v

1. Tes Pengetahuan.

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b,
¢, d atau e dari setiap item soal pilihan ganda di bawah ini:

1. Dalam MYOB, akun diberi kode dengan:

a. Satu digit
b. Dua digit
c. Tiga digitt
d. Empat digt
e. Lima digit

2. Dalam sistim pengkodean akun pada MYOB, digit pertama untuk:
a. Header akun
b. Detail akun
c. Nomor ID akun
d. Kategori akun
e. Hubungan akun

3. Dalam sistim pengkodean akun pada MYOB, digit ke-2 s.d.5 untuk:
a. Header akun
b. Detail akun
c. Nomor ID akun
d. Kategori akun
e. Hubungan akun
4. Kelompok akun yang nilainya dapat diposting:
Akun Header
Akun Detalil
Akun Header dan Akun Detall
Akun Heading
. Akun Children

5. Kelompok akun yang nilainya tidak dapat diposting:
Akun Header

Akun Detall

Akun Header dan Akun Detail

Akun Heading

Akun Children

6. Petty Cash termasuk kategori:
a. Bank
b. Account Receivable
c. Other Current Assets
d. Fixed Assets
e. Other Assets

cooow

Po0oTO
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7. Store Supplies termasuk kategori:
Bank

Account Receivable

Other Current Assets

Fixed Assets

Other Assets

8. Wages Payable termasuk kategori:
Credit Card

Account Payable

Other Current Liability

Long Term Liability

Other Liability

9. Format file yang diimport untuk pembuatan daftar akun hendaknya dalam
bentuk:
a. Text (MS-DOS)
b. Formated Text (space delimited)
c. Unicode Text.
d. Text (tab delimeted).
e. CSV(comma delimited).

10. Pada proses import daftar akun, pada kolom Duplicate Record diisi dengan

Update Existing Record, hal ini berarti:

a. Nama akun hasil import akan ditolak untuk no akun yang sama.

b. Nama akun hasil import akan ditolak untuk nama akun yang sama

c. Nama akun hasil import akan menggantikan (replace) untuk no akun
yang sama

d. No akun hasil import akan menggantikan (replace) untuk nama akun
yang sama

e. Tidak ada jawaban yang tepat.

PO TR

P TR

2. Tes Keterampilan.
Berdasarkan Kasus Daftar Akun yang ada pada ‘Lembar Kerja Peserta
Didik’, kerjakan tes berikut ini!

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh
peserta didik secara berkelompok.

2. Pada akhir waktu tes diminta setiap peserta didik menyerahkan hasil
pekerjaannya dalam bentuk file.

3. Tugas 1, Menyusun daftar akun dengan cara mengimport file Daftar-
Akun-UDRMM.txt

4. Tugas 2, Menyesuaikan Linked account
5. Tugas 3, Menghapus dan mengedit akun-akun tertentu
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o/ f. Kunci Jawaban Tes Formatif

S
1. Kunci Tes Pengetahuan

QB IWIN|F
Q|T|IO |Q|D

OO0 INO®
o|alo|o |9

2. Kunci Tes Keterampilan
Tugas 1 & 3, Menyusun daftar akun (hasil akhir).

UD Rasela Media Mandiri
JI. Pamulang Raya 17 PAMULANG
Tangerang Selatan

Accounts List [Summary]
Page 1

Account

1-0000 Assets
1-1000  Current Assets
1-1100  Cash On Hand
1-1110  Cash In Bank
1-1120  Payroll Chegue Account
1-1130 Cash Drawer
1-1140  Petly Cash
1-1150 Undeposited Funds
1-1160  Electronic Clearing Account
1-1210  Account Receivable
1-1220  Allowance for Doubtful Debts
1-1200 Merchandise Inventory
1-1310 Inventary - Computers
1-1320  Inventory - Printers
1-1400  Other Current Assets
1-1410  Supplies Inventory
1-1420 Deposits Paid
1-1430 Prepaid Insurance
1-1440 Prepaid Rent
1-2000 Fixed Assets
1-2100  Store Equipment
1-2110 Store Equip - at Cost
1-2120 Store Equip - Accum Dep'n
1-2200 Leasehold Improvements
1-2210 Improvements at Cost
1-2220 Improvements Amortisation
1-2300  Demonstration Equipment
1-2310  Demo Equip - at Cost
1-2320 Demao Equip - Accum Dep'n
1-2400 Office Equipment
1-2410 Office Equip - at Cost
1-2420  Office Equip- Accum Dep'n
1-2500  Furniture & Fidtures
1-2510 Furniture Equip - at Cost
1-2520  Furniture Equip- Accum Dep'n
1-2600 Motor Vehicles
1-2610 Motor Vehicles - at Cost
1-2620 Motor Vehicles - Accum Dep'n

42 Direktorat Pembinaan SMK (2013)




Komputer Akuntansi Jilid 2

2-0000  Liabilities
2-0300  Payroll Accruals Payable
2-1000 Current Liabilities
2-1100 Credit Cards
2-1110 Bankcard
2-1120 MasterCard
2-1200  Account Payable
2-1210 AP Accrual - Inventory
2-1300 PPN Liabilities
2-1310 PPN Collected
2-1320 PPN Paid
2-1330 PPN Payable
2-1400  Payroll Liabilities
2-1410  Wages & Salaries Payable
2-1420 Hari Raya Incentive Payable
2-1500 Customer Deposits
2-1600 Income Tax Payable
2-2000  Long Term Liabilities
2-2100  Mandiri Loan
2-2200 Other Long Term Liabilities

3-0000  Equity
3-1000  Rasela Marta's Equity
3-1100  Rasela Marta's Capital
3-1200 Rasela Marta's Drawings
3-8000 Retained Earnings
3-9000 Current Year Earmnings
3-9999  Historical Balancing

Direktorat Pembinaan SMK (2013) 43




Komputer Akuntansi Jilid 2

UD Rasela Media Mandiri

Accounts List [Summary]
Page 2

Account

4-0000  Income
4-1000 Sales
4-1100 Sales - Computers
4-1200 Sales - Printers
4-5000 Freight Collected
4-6000  Late Fees Collected
4-3000 Miscellaneous Income

5-0000 Cost of Goods Sold
5-1100 COGS - Computer
B-1200  COGS - Printer
5-3000  Sales Discounts

G-0000 Expenses
5-1000 General & Administrative Exp
6-1200 Bank Charges
B-1300  Depreciation
B-1400  Subscriptions
6-1500  Office Supplies
6-1600  Purchase Discounts
6-1700  Freight Paid
6-1800 Late Fees Paid
6-3000  Advertising & Promotion Exp
6-3100  Advertising
6-3110  In-store Promotions
6-4000  Operating Expenses
6-4100 Maintenance
6-4200 Postage
6-4300 Speedy - Internet
6-4400 Rent
6-4500  Telephone
G-4600  Water
G5-4700 Cleaning
6-4800 Store Supplies
6-4900 Merchandise Spoilage
6-5100  Employment Expenses
6-5110  Staff Amenities
6-5120  Wages & Salaries
5-5130 Workers' Compensation
5-5140 Other Employer Expenses

8-0000 Other Incomes
8-1000 Interest Income

9-0000  Other Expenses
9-1000 Interest Expense
9-2000 Income Tax Expense
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Tugas 2, Menyesuaikan Linked account

[&] MYOB Accounting - [Sales Linksd Accour_ C=nran X

@File Edit Lists Command Centres Setup Reports Window Help - |5 *

Sales Linked Accounts

Agset Account for Tracking Receivables 25 5| Account Receivable
Bank Account for Customer Feceipts & (11110 5| CashlInBank

[w | charge freight on zales

|ncome Account for Freight o | 4.5000 =/ Freight Collected
[ | krack deposits collected from customers

[v | give dizcounts for early payment

Expense or Cost of Sales Account for Discounts 2| 5-3000 5] Sales Discounts
[ | azzess charges for late payment

Income Account for Late Charges o | 4-6000 5| Late Fees Collected

Help F1 Temms

Pressz F1 to get help. Rbdtd-1 to zaldo amall

Account Payable
Bank Account for Paying Bille {11110 Cash In Bank

[ | can receive items without a Supplier bil

[ | pay freight on purchazes

Expense or Cost of Sales Account for Freight o | 61700 5| Freight Paid
[ | rack deposits paid to suppliers

[v | take dizcounts for early payment

Expenze [or Contra] Account for Dizcounts 2 | 61600 5| Purchasze Dizcounts
[v | pay charges for Jate payment

Expenze Account for Late Charges o | 6-1300 5| Late Fees Paid

Help F1 Terms

Pressz F1 to get help. Rbdtd-1 to zaldo amall
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@ MYOB Accounting - [Accounts & Banking Linked Accounts]‘ C=0E0 X

Ei]File Edit Lists Command Centres Setup Reperts Window Help - | &| %

-

Accountz & Banking Linked Accountz

E quity Account for Current Earnings:  2-9000 Current 'ear Earnings
Equity Account for Fetained Earnings:  3-8000 Retained E arnings

Equity Account far Histarical Balancing o | EREEEE Hiztarical Balancing
Bank Account for Electronic Payments 2 [ 1-1160 5| Electronic Clearing Account
Bank Account for Undeposited Funds 5| 1-1150 =/ Undeposited Funds

7.

Help F1

Presz F1 to get help. Fikdbd-1 to zaldo awal |

Fayrall Linked Accounts

Bank Account for Cash Payments S | SRR =l CashInBank

Bark Account for Cheque Payments o |1-1110 || CashlnBank
Bank Accourt for Electronic Payments S [ 1-1160 =l Electranic Clearing Account
Drefault Emplover Expenze Account = | 6-5140 = Other Employer Expenses
Default YW ages Expense Account o | 65120 ¥ wages & Salaries

Default T w0 eductions Payable &ccount o | 20300 5| Payroll &ccuals Payable

Help F1

Presz F1 to get help. Rtdbd-1 to zaldo amwal ]
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g. Lembar Kegiatan Peserta Didik

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta

didik di komputer melalui program MYOB versi 18.

Kasus Daftar Akun untuk:
Kasus 2.1. UD Rasela Media Mandiri atau
Kausus 2.2. UD Riola Media Mandiri

ﬁﬁiﬁg;: Account Name Header Account Type

10000 Assets H Asset

11000 Current Assets H Asset

11100 Cash On Hand H Asset

11110 Cash In Bank Bank

11120 Payroll Cheque Account Bank

11130 Cash Drawer Bank

11140 Petty Cash Bank

11150 Undeposited Funds Bank

11160 Electronic Clearing Account Bank

11210 Account Receivable Accounts Receivable
11220 Allowance for Doubtful Debts Accounts Receivable
11300 Merchandise Inventory H Asset

11310 Inventory - Computers Other Current Asset
11320 Inventory - Printers Other Current Asset
11400 Other Current Assets H Asset

11410 Supplies Inventory Other Current Asset
11420 Deposits Paid Other Current Asset
11430 Prepaid Insurance Other Current Asset
11440 Prepaid Rent Other Current Asset
12000 Fixed Assets H Asset

12100 Store Equipment H Asset

12110 Store Equip - at Cost Fixed Asset

12120 Store Equip - Accum Dep'n Fixed Asset

12200 Leasehold Improvements H Asset

12210 Improvements at Cost Fixed Asset

12220 Improvements Amortisation Fixed Asset

12300 Demonstration Equipment H Asset

12310 Demo Equip - at Cost Fixed Asset

12320 Demo Equip - Accum Dep'n Fixed Asset

12400 Office Equipment H Asset
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Qﬁ%?ggrt Account Name Header Account Type
12410 Office Equip - at Cost Fixed Asset
12420 Office Equip- Accum Dep'n Fixed Asset
12500 Furniture & Fixtures H Asset
12510 Furniture Equip - at Cost Fixed Asset
12520 Furniture Equip- Accum Dep'n Fixed Asset
12600 Motor Vehicles H Asset
12610 Motor Vehicles - at Cost Fixed Asset
12620 Motor Vehicles - Accum Dep'n Fixed Asset
20000 Liabilities H Liability
21000 Current Liabilities H Liability
21100 Credit Cards H Liability
21110 Bankcard Credit Card
21120 MasterCard Credit Card
21200 Account Payable Accounts Payable
21210 A/P Accrual - Inventory Other Current Liability
21300 PPN Liabilities H Liability
21310 PPN Collected Other Current Liability
21320 PPN Paid Other Current Liability
21330 PPN Payable Other Current Liability
21400 Payroll Liabilities H Liability
21410 Wages & Salaries Payable Other Current Liability
21420 Hari Raya Incentive Payable Other Current Liability
21500 Customer Deposits Other Current Liability
21600 Income Tax Payable Other Current Liability
22000 Long Term Liabilities H Liability
22100 Mandiri Loan Long Term Liability
22200 Other Long Term Liabilities Long Term Liability
30000 Equity H Equity
31000 Rasela Marta's Equity H Equity
31100 Rasela Marta's Capital Equity
31200 Rasela Marta's Drawings Equity
38000 Retained Earnings Equity
39000 Current Year Earnings Equity
39999 Historical Balancing Equity
40000 Income H Income
41000 Sales H Income
41100 Sales - Computers Income
41200 Sales - Printers Income
45000 Freight Collected Income
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Qﬁ?ﬁggrt Account Name Header Account Type
46000 Late Fees Collected Income
48000 Miscellaneous Income Income
50000 Cost of Goods Sold H Cost of Sales
51100 COGS - Computer Cost of Sales
51200 COGS - Printer Cost of Sales
53000 Sales Discounts Cost of Sales
60000 Expenses H Expense
61000 General & Administrative Exp H Expense
61200 Bank Charges Expense
61300 Depreciation Expense
61400 Subscriptions Expense
61500 Office Supplies Expense
61600 Purchase Discounts Expense
61700 Freight Paid Expense
61800 Late Fees Paid Expense
63000 Advertising & Promotion Exp H Expense
63100 Advertising Expense
63110 In-store Promotions Expense
64000 Operating Expenses H Expense
64100 Maintenance Expense
64200 Postage Expense
64300 Speedy - Internet Expense
64400 Rent Expense
64500 Telephone Expense
64600 Water Expense
64650 Electricity Expense
64700 Cleaning Expense
64800 Store Supplies Expense
64900 Merchandise Spoilage Expense
65100 Employment Expenses H Expense
65110 Staff Amenities Expense
65120 Wages & Salaries Expense
65130 Workers' Compensation Expense
65140 Other Employer Expenses Expense
80000 Other Incomes H Other Income
81000 Interest Income Other Income
90000 Other Expenses H Other Expense
91000 Interest Expense Other Expense
92000 Income Tax Expense Other Expense
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Kegiatan Belajar 3
Membuat Buku Pembantu

r *T{ a. Tujuan Pembelajaran

L J Dengan diberikan kasus akuntansi perusahaan dagang, maka pada akhir
sesi ini diharapkan peserta didik dapat:

1. Menyiapkan Buku Pembantu/kartu piutang.
2. Menyiapkan Buku Pembantu/kartu utang.

3. Menyiapkan Buku Pembantu/kartu item persediaan.

\&\/ b. Uraian Materi

Lingkup uraian materi pada kegiatan belajar 1 ini meliputi:
1. Kartu piutang dagang

2. Kartu utang dagang

3. Kartu item persediaan

Program MYOB menggunakan istilah “kartu” yang fungsinya sama dengan buku
pembantu. MYOB menyediakan menu untuk pembuatan kartu piutang (customer
cards), kartu utang (supplier cards) dan kartu item persediaan (item cards).

1. Kartu Piutang

Kartu piutang berisi informasi tentang customer, meliputi identitas, history dan
data lain. Kartu piutang ini berfungsi sebagai tempat mencatat mutasi
(penambahan, pengurangan dan saldo) piutang dagang sebagai akibat dari
transaksi penjualan atau pelunasan piutang.

Hal-hal yang perlu diperhatikan dalam menyiapkan kartu piutang:

a) Satu kartu untuk satu customer.
b) Penentuan termin pembayaran, denda keterlambatan, dan pajak.
c) Daftar customer UD Rasela Media Mandiri:

Kode Nama Alamat Telepon
C-001 Toko Ganesha Unggul | JI. Setia Budi 23, Pamulang 0217431270
C-002 Toko Global Persada JI. Cendana 11, Ciputat 0217431171
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Langkah pembuatan buku pembantu piutang:
1 Klik Command Centre Card File > Card List > New. Card Type: Customer

Ketik nama customer dan tekan [enter]. Lengkapi data customer lainnya pada
tab Profile (lihat data Toko Ganesha Unggul).

@ Card Information

Profile ' Card Detailz LSallngalglls ' Payment Details 'EontactLog' Jaobs 'H\story
>

TOKD GANESHA UNGGUL c-om A7R Balance &+ Rp0.00

Card Type: | Customer || Designatior: | Company el ™ Inactive Card

Marne: | TOKO GANESHA UNGEUL

Y Cadin: [CO01
Locatior: | Address 1: Bil To -

[ s

Address: |JI. Setia Budi 23 Pamulang Phoneftl: | 021 7421270
v Fhonetz:
/v City: | Tangerang Selatan Phonef:
State: Postoode: | Ferz
Country: Emait
‘wighsite:
5 alutatior:
Contact:

| 5 Letter =7 Email | & ‘website

fe Print

Help F1

Gambar 2. 24 Customer Profile

2 Pada tab Selling Details lengkapi data Customer Term Information.
Tax Code: PPN. Freight Tax Code: N-T. Klik OK

@ Card Information EI@

Card Details Selling Details ' Payment D etails ' Contact Log ' Jaobs ' Histary
TOKO GANESHA UNGGUL c-001 A/R Balance o> Rp0.00

Profile

Sale Layout: | ltem = Credit Limit: Fp0,00
Printed Farm: E
Irvoice Delivery: | To be Printed )
ABM.:
Income Account: = A.B.N. Branch:
Receipt Mema: | Tax 1D Nurber:
Salespersan; §| / Tax Code: [PPM | 5] Pajak Pertambahar
Sale Comment: F Freight Tax Code: [M-T & Mot Repartable
Shipping Methnd: =l [T Use Customer's Tax Code

Custormer Billing Fiate: Rp0.00 Excluding Tax

— Customer Termns Information

Papment is Due: |In a Given # of Daps - % Discount for Early Payment: | 2%
D\sWays' 10 *% Monthly Charge for Lat;:a}mnt' 2%

Balance Due Dayps: | 30 WYolume Deount %: | 0%

:-id Credit Limit & Hold
7

u v

Help F1

Gambar 2. 25 Selling Details

3 Ulangi langkah-langkah 1 dan 2 untuk pembuatan kartu customer berikutnya,
yaitu untuk Toko Global Persada.
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2. Kartu Utang Dagang

Kartu utang dagang berisi informasi tentang supplier, meliputi identitas,
history, dan juga data lainnya. Kartu utang ini berfungsi sebagai tempat
mencatat mutasi (penambahan dan pengurangan) utang sebagai akibat dari
transaksi pembelian atau pembayaran utang.

Hal-hal yang perlu diperhatikan dalam menyiapkan kartu utang adalah:

a) Satu kartu untuk satu supplier.
b) Penentuan termin pembayaran, denda keterlambatan, dan pajak.
c) Daftar Supplier UD Rasela Media Mandiri:

Kode Nama Alamat Telepon
5-001 PT Merbabu Raya JI. Gajah Mada 12 Jakaria 021 4433000
5-002 PT Merapi Abadi JI. Mangga Dua 29 Jakarta 021 2335577

Langkah pembuatan buku pembantu utang:

1 Klik Command Centre Card File > Card List > New. Card Type: Supplier
Ketik nama supplier dan tekan [enter]. Lengkapi data supplier lainnya pada tab
Profile (lihat data PT Merbabu Raya)

@ Card Information EI@

Profile ' Card Details ' Buying Details ' Payment Details 'ContactLog ' Jobs 'Histor_lg

PT HERBABU RAYA 5-001 A/P Balance 5 Rp0.00

Card Tupe:| Supplier il Deesignation: | Campany hd I Inactive Card
M arne: |F'T MERBABL RAYA
/V Card ID: | 5-001
o
Location: | Address 1 -
Address: [JI. Gajah Mada 12 /V Phone: [021 4433000
/V Phonett2
City: | Jakarta Phaonett2
State: Postcode: | Bem
Couritry: Encil

‘wiebsite
S alutation

Contact:

fe Pririt | 3 Letter =7 Email | B websit

Help F1

Gambar 2. 26 Supplier Profile
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2 Pada tab Buying Details lengkapi data Supplier Term Information.
Tax Code: PPN. Freight Tax Code: N-T. Klik OK

(] Card Information = ”ﬂl@

| Profile @qgg@@ l ] ' Payment Details ' Contact Log ' Jobs ' History
PT Merbabu Raya 5-001

A/P Balance o | Rp0.00

Purchase Layout: | No Default ) Credit Limit: [ F!;Dbﬁ
Avalable Credit: [ Rp0.00
Curently PastDue: [ Rp0.00
ABN: [
Expense Account: [ =l ABN. Branch: |

Payment Memo: | Tax ID Number: |
Purchase Comment: | =l Tax Code: | PPN §If Pajak Pertambahar
Shipping Method: \' 53\ Freight Tax Code: W@ Not Reportable
Supplier Biling Rate: [ R—Eﬂj—ﬂ Excluding Tax / [~ Use Supplier's Tax Code

Cost per Hour: | Hpﬁﬁ

— Supplier Terms Information

Payment is Due: ‘\rln a Given # of Days hdl % Discount for Earwm: |3%
Dis;?ﬁays: [10 )
BalanceDue Days: |30 Volume Discount %: | 0%

Help F1

Gambar 2. 27 Buying Details

3 Ulangi langkah-langkah 1 dan 2 untuk pembuatan kartu supplier berikutnya, yaitu
untuk PT Merapi Abadi.

3. Kartu Item Persediaan

Kartu item persediaan berfungsi sebagai tempat pencatatan saldo awal dan
keluar masuknya setiap item persediaan.

Hal-hal yang perlu diperhatikan dalam menyiapkan kartu item persediaan:

a) Satu kartu untuk mencatat satu item persediaan .

b) Tentukan linked-account dengan Cost of Sales, Tracking Sales dan Asset
Account untuk item persediaan yang terkait.

c) Tentukan kuantitas dan harga pokok per unit.
d) Daftar Item Persediaan UD Rasela Media Mandiri:

No | Kode Nama Barang Kelompok | Jml Cost/Unit Total
Unit
1| COM-001 HP Probook 4421s | Computer 20 9.000.000.- 180.000.000.-
2 | com-002 | HPProbook 5530 | computer 12 | 11.000.000.- 132.000.000.-
3 | PRN-0DA Canon Lj-215 Printer 40 650.000,- 26.000.000,-
4 | PRN-002 Canon Bj-555 Printer 40 350.000,- 14.000.000.-
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Langkah-langkah membuat buku pembantu persediaan:

1 Klik Command Centre Inventory > Item list > New. Pada tab Profile, ketik
identitas item number & name. Set linked accounts: | Buy, | Sell, | Inven
Klik tab Buying details (lihat data item persediaan HP Pro Book 44215s)

G] Item Information EI@
FProfile I Item D etails I Buying Detailz I Selling Details I Hiztory I Auto-Build _

Item Mumber: | COM-001 [ Inactive ltem

/v Mame: | HF Pro book 4421= Guantity On Hand & i}

Current Yalue o> ’W
Average Cost: ’W
Committed =: [ 0
On Order o ’70
Available = [0

[¥ | Buy This Item Cost of Sales Account & | 51100 | F)|COGS - Computer
¥ | Sell This Item Income Account for Tracking Sales =+ | 41100 & Sales - Computers
¥ | lrentory This ltem Azset Account for ltem Inventory 522 {11310 5] Inventary - Computers

= Copy From | RBE Spell
&5 7

Help F1 Hew

Gambar 2. 28 Item COM-001 Profile

2 Klik Buying Details. Pada tab Buying Details lengkapi data pajak. Tax Code
When Bought: pilih PPN

@ Itemn Information EI@
Profile I Item Details I Buying Details I Seling Details I History I Auto-Build _
COM-001 /v HFP Pro book 44215

Last Purchase Price: Rp0.00  Including Tax

Standard Cost: Rp0.00  Tax Codewhen Bought o0 | FPM (5] Pajak Pertambahan Milai

Buying Unit of Meazure:

Mumber of ltems per Buging Unit: 1

— Optional Restocking Information for the To Do List

Minimurn Level for Restocking Alert: 1]

Frimary Supplier for Reorders | =l

Supplier [tem Mumber: |

Diefault Reorder Quantity: 0

Gambar 2. 29 Item COM-001 Buying Details
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Klik Selling Details Pada tab Selling Details lengkapi data pajak. Tax Code

When Sold: PPN. Klik option untuk Prices are Tax Inclusive.

@ Item Information

Lo s

Profile I Item Dietails I Buying Details LSeIIing Details I Histaory I Auto-Build _
COM-001

ook 4421s

HP Pr

Help F1 Mew

Basze Selling Price: |

Selling Unit of Meazure:
Murnber of ltemz per Seling Unit: 1

Fp0,00  Tax CodeWhen S

= [PPN [ Pajsk Pertambahan Nilsi
Inclusive/E uclusive; W Fri

e T ax Inclusive
Caleulate Sales Taw on: |Actual Selling Price

Gambar 2. 30 Item COM-001 Selling Details

4

Klik OK. Item No. COM-001 sudah tercatat di daftar seperti terlihat di gambar

samping. Klik New untuk membuat kartu item berikutnya.

E] Itemns List

All ltems

Bought

[E=8Hol/ =)

Inventoried

Search by | Item Mumber

# Found: 1

Item Mumber

|

[I=% COk4-001

HF Pro book, 442

On Hand Last Cost Sell Price

* Indicates that the amount is Tax [nclusive

Gambar 2. 31 Item COM-001 List

Ulangi langkah-langkah yang samal s.d. 4 untuk pembuatan kartu item

berikutnya, yaitu untuk COM-002 HP Pro Book 5530. Yakinkan bahwa dalam tab
‘All Items’ akan ada dua item yaitu COM-001 dan COM-002.
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6  Klik New untuk membuat kartu item berikutnya yaitu PRN-001. Ketik identitas
item tersebut seperti dalam gambar berikut.
E] Item Information EI@
| 4
' Item Details ' Buying Details ' Selling Details ' Hiztory ' Auto-Build _
Itemn Mumber: |F'F|N-DD‘I [T Inactive ltem
Mame: |Ean0n Lj-215 Guantity On Hand ©»: 1}
Current Yalue 5= Rp0,00
Awerage Cost: Rp0.00
Committed 52 1]
On Order g 1]
Available 20 [0
v 1 Buy This ltem Cost of Sales Account = |51200 )| COGS - Printer
v | Sell Thiz Item Income Account for Tracking Sales = (41200 |5 Sales - Printers
/v ¥ | Inventary This ltem Agzzet Account For [tem [nventory S {11320 =|Inventory - Printers
% Copy From | REC Spell /
',?/ l o
Hel; F1 Hew
Gambar 2. 32 Item PRN-001 Profile
7 Klik Buying Details. Pada tab Buying Details lengkapi data pajak. Tax Code

When Bought: PPN

Cﬁ] Item Information

= Eon ==

Prafile I Item Dietails IHuying Details I Seling Details I Histary I

ruosas N

COM-001

Y  HP Pio book 44215

Last Purchaze Price: Fp0.00  Including Tax

Standard Cost: Rp0,00  Tax Code When Bought o> | PPN

Buying Unit of Meazure:

Murnber of [tems per Buying Unit: 1

Pajak Pertambahan Milai

— Optional Restocking Information for the To Do List

inimurn Level for Restacking Alert: 1]

Frimary Supplier for Reorders |

=l

Supplier [tem Hurmber: |

Diefault Reorder Quantity: 0

7.

Help F1

Gambar 2. 33 Item COM-001 Buying Details
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8 Klik Selling Details. Pada tab Selling Details lengkapi data pajak. Tax Code
When Sold: PPN. Klik option untuk Prices are Tax Inclusive.

4) Item Information o |[@ ] |
Profile I Item Dietails I Buying Details L Selling Details I Histaory I Auto-Build _
COM-001 HP Pro*book 44213
Base Seling Price: | Rp0.00 TaxCode'when S = [PPN |5 Paiak Pertambahan Nilai
Selling Unit of Meazure: Inclusive/E xclusive: W PrlcesareTaxlncIuswa

Murnber of ltemz per Seling Unit: 1 Caleulate Sales Taw on: |Actual Selling Price hd

ALT;

7. W
Help F1 Hew

Gambar 2. 34 Item COM-001 Selling Details

9 Klik New untuk membuat kartu item berikutnya. yaitu. Ulangi langkah-langkah
yang sama 6 s.d. 8 untuk pembuatan kartu item berikutnya, yaitu untuk PRN-002
Printer Canon BJ-555. Yakinkan bahwa dalam tab ‘All ltems’ akan ada empat
item yaitu COM-001, COM-002, PRN-001 dan PRN-002

c. Rangkuman

¢ MYOB menyediakan menu untuk membuat buku tambahan berupa kartu,
yakni kartu piutang (customer cards) dan kartu utang (supplier cards).
Dalam MYOB, setiap item barang dagangan juga dicatat dalam satu format
(sejenis kartu). Pada prinsipnya, kartu-kartu tersebut merupakan detil
penjabaran dari akun-akun buku besar seperti piutang dagang, utang
dagang dan Persediaan barang.

Dalam proses pembuatan kartu-kartu tersebut ada Linked-Account yang
harus diset dengan akun-akun tertentu sehinga apabila terjadi transaksi-
transaksi yang terkait dengan kartu tertentu maka secara otomatis jumlah-
jumlah yang tertulis di dalam kartu akan bertambah atau berkurang.

e Yang perlu diperhatikan dalam proses pembuatan kartu adalah bahwa
kartu harus dibuat terlebih dahulu sebelum diisi dengan saldo awalnya.
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@', A
v
v
v

Berdasarkan Kasus 3.1. UD Rasela Media Mandiri yang ada pada
‘Lembar Kerja Peserta Didik’, kerjakan tugas-tugas berikut ini !

1.

Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per
kelompok.

. Setiap peserta didik mengikuti langkah-langkah yang dijabarkan dalam
KB3 ini melalui kerjasama kelompok.

. Tugas 1, Membuat kartu Piutang (2 Customer)
. Tugas 2, Membuat kartu Utang (2 Supplier)
. Tugas 3, Membuat kartu Item Persediaan (4 item)

e.

Tes Formatif

1. Tes Pengetahuan.

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b,
c, d atau e dari setiap item soal pilihan ganda di bawabh ini:

1.

Menu yang digunakan untuk membuat kartu piutang (customer card):

a.
b.
c.
d.
e.

Card File > Card List > New > Pilih Card Type Supplier
Card List > Card File > New > Pilih Card Type Customer
Card File > New > Card List > Pilih Card Type Customer
Card List > Card File > New > Pilih Card Type Supplier
Card File > Card List > New > Pilih Card Type Customer

. Jika termin pembayaran piutang N/30, maka pilihan yang tepat untuk

Payment is Due:

PO TY

COD

On a Day of the Month
# of Days after EOM

In a Given # of Days
Day of Month ater EOM

Menu yang digunakan untuk membuat kartu utang (supplier card)

a.
b.
c.
d.
e.

Card File > Card List > New > Pilih Card Type Supplier
Card List > Card File > New > Pilih Card Type Customer
Card File > New > Card List > Pilih Card Type Customer
Card List > Card File > New > Pilih Card Type Supplier
Card File > Card List > New > Pilih Card Type Customer

Dalam pembelian dinyatakan bahwa Freight Tax Code: N-T, artinya:

a
b
c.
d
e

. Ada beban pajak dalam pembelian
. Tidak ada beban pajak dalam pembelian

Ada beban pajak dalam pembayaran biaya angkut pembelian

. Tidak ada beban pajak dalam pembayaran biaya angkut pembelian
. Tidak ada beban pajak dalam pembelian dan biaya angkut
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5. Menu yang digunakan untuk membuat kartu item persediaan:
a. Card File >Item List > New
b. Inventory > Inventory ltem > New.
c. Card File >Inventory Iltem > New
d. Inventory >lItem list > New.
e. Item list >Inventory > New.

6. M 1Buy This ltem. ™ | Sell This Item. M | Inventory This Item. Ini berarti
Item tersebut adalah:

Iltem barang dagangan

Item berupa jasa

Item berupa barang dagangan dan jasa

Item barang dalam proses

Item bahan mentah

7. Linked account untuk Cost of Sales Account adalah:
Sales of ltem

Purchases Product

Merchandise Inventory

Sales Product

Cost of Goods Sold

8. Linked account untuk Income account for Tracking Sales adalah:
Cost of Sales

Purchases Product

Merchandise Inventory

Sales Product

e. Cost of Goods Sold

9. Apa yang akan terjadi apabila kolom 'Tax Code When Bought’ diisi dengan

N-T :

a. Pada saat pembelian dan penjualan barang tidak akan diperhitungkan
PPN-nya.

b. Pada saat penjualan barang tidak akan diperhitungkan PPN-nya.

c. Pada saat pembelian barang tidak akan diperhitungkan PPN-nya.

d. Pada saat pembelian dan penjualan barang secara otomatis akan
diperhitungkan PPN-nya.

e. Pada saat pembelian barang akan diperhitungkan PPN-nya.

10. Apa yang akan terjadi apabila kolom 'Tax Code When Sold’ diisi dengan

PoooTR

Po0TR

aooo

PPN :
a. Pada saat pembelian dan penjualan barang akan diperhitungkan PPN-
nya.

b. Pada saat pembelian barang tidak akan diperhitungkan PPN-nya.

c. Pada saat penjualan barang akan diperhitungkan PPN-nya.

d. Pada saat pembelian barang secara otomatis akan diperhitungkan
PPN-nya.

e. Pada saat penjualan barang tidak akan diperhitungkan PPN-nya.
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2. Tes Keterampilan.
Berdasarkan Kasus 3.2. UD Riola Media Mandiri yang ada pada ‘Lembar
Kerja Peserta Didik’, kerjakan tugas-tugas berikut ini !
1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh peserta
didik secara berkelompok.

2. Pada akhir waktu tes diminta setiap peserta didik menyerahkan hasil
pekerjaannya dalam bentuk file.

3. Tugas 1, Membuat kartu Piutang (2 Customer)
4. Tugas 2, Membuat kartu Utang (2 Supplier)
5. Tugas 3, Membuat kartu Item Persediaan (4 item)

P f. Kunci Jawaban Tes Formatif

s

1. Kunci Tes Pengetahuan

1 e 6 a
2 d 7 e
3 a 8 d
4 (o 9 (o
5 d 10 C

ﬂ Direktorat Pembinaan SMK (2013)
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2. Kunci Tes Keterampilan

Tugas 1, Membuat kartu Piutang (2 Customer)

(5] Cards List o-E )
All Cards Supplier Employes Personal

Search by |Last Mame/Co. Name =] |
Ad d...
# Found: 2 Q e

Card ID Fhaohe Murmber Type j

; C-001
obal Persada

71 New Log Entry | 3 Letter | QJ Log | Q Combine Cardz | w Sync Cards

.,? -
7. | g
Help F1 Print

Tugas 2, Membuat kartu Utang (2 Supplier)

(] Cards List

All Cards Custorner Employes Personal

Search by |Last Mame/Co. Name =] |
Ad d...
# Found: 2z M

M ame Card ID Fhaohe Murmber Type Current Balancj

BIFT terapi Abadi i
= PT Merbabu Raya 021 4433000 Supplier

71 New Log Entry | 3 Letter | QJ Log | Q Combine Cardz | w Sync Cards

”
7. | =
Help F1 Print
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Tugas 3, Membuat kartu Item Persediaan (4 item)

@ Items List

All ltems Bought Imventaried

Search by | ltem Mumber hd |
# Found: 4

Itern Mumber On Hand
=3 C(7}4-001 HF Pro Boak H
= COM-002 HF Pro Book 5530
= PRM-001 Canon Lji-215
o PRM-002 Canon Bj-555

Last Cost Sell Price
Fp0,00

* Indicates that the amount iz Tax Inclusive

7.

Help F1 Print
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g. Lembar Kerja Peserta Didik

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta

didik di komputer melalui program MYOB versi 18.

Kasus 3.1 : Kasus UD Rasela Media Mandiri.

Daftar Customers

Kode Nama Alamat Telepon

C-001 Toko Ganesha Unggul JI. Setia Budi 23, Pamulang 021 7431270

C-002 Toko Global Persada JI. Cendana 11, Ciputat 021 7431171
Catatan:

Termin pembayaran untuk Customer: 2/10, n/30 dan denda late payment 2%.

Daftar Suppliers

Kode Nama Alamat Telepon

S-001 PT Merbabu Raya JI. Gajah Mada 12 Jakarta 021 4433000

S-002 PT Merapi Abadi JI. Mangga Dua 29 Jakarta 021 2335577
Catatan:

Termin pembayaran dari Supplier: 3/10, n/30 dan denda late payment 2%.
Persediaan Barang Dagangan

Tabel persediaan barang dagangan per awal januari 2013.

No Kode Nama Barang Kelompok  Jml Cost/Unit Total

Unit
1 COM-001  HPProbook 4421s  Computer 20 9.000.000,- 180.000.000,-
2 com-002  HPProbook5530  computer 12 11.000.000,- 132.000.000,-
3 PRN-001 Canon Lj-215 Printer 40 650.000,- 26.000.000,-
4 PRN-002  Canon Bj-555 Printer 40 350.000,- 14.000.000,-

Pencatatan Persediaan
e Sistem pencatatan persediaan: sistem perpetual.

e Metode perhitungan: metode rata-rata bergerak (moving average).
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Kasus 3.2 : Kasus UD Riola Media Mandiri.

Daftar Suppliers

Kode Nama Alamat Telepon

S-001 PT Merbabu Raya JI. Gajah Mada 12 Jakarta 021 4433000

S-002 PT Merapi Abadi JI. Mangga Dua 29 Jakarta 021 2335577
Catatan:

Termin pembayaran dari Supplier: 3/10, n/30 dan denda late payment 2%.

Daftar Customers

Kode Nama Alamat Telepon

C-001 Toko Ganesha Unggul  JI. Setia Budi 23, Pamulang 021 7431270

C-002 Toko Global Persada  JI. Cendana 11, Ciputat 021 7431171
Catatan:

Termin pembayaran untuk Customer: 2/10, n/30 dan denda late payment 2%.

Persediaan Barang Dagangan

UD Riola Media Mandiri bergerak dalam bidang penjualan komputer dan barang-barang
elektronik lainnya. Berikut tabel persediaan barang dagangan per awal januari 2013.

No Kode Nama Barang Kelompok  Jml Cost/Unit Total

Unit
1  COM-001  HPProbook 4421s  Computer 20 9.000.000,- 180.000.000,-
2 Ccom-002  HPProbook5530  computer 12 11.000.000,- 132.000.000;-
3 PRN-001  Canonlj-215 Printer 40 650.000,- 26.000.000,-
4  PRN-002 Canon Bj-555 Printer 40 350.000,- 14.000.000,-

Pencatatan Persediaan
e Sistem pencatatan persediaan: sistem perpetual.

¢ Metode perhitungan: metode rata-rata bergerak (moving average).
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. Uraian Materi

Dasar-dasar Perbankan Jilid 2
Kegiatan Belajar 4
Mengentri Saldo Awal

a. Tujuan Pembelajaran

Dengan diberikan kasus akuntansi perusahaan dagang, maka pada akhir
sesi ini diharapkan peserta didik dapat:

1. Mencatat Saldo awal akun buku besar.

2. Mencatat Saldo awal buku pembantu piutang.

3. Mencatat Saldo awal buku pembantu utang.

4. Mencatat Saldo awal buku pembantu persediaan

Lingkup uraian materi pada kegiatan belajar 1 ini meliputi:
1. Entri saldo awal akun buku besar.

2. Entri saldo awal buku pembantu piutang.

3. Entri saldo awal buku pembantu utang.

4. Entri saldo awal buku pembantu persediaan

1. Entry Saldo Awal Akun Buku Besar

Entri saldo awal akun buku besar dilakukan pada saat konversi ke sistem
baru. Jika bulan konversi sama dengan bulan awal periode akuntansi maka
hanya bisa dientri saldo-saldo dari akun-akun neraca. Apabila bulan konversi
tidak sama dengan bulan awal periode akuntansi maka bisa dientri saldo-
saldo dari akun neraca dan akun laba-rugi.

Hal-hal yang perlu diperhatikan dalam entri saldo awal akun buku besar:

a)

b)

Ada dua cara, bisa melalui menu Command Centre Accounts >
Account List > Edit Account satu per satu atau melalui menu utama
Setup > Balances > Account Opening Balances. Cara yang ke-dua ini
cenderung lebih mudah untuk mengontrol nilai Historical Balancing.

Jika nilai akun Historical Balancing = 0, ini berarti bahwa total akun-akun
assets sama dengan total akun-akun Liability dan Equity. Jika nilai akun
Historical Balancing # 0, ini berarti bahwa telah terjadi ketidak-
seimbangan antara total assets dengan total Liability dan Equity.

Akun-akun kontra dientri dengan tanda (minus). Yang termasuk akun
kontra: Allowance for Doubtful Debts, Fixed Assets Accumulation
Depresiation, Owner’s Drawing, Other Contra Account.
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d) Data Neraca Saldo UD Rasela Media Mandiri:

UD RASELA MEDIA MANDIRI
Neraca Saldo Per 31 Desember 2012

No. Akun Nama Akun Debit Kredit
Rp. Rp.

1-1110 Cash In Bank 210.000.000
1-1140 Petty Cash 5.000.000
1-1210 Account Receivable 275.000.000
1-1310 Inventory - Computers 312.000.000
1-1320 Inventory - Printers 40.000.000
1-1410 Supplies Inventory 4 300.000
1-2110 Store Equip at Cost 100.000.000
1-2120 Store Equip Accum Dep 10.000.000
1-2310 Demo Equip at Cost 20.000.000
1-2320 Demo Equip Accum Dep 2.000.000
1-2410 Office Equip at Cost 60.000.000
1-2420 Office Equip Accum Dep 12.000.000
1-2510 Furniture Equip at Cost 80.000.000
1-2520 Furniture Equip Accum Dep 16.000.000
2-1200 Account Payable 187.000.000
2-1600 Income Tax Payable §.300.000
2-2100 Bank Mandiri Loan 300.000.000
3-1100 Rasela Marta Capital 571.000.000

Jumlah 1.106.300.000 1.106.300.000

Langkah-langkah Entry Saldo Awal Akun

1 Klik Setup > Balance > Account Opening Balance
Entri saldo akun satu per satu dengan nilai positif kecuali akun-akun yang
nilainya negatif (akun kontra).

2  Cek saldo akun Historical Balancing di bawah, nilai 0 adalah tanda seimbang
dalam persamaan dasar akuntansi.
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Enter the balance of vour accounts as of 07./01/2012 [Balance Sheet Only).
[Remember, enter all balahces as pozitive numbers, unlezs the balance really waz negative. |
______________________________________________________________________________________|
Acct # Marne Openihg Balance
Asszet -
11110 Cazh In Bank g Rp210.000.000,00
11120 Payroll Chegue Account Fip0.00 e
11130 Cash Drawer Rp0.00
1-1140 Petty Cash Rp5.000.000,00
1-11580 |Indepaosited Funds Rp0.00
11160 Electronic Clearing Account Rp0.00
112410 Account Becervable Rp275.000.000,00
11220 Allowance for D oubtful Debts Rp0.00
11310 |Fventary - Computers Rp312.000.000,00
11320 |mventony - Printers Fp40.000.000,00
11410 Supplies Inventory Fipd.300.000,00
11420 Depositz Paid Rp0.00
11430 Prepaid Insurance Fip0.00
1-1440 Prepaid Rent Rp0.00
1-2110 Store Equip - at Cost Rp100.000.000,00
1-2120 Store Equip - Accum Dep'n [Rp10.000.000,00)
1-2210 |mprovemnents at Cost Rp0.00
1-2220 |mprovemnents Amortization Fip0.00
12310 Demo Equip - at Cost Rp20.000.000,00
1-2320 Demo Equip - Accum Dep'n [Rp2.000.000,00]
1-2410 (O ffice Equip - at Cost Rp&0.000.000,00
1-2420 (Office Equip- Accum Dep'n [Rp12.000.000,00)
1-2510 Furriture Equip - at Cost Rp20.000.000,00
1-2520 Furniture Equip- Accurn Dep'n [Rp16.000.000,00)
1-2610 Mator Wehicles - at Cost Rp0.00
1-2620 Motor Vehicles - Accum Dep'n Fip0.00
Liability
240300 Payroll Accruals Payable Rp0.00
21110 Barkcard Fip0.00
21120 t asterCard Rp0.00
21200 Account Pavable Rp187.000.000,00 -
Amaunt left to be allou:atﬁi:l Fipl. EIEI‘
Thiz will be the Opening Balance of the I-T’Bh:,mal—ﬁlalancmg Aooount.

Gambar 2. 35 Saldo Awal Akun Buku Besar

2. Entry Saldo awal buku pembantu piutang

Pencatatan saldo awal buku pembantu piutang atau kartu piutang dilakukan
pada saat konversi. Program MYOB akan mengecek kesamaan total semua
kartu piutang dengan saldo akun Piutang Dagang (Account Receivable). Jika
terjadi kesamaan atau ketidaksamaan maka program MYOB akan
memberikan pesan atau peringatan (warning).

Hal-hal yang perlu diperhatikan dalam pencatatan saldo awal piutang:

a) Ada dua cara. Cara yang pertama, melalui menu Setup > Balances >
Customer Balances > Pilih Customer > Add Sale. Cara kedua melalui
menu Setup, Easy Setup Assistant > Sales > Historical Sales > Add
Sale. Cara pertama yang lebih banyak digunakan
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b) Entri saldo kartu piutang sampai muncul pesan: Congratulations, yang
menandakan jumlah piutang di Customer list sama dengan jumlah piutang

di Account Opening Balances.
¢) Kasus UD Rasela Media Mandiri:

Daftar Saldo Piutang Dagang
Per awal Januari 2013
Kode Nama Keterangan Faktur Jumlah (Rp.)
C-001 Toko Ganesha Unggul | Faktur Penjualan No. FP-003 209.000.000-
tanggal 27-12-2012
Termin 2/10, n/30
Denda Late payment 2%/bl.
C-002 Toko Global Persada Faktur Penjualan No. FP-005 66.000.000 -
tanggal 29-12-2012
Termin 2110, n/30
Denda Late payment 2%/bl.
Jumlah Total 275.000.000 -

Langkah-langkah entri saldo awal kartu piutang:

1  Klik Setup > Balance > Customer Balance. Klik opsi Customer Details.

Pilih nama customer. Klik Add Sale

E] Customer Balances

[o )& =]

|TDKD GAMESHA UNGGI% " Customer Summan

&+ Customer Qeﬂv

Invaice #

Amount Due

Rp0.00
Rp275.000.000,00

Total 5ales:
Linked Receivables &ccount Balance:

Out of Balance Amount: [Rp275.000.000,00)

Tatal:

Add Sale

Gambar 2. 36 Add Sale
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Klik [Enter] untuk menampakkan format. Entri data ke dalam format. Jika telah

2 selesai diisi klik Record . Peringatan dari MYOB: Please Note.......... untuk ini
klik OK.
(8] Historical Sale IE”E‘@

Historical Sale

Customer Name: lToko Ganesha Unggul §| Balance: Rp0,00

Tems = 2% 10 Net 30
Invoice #: |FP-003
_¥ Date [27n2/2012

Customer PO #: |

Memo: | Pre-conversion sale

Total Including Tax: [Rp209.000.00000 TaxCode: [E2  |$] Tax ©: Rp19.000.000,00

Gambar 2. 37 Historical Sale

3  Saldo pembantu piutang yang pertama sudah tercatat. Klik Add Sale untuk entri
saldo pembantu piutang berikutnya atau klik Close jika sudah selesai.

(] Customer Balances ‘_CLH_@_‘@

% Customer Detail | Toka Ganesha Unggul  |&l| ¢ Customer Summary

Invoice # Date Mema Amount Due
= FP-003 2712/2012  Pre-conversion sale Rp203.000.000,00

Total Sales: Rp209.000.000,00 Total: Rp203.000.000,00
Linked Receivables Account Balance: Rp275.000.000,00

Out of Balance Amount: (RpE6.000.000,00)

Add Sale

Gambar 2. 38 Customer Balances

4  Ulangi langkah-langkah 1 dan 3 untuk entri saldo awal buku pembantu piutang
berikutnya, yaitu untuk Toko Global Persada.
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3.

1

70

Entry Saldo awal buku pembantu persediaan

Setelah disiapkan buku pembantu atau kartu item persediaan, tahap
berikutnya adalah mencatat saldo awal untuk masing-masing item. Ada dua
cara pencatatan saldo awal item persediaan. Kedua cara ini akan berakhir
pada ujung yang sama yaitu Adjust Inventory.

Hal-hal yang perlu diperhatikan dalam entri saldo awal item barang:

a) Cara pertama memakai menu Command Centre Inventory > Count
Inventory > ketik kuantitas untuk setiap Item > Adjust Inventory >
Continue > Opening Balances > ketik unit cost & nomor akun untuk
setiap item.

b) Cara kedua langsung menggunakan menu Command Centre Inventory
> Adjust Inventory > kemudian ketik kuantitas, unit cost & nomor akun
untuk setiap item

c) Cara kedua yang akan digunakan untuk latihan karena lebih praktis.

d) Kasus UD Rasela Media Mandiri, Daftar Persediaan Barang:

No | Kede Nama Barang Kelompok | Jml Cost/Unit Total
Unit
1 | COM-001 HP Probook 44215 | Computer 20 9.000.000 - 180.000.000 -
2 | comoo2 | HPProbook 5530 | computer 12 | 11.000.000.- 132.000.000,-
3 | PRN-0D1 Canon Lj-215 Printer 40 650.000.- 26.000.000 -
4 | PRN-0D02 Canon Bj-555 Printer 40 350.000.- 14.000.000 -

Langkah-langkah entri saldo awal buku pembantu persediaan:

Klik Command Centre Inventory > Adjust Inventory. Ketik data berikut:

(&) Adjust Inventory =0 oR ==
Inventory Journal Number: | /000001
/ Date: |ENFEGE
ema: |Persedlaan harang dagangan
Item Number Cluantity Unit Cost Armaunt Account Jaob Mema
COM-001 20| p9.000.000,00(:180.000.000,00 | 1-1310
SCOM-002 12{111.000.000.00(3132.000.000.00 (11310
/_ =PRN-001 40| RpB50.000,007p26.000.000,00 | 1-1320
oPRN-002 40| Rp350.000,003p14.000.000,00 | 11320

Gambar 2. 39 Adjust Inventory
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2 Cek data persediaan yang telah di Record dalam Jurnal dengan cara klik
Command Centre Inventory > Transaction Journal. Sesuaikan tanggal dari
1/12/2012 s.d. 31/01/2013.

action Journal
| 4
General ' Disbursements ' Receipts ' Sales ' Purchazes ' Inventory All
Dated From: | 01/01/2013 Taor | 31A01/2013
t e 1D Fram: Ta
=3 01/01/2013 Perzediaan barang dagangan -
1100001 11310 Inventory - Computers 4p312.000.000,00
Lo0ooot 11320 Irwentorny - Printers Fp40.000.000.00
lJ00ooot 11310 Inventory - Computers 3p180.000.000,00
-1 Lo0ooot 11310 Inwventory - Computers §p132.000.000,00
lJ00ooot 11320 Inwentorny - Printers Rp26.000.000.00
lJ00ooo 11320 Inwentory - Printers Fip14.000.000,00

7 e
7. ==
Help F1 Print

Gambar 2. 40 Inventory Transaction Journal

|c. Rangkuman

Pencatatan saldo awal untuk akun-akun buku besar, untuk kartu piutang,
kartu utang dan kartu item persediaan dilakukan pada saat pindah ke sistem
yang baru (komputerisasi akuntansi). Jadi hanya satu kali saja proses
tersebut, selanjutnya saldo-saldo ini akan dihitung dan ditampilkan secara
otomatis oleh MYOB pada awal periode berikutnya.

Kebenaran entri saldo awal buku besar ditandai akun Historical Balancing
yang mempunyai saldo Rp. 0,- (NOL). Untuk kartu piutang dan kartu utang,
kebenaran entri saldo ditandai dengan adanya pesan “Congratulation” yang
diberikan oleh MYOB. Sedang untuk entri saldo item persediaan dikatakan
benar jika dicek bahwa total cost untuk seluruh item sama dengan jumlah
persediaan yang tertulis di dalam buku besar.

Berdasarkan Kasus 3.1. UD Rasela Media Mandiri yang ada pada
‘Lembar Kerja Peserta Didik’, kerjakan tugas-tugas berikut ini !
1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per
kelompok.
2. Setiap peserta didik mengikuti langkah-langkah yang dijabarkan dalam
KB3 ini melalui kerjasama kelompok.
. Tugas 1, Mengentri saldo Awal Buku Besar.
. Tugas 2, Mengentri saldo Kartu Piutang (2 Customer)
. Tugas 3, Mengentri saldo Kartu Utang (2 Supplier)
. Tugas 4, Mengentri saldo Kartu Persediaan (4 item)
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@L

v e. Tes Formatif

v
v

1. Tes Pengetahuan.

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b,
¢, d atau e dari setiap item soal pilihan ganda di bawah ini:

1. Menu untuk mengentri saldo akun buku besar adalah:

©®oo0 Ty

Setup > Easy Setup Assisstant > Account Opening Balances
Setup > Easy Setup Assisstant >Balances

Setup > Balances > Account Opening Balances

Easy Setup Assisstant > Balances > Account Opening Balances
Setup > Easy Setup Assisstant > Balances > Account Opening
Balances

2. Akun yang termasuk dalam “Kontra Akun” berikut ini adalah:

L

Allowance for Doubtful Debt
Account Payable

Bad Debt

Depreciation of Office Equipment
Prepaid Insurance

3. Jika dalam pencatatan saldo awal ditunjukkan bahwa Historical Balancing
terdapat saldo Rp. 550.000,- ini memberi tanda:

a.
b.
c.
d.
e.

Terdapat kesalahan input sebesar Rp. 550.000,-

Jumlah debet lebih kecil sebesar Rp. 550.000,-

Jumlah debet lebih besar sebesar Rp. 550.000,-
Terdapat kelebihan kredit sebesar Rp. 550.000,-

Tidak bermasalah, karena itu adalah saldo akun tersebut.

4. Jika dalam pencatatan saldo awal ditunjukkan bahwa Historical Balancing
terdapat saldo minus Rp. 550.000,- ini memberi tanda:

PoooTR

Terdapat kesalahan input sebesar Rp. 550.000,-

Jumlah debet lebih kecil sebesar Rp. 550.000,-

Jumlah debet lebih besar sebesar Rp. 550.000,-
Terdapat kelebihan debet sebesar Rp. 550.000,-

Tidak bermasalah, karena itu adalah saldo akun tersebut.

5. Menu untuk mengentri saldo kartu piutang dagang adalah:

a.

b
c.
d.
e

Easy Setup Assistant > Sales > Historical Sales > Add Sale

Setup > Customer Balances > Balances > Add Sale> Pilih Customer
Setup > Easy Setup Assistant > Sales > Add Sale

Setup > Balances > Customer Balances> Pilih Customer > Add Sale
Setup > Balances > Customer Balances> > Add Sale> Pilih Customer
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6. Mengentri saldo seluruh kartu piutang dianggap berhasil apabila:

Tidak ada saldo kartu piutang yang dobel dientri

Seluruh saldo kartu piutang berhasil dientri ke dalam komputer

Seluruh saldo kartu piutang berhasil dientri ke dalam komputer dan
terakhir muncul pesan "Congratulation”

Ada pesan "Congratulation”, walaupun belum semua saldo dientri

Ada pesan "Congratulation”, walaupun ada saldo kartu piutang yang
dobel dientri

7. Menu untuk mengentri saldo kartu utang dagang adalah:

apow

Setup > Supplier Balances > Pilih Customer > Add Purchase

Setup > Balances > Pilih Customer > Add Purchase

Balances > Supplier Balances > Pilih Customer > Add Purchase

Setup > Balances > Supplier Balances > Pilih Customer > Add
Purchase

Setup Assisstant > Balances > Supplier Balances > Pilih Customer >
Add Purchase

8. Dalam kartu utang tertulis termin pembayaran 2% 10 Net 30, artinya:

a.
b.

C.

d.

Diskon 2% dari jumlah utang apabila dibayar dalam waktu 10-30 hari.
Diskon 2% dari jumlah utang apabila dibayar dalam waktu setelah10
hari sampai dengan 30 hari

Diskon 10% dari jumlah utang apabila dibayar dalam waktu 10 hari,
Jika tidak, maka jatuh tempo pembayaran utang 30 hari.

Diskon 2% dari jumlah utang apabila dibayar dalam waktu 10 hari, Jika
tidak, maka jatuh tempo pembayaran utang 30 hari

Diskon 10% dari jumlah utang apabila dibayar dalam waktu 10 hari,
Jika tidak, maka jatuh tempo pembayaran utang 30 hari

9. Menu untuk mengentri saldo item-item persediaan:

P00 o

Count Inventory > Inventory > Adjust Inventory

Inventory > Count Inventory > Adjust Inventory

Inventory > Adjust Inventory

Inventory > Count Inventory > Adjust Inventory > Opening Balances
Inventory > Adjust Inventory > Continue > Opening Balances

10. Menu untuk melihat tampilan jurnal setelah record Adjust Inventory:

a.

b.
C.
d
e

Count Inventory > Inventory > Adjust Inventory

Inventory > Count Inventory > Adjust Inventory

Inventory > Adjust Inventory

Inventory > Count Inventory > Adjust Inventory > Opening Balances
Inventory > Transaction Journal

Direktorat Pembinaan SMK (2013) 73




Dasar-dasar Perbankan Jilid 2
2. Tes Keterampilan.

Berdasarkan Kasus 3.2. UD Riola Media Mandiri yang ada pada ‘Lembar
Kerja Peserta Didik’, kerjakan tugas-tugas berikut ini !

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh peserta
didik secara berkelompok.

2. Pada akhir waktu tes diminta setiap peserta didik menyerahkan hasil
pekerjaannya dalam bentuk file.

Tugas 1, Mengentri saldo Awal Buku Besar.
Tugas 2, Mengentri saldo Kartu Piutang (2 Customer)
Tugas 3, Mengentri saldo Kartu Utang (2 Supplier)

o g~ w

Tugas 4, Mengentri saldo Kartu Persediaan (4 item)

f. Kunci Jawaban Tes Formatif

5

%

5

1. Kunci Tes Pengetahuan

1 (o 6 c
2 a 7 d
3 c 8 d
4 b 9 c
5 d 10 e
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2. Kunci Tes Keterampilan

Tugas 2, Mengentri saldo Kartu Piutang (2 Customer)

@Transaction]ournal EI@
| 4
General ' Lizsburzements ' Receipts ' 5 ' Purchaszes ' Inwentony ' all -
Dated From: | 01/01/2012 To: [31/01/2013
I Frarm: ’7 Tar ’7
Date ID# Account Debit Credit Job
=3 27A12/2M2 Saldo Awal Toko Ganesha Unggul -
FP-003 11210 Account Receivable 3p190.000.000,00 ]
FP-003 11210 Account Receivable Fip13.000.000.00 b
FP-003 11210 Account Receivable Fp2013.000.000.00
o 29/12/2M2 Saldo awal Toko Global Perzada
FP-005 11210 Account Receivable FipE0.000.000.00
FP-005 11210 Account Receivable RpE.000.000,00
FP-005 11210 Account Receivable RpEE.000.000,00
-
7. | -
Help F1 Print

Tugas 4, Mengentri saldo Kartu Persediaan (4 item)

(8] Transactien Journal EI@
| 4
General ' Dizsburzements ' Receipts ' Sales ' Purchases ' Al
Drated From: | 0100 /20012 To | A/0/2013
1D From: To
D ate D Accaount Diebit Credit Jaob
=3 /0172013 Persediaan Barang Dagangan -
100000t 11310 Inventary - Computers Jp180.000. 000,00 I
11000001 11320 Inventony - Printers Rp2E.000.000,00 b
1000001 11310 Inventan - Complters Ap180.000.000.00
1000001 11320 Inwventory - Printers Fip26.000.000,00
=3 01/01/2013 Perzediaan barang dagangan
100000z 1130 Inventony - Computers Jp132.000.000,00
100000z 11320 Inwentony - Printers Rp14.000.000,00
11000002 11310 Inwenton - Computers Ap132.000.000,00
1Jo0nooz 11320 Inwenton - Printers Fip14.000.000.00
7. | =
Help F1 Frint
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Tugas 1, Mengentri saldo Awal Buku Besar.

[_;] MYOE Accounting - [Account Opening Balances [E- o=l -S;h]

@File Edit Lists Command Centres 5Setup Reports Window Help |- | & %

76

Erter the balance of your accounts az of 07./071,/2013 [Balance Sheet Only).

[Remember, enter all balances az positive numbers, unless the balance really waz negative. |

Acct #

Marne

Opening Balance

Asszet
11110
11120
1-1130
1-1140
1-11580
1-1160
11210
1-1220
11310
1-1320
11410
1-1420
1-1430
1-1440
1-2110
1-2120
1-2210
1-2220
1-2310
1-2320
1-2410
1-2420
1-2510
1-2520
1-2610
1-2620

Liability
2-0300
21110
21120
21200
21210
21310
21320
21330
21410
21420
21500
21800
2-2100
2-2200

Equity
31100
31200
3-8000

Cash In Bank

Pagroll Cheque Account
Cagh Drawer

Petty Caszh

Undeposited Funds
Electronic Clearing Account
Account Receivable
Allowance for Doubtful Debts
Invenkany - Computers
Inventory - Printers

Supplies Inventory

Depozitz Paid

Prepaid Inzurance

Prepaid Rent

Store Equip - at Cost

Store Equip - Accum Dep'n
Improvements at Cost
Improvements Amortization
Demo Equip - at Cost

Demo Equip - Accum Dep'n
Qffice Equip - at Cost

Office Equip- Accum Dep'n
Furniture Equip - at Cost
Furniture Equip- Accum Dep'n
totar WVehicles - at Cost
totor Wehicles - Accum Dep'n

Payroll Accruals Payable
Bankcard

tasterCard

Arccount Payable

AP Acoal - Inventory
PPN Collected

PPM Paid

PPM Papable

Whages & Salaries Payable
Hari Flaya Incentive Payable
Cusgtorner Depozits
Income Taw Payable
tandin Loan

(Other Long Term Liabilities

Razela Marta's Capital
Razela Marta's Drawings
Retained E arnings

Fip210.000.000,00
Rp0.00

Rp0.00
Rph.000.000,00
Fip0.00

Rp0.00
Rp275.000.000,00
Rp0.00
Rp312.000.000.00
Rp40.000.000,00
Fipd. 200,000,000
Rp0.00

Rp0.00

Fip0.00
Fip100.000,000,00
[Fip10.000.000.00)
Rp0.00

Fip.00
Rp20.000.000,00
[Fip2.000.000.00)
RpE0.000.000,00
[Rp12.000.000,00)
Rpa0.000.000,00
[Fipl6.000.000.00)
Rp0.00

Rp0.00

Fip0,00

Rp0.00

Rp0.00
Rp187.000.000,00
Fip0.00

Rp0.00

Rp0.00

Rp0.00

Fip.00

Fip0,00

Rp0.00
Rp&.300.000,00
Rp300.000.000,00
Fip0.00

Rp571.000.000.00
Rp0.00
R o, 00

Amount left to be allocated: FipD,00
Thiz will be the Opening B alance of the Higtarical Balancing Account,

::?/J g

Help F1

Prezz F1 to get help.

Ridt-2. 1450
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_~_ 8. Lembar Kerja Peserta Didik

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta

didik di komputer melalui program MYOB versi 18.

Kasus 4.1 : Kasus UD Rasela Media Mandiri.

UD RASELA MEDIA MANDIRI
Neraca Saldo Per 31 Desember 2012

No. Akun Nama Akun Debit Kredit
Rp. Rp.
1-1110 Cash In Bank 210.000.000
1-1140 Petty Cash 5.000.000
1-1210 Account Receivable 275.000.000
1-1310 Inventory - Computers 312.000.000
1-1320 Inventory - Printers 40.000.000
1-1410 Supplies Inventory 4.300.000
1-2110 Store Equip at Cost 100.000.000
1-2120 Store Equip Accum Dep 10.000.000
1-2310 Demo Equip at Cost 20.000.000
1-2320 Demo Equip Accum Dep 2.000.000
1-2410 Office Equip at Cost 60.000.000
1-2420 Office Equip Accum Dep 12.000.000
1-2510 Furniture Equip at Cost 80.000.000
1-2520 Furniture Equip Accum Dep 16.000.000
2-1200 Account Payable 187.000.000
2-1600 Income Tax Payable 8.300.000
2-2100 Bank Mandiri Loan 300.000.000
3-1100 Rasela Marta Capital 571.000.000

Jumlah

1.106.300.000

1.106.300.000

Direktorat Pembinaan SMK (2013)
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Daftar Saldo Piutang Dagang
Per awal Januari 2013

Kode Nama Keterangan Faktur Jumlah (Rp.)
C-001 Toko Ganesha Unggul  Faktur Penjualan No. FP-003 209.000.000,-
tanggal 27-12-2012
Termin 2/10, n/30
Denda Late payment 2%/bl.
C-002 Toko Global Persada  Faktur Penjualan No. FP-005 66.000.000,-
tanggal 29-12-2012
Termin 2/10, n/30
Denda Late payment 2%/bl.

Jumlah Total 275.000.000,-

Daftar Saldo Utang Dagang
Per awal Januari 2013

Kode Nama Keterangan Faktur Jumlah (Rp.)
S-001 PT Merbabu Raya Faktur Pembelian No. CE-12 110.000.000,-
tanggal 26-12-2012
Termin 3/10, n/30
Denda Late payemnt 3%/bl.
S-002 PT Merapi Abadi Faktur Pembelian No. B-215 77.000.000,-
tanggal 28-12-2012
Termin 3/10, n/30
Denda Late payemnt 3%/bl.

Jumlah Total 187.000.000,-
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Kasus 4.2 : Kasus UD Riola Media Mandiri.

UD RIOLA MEDIA MANDIRI
Neraca Saldo Per 31 Desember 2012

No. Akun Nama Akun Debit Kredit
Rp. Rp.

1-1110 Cash In Bank 210.000.000
1-1140 Petty Cash 5.000.000
1-1210 Account Receivable 275.000.000
1-1310 Inventory - Computers 312.000.000
1-1320 Inventory - Printers 40.000.000
1-1410 Supplies Inventory 4.300.000
1-2110 Store Equip at Cost 100.000.000
1-2120 Store Equip Accum Dep 10.000.000
1-2310 Demo Equip at Cost 20.000.000
1-2320 Demo Equip Accum Dep 2.000.000
1-2410 Office Equip at Cost 60.000.000
1-2420 Office Equip Accum Dep 12.000.000
1-2510 Furniture Equip at Cost 80.000.000
1-2520 Furniture Equip Accum Dep 16.000.000
2-1200 Account Payable 187.000.000
2-1600 Income Tax Payable 8.300.000
2-2100 Bank Mandiri Loan 300.000.000
3-1100 Rasela Marta Capital 571.000.000

Jumlah 1.106.300.000 1.106.300.000

Daftar Saldo Piutang Dagang
Per awal Januari 2013

Kode Nama Keterangan Faktur Jumlah (Rp.)
C-001 Toko Ganesha Unggul Faktur Penjualan No. FP-003 209.000.000,-
tanggal 27-12-2012
Termin 2/10, n/30
Denda Late payment 2%/bl.

C-002 Toko Global Persada  Faktur Penjualan No. FP-005 66.000.000,-
tanggal 29-12-2012

Termin 2/10, n/30
Denda Late payment 2%/bl.

Jumlah Total 275.000.000,-
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Daftar Saldo Utang Dagang
Per awal Januari 2013

Kode Nama Keterangan Faktur Jumlah (Rp.)

S-001 PT Merbabu Raya Faktur Pembelian No. CE-12 110.000.000,-
tanggal 26-12-2012

Termin 3/10, n/30
Denda Late payemnt 3%/bl.
S-002 PT Merapi Abadi Faktur Pembelian No. B-215 77.000.000,-
tanggal 28-12-2012
Termin 3/10, n/30
Denda Late payemnt 3%/bl.

Jumlah Total 187.000.000,-
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Kegiatan Belajar 5
Mengentri Transaksi Penjualan

r j a. Tujuan Pembelajaran

Dengan diberikan kasus akuntansi perusahaan dagang, maka pada
akhir sesi ini diharapkan peserta didik dapat:

. Mencatat transaksi Order Penjualan (Sales Order)
. Mencatat transaksi Penjualan Kredit (Sales)
. Mencatat transaksi Penjualan Tunai (Counter Sales)

. Mencatat transaksi Retur Penjualan (Sales Return)
. Mencatat transaksi Retur Penjualan Tunai (Counter Sales Return)

. Mencatat transaksi Penerimaan Piutang (Receipt Payment) tanpa
Discount

. Mencatat transaksi Penerimaan Piutang (Receipt Payment) dengan
Discount

\&\) b. Uraian Materi

Lingkup uraian materi pada kegiatan belajar 1 ini meliputi:

Entri transaksi Order Penjualan (Sales Order)

Entri transaksi Penjualan Kredit (Sales)

Entri transaksi Penjualan Tunai (Counter Sales)

Entri transaksi Retur Penjualan (Sales Return)

Entri transaksi Retur Penjualan Tunai (Counter Sales Return)

Entri transaksi Penerimaan Piutang (Receipt Payment) tanpa
Discount

Entri transaksi Penerimaan Piutang (Receipt Payment) dengan
Discount

ogkwnE

N

Program MYOB menyediakan menu-menu pilihan untuk mengentri berbagai
transaksi yang terkait dengan penjualan (Sales).

m%fﬂmﬁk

Banking Time Biling Purchase: Inventory Caid File

;Sn]gs ngifler

~
Enter Sales -+ @ Receive Payments
& &
PrinEmail Qtemranrses Pri il Invoices Print Receipts

Transaction Joumal @------oooeet @Se?vius

ToDolist w Find Transactions w Reports w Analysis w

Gambar 2. 41 Menu Sales
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1. Entri Transaksi Order Penjualan (Sales Order)

Hal-hal yang perlu diperhatikan dalam transaksi order penjualan:

a) Tidak ada jurnal untuk Sales Order, jadi belum ada pengaruh apapun
terhadap akun buku besar ataupun kartu piutang dan persediaan.

b) Anda bisa lihat hasil entri pada menu Sales Register

c) Selamanya akan tercatat di Sales Register kalau anda belum merubahnya
menjadi Invoice.

d) Dokumen sumber Bukti No: 01 & 02:

BuktiNo: 01
UD. RASEL MEDIA MANDIRI SALES ORDER
JI. Pamulang Raya 17, Pamulang G@.‘g':l Date 3 Januari 2013
Tangerang Selatan SO S0-001
SALES ORDER
Sold to: Tekeo Ganesha Unggul, JI, Setia Budi 23, Pamulang
Amount: Rp. 178.200000, -
Seratus tujuh puluh delopan juta due ratus nbu Rupiah.
Details:
Mo Item Mo Description Cty Price/Unit Total Price TAX
Rp. Rp.
1 COM-001 | HPPro book4421s 10 14.850.000,- 148.500.000,- | PPN
3 PEM-001 | CanonU-215 30 550.000,- 28.700.000,- [ PPN
Total 178.200.000,- | PPN
Pemilik Perusahaan Sales Teknisi Akuntansi
Rasela Marta Renata
BuktiNo: 02
UD. RASEL MEDIA MANDIRI SALES ORDER
N Pamulang Raya 17, Pamulang G@@ Date 3 Januari 2013
Tangerang Selatan SO S0-002
SALES ORDER
Sold to: Toko Global Persada, JI. Cendana 11 Ciputat
Amount: Rp. 118800000, -
Seratus delopan belos juta delapan ratus nbu Rupiah.
Details:
Mo Item Mo Description Oty Price/Unit Total Price TAX
Rp. Rp.
1 COM-002 | HPPro book5530 6 17.600.000,- 105.600.000,- | PPN
3 PEM-002 | CanonBj-555 20 660.000,- 13.200.000,- [ PPN
Total 118.800.000,- | PPN
Pemilik Perusahaan Sales Teknisi Akuntansi
Rasela Marta Renata
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Praktekkan langkah-langkah berikut ini:

1 Klik Command Centre Sales > Enter Sales

2 Klik Layout, pilih Item, klik OK. Kemudian set ke format ORDER

(@) sates - New Item o ||@]=s

2 s ¥ TaxInclusive

- 7 .
Shoto # * Select Layout &I
|

Use the ltem laycut when pou want to
sell something from yous Items List

" Sewvice

/ "6 Item

(" Professional

Salesperson " Time Biling

Comment: " Miscellaneous
Ship Via
Promised Date:

Jownal Memo:
Referral Source:
Order Debvery Status:

(O] - g (%) Use Recuning | Lk F

2. qmg] ;

Heb F1 Print Send To

Register

Gambar 2. 42 Select Layout Item

3 Isi data Sales Order sesuai dengan dokumen sumber (Bukti No. 01). Kemudian
klik Record dan Klik Cancel.

() Sales - New Item o | ©

ORDER

“;V: Joko Ganatha Unggy Terms ©: 2% 10Net 30  Taxlnchsive
Irvoice # 0000000

Shpto w1 Toko Garesha Unggul
) Setia Budi 23 Pamulang .
Tangerang Selstan Date: 03/01/2013
Customer PO #:  S0-001

Sho Item Number Price Duck  Towd
10 ©COM-001 HP Pro Book 44215 150.000,00 500.000,00
LW 30 oPANOOI Canon L2156 190.000,00{38 | 700 000.00

Salecperzon Sublotat p178 200.000.00
Commert Freight Ap0.00

She Via Tax ©
Prorzed Date Total Amount. p178.200 000,00

Joumnal Memo: | Sale: Toko Ganesha Unggul Paid Today Rp0.00
Retenal Source Payment Method | Cheque L]
Order Delivery Status: | To be Punted Balance Due: p178 200 000,00

(B) Saye as Recung| (%) Lse Recuning | LA Reimburse P Create PO %5 Spel

= & e

SendTo | Joumal Lapout Regater

Gambar 2. 43 Sales Order
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4  Untuk melihat Sales Order yang sudah dientri klik Command Centre Sales >
Sales Register, kemudian klik Tab Order. Set Tanggal | 1/1/13 to 31/1/13

(4] Sales Register

All Open Retumns Closed
Sales l _Quoles/l Orders I Inyoices I & Credits I |nvoices

Search by. [All Customers -l

Dated From: [01/01/2013  To: [31701/2013

Date Invoice # Cust PO# Customer Amount Amt Due

(=Y 03/01/20 00000008 0-00 oko Ganesha g p178.200.000.00 {178 200.000.00
' ' | | '

& Receve Papmend | (@1 Qange toInvoice | | Create PO p178.200.000,00 ip178.200.000,00

,
9

Gambar 2. 44 Sales register

5 Ulangi langkah-langkah 1 dan 4 untuk mengisi data Sales Order sesuai dengan

dokumen sumber (Bukti No. 02)

2. Entri Transaksi Penjualan Kredit (Sales on Account)

Hal-hal yang penting diingat dalam transaksi penjualan kredit:

a) Berpengaruh terhadap: akun piutang dagang, akun penjualan, kartu

piutang dan kartu persediaan.

b) Cek terlebih dahulu jurnal yang akan dihasilkan sebelum Kklik Record.

(Tekan Ctrl-R untuk mengecek jurnalnya).
c) Dokumen sumber : Bukti No: 03 & 04
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| BuktiNo: 03
UD.RASEL MEDIA MANDIRI INVOICE
N, Parulang Raya 17, Pamulang @@‘J Dat'f: 4Januari 2013
Tangerang Selatan © Inv# 5L-001
50#/Date | 50-001/3 Januari 2013
INVOICE
Sold to: Toko Ganesha Unggul, JI. Setia Budi 23, Pamulang
Amount: Rp. 178.300000,-
Seratus tujuh puluh delapan juto tigo rotusnbu Rupiah
Details:
Mo Item Mo Description Cty Price/Unit Total Price TAX
Rp. Rp.
1 COM-001 | HPPro book4421s 10 14.850.000 - 148.500.000,- | PPM
2 PEM-001 | Camnonl-215 30 990,000 - 29.700.000- | PPM
178.200.000,- | PPM
Freight Collacted 100,000 - NT
Total 178.300.000,-
Pemilik Perusahaan Sales Teknisi Akuntansi
Rasela Marta Renata
| BuktiNo: 04
UD. RASEL MEDIA MANDIRI IN\I’IID_ICE
JI. Pamulang Raya 17, Pamulang @.? Datn.a 5 Januari 2013
Tangerang Selatan G Inv # 5L-002
S0#/Date | 50-002/3 Januari 2013
INVOICE
Sold to: Toko Global Persada, JI. Cendana 11 Ciputat
Amount: Rp.118.900000,-
Seratus delapan belas juta sembilan ratus ribu Rupiah.
Details:
Ma Item Mo Description Qty Price/Unit Total Frice TAX
Rp. Rp.
1 COM-002 | HPPro book 5530 & 17.600.000 - 105.600.000,- | PPM
3 PEM-002 | CanonBj-555 20 660,000 - 13.200.000- | PPM
113.8300.000,- | PPN
Freight Collected 100.000 - NT
Total 113.500.000,-
Pemilik Perusahaan Sales Teknisi Akuntansi
Rasela Marta Renata
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Praktekkan langkah-langkah berikut ini:

1 Klik Command Centre Sales > Sales Register, kemudian klik Tab Order.
Klik Sales Order yang akan diubah menjadi Invoice, Klik Change to Invoice

@ Sales - New Item liuﬂl

INVOICE

Customer ©: Toko Ganesha Unggul Tems ©: 2% 10 Net 30 vV Taz Inclusive

Shipto w|: Toko Ganesha Unggul Invoice #: 00000006

JI. Setia Budi 23 Pamulang

Tangerang Selatan Date: 04/01/2013
Customer PO #:
Ship  Backorder Iter Number Description Price Disc%  Total Job Tax J
10] = COM-001 HP Pro Book 4421s 350.000,00 .500.000,00| | PPN
30 = PRN-001 Canon Lj-215 390.000,00 .700.000,00] PPN

Salesperson Subtotal: p178.200.000,00

Comment: Freight: | Rp100.000,00 N-T &I
Ship Via: Tax ©: 3p16.200.000,00

Promised Date: Total Amount: p178.300.000,00

Joumnal Memo: | Sale; Toko Ganesha Unggul i Applied to Date: Rp0,00 History... i

Refenal Source: |
Invoice Delivery Status: | To be Printed

Balance Due: p178.300.000,00

(1) Save as Recuvring‘j & Reimburse | 5& Payment ‘ G} Spel_l‘

> >
Help F1 Print SendTo | Joumal Register

Gambar 2. 45 Change to Invoice

3 Isi data penjualan sesuai dengan dokumen sumber Bukti No. 03 Invoice.

@Sales-Newltem [E=H (BT |
INVOICE
Customer &: Toko Ganesha Unggul Tems ©: 2% 10 Net 30 vV TaxInclusive

Shipto »|: Toko Ganesha Unggul Invoice #: 00000006
J1. Setia Budi 23 Pamulang
Tangerang Selatan Date: 04/01/2013
Customer PO #:

Ship  Backorder Item Number Description Price  Disc%  Total Job Tax
10 = COM-001 HP Pro Book 4421s 350.000,00 .500.000,00| PPN
30| = PRN-001 Canon Lj-215 390.000,00 .700.000,00|

Salesperson Subtotal: p178.200.000,00
Comment: Freight: | Rp100.000,00

Ship Via: ~ Tax ©: 3p16.200.000,00
Promised Date: Total Amount: p178.300.000,00

Journal Mema: | Sale; Toko Ganesha Unggul Applied to Date: Rp0.,00 History...
Refenal Source: | |
Invoice Delivery Status: | To be Printed ] Balance Due: p178.300.000,00

(1) Save as Recuring | & Reimburse | ;ﬂ- Payment | A8S Spell ‘

7. = | & <o G ]
9w >
Help F1 SendTo | Joumnal Register

Gambar 2. 46 Sales Invoice
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4  Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup Recap
Transaction.

Kembali ke Invoice semula klik Record, dan klik Cancel

({&] Recap Transaction

| Recap Transaction in Sales - Edit ltem l
Sic Date ID# Account Debit Credit Job
S 04/01/2013 Sale; Toko Ganesha Unggul _]
SL-001 11210 Account Receivable 3p162.000.000,00
SL-001 11210 Account Receivable Rp16.200.000,00
SL-001 11210 Account Receivable Fp100.000,00
SL-001 41100 Sales - Computers 3p135.000.000,00
SL-001 41200 Sales - Printers Rp27.000.000,00
SL-001 21310 PPN Collected Rp16.200.000,00
SL-001 45000 Freight Collected Rp100.000,00
SL-001 51100 COGS - Computer Rp90.000.000,00
SL-001 1-1310  Inventory - Computers RpS0.000.000,00
SL-001 51200 COGS - Printer Fp19.500.000,00
SL-001 11320 Inventory - Printers Rp19.500.000,00

7
HeI;F?

Gambar 2. 47 Recap Transaction in Sales

5 Ulangi langkah-langkah 1 s.d. 4 untuk mengisi data penjualan sesuai dengan
dokumen sumber (Bukti No. 04)

3. Entri Transaksi Penjualan Tunai (Counter Sales)
Hal-hal yang perlu diperhatikan dalam transaksi penjualan tunai:
a) Dalam format Invoice kolom Paid Today diisi sebesar Total Amount.

b) Cek terlebih dahulu jurnal yang akan dihasilkan sebelum Kklik Record.
(Tekan Ctrl-R untuk mengecek jurnalnya).

c) Dokumen sumber : Bukti No: 05 & 06
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| BuktiNo: 05 |
UD. RASEL MEDIA MANDIRI CASH RECEIFT
1l F'. | Rayal7, P | CASH CHEQUE
- amd a”g |3:3 (PEMUENG TRt 6 Januari 2013 6 Januari 2013
angerang Selatan NO CR-0D01 s 21
CASH RECEIPT
Sold to: Counter Sales.
Amount: Rp96.100.000,-
Sembilon puluh enam juta seratus nbu Rupiah
Details:
MNo Ttem Mo Description Oty Price/Unit Total Price TAX
Rp. Ep.
1 COM-001 | HP Pro book4421s B 14.850.000 - 89.100.000,- | PPM
2 PRM-001 Canonl-215 7 So0.000 - 6.930,000.- | PPN
06.030.000,- | PPM
Freight Collected 70,000, - MNT
Total Received 96,100,000, -
Pemilik Perusahaan Sales Teknisi Akuntansi
Rasela Marta Renata
| BuktiNo: 06 |
UD. RASEL MEDIA MANDIRI CASH RECEIPT
1l F'. | Rayal7, P | CASH CHEQUE
- amd a”g |3:3 (rAMUENG I At 7 Januari 2013 7 Januari 2013
angerang Selatan o) CR-002 N-23
CASH RECEIPT
Sold to: Counter Sales.
Amount: Rp77.100.000,-
Tujuh puluh tujuh juta seratus ribu Rupioh
Details:
MNo Ttem Mo Description Oty Price/Unit Total Price TAX
Rp. Ep.
1 COM-002 | HP Pro book 5530 4 17.600.000 - 70400.000,- [ PPM
2 PRM-002 Canon Bj-555 10 660,000 - 6.600,000.- | PPN
77.000.000,- [ PPM
Freight Collected 100.000, - MNT
Total Received T7.100.000,-
Pemilik Perusahaan Sales Teknisi Akuntansi
Rasela Marta Renata
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Praktekkan langkah-langkah berikut ini:

1 Klik Command Centre Sales > Enter Sales
Pilih Customer: Counter Sales, karena belum ada maka anda perlu buat.
Klik New dan Ketik Nama: COUNTER SALES, Card ID#: 00, Klik OK

(] Card Information = | 2|
' Card Details ' Selling Details ' Payment Details ' Contact Log ' Jobs ' History
COUNTER SALES 00 A/R Balance ©: | Rp0.00
Card Type: {'EJ&IEm"e; E\ Designation: [Eo?naanyii [ Inactive Card
Name: [CDUNTEF! SALES
_w CadD: [o0
Location: [Address 1: Bl To 9
Address: Phone#1: [
Phone#2: i
City: | Phoneti3; | ]
State: | Postcode: | Fan
Country: | Emaik
Website:
Salutation: [
Contact: i
| = Emai | 8 websie
Help F1

Gambar 2. 48 Counter Sales

2 Pilih Customer: Counter Sales, kemudian isi data counter sales sesuai dengan
dokumen sumber Bukti No: 05. Kolom Paid Today diisi sama dengan Total
Amount.

@ Sales - New Item l&”ﬂ|@

[INvDICE

Customer ©: | COUNTER SALES sl Tems ©: C.OD. v TaxInclusive

Shipto w|: COUNTER SALES -~ Ir;oice #: CR-001
Date: 06/01/2013
Customer PO #:
Ship  Backorder Iter Number Description Price Disc%  Total J

&) = COM-001 HP Pro Book 4421s 50.000,00 |-100.000,00]
7| = PRN-001 Canon Lj-215 390.000,00 |-930.000,00
v ‘
| \

Salesperson ] Subtotal: 3p96.030.000,00

Comment: / Freight: Rp70.000,00

Ship Via: ~ Tax ©: Rp8.736.363.64
Promised Date: Total Amount: 3p96.100.000,00

Joumal Memo: | Sale; COUNTER SALES Paid Today: |3p96.100.000,00
Refenal Source: | i Payment Method: (Eheque % Details...
Invoice Delivery Status: | To be Printed | Balance Due: Rp0.,00

(B) Save as Recuring (1) Use Recuring | & Reimburse ‘

7. = | &<
Help F1 Frint SendTo | Joumnal Layout Register

Gambar 2. 49 Counter Sales Invoice
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3 Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup Recap
Transaction.

Kembali ke Invoice semula klik Record, dan klik Cancel untuk menutup format
invoice.

({&] Recap Transaction

I Recap Transaction in Sales - Edit ltem |
Sic Date  ID# Account Debit Credit Job
SJ 06/01/2013 Sale; COUNTER SALES _'J
CR-001 11210 Account Receivable Rp87.300.000,00
CR-001 11210 Account Receivable Rp8.730.000,00
CR-001 11210 Account Receivable Rp70.000,00
CR-001 41100 Sales - Computers Fp81.000.000,00
CR-001 41200  Sales - Printers Rp6.300.000,00
CR-001 21310 PPN Collected Rp8.730.000,00
CR-001 4-5000  Freight Collected Rp70.000,00
CR-001 51100 COGS - Computer Rp54.000.000,00
CR-001 11310 Inventory - Computers Fp54.000.000,00
CR-001 51200 COGS - Printer Rp4.550.000,00
CR-001 11320 Inventory - Printers Rp4.550.000,00

7
HeI; F;

Gambar 2. 50 Recap Transaction in Counter Sales

4  Ulangi langkah-langkah 2 dan 3 untuk mengisi data counter sales sesuai dengan
Bukti No: 06

4. Entri Transaksi Retur Penjualan (Sales Return)
Hal-hal yang perlu diperhatikan dalam transaksi retur penjualan:
a) Entri data seperti penjualan kredit tetapi quatity diketik angka minus.

b) Jangan lupa masuk ke Sales Register dan Tab Returns & Credits,
untuk memproses pengurangan saldo dalam kartu customer klik Apply to
Sale.

¢) Dokumen sumber : Bukti No: 07 & 08
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BuktiMo: OF

CREDIT MOTE
Date 8 Januan 2013
Credit Mote # [ CN-001
Invoice/Date | SL-001/4 Januari 2013

UD.RASEL MEDIA MANDIRI

JIl. Pamulang Raya 17, Pamulang @ﬁﬂ
Tangerang Selatan G

CREDIT NOTE
Returned by: Tekeo Ganesha Unggul, JI. Setia Budi 23, Pamulang
Amount: Rp 16.830.000 -

Enam belas juta delapan ratus tiga puluh rbu Rupiah

Returned dueto damages

Mo Item Mo Description Oty Price/Unit Total Price TAX
Ep. Ep.
1 COM-001 | HP Pro book4421s 1 14.850.000,- 14.850.000,- | PPM
2 PEM-D01 | Canonl)-215 2 So0.000 - 1.580.000- | PPN
Total 16.830,000,- | PPN
Pemilik Perusahaan Sales Teknisi Akuntansi
Rasela Marta Renata
u|
BuktiMo: 08
UD. RASEL MEDIA MANDIRI CREDIT NOTE
JI. Pamulang Raya 17, Pamulang @?ﬂ DatE_ i 8 Januari 2013
Tangerang Selatan © Credit Note # | CN-002
Invoice/Date | SL-002/5 Januar 2013

CREDIT NOTE
Returned by: Toko Globkal Persada, Jl. Cendana 11 Ciputat
Amount: Rp 18.260.000 -

Delapan belas juta duaratus enam puluh nbu Rupiah

Returned dueto damages

Ma Item Mo Description Oty Price/Unit Total Price TAX
Ep. Ep.

1 COM-002 | HP Pro book 5530 1 17.600.,000,- 17.600.000,- | PPN

2 PEMN-D02 | CanonBj-555 1 BE0.000 - 6&0.000- | PPM

Total 18.260.000,- | PPN

Pemilik Perusahaan Sales Teknisi Akuntansi

Rasela Marta Renata
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Praktekkan langkah-langkah berikut ini:

1 Klik Command Centre Sales > Enter Sales

Entri data untuk retur penjualan, jangan lupa ketik Quantity (Ship) dengan

angka minus.

2

92

@ Sales - New Item

INVOICE >

Tems ©: 2% 10 Net 30

= B |

V' TaxInclusive

Customer 5: | Toko Ganesha Unggul
EID to w|: Toko Ganesha Unggul
J1. Setia Budi 23 Pamulang
Tangerang Selatan

Invoice #: |CN-001
Date: | 08/01/2013

Customer PO #:

Ship  Backorder

Item Number Description

Price  Disc%  Total Job Tax

= COM-001
= PRN-001

HP Pro Book 4421s
Canon Lj-215

¥

50.000,00
390.000,00

850.000,00)|
980.000,00)

Salesperson
Comment:
Ship Via:
Promised Date:

Subtotal: 3p16.830.000,00)

Freight:

Tax ©: [Rpl 00,00)
Total Amount: 3p16.830.000,00)

Rp0,00

Journal Memg: ISaIe Return; Toko Ganesha Unggul
Hefenalje&|
Invoice Delivery Status: | To be Printed

85 Spell|

Register

(1) Save as HecuningJ (O) Use Recuring [ & Reimburse

Journal

vy -
Help F1 SendTo

Layout

Paid Today: |

Payment Method: | Cheque =

Balance Due: 3p16.830.000,00)

Rp0,00

Details...

Gambar 2. 51 Sales Return

Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup
Recap Transaction. Kembali ke Invoice semula klik Record, dan Kklik
Cancel

3 e Toracion_ s . ==

Recap Transaction in Sales - New ltem |

Src Date ID# Account Debit Credit Job
SJ 08/01/2013 Sale; Toko Ganesha Unggul _J

CN-001 11210 Account Receivable Rp15.300.000,00

CN-001 11210 Account Receivable Rp1.530.000,00

CN-001 41100 Sales - Computers Rp13.500.000,00

CN-001 41200 Sales - Printers Rp1.800.000,00

CN-001 21310 PPN Collected Rp1.530.000,00

CN-001 51100 COGS - Computer Rp9.000.000,00

CN-001 11310 Inventory - Computers Rp9.000.000,00

CN-001 51200 COGS - Printer Rp1.300.000,00

CN-001 11320 Inventory - Printers Rp1.300.000,00

7

DR 4

Help F1

Gambar 2. 52 Recap Transaction of Sales Return
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Kemudian klik Tab Returns & Credits. Klik Apply to Sale untuk mengurangi

jumlah piutang pada kartu customer.

=
(] Sales Register

[-o][-E- )

S%Ilzlas l Quotes I Orders I

Returns

Open
Invoices & Credits

Search by: [WM

Date Invoice # Cust PO# Customer
=% 02/01/20 CN-00 oko Ganesha Ung

Closed
_ Invoices
Amount

Credit Amt
Rp16.830.000,00)jRp16.830.000,00]

*» Pay Refund *T Apply to Sale

—

Frint

8

Help F1

3p16.830.000,00) (Rp16.830.000,00)

Gambar 2. 53 Returns & Credits

4  Entry retur penjualan sudah tercatat sebesar Rp. 16.830.000,- Klik Apply to Sale

@ Settle Returns & Credits

][50 ]

Customer o Toko Ganesha Unggul
Credit Amount: \ﬁagﬁﬁ‘ﬂﬁa
Memo: | Toko Ganesha Unggul: Credit from CN-001

ID #: |CN-001 |
Date: @@707;&13

04/01/2013) Rp178.300.000,00
|

Invoice # Status Date Amount Discount Total Due Amount Applied
FP-003 o> Open 27/12/2012| Rp209.000.000,00 Rp209.000.000,00 i
SL-001 o> Open | Rp178.300.000,00 Rp16.830.000,00

7 Include Closed Sales

Total Applied: [ Rp16.830.000,00°
Finance Charge: [ Rp0.0C
Credit &mount: | Rp16.830.000,00

7.

Help F1

Journal

Out of Balance: |

Rp0,00

Cancel

Gambar 2. 54 Settle Returns & Credits
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5

6

Sesuaikan data ID# dan Date dengan documen sumber Bukti No: 07. Kemudian
Discount diset menjadi 0 dan posisikan mouse di kolom Amount Applied
sejajar dengan SL-001 tgl. 04/01/2013 kemudian klik mouse.

Jika dilihat jurnalnya, maka akan tampak seperti berikut ini:

@ Transaction Journal = |[-3 \
| 4
General ' Disbursements ! Receipts t Sales ' Purchases t Inventory t All -
i dFrom: [UIEIEGE | To: [31/01/2013 N
1D From: r ] To: [
Date 1D# Account Debit Credit Job
= 08/01/2013 Sale Retum; Toko Ganesha Unggul A
CN-001 11210 Account Receivable Rp15.300.000,00
CN-001 11210 Account Receivable Rp1.530.000,00
CN-001 41100  Sales - Computers Rp13.500.000,00
CN-001 41200 Sales - Printers Rp1.800.000,00
CN-001 21310 PPN Collected Rp1.530.000,00
CN-001 51100 COGS - Computer RpS.000.000,00
CN-001 11310 Inventory - Computers Rp9.000.000,00
CN-001 51200 COGS - Printer Rp1.300.000,00
CN-001 1-1320  Inventory - Printers Fp1.300.000,00
=4 08/01/2013 Toko Ganesha Unggul: Credit from CN-001
CN-001 11210 Account Receivable Rp16.830.000,00
CN-001 11210 Account Receivable Rp16.830.000,00
v
Help F1 Print

Gambar 2. 55 Recap Transaction in Sales Return (Complete Journal)

Ulangi langkah-langkah 1 s.d. 5 untuk mengisi data retur penjualan sesuai
dengan Bukti No: 08

Entri Transaksi Retur Penjualan Tunai
Hal-hal yang perlu diperhatikan dalam transaksi retur penjualan tunai:
a) Entri data seperti retur penjualan kredit, quatity diketik angka minus.

b) Jangan lupa masuk ke Sales Register dan Tab Returns & Credits, untuk
memproses pembayaran kembali ke customer klik Pay Refund.

¢) Dokumen sumber : Bukti No: 09 & 10
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| BuktiNo: 09
UD.RASEL MEDIA MANDIRI CASH PAVMENT
I F'. lang Rayal7, P I CASH CHEQUE
- am”a”glfa (FEMUENG IThate | 10Januani2013 10 Januari 2013
engerang S=EEn NO CP-001 CP-001
CASH PAYMENT
Supplien Counter Sales
Arnount: Rp 15.340.000.-
Lima belas jute delapan ratusempat puluh ribu Rupiah
Details: Cash Pay Back for Counter Sales Return.
Mo Item Mo Description Qty Price/Unit Total Price TAX
Rp. Rp.
1 COM-001 | HPPro book4421s 1 14.850.000,- 14.850,000,- | PPN
2 FRM-001 | CanonlU-215 1 990.000,- 990.000,- | PPN
Total 15.840.000,- | PPN
Pemilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya
| BuktiNo: 10
UD. RASEL MEDIA MANDIRI CASH PAVMENT
) CASH CHEQUE

J. Parulang Raya 17, Pamulang

Tangerang Selatan

Date

11 Januari 2013

11 Januar 2013

MO

CP-002

CP-002

CASH PAYMENT

Supplier
Amount:

CounterSales
Rp 18.260.000.-

Delapan belas juta dua ratus enam puluh nibu Rupioh

Details: Cash Pay Back for Counter Sales Return.

Price/Unit Total Pri
Mo Item Mo Description Oty ricem arat e TAX
Rp. Rp.

1 COM-002 | HPPro book5530 1 17.600,000,- 17.600,000,.- [ PPN

2 PRM-002 Camon Bj-555 1 GE&0.000, - 6E0.000- | PPN

Total 18.2600000- [ PPN

Pemilik Perusahaan Cashier Teknisi &kuntansi
Rasela Marta Maya
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Praktekkan langkah-langkah berikut ini:
1 Klik Command Centre Sales > Enter Sales

Entri data untuk retur penjualan, jangan lupa ketik Quantity (Ship) dengan
angka minus.

@Sales-New]tem [ro-@ |

[INvoIcE

Customer ©: ECDUNTER SALES = Tems ©: C.O.D. v TaxInclusive

Stfpto w|: COUNTER SALES Invoice #: CP-001
/ Date: | 10/01/2013
Customer PO #:

Ship  Backorder Iter Number Description Price Disc%  Total
= COM-001 HP Pro Book 4421s 350.000,00 850.000,00)|
= PRN-001 Canon Lj-215 330.000,00 930.000,00)

Subtotal: 3p15.840.000,00)
Freight: Rp0,00
Tax ©: [Rp1.440.000,00)

Total Amount: 3p15.840.000,00)

K]

E

Salesperson
Comment:
Ship Via:
Promised Date:
Joumal Mema: |Sale Return; COUNTER SALES Paid Today: Rp0,00

Referal M "7 Payment Method: [.ﬁeﬁqugi v%ﬂ Details...

Balance Due: 3p15.840.000,00)

e [

&

Invoice Delivery Status: | To be Printed

(1) Save as Recuningi (J) Use Recuring | 3 Reimburse | ABS Spell |

&« G
Help F1 SendTo | Joumnal Layout Register

Gambar 2. 56 Counter Sales Return

2 Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup
Recap Transaction. Kembali ke Invoice semula klik Record, dan Klik

Cancel.

Klik Command Centre Sales > Sales Register. Kemudian klik Tab
Returns & Credits.
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@Sa!es Register o |[® |
All Open Returns Closed
Sales Lot ' Sices ' Invoices & Credits I Invoices

Search by: [All Customers 5

Date Invoice # Cust PO# Customer Amount Credit &mt
[ 10/01/20 P-00 OUNTER SAl Rp15.840.000,00){Rp15.840.000,00]

‘ ®T Apply to Sale 3p15.840.000,00) (Rp15.840.000,00]

HelpF1 | Erint

Gambar 2. 57 Sales register

3 Klik Pay Refund untuk pembayaran kembali kepada customer.

-~

@ Settle Returns & Credits inﬂ]@

Account: | 11110 | $| Cash In Bank Balance c»: Rp383.200.000,00

Customer ©: COUNTER SALES Cheque No.: [5061
Payee | : [COUNTER SALES Date: | 10/01/.

Amount: [Rp15.840.000,00]

Fifteen Million Eight Hundred and Forty Thousand Dollars and 0 Cents
Memo: | COUNTER SALES: Credit from CP-001 L0 Fasals Meacks Mandiy

™ Cheque Already Printed
Remittance Advice Delivery Status: [ To be Printed bl

Cancel

-
Print Joumal

HelpF1 |

Gambar 2. 58 Pay Refund
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4  Sesuaikan data Cheque No dan Date dengan documen sumber Bukti No:
09. Kemudian klik Record.

Jika dilihat jurnalnya, maka akan tampak seperti berikut ini:

(4] Transaction Journal = |[-E- ]
| 4
~ General ' Disbursements I Receipts ' Sales ' Purchases ' Inventory L Ali -
Dated From: |01/01/2013 To: [31:’01 /2013 -
1D From: | To: |
Src Date ID# Account Debit Credit Job
o 5l 10/01/2013 Sale Retun; COUNTER SALES ;J
CP-001 11210 Account Receivable Rp14.400.000,00
CP-001 11210 Account Receivable Fip1.440.000,00
CP-001 41100  Sales - Computers Rp13.500.000,00
CP-001 41200  Sales - Printers Rp300.000,00
CP-001 21310 PPN Collected Fp1.440.000,00
CP-001 51100 COGS - Computer Fp9.000.000,00
CP-001 11310 Inventory - Computers Rp9.000.000,00
CP-001 51200 COGS - Printer RpE50.000,00
CP-001 11320  Inventory - Printers Rp650.000,00
o CD 10/01/2013 COUNTER SALES
CP-001 11110  CashInBank Rp15.840.000,00
CP-001 11210 Account Receivable Rp15.840.000,00
Help F1 Print

Gambar 2. 59 Jurnal retur penjualan Tunai

5 Untuk menampakkan jurnal di atas, klik Sales > Transaction Journal.
Kemudian set Dated from 01/01/2013 sd 31/1/2013. Pilih Tab All

6 Ulangi langkah-langkah 1 s.d. 5 untuk mengisi data retur penjualan tunai
sesuai dengan Bukti No: 10

6. Entri Transaksi Penerimaan Piutang (Receipt Payment)
Hal-hal yang perlu diperhatikan dalam transaksi receipt payment:

a) Menggunakan Command Centre Sales > Receive Payments BUKAN
Banking > Receive Money.

b) Harus memilih secara tepat Nama Customer dan Piutang yang terkait
dengan pelunasan.

c¢) Dokumen sumber : Bukti No: 11 & 12

Direktorat Pembinaan SMK (2013)
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|BuktiMo: 11
UD. RASEL MEDIA MANDIRI CASH RECEIFT
Il F'. I Raya 17, P | cASH CHEQUE
- am a”g la:a (PAmMUENg M hate 12 Januari 2013 12 Januari 2013
angerang eiatan NO CR-003 A121
CASH RECEIPT
Receive Payment  Fromu
Customer: Toko Ganesha Unggul, JI. Setia Budi 23, Pamulang
Amount: Rp. 209.000.000,-
Dua ratus sembilan juta Rupioh
Details:
No Date Invoices Amount Discount Total Due
Rp Ep Rp.
1 2771212 | FR-D03 205.000,000,- - 205.000.000 -
Total Receipt 209,000,000 -
Pemilik Perusahaan Cachier Teknisi Akuntansi
Rasela Marta Maya
|BuktiMo: 12
UD.RASEL MEDIA MANDIRI CASH RECEIFT
Il F'. I Raya 17, P | CASH CHEQUE
- 2 a”g la:a (PEMUENG e 12 Januari 2013 12 Januan 2013
angerang elatan NO CR-004 B222
CASH RECEIPT
Receive Payment  Fromu
Customer: Toko Glokal Persada, ). Cendana 11, Ciputat
Amount: Rp. 66.000.000,-
Enam puluh enam juta Rupiah
Details:
No Date Invoices Amount Discount Tatal Due
Rp Rp Rp.
1 28/12/12 | FRP-D05 66.000.000,- - 66.000,000,-
Total Receipt 66,000,000, -
Pemilik Perusahaan Cachier Teknisi Akuntansi
Rasela Marta Maya
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Praktekkan langkah-langkah berikut:

1 Klik Command Centre Sales > Receive Payments. Kemudian pilih nama
customer sesuai dan isi data pelunasan piutang sesuai dengan dokumen sumber.

(] Receive Payments ][ B

@ Deposit to Account: 11110 E[—‘ Cash In Bank Balance ©: FRp349.100.000,00
" Group with Undeposited Funds:

Customer ©: } Toko Ganesha Unggul %—ﬁ ID #: | CR-003
Amount Received: | Rp209.000.000,0 /)ate: 12/01/2013
Payment Method: | Chegque sl Details...
Mema: \ Payment; Toko Ganesha Unggul
Invaice # Status Date Amount Discount Total Due Amount Applied
FP-003 o Open 27/12/2012| Rp209.000.000,00 Rp209.000.000,00| Rp209.000.000,00
[SL.001 = 0pen  : 04/01/2013] Rp161.470.000,00 Rp3.566.000,00| Rp157.904.000,00 /v
P

=]

Total Applied: rﬁ—ﬁﬁgﬁﬁﬂ?ﬁﬁﬁﬁﬁ‘
Finance Charge: Rp0,00

Total Received: | Rp209.000.000,00
7 Include Closed Sales OutofBalance: [ Rp000

‘T, Receive &l

;‘ﬁ; Bt )
@

Register

9w
Help F1 Joumal

Gambar 2. 60 Penerimaan Pelunasan Piutang

2 Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup Recap
Transaction. Kembali ke Invoice semula klik Record, Print Later dan klik Cancel.

Recap Transaction in Receive Payments |
Sic Date ID# Account Debit Credit Job
CR 12/01/2013 Payment; Toko Global Persada _]
CR-004 11110 Cash InBank Rp66.000.000,00
CR-004 11210 Account Receivable RpE6.000.000,00
7.
Help F1

Gambar 2. 61 Recap Transaction in Receive payments

3 Ulangi langkah-langkah 1 dan 2 untuk mengisi data penerimaan piutang sesuai
dengan Bukti No: 12
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Entri Transaksi Receipt Payment With Discount

Hal-hal yang perlu diperhatikan dalam transaksi receipt payment dengan

diskon:
a) Menggunakan Command Centre Sales > Receive Payments BUKAN

Banking > Receive Money.
b) Diskon yang menyebabkan pengurangan Pajak (PPN) dihilangkan.

c) Dokumen sumber : Bukti No: 13 & 14

BuktiMo: 13
UD. RASEL MEDIA MANDIRI CASH RECELT
i P. | Rayal7,P | CASH CHEQUE
- amu E”g latﬂ AFaMUENg - pate 13 Januari 2013 13 Januari 2013
engerang e NO CR-005 A125
CASH RECEIPT
Receive Payment  From:
Customer: Teko Ganesha Unggul, JI. Setia Budi 23, Pamulang
Amount: Rp. 157.904.000,-
Seratus lima puluh tujuh juta sembilon ratusempat ribu Rupiah
Details:
Mo Date Irvoices Amount Sales Return Total Due
Ep Rp Rp.
1 4/1/13 5L-001 178.300.000,- 16.830.000,- 161470.000,-
Discount (2% x Rp. 178.300000,-) 3.566.000 -
Total Received 157.904.000,-
Pemilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya
BuktiMNo: 14
CASH RECEIPT
JI.IIIIZ: RAS;EL h':{EDIﬁi;u"I,:NDIFI ChsH CHEQUE
- amd a”g latja Aramuiang  rnate 13 Januari 2013 13 Januari 2013
angerang seiatan NO CR-006 2125
CASH RECEIPT
Receive Payment  From:
Customer: Teko Globkal Persada, JI. Cendana 11, Ciputat
Amount: Rp. 98.262.000,-
Sembilan puluh delapan juto dua ratus enam puluh dua ribu Rupiah
Details:
Mo Date Invoice® Amount Sales Retur Total Due
Rp Rp Rp.
1 5/1/13 SL-002 118.900.000,- 18.260.000,- 100.640.000,-
Discount (2% x Rp. 118.800.000) 2378.000 -
Total Received 98.262.000 -
Pemilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya
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Praktekkan langkah-langkah berikut:

1 Klik Command Centre Sales > Receive Payments. Kemudian pilih nama

customer sesuai dan isi data sesuai dengan dokumen sumber.

@ Receive Payments

[ esa)

¢ Deposit to Account: \1—11?0‘#%1 Cash In Bank Balance =: Rp624.100.000,00

" Group with Undeposited Funds:

Customer ©o: \ Toko Ganesha Unggul

El ¥ ID #: [CR-005
Amount Received: |Rp157.904.000.0 Date: [13/01/2013
Payment Method: \ Cheque % Details...
Memo: [ Payment; Toko Ganesha Unggul
Invoice # Status Date Amount Discount Total Due Amount Applied
SL-001 o Open 04/01/2013 Rp161.470.000,00 |3p3.566.000,00 | Rp157.904.000,00 | Rp157.904.000,00
! v
|
\' ~|
Total &pplied: | Rp157.904.000,00
Finance Charge: l Rp0,00

Total Received: | Fp157.904.000,00
Out of Balance: fiﬂpﬂﬁ

7 Include Closed Sales

£ Receive Al \

HelpF1 | Joumal Register

Cancel

Gambar 2. 62 Penerimaan Pelunasan dengan Diskon

2 Klik Record, Print Later dan klik Cancel. Klik Command Centre Sales >
Transaction Journal untuk menampakkan jurnalnya:

(] Transaction Journal = | B[]
| 4
General ! Disbursements ' Receipts ' Sales I Purchases t Inventory r Al -
Dated From: |01/01/2013 To: ] 31/0/2013
1D From: [ To: [
Src Date ID# Account Debit Credit Job

= CR 13/01/2013 Payment; Toko Ganesha Unggul -
CR-005 11110  Cash InBank 3p157.904.000,00
CR-005 11210 Account Receivable 3p157.904.000,00

o S5J 13/01/2013 Toko Ganesha Unggul: Discounts on SL-001

jy LY 00000003 11210 Account Receivable Rp3.242.000,00

00000003 11210 Account Receivable Rp324.000,00
00000003 5-3000 Sales Discounts Rp3.242.000,00
00000003 21310 PPN Collected Rp324.000,00

= 5J 13/01/2013 Toko Ganesha Unggul: Credit from 00000003
SJ000001 11210 Account Receivable Rp3.566.000,00
SJ000001 11210 Account Receivable Rp3.566.000,00

v
9w
Help F1 Print

Gambar 2. 63 Jurnal Penerimaan Pelunasan Piutang dengan Diskon
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3 Klik di ® (panah kiri) untuk jurnal yang terkait dengan diskon (jurnal yang di
tengah.

(8] Sales - Edit Service ol =)=
INVOICE

Customer ©:  Toko Ganesha Unggul Tems ©: 2% 10 Net 30 vV Tax Inclusive

Shipto w|: Toko Ganesha Unggul Invoice #: 00000003 i

JI. Setia Budi 23 Pamulang
Tangerang Selatan Date: 13/01/2013
Customer PO #:

Description Accti Amount
1 5-3000 2.970.000,00)
5-3000 Ap594.000,00)
5-3000 [F!pZDUU,UD]i

Salesperson Subtotal: (Rp3.566.000,00)
Comment: Freight: Rp0,00

Ship Via: Tax o Rp0,00
Promised Date: Total Amount: (Rp3.566.000,00)

Joumnal Memo: | Toko Ganesha Unggul: Discounts on Applied to Date: (Rp3.566.000,00)
Referal Source: } 7 N o
Invoice Delivery Status: \FTo be Printed ) Balance Due: Rp0.00

(B) Save as Recuring| L& Reimburse i Ea P 1| #BG Spell

o v
Help F1 Joumal Layout Register

Gambar 2. 64 Mengeliminasi PPN dalam Diskon

4 Ubah PPN menjadi N-T untuk jumlah-jumlah yang ada dalam tabel di atas.
Hasilnya adalah jurnal yang baru seperti berikut ini. Klik Close.

@ Transaction Journal o |[-E |
| 4
General t Disbursements ' Receipts r Sales I Purchases t Inventory t All _
Dated From: |01/01/2013 To: [31/01/2013
1D From: [ To: {
Sic Date ID# Account Debit Credit Job
-
= CR 13/01/2013 Payment; Toko Ganesha Unggul
CR-005 11110 CashInBank 3p157.904.000,00
CR-005 11210 Account Receivable 3p157.904.000,00
= 5 13/01/2013 Toko Ganesha Unggul: Credit from 00000003
SJ000001 11210 Account Receivable Rp3.566.000,00
SJ000001 11210 Account Receivable Rp3.566.000,00
o S 13/01/2013 Toko Ganesha Unggul: Discounts on SL-001
00000003 11210 Account Receivable Rp3.566.000,00
00000003 5-3000 Sales Discounts Rp3.566.000,00

Help F1 | Print

Gambar 2. 65 Jurnal Eliminasi PPN dalam Diskon

3 Ulangi langkah-langkah 1 s.d. 4 untuk mengisi data penerimaan piutang dengan
potongan sesuai dengan Bukti No: 14
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. Rangkuman

» Biasanya transaksi penjualan (Sales), diawali dengan adanya order dari
pelanggan, kemudian dilanjutkan dengan penjualan kredit/tunai,
kadang-kadang terjadi retur, penerimaan piutang dan lain sebagainya.
Semua transaksi tersebut disediakan menu dan format khusus oleh
MYOB. Data transaksi dientri ke dalam format dan kemudian diproses
secara otomatis.

» Komputer akan memberikan hasil berupa laporan jurnal, saldo akun
buku besar yang sudah di-update, bahkan laporan keuangan.

Untuk mencegah kesalahan dalam data entri maka dianjurkan sebelum
di-record dicek terlebih dahulu jurnal yang akan dihasilkan dengan
menekan Ctrl-R.

Berdasarkan Kasus 3.1. UD Rasela Media Mandiri yang ada pada ‘Lembar
Kerja Peserta Didik’, kerjakan tugas-tugas berikut ini!

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per
kelompok.

2. Setiap peserta didik mengikuti langkah-langkah yang dijabarkan dalam
KB3 ini melalui kerjasama kelompok.

Tugas 1, Mencatat transaksi Order Penjualan (2 transaksi)
Tugas 2, Mencatat transaksi Penjualan Kredit (2 transaksi)
Tugas 3, Mencatat transaksi Penjualan Tunai (2 transaksi)
Tugas 4, Mencatat transaksi Retur Penjualan (2 transaksi)
Tugas 5, Mencatat transaksi Retur Penjualan Tunai (2 transaksi)

O

Tugas 6, Mencatat transaksi Penerimaan Piutang tanpa diskon (2
transaksi)

9. Tugas 7, Mencatat transaksi Penerimaan Piutang dengan Discount (2
transaksi)

Direktorat Pembinaan SMK (2013)
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e. Tes Formatif

1. Tes Pengetahuan.

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b,

C,
1.

d atau e dari setiap item soal pilihan ganda di bawah ini:

Jenis layout faktur yang biasa digunakan oleh perusahaan dagang:
Service

Item and Service

Item

Miscellaneous

Sales > Sales Register > Pilih Order > Change to Invoice

PO TO

Langkah mengubah order penjualan menjadi penjualan kredit/tunai:
a. Sales > Enter Sales

b. Sales > Sales Register > Enter Sales

c. Sales Register > Enter Sales

d. Sales Register > Pilih Order > Change to Invoice

e. Sales > Sales Register > Pilih Order > Change to Invoice

. Langkah mengentri transaksi penerimaan piutang dari debitur:

Sales > Receive Money

Sales > Receive Payment

Sales Register > Receive Money

Sales Register > Sales > Receive Payament
Sales > Sales Register > Receive Money

Poo o

. Langkah mengentri transaksi retur penjualan, pertama Sales > Enter Sales

> Quantity minus. Kedua ...

Sales > Enter Sales > Receive Payment

Sales > Receive Payment

Sales Register > Sales > Receive Payment > Apply to Sale

Sales > Sales Register > Pilih Tab Returns & Credit > Apply to Sale
Sales > Sales Register > Pilih Tab Returns & Debett > Apply to Sale

P20 T O

Langkah mengentri transaksi penjualan counter atau tunai....
Sales > Enter Sales > Paid to Day diisi dengan total penjualan
Sales > Paid to Day diisi dengan total penjualan

Sales Register > Sales > Receive Payment

Sales > Sales Register > Receive Payment

Sales Register > Paid to Day diisi dengan total penjualan

PaooTO

. Dalam Faktur penjualan kolom untuk Tax Inclusive dicontreng ™ ini berarti

kolom harga barang akan diisi dengan....
a. Hargajual plus PPN 5%.

b. Harga jual plus PPN 10%.

c. Hargajual plus PPN 15%

d. Harga jual tidak termasuk PPN.

e. Harga jual minus PPN.
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7.

10.

Perintah untuk melihat jurnal Order Penjualan....
a. Sales > Sales Journals

b. Sales > Sales Register > Sales Journal

c. Sales Register > Sales > Sales Journal

d. Tidak ada jurnal untuk Sales Order

e. Ada jurnal untuk Sales Order

. Perintah untuk melihat jurnal Penjualan....

a. Sales > Sales Transaction Journals

b. Sales > Sales Register > Sales Journal
c. Sales Register > Sales > Sales Journal
d. Sales > Sales Journals

e. Sales > Transaction Journals

. Dalam pengisian data Faktur Penjualan, terlihat kolom 'Out of Balance’

berisi dengan Rp. 500.000,- . Apa yang akan terjadi jika diklik Record ?

a. Jurnal penjualan akan diproses.

b. Data yang tertulis di invoice akan dihapus.

c. Jurnal penjualan tidak akan diproses karena ada pilihan yang salah.

d. Jurnal penjualan akan diproses walapun ada data yang salah

e. Jurnal penjualan tidak akan diproses karena jumlah debet dan kredit
tidak seimbang.

Perintah untuk mengecek jurnal penjualan sebelum diklik Record:
a. Ctrl-C

b. Sales > Transaction Journal.
c. Ctrl-J

d. Ctrl-R

e. Sales > Sales Register

2. Tes Keterampilan.

Sesuaikan daftar pajak pada MYOB dengan Pajak yang berlaku di Indonesia
(Lihat Kasus 1.1 di lembar kerja peserta didik):

Berdasarkan Kasus 3.1. UD Riola Media Mandiri yang ada pada ‘Lembar
Kerja Peserta Didik’, kerjakan tugas-tugas berikut ini !

1.

2.

©ONO Ok~ W

9.

Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per
kelompok.

Setiap peserta didik mengikuti langkah-langkah yang dijabarkan dalam
KB3 ini melalui kerjasama kelompok.

Tugas 1, Mencatat transaksi Order Penjualan (2 transaksi)

Tugas 2, Mencatat transaksi Penjualan Kredit (2 transaksi)

Tugas 3, Mencatat transaksi Penjualan Tunai (2 transaksi)

Tugas 4, Mencatat transaksi Retur Penjualan (2 transaksi)

Tugas 5, Mencatat transaksi Retur Penjualan Tunai (2 transaksi)

Tugas 6, Mencatat transaksi Penerimaan Piutang tanpa diskon
(2 transaksi)

Tugas 7, Mencatat transaksi Penerimaan Piutang dengan Discount
(2 transaksi)
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f. Kunci Jawaban Tes Formatif

S

1. Kunci Tes Pengetahuan
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O|0|INIO®

QB|WIN|F

QIO

oD |0 |Q|T

2. Kunci Tes Keterampilan

Tugas 1 Transaksi Order Penjualan (2 transaksi)

Tidag ada

Jurnal

Tugas 2, Transaksi Penjualan Kredit (2 transaksi)

@File Edit Lists Command Centres

Setup Reports

Window Help

General ' Dizbursements I Feceipts

T o= 1

Purchases I Irwentary I Ak
Dated From: | 07/01/2013 Tor | 31/01/2013
1D Fram: To
Src Date 1D Account Drebit Credit Job
o 5 04/01/2013 Sale; Toko Ganesha Unggul J

SL-001 11210 Account Receivable Jp162.000.000,00 J
SL-00m 11210 Account Receivable Rp1E.200.000,00

SL-00m 11210 Account Receivable Fip100.000,00

SL-001 41100 Sales - Computers 1p135.000.000,00

SL-0m 41200 Sales - Printers Rp27.000.000.00

SL-0m 21310 PPN Collected Rp16.200.000.00

SL-0m 4-5000  Freight Collected Rp100.000.00

SL-0m 51100 COGS - Computer Rp90.000.000,00

SL-001 11310 Inventary - Computers RpS0.000.000,00

SL-0m 51200 COGS - Printer Rp13.500.000,00

SL-00m 11320 Inwentary - Printers Fip13.500.000,00

o 5l 05/01/2013 Sale; Toko Global Persada

SL-002 11210 Account Receivable 3p108.000.000,00

SL-002 11210 Account Receivable Rp10.800.000.00

SL-002 11210 Account Receivable Fip100.000,00

SL-002 41100 Sales - Computers FipSE.000.000,00

SL-002 41200 Sales - Printers Rp12.000.000.00

SL-002 21310 PPN Collected Fp10.800.000.00

SL-002 4-5000  Freight Collected Rp100.000.00

SL-002 51100 COGS - Computer RpEE.000.000,00

SL-002 1130 Irwentory - Computers FipEE.000.000,00

SL-002 51200 COGS - Printer Rp7.000.000,00

5L-002 11320  Inventory - Printers Fp7.000.000,00

Direktorat Pembinaan SMK (2013)
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Tugas 3, Transaksi Penjualan Tunai (2 transaksi)

G]File Edit Lists Command Centres Setup Reports  Window Help

ﬁenaral' Dishurzements ' Receipts ' Sales I Purchazes I Inwentary I

Drated Fram: | 01/ /2013

Ta [31/01/2013

1D From: | To |
Sic Date ID# Account Debit Credit Job
-
o 5 0E/01/2012 Sale; COUNTER SALES
CR-001 11210 Account Receivable Fipi7.300.000,00
CR-00 11210 Account Receivable Fp8.730.000,00
CR-001 11210 Account Receivable Rp70.000,00
CR-001 41100 Sales - Computers Rp&1.000.000,00
CR-001 41200 Sales - Printers Fipb.300.000,00
CR-001 21310 PPN Collected Fp8.730.000.00
CR-001 48000 Freight Callected Rp70.000,00
CR-001 51100 COGS - Computer Fp54.000.000,00
CR-00 11310 Inwventary - Computers Fip54.000.000,00
CR-001 51200 COGS - Printer Rp4.550.000,00
CR-001 11320 Inventary - Printers Fip4.550.000.00
or 5 07/01/2013 Sale; COUNTER SALES
CR-002 11210 Account Receivable Rp70.000.000,00
CR-002 11210 Account Receivable Fip7.000.000,00
CR-002 11210 Account Receivable Fp100.000,00
CR-002 41100 Sales - Computers RpE4.000.000,00
CR-002 41200 Sales - Printers FipB.000.000,00
CR-002 21310 PPN Collected Rp?.000.000.00
CR-002 45000  Freight Callected Rp100.000.00
CR-002 51100 COGS - Computer Rp44.000.000,00
CR-002 11310 Inventory - Computers Fp44.000.000,00
CR-002 51200 COGS - Printer Rp3.500.000,00
CR-002 11320 Inwentary - Printers Fip3.500.000.00

Help F1

Tugas 4, Transaksi Retur Penjualan (2 transaksi)

gFile Edit Lists Command Centres Setup  Reports  Window Help

General I Disbursements I Receipts I Sales I Purchases ' Irentary ' AlE
Diated From: [01/01/2013 To: [31/01/2013
10 From: | Tor |
Sre Date 1D# Account Dehit Credit Job
=]
o 5 08/01/2013 Sale Retumn; Toko Ganesha Unggul
CH-001 11210 Account Receivable Fip15.300.000,00
CH-001 11210 Account Feceivable Rp1.530.000.00
CH-001 41100 Sales - Computers Fip13.500.000,00
CH-001 41200 Sales - Printers Rp1.800.000,00
CH-001 21310 PPN Collected Rp1.530.000,00
CH-001 51100 COGS - Computer Rp3.000.000,00 J
CH-001 11310 Inwventary - Computers Fp9.000.000,00
CH-001 51200 COGS - Printer Rp1.300.000,00
CH-001 11320 Inventary - Printers Rp1.300.000,00
o 5 08/01/2013 Toko Ganesha Unggul Credit from CH-007
CH-001 11210 Account Receivable Fip16.830.000,00
CH-001 11210 Account Receivable Fip16.830.000,00
o 5l 08/01/2013 Sale Retumn; Toko Global Persada
CH-002 11210 Account Receivable Fip16.600.000,00
CH-002 11210 Account Receivable Rp1.660.000.00
CH-002 41100 Sales - Computers Rp16.000.000,00
CH-002 41200  Sales - Printers Rp&00. 000,00
CN-002 21310 PPN Collected Rp1.660.000,00
CN-002 51100 COGS - Computer Rp11.000.000,00
CH-002 11310 Inwentary - Computers Rp11.000.000,00
CN-002 51200 COGS - Printer Rp350.000,00
CH-002 11320 Inwentary - Printers Rp350.000,00
= A 02/01/2013 Toko Global Persada: Credit from Ch-002
CH-002 11210 Account Feceivable Fip18.260.000,00
CH-002 11210 Account Receivable Fip18.260.000,00
-
'/?/ =
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Tugas 5, Transaksi Retur Penjualan Tunai (2 transaksi)

G]File Edit Lists Command Centres

Setup  Reports

Window Help

r
General ' Disbursements ' Receipts ' Sales ' Purchazes T Inwentory T Al
Dated From: | 01/01/2013 Tao: [ 3170172013
1D From: To:
Src Date 1D Account Dehit Credit Jaob

o 5l 10/01/2013 Sale Retum; COUMTER SALES
CP-0m 11210 Account Receivable Rp14.400.000,00
CP-0M 11210 Account Receivable Fp1.440.000,00
CP-0m 41100 Sales - Computers Rp13.500.000.00
CP-0M 41200 Sales - Printers Rp300.000,00
CP-001 21310 PPN Collected Rp1.440.000,00
CP-001 51100 COGS - Computer Fp3.000.000,00
CP-0m 11310 Inwentory - Computers Fp9.000.000,00
CP-001 5-1200 COGS - Printer RpE&0.000,00 J
CP-0m 11320 Inwentory - Printers RpE&0.000,00

o CD 10/01,/2013 COUMTER SaLES
CP-001 1-1110  Cash In Bank Rp15.840.000,00
CP-0m 11210 Account Receivable Rp15.840.000,00

o 5l 11/01/2013 Sale Retun; COUMTER SALES
CP-002 11210 Account Receivable Rp16.600.000.00
CP-002 11210 Account Receivable Rp1.660.000,00
CP-002 41100 Sales - Computars Rp16.000.000,00
CP-00z2 41200 Sales - Printers RpE00.000,00
CP-002 21310 PPN Collected Rp1.6E0.000,00
CP-002 51100 COGS - Computer Rp11.000.000,00
CP-002 11310 Inwentory - Computers Rp11.000.000.00
CP-002 5-1200 COGS - Printer Rp350.000,00
CP-002 11320 Inwentory - Printers Rp350.000,00

o CD 11/01/2013 COUNTER SaLES
CP-002 1-1110  CaghIn Bank Rp18.260.000,00
CP-002 11210 Account Receivable Rp18.260.000.00

Help F1 Frint

Tugas 6, Transaksi Penerimaan Piutang tanpa diskon (2 transaksi)

G]FHE Edit Lists Command Centres Setup Reports Window Help

General' Dizbursements 'Heceu:-ts ' Sales ' Purchaszes T Inventom T

AlE
Dated From: | 01/01/2013 To: | 31/017/2013
10 From: | Tao: |
Sic Date ID# Account Dehit Credit Job
= CR 12/01/2013 Papment; Toko Ganesha Unggul
CR-003 1-1110  CashInBank 4p209.000.000,00
CR-003 11210 Account Receivable 3p209.000.000,00 J
= CR 12/01/2013 Papment; Toko Global Perzada
CR-004 1-1110  Cash In Bank R pEE.000.000,00
CR-004 11210 Account Receivable R pEE.000.000,00

7.

Help F1
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Tugas 7, Transaksi Penerimaan Piutang dengan Discount (2 transaksi)

E]FHE Edit Lists Command Centres Setup Reports  Window Help
Genelal' Disbursements ' Receipts ' Sales ' Purchases ' Inwentory ' Al

Dated From: [01/01/2013 To: | 3140172013
ICv Fram: | To |
S Date 0§ Account Drehit Credit Job

=] 134014203 Payment; Toko Ganesha Unggul
CR-005 11110 CashlnBank 3p1567.904.000.00
CR-005 11210 Account Receivable 3p157.904.000,00

o 5)J 13/0/2M3 Toko Ganesha Unggul: Credit from 00000003
5000001 11210 Account Receivable Rp3.566.000,00
S.J000001 11210 Account Receivable Rp3.566.000,00

= 13/1/2013 Toko Ganesha Unggul: Discounts on SL-001
00000003 11210 Account Beceivable Fip3.566.000.00 J
00000003 5-3000  Sales Discaunts Rip3.5EE.000.00

= CH 13/01/2M3 Payment; Toko Global Persada
CR-006 11110 CashInBank Fp98.262.000.00
CR-00& 11210 Account Receivable Rp98.262.000,00

o 5l 13/01/2M3 Toko Global Persada: Credit from 00000004
5000002 11210 Account Receivable Fip2.378.000,00
5J000002 11210 Account Receivable Rp2.378.000.00

S| 130123 Toko Global Persada: Dizcounts on SL-002
0o0onoo4 11210 Account Receivable Rp2.378.000.00
00000004 5.3000  Sales Discounts Rp2.378.000.00
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g. Lembar Kerja Peserta Didik

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta

didik di komputer melalui program MYOB versi 18.

Kasus 5.1 : Kasus UD Rasela Media Mandiri.

Transaksi Order Penjualan (2 transaksi)

BuktiMo: 01
UD. RASEL MEDIA MANDIRI SALES ORDER
JI. Pamulang Raya 17, Pamulang 3 Januari 2013

Tangerang Selatan

50-001
SALES ORDER
Seld to: Toko Ganesha Unggul, JI. Setia Budi 23, Pamulang
Amcunt: Rp. 178.200,000,-
Seratus tujuh puluh delapon juta dua rotus ribu Rupiah.
Details:
No Item No ription oty Price/Unit Total Price TAX
Ep. Rp.
1 COM-001 | HPPro book4421s 10 14.350.000,- 148.500.000.- | PPN
3 PREN-001 | Camonl-215 30 990.000,- 29.700.000,- | PPN
Total 178.200.000,- | PPM
Pemilik Perusahaan Sales Teknisi Akuntansi
Rasela Marta Renata
BuktiNo: 02
UD.RASEL MEDIA MANDIRI SALES ORDER
JI. Parulang Raya 17, Pamulang 3 Januari 2013
Tangerang Selatan So-002
SALES ORDER
Sold to: Toko Globkal Persada, JI. Cendana 11 Ciputat
Amount: Rp. 118.800.000,-
Seratus delapon belos juta delgpan ratus nibu Rupioh.
Details:
Mo Item Mo ription Oty Price/Unit Total Price Tax
Rp. Rp.
1 COM-002 | HP Pro book5530 & 17.600.000,- 105.600.000,- | PPM
3 PRMN-002 | CamonBj-355 20 &60.000,- 13.200.000,- | PPM
Total 118.800.000,- | PPN
Pemilik Perusahaan Sales Teknizi Akuntansi
Rasela Marta Renata
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Transaksi Penjualan Kredit (2 transaksi)

| BuktiNo: 03
UD. RASEL MEDIA MANDIRI INVQICE
Jl.Pamulang Raya 17, Pamulang @.@\J Datni: 4 Januari 2013
Tangerang Selatan G Inv# SL-001
SC#/Date | SO-001/3 Januan 2013

INVOICE
Sold to: Teko Ganesha Unggul, JI. Setia Budi 23, Pamulang
Amount: Rp. 178.300.000.-
Seratus tujuh puluh delapan juta tiga ratusribu Rupiah
Details:
Mo Item Mo Description Cty Price/Unit Total Price TAX
Rp. Rp.
1 COM-001 | HPPro book4421s 10 14.850.000, - 148.500.000,- | PPM
2 PEM-001 | Camnonl-215 30 S90.000, - 29.700.000,- | PPN
178.200.000,- | PPM
Freight Collected 100.000, - NT
Total 178.300.000 -
Pemilik Perusahaan Sales Teknisi Akuntansi
Rasela Marta Renata
| BuktiNo: 04
UD. RASEL MEDIA MANDIRI INVOICE
JI. Pamulang Raya 17, Pamulang @_.? Datn.a 3 Januari 2013
Tangerang Selatan © Inv# 5L-002
S0#/Date | 50-002/ 3 Januari 2013

INVOICE
Sold to: Teko Global Persada, ). Cendana 11 Ciputat
Amount: Rp.118.900.000.-
Seratus delapan belas juta sembilan ratus ribu Rupiah.
Details:
Ma Item Mo Description Qty Pnc::?lmt Tu:utaRIthrlce TAX
1 COM-002 | HPPro book5530 & 17,600,000, - 105.600.000,- | PPM
3 PRM-002 | CamonBj-355 20 BE0.000, - 153.200.000,- | PPN
118.300.000,- | PPM
Freight Collected 100.000, - NT
Total 118.900.000 -
Pemilik Perusahaan Sales Teknisi Akuntansi
Rasela Marta Renata
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Transaksi Penjualan Tunai (2 transaksi)

| BuktiNo: 05 |
UD. RASEL MEDIA MANDIRI CASH RECEIPT
n F'. | Rayal7 P | CASH CHEQUE
- am a”g lat*a FEMUENg M hate 6 Januari 2013 6 Januari 2013
angerang Selatan NO CR-001 s 21
CASH RECEIPT
Sold to: Counter Sales,
Amcunt: Rp 96.100.000 -
Sembilon puluh enam juta seratus ribu Rupiah
Details:
MNo Ttem Mo Description Oty Price/Unit Total Frice TAX
Rp. Rp.
1 COM-001 | HPPro book4d421s B 14.850.000 - 89.100.000- | PPM
2 PRMN-001 Canonl)-215 7 00,000 - 6530,000- | PPM
06.030.000- [ PPN
Freight Collected T0.000,- MNT
Total Received 06,100,000 -
Pemilik Peruzahaan Sales Teknisi &kuntansi
Rasela Marta Renata
| BuktiNo: 06 |
UD. RASEL MEDIA MANDIRI CASH RECEIPT
n F'. | Rayal7 P | CASH CHEQUE
- amd a”g la:a (FAMUENG - bate 7 Januari 2013 7 Januari 2013
angerang Selatan NO CR-002 N-23
CASH RECEIPT
Sold to: Counter Sales,
Amount: Rp 77.100.000,-
Tujuh puluh tujuh jute seratus ribu Rupiah
Details:
MNo Ttem Mo Description Oty Price/Unit Total Frice TAX
Rp. Rp.
1 COM-002 | HP Pro book5530 4 17.600.000 - 70400.000- [ PPN
2 PRMN-002 Camon Bj-555 10 660,000 - 6.600,000- | PPM
77.000.000- | PPM
Freight Collected 100.000 - MT
Total Received 77.100.000 -
Pemilik Perusahaan Sales Teknisi &kuntansi
Rasela Marta Renata
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Transaksi Retur Penjualan (2 transaksi)

| BuktiNo: 07

CREDIT NOTE
Date & Januari 2013
CreditMote # | CN-001
Inveice/Date | SL-001/4 Januari 2013

UD. RASEL MEDIA MANDIRI

). Pamulang Raya 17, Pamulang @'@"\J
Tangerang Selatan G

CREDIT NOTE
Returned by: Toko Ganesha Unggul, JI, Setia Budi 23, Pamulang
Amount: Rp 16,830,000 -

Enam belas juta delapan ratus tiga puluh ribu Rupiah

Returned dueto damages

Price/Unit Total Pri
MNo Item Mo Description Oty e oratrrice TAX
Rp. Rp.
1 COM-001 | HPPro book4421s 1 14,850,000 - 14.850.000- | PPN
2 PRMN-001 Canonl-215 2 S90.000, - 1.580,000- | PPN
Total 16.830.000- | PPN
Pemilik Perusahaan Sales Teknisi &kuntansi
Razela Marta Renata
| BuktiNo: 08
UD. RASEL MEDIA MANDIRI CREDIT NOTE
Date 8 Januari 2013

JI. Pamulang Raya 17, Pamulang G@,'@ﬂ

Tangerang Selatan Credit Mote # | CN-002

Invoice/Date | SL-002/5 Januar 2013

CREDIT NOTE
Returned by: Tokeo Glokal Persada, JI. Cendana 11 Ciputat
Amcunt: Rp 18.260.000 -

Delapan belas juta duaratus enam puluh nbu Rupiah
Returned duetc damages

Price/Unit Total Pri
MNo Item Mo Description Oty e oratrrice TAX
Rp. Rp.

1 COM-002 | HP Pro book 5530 1 17.600.000 - 17.600.000- | PPN

2 PRMN-002 Canon Bj-555 1 E6E0.000.- 660.000- | PPM
Total 18.260.000- | PPM

Pemilik Perusahaan Sales Teknisi &kuntansi

Rasela Marta Renata
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Transaksi Retur Penjualan Tunai (2 transaksi)
| BuktiNo: 09
UD. RASEL MEDIA MANDIRI CASH PAVMENT
1] F'. lang Raya 17, Pamul cAsH CHEQUE
T' amu a”g lat*a PEMUENG - Mhate 10 Januari 2013 10 Januari 2013
angerang setatan NO CP-001 CP-001

CASH PAYMENT

Counter Sales
Rp 15.840.000-

Supplien
Amount:

Lima belos juta delopan ratusempat puluh ribu Rupiah

Details: Cash Pay Back for Counter Sales Return,

MNo Ttem Mo Description Oty Price/Unit Total Frice TAX
Ep. Rp.

1 COM-001 | HPPro book4d421s 1 14.850.000 - 14.850.000- | PPM

2 PRMN-001 Canonl)-215 1 00,000 - So0.000- | PPN

Total 15.240.000- [ PPN

Pemilik Perusahaan Cashier Teknisi &kuntansi

Rasela Marta Maya
| BuktiNo: 10

UD. RASEL MEDIA MANDIRI CASH PAYMENT

n F'. I Rayal7 P I CASH CHEQUE

- 2 a”g la:a ramuEng e 11 Januari 2013 11 Januari 2013

angerang s=iatan NO CP-002 CP-002

CASH PAYMENT

Counter Sales
Rp 18.260.000-

Supplien
Amount:

Delopan belas jute duaratus enam puluh ribu Rupiah

Details: Cash Pay Back for Counter Sales Return,

Price/Unit Total Pri
MNo Ttem Mo Description Oty et aratrrce TAX
Ep. Rp.

1 COM-002 | HP Pro book5530 1 17.600.000 - 17.600.000- | PPM

2 PRMN-002 Camon Bj-555 1 660,000 - 6&0.000- | PPN
Total 18.260.000- [ PPN

Pemilik Perusahaan Cashier Teknisi &kuntansi

Rasela Marta Maya
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Transaksi Penerimaan Piutang tanpa diskon (2 transaksi)

| BuktiNo: 11
CASH RECEIPT
_hl[; RASlEL h';EDIﬁ; I';I;:LN [}I|RI CASH CHEQUE
- am a”g la;a :FEMUEANg - IMDate 12 Januari 2013 12 Januari 2013
angerang seistan NO CR-003 Al21
CASH RECEIPT
Receive Payment  From:
Customer: Toko Ganesha Unggul, JI. Setia Budi 23, Pamulang
Amount: Rp. 209,000000,-
Dua ratus sembilan juta Rupigh
Detail=:
Mo Date Invaices Amount Discount Tatal Due
Rp Rp Rp.
1 27712712 | FP-D03 205.000.000,- - 209,000,000 -
Total Receipt 209,000,000 -
Pemilik Perusahaan Cachier Teknisi Akuntansi
Rasela Marta Maya
| BuktiNo: 12
UD. RASEL MEDIA MANDIRI CASH RECEIPT
Il F'. | Rayal7 P | CASH CHEQUE
.Pamulang Raya 17, Pamulan
. 2 o 9 |Date | 12Januari2012 12 Januari 2013
angerang s=taEan NO CR-004 B222
CASH RECEIPT
Receive Payment  From:
Customer: Toko Global Persada, JI. Cendana 11, Ciputat
Amount: Rp. 66.000.000.-
Enam puluh enam juta Rupiah
Details:
Mo Date Invaices Amount Discount Tatal Due
Rp Rp Rp.
1 28/12/12 | FP-DO5 66.000.000 - - E6.000.000 -
Total Receipt E6.000.000 -
Pemilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya
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Komputer Akuntansi Jilid 2
Transaksi Penerimaan Piutang dengan Discount (2 transaksi)

|BuktiNo: 13
UD. RASEL MEDIA MANDIRI CASH RECERT
Il F'. lang Rayal7,P I CASH CREQUE
- = a”g la:a (TAmEENg Date | 12Januari2013 13 Januari 2013
angerang seEEn NO CR-005 A125
CASH RECEIPT
Receive Payment  From:
Customer: Toko Ganesha Unggul, JI. Setia Budi 23, Pamulang
Amount: Rp 157.904.000,-
Seratus lima puluh tujuh juto sembilon ratusempat ribu Rupiah
Details:
No Date Invoices Amaunt 5ales Return Total Due
REp REp Rp.
1 4/1/13 SL-001 178.300.000,- 16.830.000 - 161.470.000,-
Discount (2%x Rp.173.300,000.-) 3.566.000 -
Total Received 157.904.000 -
Pemilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya
|BuktiNo: 14
UD. RASEL MEDIA MANDIRI CASH RECETT
1l F'. lang Rayal7,P I CAsH CREQLE
. am a”g la:a (PEMUENG T hote 13 Januari 2013 13 Januari 2013
angerang-elatan NO CR-006 A125
CASH RECEIPT
Receive Payment  From:
Customer: Teko Global Persada, JI. Cendana 11, Ciputat
Arount: Rp. 98.262.000,-
Sembilan puluh delopan juta dua ratus enam puluh dua ribu Rupioh
Details:
Mo Date Irvoices Amaunt Sales Retur Total Due
Rp Rp Rp.
1 5/1/13 SL-002 118.500.000,- 18.260.000 - 100,640.000,-
Discount (2% x Rp. 118.500000) 7378.000,-
Total Received 98.262.000, -
Pemilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya
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Kasus 5.2 : Kasus UD Riola Media Mandiri.

Transaksi Order Penjualan (2 transaksi)

Buktiho : 01
UD.RIOLA MEDIA MANDIRI SALES ORDER
JI. Pamulang Raya 17, Pamulang @ﬁ Date 3 Januari 2013
Tangerang Selatan @@ 0% S0-001
SALES ORDER
Sold to: Toko Ganesha Unggul, JI. Sstia Budi 23, Pamulang
Amount: Rp.178.200.000 -
Serarus tujuh puluh delspan juts dua ratus riby Rupiah.
Details:
Mo | ltem Mo Description Qty | Prce/Unit R, T“‘EF!;"DE TAX
1 COMA001 HP Probook 4421s 10 14 850000 - 148500000- [ PPN
3 PRN001 Canon LJ-215 a0 990,000 - 29.700000- [ PPN
Total 178200000- [ PPN
Pemilik Perusahaan Sales Teknisi Akuntansi
Riola Marta Renata
BuktiMNo : 02
UD. RIOLA MEDIA MANDIRI SALES ORDER
JI. Pamulang Raya 17, Pamulang @@ Date 3 Januari 2013
Tangerang Selatan @ S0E 2000
SALES ORDER
Sold to: Toko Global Persada, JI. Cendana 11 Ciputat
Amount: Rp.118.800.000 -
Seratus delapan belas juta delapan ratusriby Rupiah.
Details:
- o Total Price
Mo [tem Mo Descrption Qty | Prce/Unit Rp. R TAX
1 con02 HP Pra book 5530 [ 17600000 - 1054600000- | PPN
3 PRN002 Canon Bj-555 20 650.000 - 13.200000- | PPN
Total 118.800000- | PPN
Pemilik Peruzshaan Sales Teknizi Akuntansi
Riola Marta Renata
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Transaksi Penjualan Kredit (2 transaksi)

Bukti No: 03
UD. RIOLA MEDIA MANDIRI INVOICE
JI. Pamulang Raya 17, Pamulang Date 4 Januari 2013

Tangerang Selatan @@@Qﬂ I # SL-00

SO#Date 50-001/3 Januari 2013

INVOICE
Sold to: Toko Ganesha Unggul, JI. Setia Budi 23, Famulang
Amount: Rp.178.300.000 -
|Serarus tujuh puluh delapan juta tiga ratus riby Rupiah.
Details:
No | liem Mo Description Qty | Price/Unit Ro. T‘JEFLDP"“E TAX
1 Con00 HP Pro book 4421s 10 14.850.000 - 143500000- | PPN
2 PRHA01 CanonLJ-215 30 990.000 - 29.700000- | PPN
178.200000- | PPN
Freight Collected 100000 - NT
Total 178.300000 -
Pemilik Perusahaan Sales Teknisi Akuntansi
Riola Marta Renata
BuktiMo : 04
UD_RIOLA MEDIA MANDIRI INVOICE
JI. Pamulang Raya 17, Pamulang %[} Date 5 Januari 2013
Tangerang Selatan G@ Inv# SL-002
SCeEDate SC-002/ 3 Januari 2013

INVOICE
Sold to: Toko Global Persada, Jl. Cendana 11 Ciputat
Amount; Rp.. 118.900.000,-
Seratus delapan belas juta sembian ratus ribu Rupiah.
Details:
No | ltem Mo Description Qty | PricelUnit Rp. T‘“HF!;"‘* TAX
1 comon2 HP Pro book H530 [ 17.600.000 - 105.600000- [ PPN
3 PRN0Z Canon BFO55 20 660.000 - 13.200000- [ PPN
116.600000- [ PPN
Freight Collected 100.000 - NT
Total 118.900.000 -
Pemilik Perusahaan Salkes Teknisi Akuntansi
Riola Marta Renata
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Komputer Akuntansi Jilid 2
Transaksi Penjualan Tunai (2 transaksi)

Buktiho : 05
CASH RECEIPT
jnﬁ RIDII_A I.‘I:I] lA:.ﬂTA:DIRII CASH CHEQUE
- ramuiang naya 1, Famuiang Date 5 Januan 2013 5 Januari 2013
Tangerang Selatan
MO CR-001 3-21
CASH RECEIPT
Sold to: Counter Sales.
Amount: Rp.96.10:0.000.-
Sembian puluh enam juta seratus ribu Rupiah
Details:
No | Item Mo Description Qty | PricelUnit Ro. Tmﬂ;'“ TAX
1 Con0Mm HP Probook 4421s [ 14.850.000 - 89.100000- [ PPN
2 PRHA001 CanonLJ-215 7 990.000 - 0930000-| PPN
96.030000- [ PPN
Freight Collected 10,000 - NT
Total Recened 96.100.000 -
Pemilik Perusahaan Sales Teknisi Akuntansi
Riola Marta Renata
BuktiMo : 06
CASH RECEIPT
jDﬁRIDTA MFI;ZDIA:.I'ITA:DIR: CASH CHEQUE
- Pamuiang nays 1, Famuiang Date 7 Januari 2013 7 Januari 2013
Tangerang Selatan
N CR-00 M-23
CASH RECEIPT
Sold to: Counter Sales.
Amount: Rp.77.100.000. -
Tujuh putuh tujuh juta seratus riby Rupiah
Details:
N o Total Pace
Mo [tem Ma Descraption Qty | Prce/Unit Rp. Ro TAX
1 COM002 HP Pro book 5530 4 17.500.000 - T70.400000-| PPH
2 PRHA002 Canon Br555 10 660.000 - 6.600000.-| PPN
T7.000000- | PPH
Freight Collectad 100.000 - NT
Total Recaned T7.100.000 -
Pemilik Perusahaan Sales Teknisi Akuntansi
Riola Marta Renata
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Transaksi Retur Penjualan (2 transaksi)

BuktiMNo : 07
UD. RIOLA MEDIA MANDIRI CREDIT NOTE
JI. Pamulang Raya 17, Pamulang %ﬂ Date 8 Januari 2013
Tangerang Selatan C,@ Credit Mote # CN-001
Invoice/Date SL-001/ 4 Januari 2013
CREDIT NOTE
Returned by: Toko Ganesha Unggul, JI. Setia Budi 23, Pamulang
Amount: Rp 16.830.000 -
Enam beias juta deigpan ratustiga puluh ribu Rupiah
Returned due to damages
Mo | ltemMNo Description Qty | PricsfUnit Rp. T"‘ﬂ;“ TAX
1 COMHI0T | HP Pro book 4421= 1 14,850,000 - 14.850000- | PPN
pl PRMO01 Canon LJ-215 Z 990.000 - 1950.000- [ PPN
Total 16.830.000- | PPN
Pemilik Perusshasn Sales Teknizi Akuntansi
Riola Marta Renata
| BuktiNo : 08
UD.RIOLA MEDIA MANDIRI CREDIT NOTE
JI. Pamulang Raya 17, Pamulang @%ﬂ Date 8 Januari 2013
Tangerang Selatan @O CredtNote# | CN-002
Invoice/Date SL-002/ & Januari 2013
CREDIT NOTE
Returnad by: Toko Global Persada, J. Cendana 11 Ciputat
Amount: Rp 13.260.000,-
Delgpan beias juta dug ratus enam puluh riby Rupiah
Returned dus to damages
No | lemNo Description Qty | PrcefUnit Re. Tmi_:;"‘* TAX
1 COM002 | HP Probook5530 1 17.600.000 - 17.600000- [ PPN
2 PEN002 | CanonBp255 1 660,000 - 60.000- | PPN
Total 16.260.000- [ PPN
Pemilik Peruzahaan Sales Teknigi Akuntansi
Riola Marta Renata
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Komputer Akuntansi Jilid 2
Transaksi Retur Penjualan Tunai (2 transaksi)

BuktiNo : 09
CASH PAYMENT
jnﬁ RIDII_A M:I] lA:a;A;II]IR: CASH CHEQUE
- remuiang neya 11, Famuiang Date 10.Januari 2013 10.Januari 2013
Tangerang Selatan
WO CP-00 CP-00
CASH PAYMENT
Supplier: Counter Sales
Amount: Rp. 15.640.000-
Lima belas juta deiapan ratus empat pulh riby Rupiah
Details: Cash Pay Back for Counter Sales Return.
No | ItemMNo Description Qty | Prce/Unit R, T“‘Eg;"oe TAX
1 COn-001 HP Pro book 44215 1 14 850000 - 14 850.000- [ PPN
2 PRNA01 Canon LJ-215 1 990.000 - 990.000- [ PPN
Total 15.840000- [ PPN
Pemilik Perusahaan Cashier Teknisi Akuntansi
Ricla Marta Maya
BuktiMo : 10
CASH PAYMENT
jnﬁ: RIDII_A MFIfDlA:.I;A;IDIRII CASH CHEQUE
- amuiang nays 1, Famuiang Date 11 Januari 2013 11.Januari 2013
Tangerang Selatan
WO CP-002 CP-002
CASH PAYMENT
Supplier: Counter Sales
Amount: Rp. 18.250.000-
Delapan beias juta dua ratus enam puluh ribu Rupiah
Details: Cash Pay Back for Counter Sales Return.
No | liemMo Description Qty | Proe/Unit Ro. Tmaépp"‘* TAX
Con002 HP Pro book 5530 1 17 600000 - 17600000- | PPN
2 PRN-002 Canon B}955 1 6560.000 - 660.000- | PPN
Total 18.260000- | PPN
Pemilik Perusahaan Cashier Teknisi Akuntansi
Riola Marta Maya
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Komputer Akuntansi Jilid 2
Transaksi Penerimaan Piutang tanpa diskon (2 transaksi)

BuktiNo : 11
CASH RECEIPT
jnﬁmnth M:D IA:.I'ITAFI:DIR: CASH CHEQUE
- mamuiang raya 1, Famiiang Date 12 Januari 2013 12 Januari 2013
Tangerang Selatan
NO CR-00 Al21
CASH RECEIPT
Receive Payment From:
Customer: Toko Ganesha Unggul, JI. Setia Budi 23, Pamulang
Amount: Rp.. 209.000.000,-
Dua ratus sembian futa Rupiah
Dietails:
- Amount Dizcount Total Due
Mo Date Invoice# Ro Ro Ro.
1 2722 | rr4003 209.000.000 - - 209.000.000 -
Total Receipt 209.000.000 -
Pemilik Perusshaan Cashier Teknisi Akuntansi
Riola Marta Maya
BuktiMo : 12
CASH RECEIPT
. Faming Ry 17, Pam CHEQUE
' g hays A g Date 12 Januari 2013 12 Januari 2013
Tangerang Selatan
NO CR-004 B222
CASH RECEIPT
Receive Payment From:
Customer: Toko Global Persada, Jl. Cendana 11, Ciputat
Amount; Rp.. 66.000.000 -
Enam puluh enam juta Rupiah
Details:
Mo Date Invoicel Amount Discount Total Due
Fp Fp Rp.
1 291212 | FPAO05 65.000.000 - - 65.000.000 -
Total Receipt 66.000.000 -
Pemilik Perusahaan Cashier Teknisi Akuntansi
Riola Marta Maya
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Komputer Akuntansi Jilid 2
Transaksi Penerimaan Piutang dengan Discount (2 transaksi)

| BuktiNo : 13
CASH RECEIPT
jnﬁ: RIDII_A MFI;ZI]IA:JTA:DIRII CASH CHEGUE
- amuiang nays 1, Famuiang Date 13 Januan 2013 13 Januari 2013
Tangerang Selatan
N CR-005 A28
CASH RECEIPT
Receive Payment From:
Customer: Toko Ganasha Unggul, JI. Setia Budi 23, Pamulang
Amaount; Rp. 157.904.000 -
Seratus fima puluh tujuh juta sembian ratus empat ribu Rupiah
Details:
No Date " Amount Sales Retum Total Due
Fp Fp Fp.
1 4113 SL-001 178.300.000 - 16.630.000 - 161.470000 -
Discount (2% x Fp. 175.300000.- 3.566.000 -
Total Recened 157 904 000 -
Pemilik Perusahaan Cashier Teknisi Akuntansi
Riola Marta Maya
BuktiNo : 14
CASH RECEIPT
:.III]F., RIDII_A MFEDIA:.I;AFI:DIR: CASH CHEQUE
ramiisng naya 1, Femtisng Date 13 Januari 2013 13 Januari 2013
Tangerang Selatan
N CR-006 Al25
CASH RECEIPT
Receive Payment From:
Customer: Toko Global Persada, Jl. Cendana 11, Ciputat
Amount; Rp.98.262.000 -
Sembilan puiuh delapan juta dua ratus enam puluh dua riby Rupiah
Details:
No Date Imvoice Amaount Sales Retur Total Due
Fp Fp Fp.
1 h13 SL-002 118.900.000,- 18.260.000 - 100640000 -
Discount {2%x Rp. 115.900.000) 2.378.000 -
Total Recaied 95.262000.-
Pemilik Perusahaan Cashigr Teknisi Akuntansi
Riola Marta Maya
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Dasar-dasar Perbankan Jilid 2
Kegiatan Belajar 6
Mengentri Transaksi Pembelian

r "{ a. Tujuan Pembelajaran

Dengan diberikan kasus akuntansi perusahaan dagang, maka pada akhir
sesi ini diharapkan peserta didik dapat:

. Mencatat transaksi order pembelian (purchase order)

. Mencatat transaksi pembelian (purchases)

. Mencatat transaksi pebelian aktiva tetap (purchase of fixed asset)
. Mencatat transaksi retur pembelian (purchase return)

. Mencatat transaksi pembelian tunai (cash purchase)

. Mencatat transaksi retur pembelian tunai (cash purchase return)

. Mencatat transaksi pembayaran utang (pay bill)

\‘5\/ b. Uraian Materi

Lingkup uraian materi pada kegiatan belajar 1 ini meliputi:

Entri transaksi Order Pembelian (Sales Order)

Entri transaksi Pembelian Kredit (Sales)

Entri transaksi Pembelian Tunai (Counter Sales)

Entri transaksi Retur Pembelian (Sales Return)

Entri transaksi Retur Pembelian Tunai (Counter Sales Return)
Entri transaksi Pembayaran Utang (Pay Bill) tanpa Discount
Entri transaksi Pembayaran Utang (Pay Bill) dengan Discount

Nook~wbdE

Program MYOB menyediakan berbagai menu pilihan untuk mengentri
transaksi pembelian yang dilakukan oleh perusahaan.

[mvos PURCHASES 2|
Rl
/// )’
Accounts Banking Time Bﬁ'\g Pun:hases lnvenlmy Card File
~
PayBills @ «-oceoeeeeenieainies Enter Purchases
(4 H
Prepare Electronic Payments .. L4
) . PrinEmail Purchase Orders
Print Chegues - :
€ e 1-powered €11
Print/Email Remittance Advices ---- @ Transaction Journal Services
@ Centre
ToDoList w Find Transactions w Reports w» Analysis »

Gambar 6-1 Menu Purchase
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Dasar-dasar Perbankan Jilid 2
1. Entri Transaksi Order Pembelian (Purchase Order)

Hal-hal yang perlu diperhatikan dalam transaksi order pembelian:
a) Seperti halnya pada order penjualan, order pembelian tidak dijurnal.
b) Anda bisa lihat hasil entri pada menu Purchase Register

¢) Selamanya akan tercatat di Purchase Register kalau anda belum
merubahnya menjadi Bill.

d) Dokumen sumber Bukti No: 15 & 16

BuktiMo: 15
UD. RASEL MEDIA MANDIRI PURCHASE ORDER
: ofy] | Date 14 Januari 2013
JI. Pamulang Raya 17, Pamulang c’@ -
PO# PC-001
Tangerang Selatan - -
Termin 3/10, n/30 LateFees2%
PURCHASE ORDER
Supplier: PT Merbabku Raya, JI. Gajah Mada 12 Jakarta
Amount: Rp. 188.100.000,-
ISEJ"ﬂ.*us delapanpuluhdelapan juta seratus ribu rupioh.
Details:
Mo Item Mo Description Cty Price/Unit Total Price TAX
Rp. Rp.
1 COM-001 | HP Pro book4421s 19 10.164.000,- 193.116.000,- | PPN
2 PRM-001 | CanonU-215 19 726,000, - 13.794.000,- | PPN
Total 206.910.000- | PPN
Pemilik Perusahaan Purchases Teknisi Akuntansi
Rasela Marta Lisa
BuktiMo: 16
UD.RASEL MEDIA MANDIRI ﬂ PURCHASE ORDER
NI, Pamulang Raya 17, Pamulang G@? Date 14 Januari 2013
Tangerang Selatan POz PO-002
PURCHASE ORDER
Supplier: PT Merapi Abadi, JI. Mangga Dua 29 Jakarta
Amount: Rp. 240.850.000,-
}Dun ratus empat puluh juta delapan ratus lima puluhribu Rupish
Details:
Ma Item Mo Description Cy Price/Unit Total Price TAX
Rp. Rp.
1 COM-002 | HP Pro book 5530 21 12364000, - 259.644.000,- | PPN
2 PRM-002 | CanonBj-555 13 407.000,- 5.291.000,- [ PPN
Total 264.535.000,- | PPN
Pemilik Perusahaan Purchases Teknisi Akuntansi
Rasela Marta Lisa
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Dasar-dasar Perbankan Jilid 2

Praktekkan langkah-langkah berikut ini:

1 Klik Command Centre Purchase > Enter Purchase

2  Klik Layout, pilih Item, klik OK. Kemudian set ke format ORDER

(&) Purchases - New Service o |[@] =

[ORDER ~l

Supplier vV TaxInclusive

Shipta Purchase #:

Date:

] S o e — ==
Description T E———————. e

— | Use the Item layout when you want to
- — E= | purchase something from your ltems
" Service e List.

@ ltem
Comment: -~ (" Professional
Ship Via:
Promised Date:

" Miscellaneous '

Journal Mema:

Order Delivery Status:

0

. ' = \

Help F1 Print SendTo | Joumal prayout

=

Cancel

RS —

Cancel

um;l (fJ) Use Recuring [ REG Spel| ‘

Register

Gambar 6-2 Layout Item for Purchase

3 Isi data Purchase Order sesuai dengan dokumen sumber (Bukti No. 15).
Kemudian klik Record dan Klik Cancel.

-
@ Purchases - New ltem |i‘ ﬂ|

Supplier o %PT Merbabu Raya = Terms ©: 3% 10 Net 30 vV TaxInclusive

Ship##” w |: UD Rasela Media Mandiri Purchase #: PO-001
JI. Pamulang Raya 17 PAMULANG
Tangerang Selatan Date:  14/01/2013
Supplier Invi:

Order Received Item Number Description Price  Disc% Total Job
13 =COM-001 HP Pro Book 4421s £4.000,00 |-116.000.,00]
/ 19 ©PRN-001 Canon Lj-215 726.000,00 |.794.000,00

| |
Subtatal: p206.910.000,00

Comment: Freight: Rp0.00
Ship Via: I Tax ©: 3p18.810.000,00
Promised Date: Total Amount: p206.910.000,00

Joumal Mema: |Purchase Orded: PT Merbabu Raya Paid Today: Rp0,00

Order Delivery Status: [ To be Printed | Balance Due: p206.910.000,00

(8) Save as Recuring| (%) Use Recuring i REC Spell

AR

Help F1 Frint SendTo | Joumnal Layout Register

Gambar 6-3 Purchase Order
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Dasar-dasar Perbankan Jilid 2

4 Untuk melihat Purchase Order yang sudah dientri kik Command Centre
Purchase > Purchase Register, kemudian klik Tab Order. Set Tanggal dari
1/1/13 to 31/1/13. Klik New Order untuk mencatat order berikutnya..

(8] Purchases Register _‘:’__”_E’_|

All Open Retums Closed
Puichases I Quotes I Urders I Eill I & Debits I Bill

Search by: | &l Suppliers b |

Dated From: [01/01/2013  To: [31/01/2013
.4

“Date PO# Supplier InvH Supplier Amount Amt Due Promised Received
4/01/20 PO-00 PT Merbabu Raya 206.510.000.00 1x206.310.000,00 |

\‘

J \
| \
| \
| \
| \
| |
| |

::;208.91 0.000,00 p206.910.000,00

Receive ltems 11 Change to Bill | & Pay Bill
= -

Gambar 6-4 Layout Item for Purchase

6 Ulangi langkah-langkah 1 s.d. 5 untuk mengisi data Purchase Order sesuai
dengan dokumen sumber (Bukti No. 16)

2. Entri Transaksi Pembelian Kredit

Hal-hal yang penting diingat dalam transaksi pembelian kredit:

a) Transaksiini mempunyai pengaruh terhadap: akun utang dagang, akun
pembelian, kartu utang dan kartu persediaan.

b) Cek terlebih dahulu jurnal yang akan dihasilkan sebelum klik Record.
(Tekan Ctrl-R untuk mengecek jurnalnya).

c) Dokumen sumber : Bukti No: 17 & 18
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Dasar-dasar Perbankan Jilid 2

| BuktiNo: 17
INVOICE
_IITTGM Ef::‘: UIR;YA Date 15 Januari 2013
i arJ:' acs INVE MR-57
Fans PO PO-001 /14 Januari 2013
INVOICE
Customer: UD RASEL MEDIA MAMDIRL JI. Pamulang Raya 17, Pamulang
Amount: Rp. 188.200.000 -
|5emtus delopanpuluhdelapan juta dua ratus ribu rupich.
Details:
Ma Item Ma Crescription Oty Price/Unit Total Frice TAX
Rp. Rp.
1 COM-001 | HPPro book4421s 15 10163000 - 153.116.000.- | PPM
2 PRM-001 Camnonl-215 15 726.000,- 13.784.000- | PPM
2068.910,000,- | PPM
Freight G0.000, -
Total 207.000.000,-
Pemilik Perusahaan Purchases Teknisi Akuntansi
Suycko Sena
BuktiMo: 18
PT.MERAFPI ABADI INVOICE
J M Dua 29 Date 16 Januari 2013
o :t”gga He INVE MA-62
akarta
PO= PO-002 714 Januan 2013
INVOICE
Supplier UD RASEL MEDLA MAMDIRL JI. Pamulang Raya 17, Pamulang
Amount: Rp. 241.000.000.-
puu ratus empat puluh satu juta Rupiah
Details:
Mo Item Mo Description Oty Price/Unit Total Price TAX
Rp. Rp.
1 COM-002 | HP Pro book5530 21 12.364.000,- 259.644.000,- | PPM
2 PEM-002 | CanonBj-355 13 407.000,- 5.291.000- | PPM
264.935.000,- | PPM
Freight B5.000.- | MT
Total 265.000.000,-
Pemilik Perusahaan Purchases Teknisi Akuntansi
Mina Rika
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Dasar-dasar Perbankan Jilid 2

Praktekkan Langkah-langkah berikut ini:

1  Klik Command Centre Purchase > Purchase Register

@ Purchases Register i“ﬂl

All Open Retums Closed
Puichases I Quotes I Urders I Eill I & Debits I Bill

Search by: [All Suppliers had|
Dated From: [01/01/2013  To: [31/01/2013

Date PO# Supplier Invi Supplier Amount Amt Due Promised Received
4/01/20 PO-00 P erbabu Raya 2006.910.000,00 [>206.310.000,00

14/01/2013 |PO-002 | PT Merapi Abadi 1264.935.000,00 [264.935.000,00 |
|

\

l

\
3:4?1.845,000,00 p471.845.000,00

@Heceive Items ‘ @C aeto Bil | &Pa}}BiII

7.

HelpF1 |

FPrint

Gambar 6-5 Purchase Register

2  Klik purchase order yang akan diubah menjadi Bill. Kemudian klik Change
to Bill. Isi data pembelian sesuai dengan bukti no. 17 ditambah freight
sebesar Rp. 90.000,-

@ Purchases - New Item ILHEI

Supplier ©: PT Merbabu Raya Tems ©: 3% 10 Net 30 vV Tax Inclusive

Shipto »|: UD Rasela Media Mandiri Purchase #:  P0-001
JI. Pamulang Raya 17 PAMULANG Date: 15/01/2013

Tangerang Selatan
Supplier Invi: MR-57
Bill ReceivedBackorder Item Number Description Price Disc%  Total Job

19| SCOM-001 HP Pro Book 4421s 64.000,00 |-116.000,00|
19 SPRN-001 Canon Lj-215 '26.000,00 |-794.000,00

i |

Subtotal: p206.910.000,00
Comment: Freight: Rp30.000,00
Ship Via: /Tax ©: 3p18.810.000,00

Promised Date: Total Amount: p207.000.000,00

Journal Memo: 1F’urchasé; PT Merbabu Raya i Applied to Date: Rp0.,00 History...

Bill Delivery Status: | To be Printed > Balance Due: p207.000.000,00

(1) Save as Recuring| &Paymenl! Gl Spel_l‘
9w - \g?-

-~
Help F1 SendTo | Joumnal

Gambar 6-6 Purchase Bill
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Dasar-dasar Perbankan Jilid 2

3  Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup
Recap Transaction. Kembali ke Invoice semula klik Record, Print Later dan

klik Cancel.
I Recap Transaction in Purchases - New ltem
Sic Date  ID# Account Debit Credit Job
PJ 15/01/2013 Purchase Order; PT Merbabu Raya _J
PO-001 21200 Account Payable 3p188.100.000,00
PO-001 21200 Account Payable Rp18.810.000,00
‘ PO-001 21200 Account Payable Rp30.000,00
‘ PO-001 1-1310  Inventory - Computers  3p175.560.000,00
PO-001 11320  Inventory - Printers Rp12.540.000,00
PO-001 21320 PPN Paid Rp18.810.000,00
| PO-001 61700  Freight Paid Fp30.000,00
y/v
Help F1

Gambar 6-7 Recap Transaction in Purchases

4  Ulangi langkah-langkah 1 s.d. 3 untuk mengubah Purchase Order ke Bill
sesuai dengan dokumen sumber (Bukti No. 18)

3. Entri Tansaksi Pembelian Aktiva Tetap (Purchases of Fixed Assets)
secara kredit.

Hal-hal yang perlu diperhatikan dalam pembelian untuk Aktiva Tetap:

a) Transaksi ini mempunyai pengaruh terhadap: akun utang, akun aktiva
tetap, kartu utang.

b) Set layout ke format Miscellaneous dan isi data pembelian.

c) Cek terlebih dahulu jurnal yang akan dihasilkan sebelum Kklik Record.
(Tekan Ctrl-R untuk mengecek jurnalnya).

d) Dokumen sumber : Bukti No: 19 & 20
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Dasar-dasar Perbankan Jilid 2

| BuktiNo: 19
BT Auto 2000 INVOICE
. Date 17 Januari 2013
M. Cilandak 12, Jakarta Selatan Tvoce® (12345
Telp 0217433322 Term 10 bulan
INVOICE
Sold to: UD RASEL MEDLA MANDIRL, JI. Pamulang Raya 17, Pamulang
Amount: Rp. 240.000000,-
Dua rotus empat puluh juto Rupioh
Details:
No Description Qty | Price/Unit Rp. T':'taF:pP”':E TAX
1 Mabil Box - Toyota 2012 1 240,000,000 - 240,000,000, - -
Total due 240,000,000, - -
Pemilik Perusahaan Sales Pembukuan
Lie Ban Piet Megah
| BuktiNo: 20
PT Auto 2000 INVOICE
| Cilandak K | Date 17 Januari 2013
M. Cilandak 12, Jakarta Selatan Ivoice® | 321
Telp 0217433322 Term 10 bulan
INVOICE
Sold to: UD RASEL MEDLA MAMNDIRL, JI. Pamulang Raya 17, Pamulang
Amount: Rp. 140,000,000 -
Sergtus empat puluh juta Rupioh
Details:
No Description Qty | Price/Unit Rp. T':'taF:pP”':E TAX
1 Mabil Sedar—Handa 2012 1 140,000,000 - 140,000,000, - -
Total due 140,000,000, - -
Pemilik Perusahaan Sales Pembukuan
Lie Ban Piet Megah
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Praktekkan Langkah-langkah berikut ini:

1 Klik Command Centre Purchase > Enter Purchase
Set ke format BILL, Pilih Supplier PT AUTO 2000 karena belum ada, klik New

=
@Pur(haseﬁ - New Item o3[ =

]

Supplier |, — %
Shipto g

@ Select from List

‘ Loak for: H
Received Backorder Item Number = =

PT Merapi Abadi
PT Merbabu Raya

Comment:
Ship Via:
Promised Date:

Journal Mema:

Bill Delivery Status:

(®) Save s ! (%) Use Recuriing } GLI=ES |

- 47/ y |5y % Use Supplier
7. | = | &4 28
DR - - f| HelpE New Easy-Add Cancel

Help F1 Print SendTo | Joumal L& o

Gambar 6-8 Membuat Supplier Baru

2 Ketik Nama PT AUTO 2000 dan alamat serta no. telepon. Klik OK.

(] Card Information = |- =[]
Profile ' Card Details ' Buying Details ' Payment Details ' Contact Log ' Jobs ' History
PT AUTO 2000 $-003 A/P Balance ©: | Rp380.000.000,00

Card Type:iSupplier >l Designation: [Eompany ;_,’ [ Inactive Card
Name: [PT AUT0 2000

¥ CadiD: [5:003

Location: !Address 1

Address: |JI. Cilandk 12 Jaksel Phonettl: [ 021 7433322

/V Phonett2: |
Ci

ity: | Phone#t3: |
State: | Postcode: |

Country: [

Fax:

Email:
Website:
Salutation: |
Contact: |

s Print ‘ 3 Letter =7 Email ‘ & ‘Website

Gambar 6-9 Supplier Baru
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2  Kembali ke format BILL. Set Lay-out ke Misscellaneous. Pilih Supplier PT
AUTO 2000. Isi data pembelian sesuai dengan bukti no. 19 .

@ Purchases - New Miscellaneous

= B | |

Supplier & fPT AUTO 2000 = Tems ©: Net EOM
/ Purchase #:  PJO00001

Date: |17/01/2013
Supplier Invi: 12345
Name Amount Job Tax
Motor Vehicles - at Cost }AU.UUO.UUU,DDJ Ei; N-T
Subtotal: p240.000.000,00

IV TaxInclusive

Description
Mobil Box - Toyota 2012
v

Tax o Rp0,00
Total Amount: p240.000.000,00

Joumnal Mema: | Purchase; PT AUTO 2000 Paid Today: | Rp0,00

Balance Due: p240.000.000,00
(1) Save as Recuning} (('J) Use Recuring : Gl Spel_lj

Journal Layout Register

Gambar 6-10 Mengubah layout Misscellaneous

3 Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup Recap

Transaction. Kembali ke Invoice semula klik Record, Print Later dan klik
Cancel.

—— I ==

@ Recap Transaction

Recap Transaction in Purchases - New Miscellaneous ‘
Sic Date ID# Account Dehit Credit Job
PJ 17/01/2013 Purchase; PT AUTO 2000
Auto # 21200 Account Payable 4p240.000.000,00
Auto # 1-2610  Motor Vehicles - at Cost  3p240.000.000,00
|
2.
Help F1

Gambar 6-11 Recap Transaction in Fixed Asset Purchase

4  Ulangi langkah-langkah 1 s.d. 3 untuk mencatat pembelian aset tetap sesuai
dengan dokumen sumber (Bukti No. 20)
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4. Mengentri Transaksi Retur Pembelian (Purchase Return).

Hal-hal yang perlu diperhatikan dalam transaksi retur pembelian:
a) Entri data seperti pembelian kredit, quatity diketik angka minus.

b) Jangan lupa masuk ke Purchase Register dan Tab Returns &
Debits, untuk pengurangan julah di kartu Supplier.

c) Dokumen sumber : Bukti No: 21 & 22

BuktiNo: 21

CREDIT NOTE
Date 17 Januari 2013
CreditMote ® | 11

PT.MERBABL RAYA
). Gajah Mada 12

Jakart
s Inv.#/Date | MR-57/15 Januari 2013
CREDIT NOTE
Returned by: UDRASEL MEDLA MAMDIRL JI. Parmulang Raya 17, Pamulang
Amcunt: Rp. 9.900.000,-

Sembilan juta sembilan ratus nbu Rupich
Returned due to damages

Price/Unit Taotal Pri
Mo Item Mo Description Gty riee/unt otal Frice TAX
Ep. Rp.

1 COM-001 | HPPro bookd421s 1 10.1641.000, - 10164.000,- | PPN
2 PRM-001 Canonl)-215 1 726,000, - 726.000- | PPM

Total 10,890,000,- | PPM
Pemilik Perusahaan Purchases Sales

Suyoko Sena
BuktiNo: 22
PT. MERAFI ABADI CREDIT NOTE

' Date 18 Januari 2013

Jl. Mangga Dua 23 CreditNote 2 | 07

fakarta Inv.#/Date | MA-62/16 Januari 2013
CREDIT NOTE

Returned by: UD RASEL MEDTA MAMNDIRL JI. Pamulang Raya 17, Pamulang

Amount: Rp. 11.610.000-

Sebelos juta emom ratus sepuluhribu Rupigh

Returned due to damages

Mo Item Mo Description Oty Price/Unit Total Price TAX
Rp. Rp.
1 COM-002 | HP Pro book 5530 1 12.364.000, - 12364.000,- | PPM
2 PRMN-D02 Canon Bj-555 1 407.000,- 407.000- | PPM
Total 12771000~ | PPM
Pemilik Perusahaan Purchases Sales

Mina Rika
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Praktekkan langkah-langkah berikut ini:

1 Klik Command Centre Purchases > Enter Purchases

Entri data untuk retur pembelian, jangan lupa ketik Quantity (Ship) dengan angka

minus (lihat Bukti No. 21).

@ Purchases - New Item

Supplier ©: |PT Merbabu Raya

=

Tems ©: 3% 10 Net 30

= | |

vV TaxInclusive

Tangerang Selatan

ShM : UD Rasela Media Mandir
JI. Pamulang Raya 17 PAMULANG

Purchase #:  CN-11
Date: | 17/01/2013
Supplier Inv:  MR-57

Description

Price  Disc%  Total Job Tax

Bil ReceivedBackorder Item Number

-1 COM-001
=1 ©PRN-001

HP Pro Book 4421s
Canon Lj-215

64.000,00 164.000,00)|
726.000,00 726.000,00)

Comment:
Ship Via:
Promised Date:

Subtatal: 3p10.890.000,00)
Freight: Rp0.00

Tax ©:  (Rp3990.000,00)
Total Amount: 3p10.890.000,00)

Journal Memo: 1Purchase Returrf PT Merbabu Raya

Bill Delivery Status: | To be Printed

=

(1) Save as Recuningi (¥) Use Recuring { RBC Spel| J

Help F1 Frint

= o &G

SendTo | Joumnal Layout

Register

Paid Today: | Rp0,00

Balance Due: 3p10.830.000,00)

Gambar 6-12 Purchase Return

2 Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup Recap
Transaction. Kembali ke Bill semula klik Record, dan klik Cancel.

e

Recap Transaction in Purchases - New ltem

|

Src Date ID# Account Debit Credit Job
PJ 17/01/2013 Purchase; PT Merbabu Raya _J
CN-11 21200 Account Payable Rp9.900.000,00
CN-11 21200  Account Payable Rp3930.000,00
CN-11 11310 Inventory - Computers Rp9.240.000,00
CN-11 11320 Inventory - Printers RpE60.000,00
| CN-11 21320 PPN Paid Rp990.000,00

7

DR 4

g
Help F1

Gambar 6-13 Recap Transaction in Purchase Return

3 Klik Command Centre Purchases > Purchases Register. Kemudian klik Tab

Returns & Debits.

136

Direktorat Pembinaan SMK (2013)



Dasar-dasar Perbankan Jilid 2

[I__H‘]Purchases Register = H =] |@
All Open Closed
Puchases ' Quotes l Diders ' Bils J Bils |
Search by: [l Suppliers =]
Date PO# Supplier Invi# Supplier Amount Debit Amt
=3 01/20 C! A PT Merbabu Raya (R p10.830.000,00)|Rp10.830.000,00]

‘ 51 Apply to Purchase 3p10.890.000,00) (Rp10.890.000,00)

** Receive Refund

Help F1 FErint

Gambar 6-14 Purchase Register

4  Klik Apply to Purchase untuk memproses pengurangan di kartu Supplier.

(4] Settle Returns & Debits = |- E- ]
Supplier o PT Merbabu Raya 1D #: (Cﬁﬁ ]
Debit Amount: | Ap10.890.000( ¥ Dae [T0172013
Memo: | PT Merbabu Raya: Debit from CN-11
Purchase #  Status Date Amount Discount Total Dwed Amount Applied
00000001 o Open | 26/12/2012) Rp110.000.000,00 Rp110.000.000,00
PO-001 o 0pen | 15/01/2013 Rp207.000.000,00 | Rp207.000.000,00, Rp10.890.000,00

Total &pplied: | Rp10.830.000,00

Finance Charge: [ Hpﬂﬁﬁ
Debit Amount: | Rp10.890.000,00
™ Include Closed Purchases Out of Balance: | Hﬁﬁﬁ

7. &

DR 4

Help F1 Journal Cancel

Gambar 6-15 Apply to Purchase

5 Sesuaikan data ID# dan Date kemudian tempatkan kursor di kolom Amount
Applied sejajar dengan baris PO-001 tgl. 15/01/2013. Klik Record. Klik Close
untuk menutup Purchase Register.

6 Ulangi langkah-langkah 1 s.d. 5 untuk mengentri data untuk retur pembelian,
sesuai dengan Bukti No. 22.
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5. Entri Transaksi Pembelian Tunai (Cash Purchases)

Hal-hal yang perlu diperhatikan dalam transaksi pembelian tunai:

a) Buat Supplier baru dengan nama: cash purchase.

b) Entri data seperti pembelian kredit.

¢) Jangan lupa Paid To Day diisi sejumlah total amount pembelian.
d) Dokumen sumber : Bukti No: 23 & 24

BuktiMo: 23
CASH PAYMENT
UD. RASEL MEDIA MANDIRI CASH CHEQUE
JI. Pamulang Raya 17, Pamulang Date 19 Januari 2013 18 Januari 2013
Tangerang Selatan NC CP-003 CP-003
Inv#
CASH PAYMENT
Supplier: Cash Purchases
Amount: Rp. 69.000000,-
Enam puluh sembilan juta Rupiah
Details:
Mo Itemn Mo Description Gty Price/Unit Total Price TAX
Rp. Rp.
1 COM-001 | HP Pro book4421s 7 10.098.000,- 70.686.000,- [ PPN
2 PRMN-001 | Canonl-215 7 723.250,- 5.082.750,- | PPN
Tatal 75.748.750,- [ PPN
Freight 51.250- | NT
Tatal Tagihan 75.800.000 -
Pemilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya
BuktiMo: 24
CASH PAYMENT
UD. RASEL MEDIA MANDIRI CASH CHEQUE
JI. Parnulang Raya 17, Pamulang Date 20 Januari 2013 20 Januari 2013
Tangerang Selatan NO CP-004 CP-004
Inv&
CASH PAYMENT
Supplier: Cash Purchases
Armcunt: Rp. 81.000.000.-
Delapan puluh satu juta Rupioh
Details:
Mo Itemn Mo Description Gty Price/Unit Total Price TAX
Rp. Rp.
1 COM-002 | HP Pro book5530 7 12.320.000,- 86.240.000,.- [ PPN
2 PRM-002 | CanonBj-5355 7 396.000,- 2772.000,- | PPN
Total 89.012.000,- [ PPN
Freight 88.000, - NT
Tatal Tagihan 89.100.000 -
Pemilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya
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Praktekkan langkah-langkah berikut ini:

1 Klik Command Centre Purchases > Enter Purchases

Set ke format Bill, Pilih Supplier CASH PURCHASE. Jika belum ada klik New.
Buat Supllier baru nama CASH PURCHASE, Card ID S-000. Klik OK.

(] Card Information ‘i”ﬂl

I _Card Detals ' Blyiog Details ' EymeDetals 'Cowté.ﬂkos ' ' History

CASH PURCHASE $-000 A/P Balance o | Rp0.00

Card Type: | Supplier ~ Designation: | Company ;_ ™ Inactive Card
o Name: [CASH PURCHASE
- Card ID: [$-000

Location: |Address 1 hdl
Address: ‘ Phonettl: |
Phonett2: |
City: | Phone#t3; |
State: | Postcode: | Fi [
Country: ‘ Email: |
Website: |
Salutation: |
Contact: |

s Print

7.

Help F1

G | 5
| J{Eﬂel | =3 l::{_nall [ , ‘Website

Gambar 6-16 Cash Purchase

2 Kembali ke Bill, pilih Supplier Cash Purchase. Entri data untuk pembelian, jangan
lupa ketik Paid Today sebesar total pembelian (lihat bukti no. 23).

[E Purchases - New Item ‘i”ﬂ‘@

Supplier ©: | CASH PURCHASE E Terms o: C.OD. v TaxInclusive

pto wl: UD Rasela Media Mandir Purchase #: CP-003
JI. Pamulang Raya 17 PAMULANG
Tangerang Selatan Date: 119/01/2013
Supplier Invi:

| Bil ReceivedBackorder Item Number Description Price Disc% Total Job Tax
=COM-001 HP Pro Book 4421s 198.000,00 686.000,00)
©PRN-001 Canon Lj-215 723.250,00 .062.750,00

Subtotal: 3p75.748.750,00

/ Freight: Rp51.250,00
Tax ©: FRpb 50,00

Comment:
Ship Via: 1
Promised Date: Total Amount: 3p75.800.000,00

KT

Joumal Memo: | Purchase; CASH PURCHASE | Paid Today: |3p75.600.000,00

Bill Delivery Status: | To be Printed r| Balance Due: Rp0.00

ng‘ (%) Use Recuriing 1 AEC) Spell 1

Help F1 Print SendTo | Joumal Layout Register

Gambar 6-17 Pengisian Jumlah Paid Today
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3 Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup Recap
Transaction

(i8] Recap Transaction

Recap Transaction in Purchases - New Item
Sic Date  ID# Account Debit Credit Job
PJ 19/01/2013 Purchase; CASH PURCHASE
CP-003 21200 Account Payable Rp68.862.500,00
| CP-003 21200 Account Payable RpE.886.250,00
CP-003 21200 Account Payable Rp51.250,00
CP-003 11310 Inventory - Computers Rp64.260.000,00
I CP-003 11320 Inventory - Printers Rp4.602.500,00
CP-003 21320 PPN Paid Rp6.886.250,00
CP-003 61700  Freight Paid Rp51.250,00
co  19/01/2013
Auto # 11110  Cash In Bank Fp75.800.000,00
Auto # 21200 Account Payable Rp75.800.000,00

7
Help F:

4 Ulangi langkah-langkah 2 dan 3 untuk mengentri data pembelian tunai, sesuai
dengan Bukti No. 24.

Gambar 6-18 Recap Transaction in Cash Purchase

6. Mengentri Transaksi Retur Pembelian Tunai (Cash Purchase Return)
Hal-hal yang perlu diperhatikan dalam transaksi retur pembelian tunai:
a) Entri data seperti retur pembelian kredit, quatity diketik angka minus.

b) Jangan lupa masuk ke Purchase Register dan Tab Returns & Debits,
untuk memproses penerimaan uang kembali dari supplier klik Receive
Refund.

c) Dokumen sumber : Bukti No: 25 & 26
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| BuktiNo: 25
CASH RECEIPT
UD. RASEL MEDIA MANDIRI CASH CHEQUE
JIl. Pamulang Raya 17, Pamulang Date 21 Januari 2013 21 Januari 2013
Tangerang Selatan MO CR-007 G-30
T
CASH RECEIPT
Supplien Cash Purchases
Amcunt: Rp. 9.837.500-
Sembilan juta delapan ratus tiga puluh tujuh ribu lima ratus rupiah
Details: Cash Receipt for Cash Purchases Return
Mo Item Mo Description Crhy Price/Unit Total Price TAX
Rp. Rp.
1 COM-001 | HPPro book4421s 1 10.058.000, - 10.058.000- | PPN
2 PRM-001 | Canonl)-215 1 723.250,- 723.250,- | PPM
Total 10.821.250,- | PPN
Pemilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya
|BuktiNo: 26
CASH RECEIPT
UD. RASEL MEDIA MANDIRI CASH CHEQUE
Jl. Pamulang Raya 17, Pamulang Date 22 Januari 2013 22 Januari 2013
Tangerang Selatan MO CR-008 H-17
Inw&
CASH RECEIPT
Supplier Cash Purchases
Armcunt: Rp 11.560.000.-
Lebelas juta lima ratus enam puluh ribu rupioh
Details: Cash Receipt for Cash Purchases Return
Mo Item Mo Description CQty Price/Unit Total Price TAX
Rp. Rp.
1 COM-002 | HPPro book5530 1 12.320.000,- 12320.000,- | PPN
2 PRM-00Z | CanonBj-555 1 396.000,- 396.000.- | PPN
Total 12716.000,- | PPN
Permilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya
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Praktekkan langkah-langkah berikut ini:

1 Klik Command Centre Purchases > Enter Purchases

Pilih Supplier CASH PURCHASE. Entri data untuk retur pembelian tunai, jangan
lupa ketik Quantity (Ship) dengan angka minus (lihat Bukti No. 25).

Cl] Purchases - New Item == ﬂf@

[BILL

Supplier ©: {CASH PURCHASE s Tems =: C.O.D. vV TaxInclusive

Skefo : D Rasela Media Mandiri Purchase #: |CR-007

JI. Pamulang Raya 17 PAMULANG
Tangerang Selatan Date:  21/01/2013
Supplier Invi:

I Bil ReceivedBackorder [tem Number Description Price  Disc% Total Job Tax
COM-001 |HP Pro Book 4421s )38.000,00] 1098.000,00) | PPN
=PRN-001 |Canon Lj-215 '23. 250,001 723.250,00) | PPN
| i

Subtotal: 3p10.821.250,00)

Comment: Freight: Rp0.00
Ship Via: Tax ©:  (Rp3983.750,00)
Promised Date: Total Amount: 3p10.821.250,00)

i [

Journal Memo: |Purchase Returr CASH PURCHASE q Paid Today: [ F!pU,UU.

Bill Delivery Status: | To be Printed | Balance Due: 3p10.821.250,00)

(1) Save as Recuring | () Use Recuriing 1 G Spell|

Help F1 Frint SendTo | Joumnal Layout Register

Gambar 6-19 Retur Pembelian Tunai

2 Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup Recap
Transaction. Kembali ke Bill semula klik Record, dan klik Cancel.

Klik Command Centre Purchases > Purchases Register. Kemudian klik Tab
Returns & Debits.

@ Purchases Register |£”ﬂ|@

Al Open Returns Closed
L Purchases I Quotes I Orders I QjIIsJ & Debits I Bills

Search by: [Wrsyj

Date PO# Supplier Invi
- e e

o Receive Refund ‘ ®T Apply to Purchase hm 0.821.250,00) (Rp10.821.250,00) ]

HelpF1 | Print

Gambar 6-20 Purchase Register untuk Cash Purchase
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3  Klik Receive Refund untuk penerimaan pembayaran kembali dari Supplier.

(8] Settle Returns & Debits =5 o

‘‘‘‘‘‘‘ —ra

@ DeposittoAccount: | 11110 |5 CashInBank Balance ©: Rp715.366.000,00
" Group with Undeposited Funds:

Supplier ©: CASH PURCHASE ID #: [CR-007
Amount Received: | Rp10.821.250,00 Date: | 21/01/2013
Payment Method: \ Cheque :%j‘ Details.... /V

Memo: [E‘ASH PURCHASE: Debit from CR-007

HelpF1 | Joumal Cancel

Gambar 6-21 Settle Returns & Debits untuk Cash Purchase

4  Ulangi langkah-langkah 1 s.d. 3 untuk mengentri data untuk retur pembelian tunai
sesuai dengan Bukti No. 26.

7. Entri Transaksi Pembayaran Utang (Pay Bill)
Hal-hal yang perlu diperhatikan dalam transaksi receipt payment:

a) Menggunakan Command Centre Purchase > Pay Bills BUKAN
Banking > Spend Money.

b) Harus memilih secara tepat Nama Supplier dan Utang yang terkait
dengan pembayaran.

c) Dokumen sumber : Bukti No: 27 & 28
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| BuktiNo: 27
CASH PAYMENT
j-ll[; RASlEL h';EDIﬁ;;ﬂ;:N [.‘II|RI s CHEQUE
- am a”g la:a FAMUEng M hote 23 Januari 2013 23 Januari 2013
angerang selatan NO CP-005 CP-005
CASH PAYMENT
Paid to
Supplier: PTMERBABU RAYA, JI, Gajah Mada 12, Jakarta
Amcunt: Rp. 110.000000,-
Seratus sepuluh juta rupioh
Details:
No Date Invoices Amount Discount Total Due
Rp Rp Fp.
1 26/12/12 | C-12 110.000.000,- - 110.000.000,-
Total Payment 110,000.000,-
Pemilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya
| BuktiNo: 28
UD. RASEL MEDIA MANDIRI CASH PAYMENT
J F'. | Rayall, P | cAsH CHEQUE
- amt a”g la:a amiEang - Mpate 23 Januari 2013 23 Januari 2013
angerang »elatan NO CP-006 CP-006
CASH PAYMENT
Paid to
Suppliern PTMERAPIABALL JI. Mangga Dua 29, Jakarta
Armount: Rp. 77.000.000,-
Tujuh puluh tujuh futa rupioh
Details:
No Date Invoice® Amount Discount Total Due
Rp Rp Fp.
1 28/12/12 | B-215 T7.000,000 - - F7.000,000,-
Total Payment 77.000,000,-
Pemilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya
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Praktekkan langkah-langkah berikut:

Klik Command Centre Purchase > Pay Bills. Kemudian pilih nama supplier
sesuai dan isi data pembayaran utang sesuai dengan dokumen sumber (Bukti
No. 27)

(@] Pay Bills = [ |

& Pay from Account: [11110" [$] CashInBank Balance ©: Rp738.903.250,00
" Group with Electronic Payments: /V

Supplier ©: IPT Merbabu Raya %] Cheque No.: ’EI;-UUS

Payee w|: |PT Merbabu Raya Date: | 23/01/2013
J1. Gajah Mada 12 =

Jakarta Amount: | Rp110.000.000,0

One Hundred and Ten Milion Dollars and 0 Cents

Memo:gFayment; PT Merbabu Raya L4 Fasals Mtz Mandiy

Purchase #  Status Date Amount Total Owed Amount Applied
00000001 > Open 26/12/2012| Rp110.000.000,00 Rp110.000.000,00| Rp110.000.000,00
PO-001 o Open 15/01/2013| Rp196.110.000,00 Rp196.110.000,01

=l
Total &pplied: [ Rp110.000.000,00
™ Include Closed Purchases Finance Charge: | Rp0.00)
I Cheque Already Printed Total Paid: | Rp110.000.000,00
Remittance Advice Delivery Status: | To be Printed OutofBalance: | Rp000

-

Help F1 Print Journal | Register

Gambar 6-22 Pembayaran Utang

2  Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup Recap
Transaction. Kembali ke Bill semula klik Record, Print Later dan klik Cancel.

@ Recap Transaction

L ..
Recap Transaction in Pay Bills ‘
Sic Date  ID# Account Debit Credit Job
cD 23/01/2013 Payment; PT Merbabu Raya _j
CP-005 11110 Cash InBank 3p110.000.000,00
CP-005 21200 Account Payable 3p110.000.000,00
5.
Help F1

Gambar 6-23 Recap Transaction in Pay Bills

3 Ulangi langkah-langkah 1 dan 2 untuk mengentri data pembayaran utang, sesuai
dengan Bukti No. 28.
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8. Entri Transaksi Pembayaran Utang (Pay Bill) Dengan Diskon

Hal-hal yang perlu diperhatikan dalam transaksi pembayaran utang
dengan diskon:

a) Menggunakan Command Centre Purchase > Pay Bills BUKAN
Banking > Spend Money.

b) Diskon yang menyebabkan pengurangan Pajak (PPN) dihilangkan.
c) Dokumen sumber : Bukti No: 29 & 30

146

[BuktiNo: 29
CASH PAYMENT
JI.||[IZ; RAS;EL MRED[?_;H,:NDIFI CASH CHEQUE
- amu a”g latJa AFamuang Mt 24 Januari 2013 24 Januari 2013
angeErang seiatan NO CP-007 CP-007
CASH PAYMENT
Paidto
Supplier: PT MERBABU RAYA, JI. Gajah Mada 12, Jakarta
Amcunt: Rp. 172.654.000,-
Sergtus tujuh puluh dua juta enam ratus lima puluh empat ribu Rup.
Details:
) Amaunt Purchase Retum Total Due
Mo Date Invoice#
Ep Rp Ep.
1 15/1/13 | MR-57 207.000.000.- 10.890.000 - 196.110.000,-
Discount (3% x Rp. 207.000:000,-) £.210.000,-
Total Payment 189.800.000 -
Pemilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya
[BuktiNo: 30
UD. RASEL MEDIA MANDIRI CASH PAYMENT
J P. | Rayal7, P | cASH CHEQUE
- amu a”g la:a (TEMUENG hate | 24 Januari 2013 24 Januari 2013
angerang seiatan NO CP-008 CP-008
CASH PAYMENT
Paidto
Supplier: PT MERAPIABALL JI. Mangga Dua 29, Jakarta
Amcunt: Rp 222,160,000
Dua ratus duae puluh dua juta seratusenam puluhribu Rupiah
Details:
Mo Date Invoices Amount Purchase Retum Total Due
Rp Rp Rp.
1 16/1/13 | MA-B2 265,000,000 - 12771000 - 252.229.000,-
Discount (3% x Rp. 265.000,000,-) 7.850.000,-
Total Payment 244.279.000 -
Pemilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya
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Praktekkan langkah-langkah berikut:

1 Klik Command Centre Purchase > Pay Bills. Kemudian pilih nama supplier dan
isi data sesuai dengan dokumen sumber (Bukti No. 29).

(] Pay Bills |

& Pay from Account: [1-1110 5/ CashInBank Balance ©: Rp551.903.250,00

" Group with Electronic Payments:/v

Supplier ©: | PT Merbabu Raya

KT

v Cheque No.: \Eﬁﬁﬂ?
Payee =i zTGhl;rﬁaﬁggafZa - Date: [24/01/2013
Jakarta Amount: [Hp1 83.900.000,0

One Hundred and Eighty Nine Million Nine Hundred Thousand Dollars and 0 Cents

Mﬁ: !Paymenl; PT Merbabu Raya £40 Basals Meadkiz Mty
Purchase #  Status Date Amount Discount Total Owed Amount Applied
PO-001 ©Open | 15/01/2013) Rp196.110.000,00 |3p6.210.000,00 | Rp189.900.000,00 | Rp189.900.000,00
| |
i ‘ —
|
‘\ =]
Total Applied: [ Rp183.900.000,00°
7 Include Closed Purchases Finance Charge: [ ﬁﬁﬁa
[ Cheque Already Printed Total Paid: | Rp189.900.000,00°
Remittance Advice Delivery Status: | To be Printed hdl Out of Balance: Rp0.00
£ Pay Al ‘

Help F1 Print | Joumal | Register Cancel

Gambar 6-24 Pay bill dengan Diskon

2  Klik Record, Print Later dan klik Cancel. Klik Command Centre Purchase >
Transaction Journal untuk menampakkan jurnalnya:

@ Transaction Journal

| 4
mﬁeneral' Disbursements ! Heceipﬁgsﬁt Sajes ' Purchases ' Inventory '

Dated Eam: [01/01/2013 To: [3170172013
D From: [ To: |
Src Date ID# Account Debit Credit Job
= CD 24/01/2013 PT Merbabu Raya _A_J
CP-007 11110  Cash InBank 3p189.900.000,00
CP-007 21200 Account Payable 3p189.900.000,00
= PJ 24/01/2013 PT Merbabu Raya: Discounts on PO-001
Ly 00000003 21200  Account Payable Rp5.645.700,00
e 00000009 21200 Account Payable Rp564.300,00
00000009 B-1600  Purchase Discounts Fp5.645.700,00
00000009 21320 PPN Paid Rp564.300,00
= P 24/01/2013 PT Merbabu Raya: Debit from 00000009
PJO0O0003 21200 Account Payable Rp6.210.000,00
PJOO0DDO3 2-1200  Account Payable Rp£.210.000,00

Help F1 Print

Gambar 6-25 Jurnal Pembayaran Utang dengan Diskon
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3 Klik di = (panah kiri) untuk jurnal yang terkait dengan diskon.

@ Purchases - Edit Service |£HEI@

Supplier &: PT Merbabu Raya Tems ©: 3% 10 Net 30 vV Taz Inclusive

Shipto »|: UD Rasela Media Mandiri Purchase #: 00000009
JI. Pamulang Raya 17 PAMULANG
Tangerang Selatan Date: | 24/01/2013

Supplier Invi:
Description Acctit Amount Job
| 61600 5.793.480,00)
| 6-1600 Ap413.820,00)
i 6-1600 (Rp2.700,00

Subtotal: (Rp6.210.000,00)

Comment: Freight: Rp0.0C
Ship Via: 5 Tax o Rp0,00
Promised Date: Total Amount: (Rp6.210.000,00)

Joumnal Mema: | PT Merbabu Raya: Discounts on PCI-(V Applied to Date: (Rp6.210.000,00) History... ]

Bill Delivery Status: | To be Printed Al Balance Due: Rp0.00

(1) Save as Recuring| ,;h t| Gllo) Spel_l‘

I
D v . - i

Help F1 Print SendTo | Joumal Register

Gambar 6-26 Mengeliminasi Diskon Pembelian

4  Ubah PPN menjadi N-T untuk jumlah-jumlah yang ada dalam tabel di atas.
Hasilnya adalah jurnal yang baru seperti berikut ini. Klik Close.

(] Transaction Journal = |- E- =]
General ' Disbursements t Receipts t Sales ' Purchases t Inventory I All -
Dated From: |01/01/2013 To: [31:’01 /2013
1D From: [ To: [
Src Date ID# Account Debit Credit Job _J
-
= CD 24/01/2013 PT Merbabu Raya
CP-007 11110  Cash InBank 3p189.900.000,00
CP-007 21200 Account Payable 3p189.900.000,00
= Pl 24/01/2013 PT Merbabu Raya: Debit from 00000009
PJO00003 21200 Account Payable Rp6.210.000,00
PJOO0DDO3 21200 Account Payable Rp£.210.000,00
= PJ 24/01/2013 PT Merbabu Raya: Discounts on PO-001
00000009 21200  Account Payable Rp6.210.000,00
00000009 B-1600 Purchase Discounts Fp6.210.000,00

7. =

HelpF1 | Print

Gambar 6-27 Jurnal Mengeliminasi PPN dalam Diskon

5 Ulangi langkah-langkah 1 s.d. 4 untuk mengentri data pembayaran utang dengan
diskon sesuai dengan Bukti No. 30.
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c. Rangkuman

e Biasanya transaksi pembelian (Purchases), diawali dengan adanya
order dari pemasok, kemudian dilanjutkan dengan pembelian
kredit/tunai, kadang-kadang terjadi retur, pembayaran utang dan lain
sebagainya. Semua transaksi tersebut disediakan menu dan format
khusus oleh MYOB.

o Data transaksi dientri ke dalam format dan kemudian diproses secara
otomatis. Komputer akan memberikan hasil berupa laporan jurnal,
saldo akun buku besar yang sudah di-update, bahkan laporan
keuangan.

Untuk mencegah kesalahan dalam data entri maka dianjurkan
sebelum di-record dicek terlebih dahulu jurnal yang akan dihasilkan
dengan menekan Ctrl-R

Berdasarkan Kasus 3.1. UD Rasela Media Mandiri yang ada pada ‘Lembar
Kerja Peserta Didik’, kerjakan tugas-tugas berikut ini !

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per
kelompok.

2. Setiap peserta didik mengikuti langkah-langkah yang dijabarkan dalam
KB3 ini melalui kerjasama kelompok.

Tugas 1, Mencatat transaksi order pembelian (2 transaksi)

Tugas 2, Mencatat transaksi pembelian (2 transaksi)

Tugas 3, Mencatat transaksi pebelian aktiva tetap (2 transaksi)

Tugas 4, Mencatat transaksi retur pembelian (2 transaksi)

Tugas 5, Mencatat transaksi pembelian tunai (2 transaksi)

Tugas 6, Mencatat transaksi retur pembelian tunai (2 transaksi)

Tugas 7, Mencatat transaksi pembayaran utang tanpa diskon (2 transaksi)

10. Tugas 8, Mencatat transaksi pembayaran utang dengan diskon
(2 transaksi)

© o N OB
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@\

v e. Tes Formatif

v

1. Tes Pengetahuan.

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b,
¢, d atau e dari setiap item soal pilihan ganda di bawah ini:
Berikut ini menu yang tidak termasuk dalam Command Centre:

1.

150

P20 T O

Sales
Purchases
Card Files
Setup
Inventory

Langkah mengubah order pembelian menjadi pembelian kredit/tunai:

PoooTR

Purchase > Enter Purchase

Purchase > Purchase Register > Enter Purchase

Purchase Register > Enter Purchase

Purchase Register > Pilih Order > Change to Bill

Purchase > Purchase Register > Pilih Order > Change to Bill

Langkah mengentri transaksi pembayaran utang:

Po0TR

Purchase > Spend Money

Purchase > Pay Bill

Purchase Register > Pay Bill

Purchase Register > Purchase > Spend Money
Purchase > Purchase Register > Pay Bill

Langkah mengentri transaksi retur pembelian, pertama Purchase > Enter
Purchase > Ketik quantity minus. Kedua ...

a.

b.
c.
d
e

Purchase > Enter Purchase > Spend Money

Purchase > Purchase Register

Purchase Register > Purchase > Apply to Sale

Purchase Register > Pilih Tab Returns & Credit >

Purchase > Purchase Register > Pilih Tab Returns & Credit > Apply to
Purchase

Langkah mengentri transaksi pembelian counter atau tunai:

aoow

e.

Purchase> Enter Purchase > Paid to Day diisi dengan total pembelian
Enter Purchase > Paid to Day diisi dengan total pembelian

Purchase Register > Purchase

Purchase > Purchase Register

Purchase Register > Paid to Day diisi dengan total pembelian

Pada pengisian data dalam Purchases Invoice kolom Tax Inclusive
dikosongkan, ini berarti dalam kolom harga diisi dengan jumliah....

a.
b.
c.
d.

Harga beli termasuk PPN

Harga beli tidak termasuk PPN
Harga beli termasuk PPN dan Freight
Harga beli termasuk Freight

Direktorat Pembinaan SMK (2013)
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e. Harga beli termasuk PPN, Freight, and Insurance
7. Jenis Layout apakah yang digunakan untuk pembelian Aset Tetap secara

kredit ?

a. Service

b. ltem

c. Professional

d. Miscellaneous
e. Fixed Asset

8. Perubahan akun apa saja yang dipengaruhi oleh adanya transaksi
pembelian kredit ?

Account Payable, Merchandise Inventory, Purchases

Purchases, Account Payable

Purchases, Merchandise Inventory

Purchases, Account Receivable

Account Payable, Merchandise Inventory

9. Program MYOB menghitung potongan utang dagang dari ..

Total utang dagang

Total utang dagang setelah dikurangi dengan retur pembelian
Total utang dagang setelah dikurangi dengan PPN

Total utang dagang setelah ditambah PPN

Total utang dagang setelah dikurangi uang muka.

®ooow

PO oTR

10. Perintah untuk melihat jurnal Pembelian ....
a. Purchases > Purchases Transaction Journals
b. Purchases > Purchases Register > Purchases Journal
c. Purchases Register > Purchases > Purchases Journal
d. Purchases > Purchases Journals
e. Purchases > Transaction Journals

2. Tes Keterampilan.

Berdasarkan Kasus 3.2. UD Riola Media Mandiri yang ada pada ‘Lembar
Kerja Peserta Didik’, kerjakan tugas-tugas berikut ini !

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per
kelompok.

2. Setiap peserta didik mengikuti langkah-langkah yang dijabarkan dalam
KB3 ini melalui kerjasama kelompok.

Tugas 1, Mencatat transaksi order pembelian (2 transaksi)

Tugas 2, Mencatat transaksi pembelian (2 transaksi)

Tugas 3, Mencatat transaksi pebelian aktiva tetap (2 transaksi)

Tugas 4, Mencatat transaksi retur pembelian (2 transaksi)

Tugas 5, Mencatat transaksi pembelian tunai (2 transaksi)

Tugas 6, Mencatat transaksi retur pembelian tunai (2 transaksi)

Tugas 7, Mencatat transaksi pembayaran utang tanpa diskon (2 transaksi)

© ® N kAW
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10. Tugas 8, Mencatat transaksi pembayaran utang dengan diskon
(2 transaksi)

¢/ f. Kunci Jawaban Tes Formatif
y

1. Kunci Tes Pengetahuan

1 d 6 b
2 e 7 d
3 b 8 e
4 e 9 a
5 a 10 e

2. Kunci Tes Keterampilan

Tugas 1, Mencatat transaksi order pembelian (2 transaksi)

Tidak ada jurnalnya.

Tugas 2, Mencatat transaksi pembelian (2 transaksi)

@ File Edit Lists Command Centres Setup Reports  Window Help - =] =
| 4
General ' Disbursements ' Receipts ' Sales ' Furchazes ' | ko ' AlE
Drated From: {07/01/2013 To | 31/01/2013
1D From: To
S Date ID# Account Debit Credit Job

o Rl 18/01/2013 Purchase; PT Merbabu Raya ]
FO-00 21200 Account Payable 3p183.100.000.00
FO-001 21200 Account Payable Rp18.810.000,00
FPO-001 21200 Account Payable RipS0.000,00
PO-001 11310 Irwentory - Computers 3p175.560.000,00
PO-001 11320 Irwentory - Printers Rip12.540.000,00
FO-00 21320 PPH Paid Rp18.510.000,00
FO-00m E-1700  Freight Paid Fp490.000,00

= Rl 1B/01/2013 Purchasze; PT Merapi Abadi
FO-002 21200 Account Payable Jp240.850.000,00
FPO-002 21200 Account Payable Rp24.085.000,00
PO-002 21200 Account Payable Rpk5.000,00
PO-002 11310 Irwentory - Computers 3p236.040.000,00
PO-002 11320 Irwentory - Printers Fipd.510.000,00
FO-002 21320 PPH Paid Rp24.085.000,00
FO-002 E-1700  Freight Paid FpE5.000,00

5w
Help F1 Frint
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Tugas 3, Mencatat transaksi pebelian aktiva tetap (2 transaksi)

G]File Edit Lists Command Centres Setup Reports Window Help

| 4
General ' Dishursements ' Receints ' Salex ' Purchases ' Irwentam ' Al
Diated From: | 01/07/2013 To: | 3140172013
1D Fram: | T |
Sic Date ID# Account Debit Credit Job

o Fl 17/01/2013 Purchase; PT AUTO 2000 J
FJO00a01 21200 Account Payable 3p240.000.000.00
PJOoaao 1-2610  Motor Vehicles - at Cost  3p240.000.000,00 J

o Fl 17/01/2013 Purchase; PT AUTO 2000
PJOooa0z 21200 Account Payable 3p140.000.000.00
PJOoaoaoz 1-2670  Motor Vehicles - at Cost 3p140.000.000,00

Tugas 4, Mencatat transaksi retur pembelian (2 transaksi)

E]File Edit Lists Command Centres Setup Reports Window Help

| 4
ﬁeneral' Disburzements ' Receipts ' Sales ' Purchazes ' Inwentary '

Ale
Dated Fram: | 01/01/2013 Tor | 3/01/2013
10 From: Tox
Sic Date 1D Account Debit Credit Job
= Pl 17/01/2013 Purchase Retumn; PT Merbabu Raya J
CH-11 27200 Account Papable Fp39.900.000,00
CH-11 21200 Account Papable Fip930.000.00
CH-11 11310 Inwentory - Computers Fip3.240.000,00
CH-11 11320 Inwentory - Printers RpEE0.0O00,00
CN-11 21320 PPM Paid Fp330.000,00
= Rl 17/01/2013 PT Merbabu Raya: Debit from Ch-11
CH-11 21200 Account Pavable Rp10.830.000,00
CH-11 21200 Account Payable Rp10.830.000,00
= Pl 18/01/2013 Purchase Retumn; PT Merapi Abadi J
CH-O7 27200 Account Papable Rp11.610.000,00
CH-O7 21200 Account Papable Fip1.161.000,00
CH-O7 11310 Inwentory - Computers Rp11.240.000,00
CH-07 11320 Inventory - Printers Rp370.000,00
CN-07 21320 PPM Paid Rp1.1617.000,00
o PJ 18/01/2013 PT MerapiAbadi: Dehit from CN-07
CM-07 21200 Account Pavable Rp12.771.000,00
CM-07 21200 Account Payable Rp12.771.000.00

7.

Help F1

Print
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Tugas 5, Mencatat transaksi pembelian tunai (2 transaksi)

E] File Edit Lists Command Centres Setup Reports  Window Help - | =
r
General ' Dizshursements ' Receipts ' Sales ' Furchazes ' Ireertan T Ali
Dated From: |01/01/2013 To: | 31401/2013
1D From: Tao
Sz Date D Account Dehit Credit Job

o Rl 19/01/2013 Purchase; CASH PURCHASE e
CP-003 21200 Account Payable RpEa.862 500,00
CP-003 21200 Account Payable FipE.836.250,00
CP-003 21200 Account Payable Rp51.250,00
CP-003 11310 Inwventory - Computers RpE4. 260.000,.00
CP-003 11320 Inwventory - Printers Rp4.602.500,00
CP-003 21320 PPN Paid RpE.886.250,00
CP-003 B-1700  Freight Paid Fp&1.250.00

o Rl 2040142013 Purchaze; CASH PURCHASE
CP-004 21200 Account Payable Fpa0.5920.000,00 =
CP-004 21200 Account Payable Rp&.052.000,00
CP-004 21200 Account Payable Fip8e.000,00
CP-004 11310 Inventory - Computers Rip78.400.000,00
CP-004 11320 Inventary - Printers Fip2.520.000,00
CP-004 21320 PPM Paid RipA.032.000,00
CP-004 B-1700  Freight Paid Fp&E.000.00

-

7. | =

Help F1 Print

Tugas 6, Mencatat transaksi retur pembelian tunai (2 transaksi)
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E‘] File Edit Lists Command Centres 5Setup  Reports Window Help - &) =
r
General ' Dishursements ' Receipts ' Sales ' Purchases ' Ireeentam ' Al
Diated From: | 01/01/2013 To: | 31/01/2013
ID Fram: | To: |
Sic Date ID# Aocount Debit Credit Job
FY

=l 21/01,/2M3 Purchase Return; CASH PURCHASE s
CR-007 21200 Account Payable Rp3.837.500.00
CR-007 21200 Account Payable Rp9g3.750,00
CR-007 11310 Inwentom - Computers Fip9.180.000.00
CR-007 11320 Irwenton - Printers FpE57.500,00
CR-007 21320 PPM Paid Rp383.750.00

o CR 21/01/2013 CASH PURCHASE: Debit from CR-007
CR-007 11110 Cash InBank Rpl10.821.250,00
CR-007 21200 Account Payable Fip10.821.250,00

o Rl 22/01/2013 Purchaze Return; CASH PURCHASE
CR-002 21200 Account Payable Rp11.560.000,00
CR-008 21200 Account Payable Fip1.156.000,00
CR-008 11310 Inwenton - Computers Rp11.200.000,00 )
CR-008 11320 Inwentony - Printers Rp360.000.00
CR-008 21320 PPM Paid Rp1.156.000.00

o CR 22/01/2013 CASH PURCHASE: Diebit fram CR-003
CR-008 11110 CazhInBank Rp12.716.000.00
CR-008 21200 Account Payable Rp12.716.000.00

7.

Help F1 Frint

Tugas 7, Mencatat transaksi pembayaran utang tanpa diskon (2 transaksi)

G]File Edit Lists Command Centres Setup Reports Window Help
| 4
generaI' Dishurserments ' Receipts ' Sales ' Purchazes ' |rererkang ' At

Diated From: | 01/01/2013 To: [ 3140172013
1D Frarn: | T |
Sic Date ID# Acocount Ciehit Credit Job

= CD 230/2M3 PT Merbabu Rapa

CP-005 11110 CashInBank 3p110.000.000,00
CP-005 21200 Account Papable 3p110.000,000,00
o CD 23/01/2M3 PT Merapi Abadi J
CP-00E 11110 Cash InBank Rp77.000.000,00
CP-006 21200 Account Paypable Rp#7.000.000,00

?-:e-:J

Help F1 Frrint

Tugas 8, Mencatat transaksi pembayaran utang dengan diskon (2 transaksi)
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File Edit Lists Command Centres Setup Reports Window Help
r
ﬁenelaI' Disbursements ' Receipts ' Sales ' Purchases ' Inwentary ' Al

Dated From: | 01/01/2013 To | 31/01/2013
1D From: | To |
S Date ID# Account Debit Credit Job

o Ch 24/01/2M3 FT Merbabu Rapa
CP-007 11110 CashInBank 1p189.900.000,00
CP-007 21200 Account Papable 3p189.500.000,00

o Rl 24017203 PT Merbabu Rapa: Debit from 00000003
PJ000003 21200 Account Payable RpE.210.000.00
PJI000003 21200 Account Papabls Rpk.210.000.00

= Rl 24017213 PT terbabu Rapa: Digcounts on PO-001
Oooooaas 21200 Account Papable Rpk.210.000,00
Q0000009 E-1600  Purchase Discounts RpE.210.000,00

o CD 24/01/213 PT Merapi Abadi
CP-008 11110 CashInBank Ap244.279.000,00
CP-008 21200 Account Papable Ip244.279.000,00

= Rl 24/01/2M3 PT Merapi Abadi: Debit from 00000070
FJO0D004 21200 Acocount Payable Fip?.350.000.00 _I
FJOOD004 21200 Account Payable Fp7.950.000,00

= Rl 24/01/203 PT Merapi Abadi; Dizcounts on PO-002
00000010 21200 Account Papable Fp7.950.000,00
0ooooo1o B-1600  Purchaze Dizcounts Fip?.950.000,00

~ 8. Lembar Kegiatan Peserta Didik

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta

didik di komputer melalui program MYOB versi 18.

Kasus 6.1 : Kasus UD Rasela Media Mandiri.

Transaksi order pembelian (2 transaksi)
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BuktiMo: 15
UD. RASEL MEDIA MANDIRI PURCHASE ORDER
. ij Date 14 Januari 2013
). Pamulang Raya 17, Pamulang C@ -
POz PO-001
Tangerang Selatan - -
Termin 3/10, n/30 Late Fees 2%
PURCHASE ORDER
Supplien PT Merbabu Raya, Jl. Gajah Mada 12 Jakarta
Amcunt: Rp. 188,100.000,-
|Semtus delapanpuluh delapan juta seratus nbu rupioh,
Details:
Mo Item Mo Description Gty Price/Unit Total Price TAX
Rp. Rp.
1 COM-001 | HP Pro book4421s 15 10.164.000 - 1593.116.000,- | PPN
2 PRM-001 | Camonll-215 15 726.000,- 13.794.000,- | PPN
Total 206.910,000,- | PPN
Permilik Perusahaan Purchases Teknisi Akuntansi
Rasela Marta Lisa
BuktiMo: 16
UD. RASEL MEDIA MANDIRI j PURCHASE CRDER
JI. Pamulang Raya 17, Pamulang o@'@q Date 14 Januari 2013
Tangerang Selatan POz PO-002
PURCHASE ORDER
Supplier: PTMerapi Akadi, Jl. Mangga Dua 29 Jakarta
Armcunt: Rp. 240.850.000,-
pua ratus empat puluh juto delopan ratus lima puluh ribu Rupioh
Details:
Mo Item Mo Description Oty Price/Unit Total Price TAX
Rp. Rp.
1 COM-002 | HP Pro book 5530 21 12.364.000, - 259.644.000,- | PPN
2 PRM-002 | CanonBj-355 13 407.000,- 5.291.000,- | PPM
Total 264.935.000,- | PPN
Perilik Perusahaan Purchases Teknisi Akuntansi
Rasela Marta Lisa

Transaksi pembelian (2 transaksi)
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| BuktiNo: 17
PT. MERBABU RAYA INVOICE
i G - Mada 12 Date 15 Januari 2013
i arJ:‘ aca INV# MR-57
aans PO PO-001/ 14 Januari 2013
INVOICE
Customer: UD RASEL MEDTA MAMDIRL JI, Parmulang Raya 17, Pamulang
Amcunt: Rp. 188.200.,000,-
|5emtus delapanpuluh delapon juta dua ratus nibu rupich.
Details:
MNo Item Mo Description Oty Price/Unit Total Price TAX
Rp. Rp.
1 COM-001 | HPPro book4421s 19 10,164,000, - 193.116.000- | PPM
2 PRM-001 Canonl-215 19 726,000 - 13.754.000- | PPM
206,910,000~ | PPM
Fraight S0.000,-
Total 207.000,000,-
Pemilik Perusahaan Purchases Teknisi Akuntansi
Suycko Sena
BuktiMo: 18
PT. MERAPI ABADI INVOICE
) M Dus 29 Date 16 Januari 2013
i :t”gga He NV MA-62
akarta
POz PO-002 /14 Januari 2013
INVOICE
Supplien UD RASEL MEDTA MAMDIRL JI, Parmulang Raya 17, Pamulang
Amount: Rp. 241.000.000,-
pua ratus empat puluh sotu jute Rupioh
Details:
MNo Item Mo Description Oty Price/Unit Total Price TAX
Rp. Rp.
1 COM-002 | HP Pro book 5530 21 12.364.000,- 2559.644.000,- | PPN
2 PRM-002 CanonBj-555 13 407.000 - 5.291.000- | PPM
264935000~ | PPM
Freight 65000~ | NT
Total 265,000,000 -
Pemilik Perusahaan Purchases Teknisi Akuntansi
Mina Rika

Transaksi pembelian aktiva tetap (2 transaksi)
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| BuktiNo: 19
BT Auto 2000 INVOICE
] Date 17 Januari 2013
M. Cilandak 12, Jakarta Selatan Tvoce® | 12345
Telp 0217433322 Term 10 bulan
INVOICE
Sold to UD RASEL MEDTA MAMDIRL JI. Pamulang Raya 17, Pamulang
Amount: Rp. 240,000000.-
Dua ratus empat puluh juta Rupigh
Details
Mo Description Gty | Price/Unit Rp. T':'taF:pP”':E TAX
1 Maobil Box —Toyota 2012 1 240,000,000 - 240,000,000 - -
Total due 240,000,000 - -
Pemilik Peruzahaan Sales Pembukuan
Lie Ban Piet Megah
| BuktiNo: 20
PT Auto 2000 INVOICE
| Cilandak K | Date 17 Januari 2013
J. Cilandalk 12, Jakarta Selatan Tvoce® | 371
Telp 0217433322 Term 10 bulan
INVOICE
Sold to: UD RASEL MEDLA MAMNDIRL JI. Pamulang Raya 17, Pamulang
Amount: Rp. 140.000,000,-
Seratus empat puluh juta Rupiah
Details
Mo Description Gty | Price/Unit Rp. T':'taF:pP”':E TAX
1 Mobil Sedan—Honda 2012 1 140,000,000 - 140,000,000 - -
Total due 140,000,000 - -
Pemilik Peruzahaan Sales Pembukuan
Lie Ban Piet Megah

Transaksi retur pembelian (2 transaksi)
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| BuktiNo: 21
CRECIT NOTE

_IITTGM E:;A: UIR;‘I'A Date 17 Januari 2013

" arJ:‘ e CreditNote # | 11

s Inv.2/Date | MR-57/15 Januari 2013

CREDIT NOTE

Returned by: UD RASEL MEDIA MAMDIRL JI. Pamulang Raya 17, Pamulang
Amount: Rp. 9.900.000,-

Sembilan juta sembilan rotus ribu Rupich

Returned dueto damages

Mo Item Mo Description Qty Price/Unit Total Frice TAX
Rp. Rp.
1 COmM-001 | HPPro book4421s 1 10.164.000,- 10.164.000,- | PPM
2 PRM-001 | CamonU-215 1 726,000, - 726,000~ [ PPM
Total 10.850.000,- | PPM
Pemilik Perusahaan Purchases Sales
Suyocko Sena
| BuktiNo: 22
PT. MERAFPI ABADI CREDIT NOTE
) M Dus 26 Date 18 Januari 2013
p :t”gga H CreditNote # | 07
arane Inv.#/Date | MA-62/ 16 Januari 2013
CREDIT NOTE
Returned by: UDRASEL MEDIA MAMDIRL JI. Pamulang Raya 17, Pamulang
Amcunt: Rp. 11.610.000,-

Sebelos juta enam ratus sepuluh ribu Rupioh
Returned duetc damages

Price/Unit Total Pri
Mo Item Ma Description Oty e aRatrnes TAX
Rp. Rp.

1 COM-002 | HP Pro book5530 1 12.364.000, - 12.364.000- | PPM
2 PRMN-002 Camon Bj-555 1 407,000, - 407.000- | PPM
Total 12771000~ | PPN

Pemilik Perusahaan Purchases Sales

Mina Rika

Transaksi pembelian tunai (2 transaksi)
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[BuktiNo: 23
CASH PAYMEMT
UD. RASEL MEDIA MANDIRI CASH CHEQUE
JIl. Pamulang Raya 17, Pamulang Date 19 Januari 2013 19 Januari 2013
Tangerang Selatan MO CP-003 CP-003
[nv#
CASH PAYMENT
Supplier: Cash Purchases
Amount: Rp. 69.000.000,-
Enam puluh sembilan juta Rupiah
Details:
Ma Item Mo Description Oty Price/Unit Total Price TAX
Rp. Rp.
1 COM-001 | HP Pro book4421s 7 10.098.000,- T0.636.000,- | PPN
2 PEM-001 | Canonl-215 7 723.250 - 5.062.750- | PPM
Total 75.748.750- | PPM
Freight 51.250- | NT
Total Tagihan 75.800.000 -
Pemilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya
| BuktiNo: 24
CASH PAYMEMT
UD. RASEL MEDIA MANDIRI CASH CHEQUE

JIl. Pamulang Raya 17, Pamulang Date

20 Januan 2013

20 Januar 2013

Tangerang Selatan MO

CP-004

CP-004

[nv#

CASH PAYMENT

Supplier: Cash Purchases
Armount: Rp. 81.000.000,-
Delapan puluh satu juta Rupiah
Details:
Price/Unit Total Pri
Mo Item Mo Description Oty riesn oratFres TAX
Ep. Ep.
1 COM-002 | HP Pro book 5530 7 12.320,000 - 86.240,000- | PPN
2 PEM-002 | CanonBj-355 7 396.000,- 2772000 | PPM
Total 89.012.000- | PPN
Freight BE.000- | NT
Total Tagihan 89,100,000 -
Pemilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya

Transaksi retur pembelian tunai (2 transaksi)
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[ BuktiNo: 25
CASH RECEIPT
UD. RASEL MEDIA MANDIRI CASH CHEQUE
JI. Pamulang Raya 17, Pamulang Date 21 Januari 2013 21Januari 2013
Tangerang Selatan MO CR-007 G-30
I
CASH RECEIPT
Supplien Cash Purchases
Armcunt: Rp. 9.837.500-
Sembilon juta delapan ratus tiga puluh tujuh rbu lima ratus rupiah
Details: Cash Receipt for Cash Purchases Return
Mo Item Mo Description ity Price/Unit Total Price TAX
Rp. Rp.
1 COM-001 | HPPro book4421s 1 10.098.000,- 10.098.000.- | PPN
2 PRM-001 | CamonlI-215 1 723250, - 723.250,- | PPM
Total 10.821.250.- | PPN
Permilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya
[ BuktiNo: 26
CASH RECEIPT
UD. RASEL MEDIA MANDIRI CASH CHEQUE
JI, Pamulang Raya 17, Pamulang Date 22 Januari 2013 22 Januari 2013
Tangerang Selatan N CR-008 H-17
I
CASH RECEIPT
Supplier Cash Purchases
Armount: Rp. 11.560.000,-
Sebelas juta lima ratus enam puluh ribu rupiah
Details: Cash Receipt for Cash Purchases Return
MNo Ttem Mo Description Oty Price/Unit Total Price TAX
Rp. Rp.
1 COM-002 | HPPro book3530 1 12.320.000,- 12320,000.- | PPN
2 PEM-002 | CanonBj-555 1 356,000, - 396.000,- | PPN
Total 12.716.000- | PPN
Permilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya

Transaksi pembayaran utang tanpa diskon (2 transaksi)
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| BuktiNo: 27
UD. RASEL MEDIA MANDIRI CASH PAVMENT
1l F'. I Raya 17, P I CASH CHEQUE
- am”a”g la:a (PEMUIENG Aot 23 Januari 2013 23 Januari 2013
angerang»eiatan NO CP-005 CP-005
CASH PAYMENT
Paidto
Supplier PTMERBABURAYA, JI. Gajah Mada 12, Jakarta
Amount: Rp. 110.000.000,-
Seratus sepuluh jute rupioh
Details:
No Date Invoice® Amount Discount Total Due
Rp Rp Rp.
1 26/12/12 | C-12 110,000,000 - - 110,000,000 -
Total Payment 110,000,000 -
Pemilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya
| BuktiNo: 28
UD. RASEL MEDIA MANDIRI CASH PAVMENT
1l F'. | Raya 17, P | cASH CHEQUE
- am“”g la:a (PAMHENG M pste 23 Januari 2013 23 Januari 2013
angerang ~elatan NO CP-006 CP-006

CASH PAYMENT

Paidto
Supplier: PTMERAPIABADL Jl. Mangga Dua 29, Jakarta
Arount: Rp. 77,000,000, -
Tujuh puluh tujuh juta rupiah
Details:
Mo Date Invoices Amaunt Discount Tatal Due
Rp REp Fp.
1 28/12/12 | B-215 77.000.000,- - 77.000.000,-
Total Payment 77.000.000,-
Pemilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya

Transaksi pembayaran utang dengan diskon (2 transaksi)
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[ BuktiNo: 29
CASH PAYMENT
j-ll[; RASlEL hﬂ;EDIﬁ;;ﬂ;:NDIlﬂl CASH CHEQUE
- amd a”g la:a (PEMUENG I Date 24 Januari 2012 24 Januari 2013
angerang s=iatan NO CP-007 CP-007
CASH PAYMENT
Paidto
Supplien PT MERBABU RAYA, ). Gajah Mada 12, Jakarta
Amount: Rp. 172.654.000,-
Seratus tujuh puluh dua juta enam ratus lima puluh empat ribu Rup.
Details:
) Amount Purchase Retum Total Due
MNo Date Invoice#
Ep Rp Fp.
1 15/1/13 | MR-57 207.000.000 - 10,890,000 - 196,110,000 -
Discount (3% xRp. 207.000000,-) 6.210.000 -
Total Payment 139.900.000,-
Pemilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya
[ BukiNo: 30

CASH PAYMENT

UD. RASEL MEDIA MANDIRI

CASH CHEQUE
?'as;;”r:':;;:::n”’Pam”'ang Date | 24 Januari 2013 24 Januari 2013
MO CP-008 CP-008
CASH PAYMENT
Paid to
Supplier PT MERAPTABALL JI. Mangga Dua 29, Jakarta
Armount: Rp. 222,160,000
Dua ratus dua puluh dua juta seratus enam puluh ribu Rupich
Details
No Date Invoices Amount Purchase Retum Total Due
Ep REp Rp.
1 18/1/13 | MA-B2 265.000.000 - 12771000 - 252.228,000 -
Discount (3% x Rp. 265.000000.-) 7.950.000,-
Total Payment 244,279,000 -
Pemilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya

Kasus 6.2 : Kasus UD Riola Media Mandiri.
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Transaksi order pembelian (2 transaksi)

Bukti No : 15
UD.RIOLA MEDIA MANDIRI PUHCHASF ?HDEH
JI. Pamulang Raya 17, Pamulang @@31] Date 14 Januari 2013
Tangerang Selatan @ PO# PC-0
Termin 310, ni30 Late Fees 2%
PURCHASE ORDER
Supplier: PT Merbabu Raya, JI. Gajah Mada 12 Jakarta
Amount; Rp. 188.100.000.-
lSerarus delapan pulth delapan juta seratus ribu rupiah.
Details:
No | ltemNo Description Qty | Prce/Unit Ro. Tmﬂ;"“e TAX
1 COM001 | HP Probook 44212 19 10.164.000. - 193116000 | PPN
2 PRN001 Canon LJ-215 19 T26.000- 13.794.000- | PPN
Taotal 206.910000- | PPN
Femillk Perusahaan Purchasas Teknigi Akuntansi
Riola Marta Lisa
BuktiMo : 16
UD. RIOLA MEDIA MANDIRI FURCHASE CRDER
JI. Pamulang Raya 17, Pamulang @@(@3]] Date 14 Januari 2013
Tangerang Selatan PO& FO-00
PURCHASE ORDER
Supplier: PT MerapiAbadi, JI. Mangga Dua 23 Jakarta
Amount: Rp. 240.850.000 -
}D'uararus empal puluh juta delapan ratus fima pulth ribu Rupiah
Details:
No | ltemNo Descripion Qty | PrceiUnit Rp. T‘“E’F'l;jm TAX
1 COM002 | HP Probook 3530 21 12.364.000 - 259644 000- [ PPN
2 PRMA02 | CanonBr555 13 407.000 - 5291.000- [ PPN
Total 264 935000- | PPN
Femillk Perusahaan Purchases Teknizi Akuntansi
Riola Marta Lisa

Transaksi pembelian (2 transaksi)
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BuktiNo : 17
INVOICE
PT. ME RBABURAYA Date 15 Januan 2013
JI. Gajah Mada 12 — =
Jakara INV# MR-5:
PO# PO-001/14 Jamuan 2013
INVOICE
Customer: |JDRICLA MEDIA MANDIRI, JI. Pamulang Raya 17, Pamulang
Amount; Fp. 188.200.000 -
Fsmﬂ.rs defapan pulnh delapanjuta duaratus by rupiah.
Details:
Mo | ltemMNo Description Qty | PricefUnit Rp. T“‘Eg;m TAX
1 COND01 HP Pro book 4421s 19 10.164.000.- 193.116000- [ PPN
2 PRN001 Canon LJ-215 19 726000 - 13.794.000- [ PPN
206970000 1 PPN
Freight 90.000-
Total 207000000 -
Pemilik Perusahaan Purchases Teknisi Akuntansi
Suyoko Sena
BuktiMo : 18
INVOICE
Tﬂm Em’“’[: “B;”' Date 16 Januari 2013
Manggatis <= INVE MA-62
Jakarta
PO# PO-0021 14 Januari 2013
INVOICE
Supplier: UD RIOLA MEDIA MANDIRI, JI. Pamulang Raya 17, Pamulang
Amaount: Rp. 241.000.000 -
Pua ratus empat puiuh satu juta Rupiah
Dietails:
No | ltemMNo Description Qty | Price/Unit Rp. T‘“ﬂ;"‘* TAX
1 COM002 | HP Pro book 5530 21 12.364.000 - 2h9644000- | PPN
2 PRH002 Canon Br555 13 407 .000 - h291.000-| PPN
264 9350001 PPN
Fraight 55.000- NT
Total 265000000 -
Pemilik Perusahaan Purchases Teknisi Akuntansi
Nina Rika

Transaksi pebelian aktiva tetap (2 transaksi)
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BuktiNo : 19
PT Auto 2000 INVD.ICE
] Date 17 Januari 2013
JI. Gilandak 12, Jakarta Selatan —— 12345
TE||:J 0217433322 Term 10 bulan
INVOICE
Sold to: LD RIOLA MEDIA MANDIRI, JI. Pamulang Raya 17, Pamulang
Amaount: Rp. 240.000.000 -
Dua ratus empat puiuh juta Rupiah
Details:
No Description Qty | PrcslUnit Ro. T‘“ER!DP"DE TAX
1 Mobil Box - Toyota 2012 1 240000000 - 240.000.000 - -
Totaldue 240000000 - -
Pemilik Perusahaan Sales Fembukuan
Lie Ban Piet Megah
| BuktiNo : 20
PT Auto 2000 NVOICE
] Date 17 Januari 2013
JI. Gilandak 12, Jakarta Selatan oI £ 321
TE||3I 0217433322 Term 10 bulan
INVOICE
Sold fo! UD RICLAMEDIA MANDIRI, JIl. Pamulang Raya 17, Pamulang
Amount: Rp. 140.000.000 -
Seratus empar puluh juta Rupiah
Details:
R - Total Prce
Mo Deszcrption Oty Prce/Unit Rp. R TAX
1 Mobil Sedan—Honda 2012 1 140.000 000 - 140,000 000 - -
Totaldue 140000000 - -
Pemilik Peruzahaan Sales Pembukuan
Lis Ban Pist Magah

Transaksi retur pembelian (2 transaksi)
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BuktiNo : 21
CREDIT NOTE
TGM'EEzAS U1R2MA Date 17 Januan 2013
- Sapn Mo CrediNoe# | 11
Jakarta
Inv.#Date MR-57/ 15 Januari 2013
CREDIT NOTE
Returned by: UD RIOLA MEDIA MANDIRI, JI. Pamulang Raya 17, Pamulang
Amount: Rp.  9.900.000 -
Sembilan juta sembifan ratus riby Rupiah
Returnad dus to damages
Mo |  HemNo Description Qty | PrcefUnit Ro. T““ﬂf"“ TAX
con001 HP Pro book4421s 1 10.164.000 - 10.164.000- | PPN
2 PEN-001 CanonLJ-215 1 T26.000- T26.000- | PPN
Total 10.890.000- | PPN
Pemilik Perusahaan Purchases Sales
Suyoko Sena
BuktiNo @ 22
CREDIT NOTE
PT.MERAPIABADI Date 18 Janusari 2013
Jl. Mangga Dua 29 T o7
Jakarta redit Note -
Inv #Date MA-82/ 18 Januari 2013
CREDIT NOTE
Returned by: UD RICLA MEDIA MAMDIRI, JI. Pamulang Raya 17, Pamulang
Amount: Rp.  11.610.000 -
Sebelas juta enam ratus sepulth ribu Rupiah
Returned dueto damages
No | ltem Mo Description Qty | PrcelUnit Ro. T“‘HF!;“DE TAX
1 COM02 | HP Probook 5530 1 12.364.000 - 12.364.000- | PPM
P PRM-002 Canon Br555 1 407.000 - 407.000- | PPH
Total 12771.000- | PPN
Pemilik Perusahaan Purchases Sales
Nina Rika

Transaksi pembelian tunai (2 transaksi)
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BuktiNo : 23
CASH PAYMENT
UD. RIOLA MEDIA MANDIRI AT CHEQUE
JI. Pamulang Raya 17, Pamulang _ _
Tangerang Selatan Date 19 Januan 2013 19 Januan 2013
NO CrO03 CP003
CASH PAYMENT
Supplier: Cash Purchases
Amount: Rp. 69.00:0. 000, -
Enam puluh sembian juta Rupiah
Details:
No | ltem Mo Description Qty | PrcsfUnit Ro. Tmi;""e TAX
1 COM001 HP Pro book 4421 7 10.098.000 - 70.686.000-| PPN
2 PENODT | CanonLJ-21H 7 723250 - h.052.750,- | PPN
Total 75748750~ PPN
Fraight 51250~ NT
Total Tagihan 75.800.000-
Pemilik Perusahaan Cashier Teknisi Akuntansi
Riola Marta Maya
BuktiNo : 24
CASH PAYMENT
UD. RIOLA MEDIA MANDIRI CASH CHEQUE
JI. Pamulang Raya 17, Pamulang Date 20 Januan 2013 20 Januan 2013
Tangerang Selatan NO P04 P04
I
CASH PAYMENT
Supplier: Cash Purchases
Amount: Rp.. 81.000.000 -
Delgpan puiuh satu juta Rupiah
Details:
Mo | ltemMo Description Qty | PricsfUnit Ro. T‘“EFLDP"DE TAX
1 COMD02 | HP Pro book 5530 7 12.320.000 - 86.240000- | PPN
2 PRN-D02 Canon Brhhh T 396.000 - 277T2000-1 PPN
Total 59.012000- | PPN
Fraight §5.000- NT
Total Tagihan 89.100.000-
Pemilik Perusahaan Cashigr Teknisi Akuntansi
Riola Marta Maya

Transaksi retur pembelian tunai (2 transaksi)
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Bukti No :
CASH RECEIPT
UD.RIOLA MEDIA MANDIRI CAsH CHEQUE
JI. Pamulang Raya 17, Pamulang Date 21 Januari 2013 21 .Januari 2013
Tangerang Selatan MO CR-00 G-30
I
CASH RECEIPT
Supplier: Cach Purchases
Amount: Rp. 9.837.500 -
Sembiian juta delgpan ratus tiga puluh tujuh ribu ima ratus rupiah
Details: Cash Receipt for Cash Purchases Return
No | ltem Mo Description Qty | Pres/Unit Ro. T‘“g;’“ TAX
COon-001 HF Pro book 4421s 1 10.095.000- 10.098000- | PPN
2 PRH001 Canon LJ-215 1 123290 - T2325-| PPN
Total 10821250- | PPN
Pemilik Perusahaan Cashier Teknisi Akuntansi
Riola Marta Maya
| Bukti No :
CASH RECEIFT
UD. RIOLA MEDIA MANDIRI CASH CHEQUE
JI. Pamulang Raya 17, Pamulang Date 22 Januari 2013 22 Januari 2013
Tangerang Selatan MO CR-008 H-17
I
CASH RECEIPT
Supplier: Cash Purchases
Amount: Rp. 11.560.000 -
Sebelas juta fma ratus enam puluh ribu rupiah
Detaile: Cash Reosipt for Cash Purchases Return
Mo | HemNo Description Qty | Prce/Unit Rp. T‘“EF!;'“ TAX
1 COM002 | HP Pro book 5530 1 12320000 - 12.320000- | PPM
2 PRW-002 Canon B335 1 396.000 - 396.000- [ PPN
Total 12.716.000- | PPN
Pemilik Perusahaan Cashier Teknisi Akuntansi
Riola Marta Maya

Transaksi pembayaran utang tanpa diskon (2 transaksi)
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BuktiMo : 27
CASH PAYMENT
jnﬁﬂm:-ﬁ MFED lA:;;AFr:I]IRII CAGH CHEQUE
- ramdiang Raya 1, Famdiang Date 73 Januari 2013 73 Januari 2013
Tangerang Selatan
NO CP-005 CP-005
CASH PAYMENT
Paid to
Supplier: FT MERBAEBU RAYA, JI. Gajah Mada 12, Jakarta
Amount: Rp.. 110.000.000, -
Sergtus sepulth juta rupiah
Details:
_ Amount Discount Total Due
Mo Dat= Invoice# Ro Ro Ro.
1 261212 | ¢12 110.000.000 - - 110.000.000 -
Total Payment 110.000.000 -
Pemilik Perusahaan Cashier Teknisi Akuntansi
Riola Marta Maya
Buktino : 28
CASH PAYMENT
jnﬁ:RIDTA ”F:ZBM:;A:DIR: CASH CHEQUE
- ramuiang Raya 1, Famiang Date 73 Januari 2013 73 Januani 2013
Tangerang Selatan
N CP-006 CP-00G
CASH PAYMENT
Paid to
Supplier: PT MERAFI ABADI, JI. Mangga Dua 29, Jakarta
Amount; Rp.. 77.000.000.-
Tujuh puih tujuh juta rupiah
Details:
_ Amount Discount Total Due
Mo Date Invoics# R Ro Ro.
1 28122 | B215 T7.000.000- - T7.000.000.-
Total Payment T7.000.000 -
Pemilik Perusahaan Cashigr Teknisi Akuntansi
Riola Marta Maya

Transaksi pembayaran utang dengan diskon (2 transaksi)
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BuktiNo : 29
CASH PAYMENT
jnﬁ RIDII_A M:D IA:.I;A:DIRII CASH CHEQUE
- amuiang Rays 1, Famiang Date 24 Januani 2013 24 Januari 2013
Tangerang Selatan
NO CP-007 CP-007
CASH PAYMENT
Paid to
Supplier: FT MERBABU RAYA, JI. Gajsh Mada 12, Jakarts
Amount: Rp. 172.654.000 -
Seratus twjuh puluh dua juta enam ratus fma puluh empat ribu Rup.
Details:
Mo Dste T Amount Purchazs Fetum Total Dus
Fp Fp Rp.
1 15113 MR-57 207.000.000,- 10.890.000 - 196.110.000 -
Dizcount (3% xRp. 207.000000-) 5.2 10,000 -
Total Payment 169.900.000 -
Pemilik Perusahaan Cashier Teknisi Akuntansi
Riola Marta Maya
| BuktiNo : 30
CASH PAYMENT
jnp; RIDII_A M:D lA:;;A:DIRll CASH CHEQUE
- ramidiang haya 1f, Famiang Date 24 Januar 2013 24 Januari 2013
Tangerang Selatan
NO CP-0eX CP-00
CASH PAYMENT
Paid to
Supplier: PT MERAPI ABADI, J. Mangga Dua 29, Jlakarta
Amount: Rp. 222160000
Dua ratus dua pulh dua juts seratus enam puluh ribu Rupiah
Details:
o, Amount Purchazs Retum Total Dus
No Date Inuoices
Fp Fp Fp.
1 161113 MAa-52 265.000.000.- 12.771.000- 252229000 -
Dizcount (3% x Rp. 265.000000-) 7.950.000 -
Total Payment 244 279000 -
Pemilik Perusahaan Cashigr Teknisi Akuntansi
Riola Marta Maya
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Kegiatan Belajar 7
Mengentri Transaksi Kas Bank

a. Tujuan Pembelajaran

Dengan diberikan kasus akuntansi perusahaan dagang, maka pada
akhir sesi ini diharapkan peserta didik dapat:

1. Mencatat transaksi Pengeluaran Kas
2. Mencatat transaksi Pengeluaran Kas Kecil
3. Mencatat transaksi Penerimaan Kas

Q[\) b. Uraian Materi

Lingkup uraian materi pada kegiatan belajar 1 ini meliputi:

1. Entri transaksi Pengeluaran Kas
2. Entri transaksi Pengeluaran Kas Kecil
3. Entri transaksi Penerimaan Kas

Program MYOB menyediakan berbagai Command Centre Banking yang
digunakan untuk mengentri transaksi pengeluaran kas untuk pembayaran beban-
beban dan juga penerimaan kas dari pendapatan lain-lain.

BANKING -.‘?|
@/ , !\
///

s Time BFMg Purchases Payrall Inventory Caﬂd File

i seenennenerenns Bank Register «------oooooeeeee © Receive Money

v v

Reconcile Accounts Prepare Bank Deposit
P ) 0 > .0 M Powered (D

inYEmail Remittance Advices --- @ Transaction Journal @ Cerm
ToDoList w Find Transactions w Reports w Analysis

Gambar 7-1 Menu Banking
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1. Entri Transaksi Pengeluaran Kas (Spend Money - Cash In Bank)

Hal-hal yang perlu diperhatikan dalam transaksi pengeluaran Kas:

a) Menggunakan Command Centre Banking > Spend Money.

b) Mengidentifikasi pembayaran dengan cek, tunai (cash on hand), kas kecil

atau via kartu kredit.

¢) Dokumen sumber : Bukti No: 31 & 32

174

BuktiNo: 31

CASH PAYMENT

UD. RASEL MEDIA MANDIRI

CASH CHEQUE

JI. Pamulang Raya 17, Pamulang Date 35 Janu

an 2013 25 Januan 2013

Tangerang Selatan Doc CP-000

CP-009

CASH PAYMENT

Amount: Rp. 1.500.000,-
Satu juta lima ratus ribu Rupiah
Details:
Mo Explanations Amount (Rpl TAX
1 Supplies Inventory 650.000,- N.T
2 Telephane 450,000~ [ MNT
3 Water 150.000,- [ MT
4 Speedy-Internet 250000~ | MNT
Total Payment 1.500.000 -

Pemilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya
BuktiMNo: 32
CASH PAYMEMNT
:.llll.‘; RAFInEL I'ln'IREDIJ:n-;:‘I,:NDIIRI CASH CHEQUE
- am“”g IE;-E TEMUENG Rt 26 Januari 2013 26 Januani 2013
angerang selatan Doc CP-010 CP-010
CASH PAYMENT
Amount: Rp. 11.500.000,-
Sebelas juta lima rotus ribu Rupiah.
Details:
Mo Explanations Amount TAX
1 Cther Employers Expenses 200.000,-
2 ‘Wages and Salaries 2.500.000,-
3 Income Tax Payable 2.275.000,-
4 | Electricity 525,000,
Total Payment 11.500.000,-

Pemilik Perusahaan Cashier

Rasela Marta Maya

Teknisi Akuntansi
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Praktekkan langkah-langkah berikut:

1 Klik Command Centre Banking > Spend Money. Kemudian isi data sesuai
dengan dokumen sumber. Untuk memilih akun yang terkait klik < dan pilih
akun. Kemudian klik Use Account.

¥
@Spend Money =)= Ei

& Pay from Account:  |1-1110 5/ CashInBank Balance ©: Rp117.724.250,00
" Group with Electronic Payments: v V' TaxInclusive

Cad ﬂ Chegue No.:iCP-UDS

>
Payee w|: @ Select from List
Look for: [1-1410

One Million Five

11110 CashInBank Asset
Memo:| Pembayaran bg | [1-1120  Payroll Cheque Account Asset
11130 Cash Drawer Asset
11140 Petty Cash Asset
11150  Undeposited Funds Asset
1-1160  Electronic Clearing Account Asset
11210 Account Receivable Asset
11220 Allowance for Doubtful Debts Asset
11310 Inventory - Computers Asset
11320 Inventory - Printers Asset
1-1410  Supplies [nventor Asset
11420 Deposits Paid Asset
W Prepaid Insurance Asset
1-1440  Prepaid Rent Asset
1-2110  Store Equip - at Cost Asset
1-2120  Store Equip - Accum Dep'n Asset

z oy 2 Use Account
7.5 & e

Help F1 New Eagy-Add Cancel

Print Joumnal | Rl

Gambar 7-2 Spend Money — Memilih Akun Beban

2 Isi format Spend Money sesuai dengan dokumen sumber (Bukti No. 31) seperti
berikut.
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3

4
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@ Spend Money = :]E'

& Pay from Account: [1-1110 &/ Cash InBank Balance = Rp117.724.250,00
¢ Group with Electronic Payme:gke

V' TaxInclusive

Cad S/ Cheque No.[CP-003
Date:| 25/01/2013

Payee w|:
~v Amount:| Rp1.500.000,00

One Milion Five Hundred Thousand Dollars and 0 Cents

tMema: | Pembayaran beban operasi £42 Bavals Macks Mandiy

-

Name Amount Memo

Supplies Inventory Rp650.000,00
Telephone Rp450.000,00
Water Rp150.000,00
Speedy - Internet Rp250.000,00 =

Help F1

Total Allocated: | Rp1.500.000,00
Tax o m I™ Cheque Already Printed
Total Paid: | Rp1.500.000,00 Remittance Advice Delivery Status:
Rp0,00 [ To be Printed >

Out of Balance: |

=
3 3
Print Journal | Register

Gambar 7-3 Spend Money — Cash In Bank

Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup Recap

Kembali ke Bill semula klik Record, dan klik Cancel.

Transaction.
Recap Transaction in Spend Money l
Src Date ID# Account Debit Credit Job
CcD 25/01/2013 Pembayaran beban operasi _]
CP-009 11110 Cash InBank Rp1.500.000,00
CP-009 11410 Supplies Inventory RpE50.000,00
CP-003 6-4500 Telephone Rp450.000,00
CP-009 B-4600 ‘Water Rp150.000,00
CP-009 B-4300 Speedy - Intemnet Rp250.000,00
g.
Help F1

Gambar 7-4 Recap Transaction in Spend Money- Cash In Bank

Ulangi langkah-langkah 1 s.d. 3 untuk mengentri data pengeluaran kas sesuai
dengan Bukti No. 32.
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2. Entri Transaksi Pengeluaran Kas Kecil (Spend Money - Petty Cash)

Hal-hal yang perlu diperhatikan:

a) Menggunakan Command Centre Banking > Spend Money.

b) Mengubah Cash in Bank dengan Petty Cash.
c) Dokumen sumber : Bukti No: 33 & 34

BuktiNo: 33
UD. RASEL MEDIA MANDIRI PETTY CASH VOUCHER
JI. Pamulang Raya 17, Pamulang Date 27 Januari 2013
Tangerang Selatan NO PC-001
PETTY CASH VOUCHER
Armount: Rp.600.000.-
|Enammtus ribu Rupiah,
Details:
Mo Explanations Amount TAX
1 Postage 100.000,-
2 Subscriptions 300.000,-
3 In-5tore Promotion 200.000,-
Total Payment 600.000,-
Pemilik Perusahaan Petty Cashier Teknisi Akuntansi
Rasela Marta Yoyo

BuktiNo: 34
UD. RASEL MEDIA MANDIRI PETTY CASH VOUCHER
Jl. Pamulang Raya 17, Pamulang Date 28 Januari 2013
Tangerang Selatan NO pc-002]
PETTY CASH VOUCHER
Amount: Rp. 700.,000.-
| Tujuh ratus ribu Rupiah.
Details:
Mo Explanations Amount TAX
1 Staff Amenities 200.000,-
2 Cleaning Service 300.000,-
3 Maintenance 200.000,-
Total Payment 700.000,-
Pemilik Perusahaan Petty Cashier Teknisi Akuntansi
Rasela Marta Yoyo
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Praktekkan langkah-langkah berikut:

1 Klik Command Centre Banking > Spend Money. Kemudian ubah Cash in
Bank menjadi Petty Cash. Isi data sesuai dengan dokumen sumber (Bukti

No. 33).
@ Spend Money E”E

¢ Pay from &ccount:  |1-1140 5| Petty Cash Balance ©>: Rp4.400.000,00
IV TaxInclusive

¢ Group with Electronic Payments: P 4

Cad S| Cheque No.[PC-002
Payee w|: Date:| 28/01/2013

/V\moun!: Rp700.000,00

Seven Hundred Thousand Dollars and 0 Cents
Memo: [ Pembayaran beban dengan petty cash LD Rasals Meacks My

Acct # /* Name Amount Mema
65110 Staff Amenities Rp200.000,00
6-4700 Cleaning Rp300.000,00
6-4100 Maintenance Fp200.000,00

/ Total Allocated: | Rp700.000,00
Tax o r—ﬁm ™ Cheque Already Printed
Total Paid: [m Remittance Advice Delivery Status:
Out of Balance: | Rp0,00 |To be Printed hl

(B) Save as Recuring Recuring

P
Print Journal | Register

Gambar 7-5 Spend Money — Petty Cash

2 Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup
Recap Transaction. Kembali ke Bill semula klik Record, dan klik Cancel.

Recap Transaction in Spend Money ‘
Sic Date ID# Account Debit Credit Job
CcD 27/01/2013 Pembayaran beban dengan petty cash .
PC-001 1-1140  Petty Cash Rp600.000,00
PC-001 6-4200 Postage Rp100.000,00
PC-001 61400  Subscriptions Rp300.000,00
PC-001 6-3110  In-store Promotions Rp200.000,00
g.
Help F1

Gambar 7-6 Recap Transaction in Spend Money — Petty Cash

3 Ulangi langkah-langkah 1 dan 2 untuk mengentri data pengeluaran kas kecil
sesuai dengan Bukti No. 34.
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3. Transaksi Penerimaan Kas (Receive Money)

Hal-hal yang perlu diperhatikan dalam transaksi pembayaran utang dengan
diskon:

a) Menggunakan Command Centre Banking > Receive Money.
b) Dokumen sumber : Bukti No: 35 & 36

BuktiNo: 35
CASH RECEIPT
UD. RASEL MEDIA MANDIRI CASH CHEQUE
JI. Pamulang Raya 17, Pamulang Date 29 Januari 2013 29 Januari 2013
Tangerang Selatan MO CR-009 p-12
CASH RECEIPT
Amount: Rp. 35.000.000,-
Tiga puluh lima juta Rupiah.
Details:
Mo Description Amount TAX
Rp.
1 Setoran modal dari pemilik perusahaan 35.000.000,- -
Total 35.000.000, - -
Pemilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya
BuktiNo: 36
CASH RECEIPT
UD. RASEL MEDIA MANDIRI CASH CHEQUE
NI, Parulang Raya 17, Pamulang Date 30 Januari 2013 30 Januari 2013
Tangerang Selatan MO CR-010 X-10
CASH RECEIPT
Amount: Rp. 15.000.000.-
Lima belas juta Rupiah.
Details:
Ma Description Amount TAX
Rp.
1 Setoran modal dari pemilik perusahaan 15.000.000,- -
Total 15.000.000,- -
Pemnilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya
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Praktekkan langkah-langkah berikut:

1 Klik Command Centre Banking > Receive Money. Kemudian isi data sesuai
dengan dokumen sumber (Bukti No. 35)

@ Receive Money

o] O]

¢ Deposit to Account:

Balance ©: Rp104.724.250,00

11110 ¥ CashInBank

" Group with Undeposited Funds/v

v TazInclusive

ID #: [CR-009

Aate: 29/01/2013

Payor [
Amount Recsived: | Rp35.000.000,00

Payment/Me;od: Cheque S| Details...

emo: | Tambahan investasi pemilik

Amount
Fp35.000.000,00

Name
Rasela Marta's Capital

Scct#

31100,
—~

Tatal Allocated: | Rp35.000.000,00
Tax o ] F:p»]ﬁ
Total Received: fFIp35.UUU.UUU,UU

Out of Balance: | F!pU,IJUA

(®) Use Recuring

(B) Save as Recuring

Cancel

Help F1 Journal | Register

Gambar 7-7 Receive Money

2 Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup Recap
Transaction. Kembali ke Bill semula klik Record, dan klik Cancel.

Recap Transaction in Receive Money |
Sic Date ID# Account Debit Credit Job
CR 29/01/2013 Tambahan investasi pemilik _]
CR-003 11110 CashInBank Rp35.000.000,00
CR-009 31100 Rasela Marta's Capital Rp35.000.000,00
g.
Help F1

Gambar 7-8 Recap Transaction In Receive Money

3 Ulangi langkah-langkah 1 dan 2 untuk mengentri data penerimaan kas sesuai
dengan Bukti No. 36.
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c¢. Rangkuman

Transaksi pengeluaran yang dapat dientri melalui Command Centre
Banking adalah berbagai transaksi pembayaran beban operasi dan
beban non operasi yang dibayar dengan cek, kas atau kas kecil, tetapi
tidak termasuk transaksi pembayaran utang (Command Centre
Purchases). Demikian juga transaksi penerimaan yang dapat dientri
melalui Banking adalah berbagai transaksi penerimaan kecuali
penerimaan pembayaran piutang.

Semua transaksi penerimaan dan pengeluaran tersebut disediakan
menu dan format khusus oleh MYOB. Data transaksi dientri ke dalam
format dan kemudian diproses secara otomatis. Komputer akan
memberikan hasil berupa laporan jurnal, saldo akun buku besar yang
sudah di-update, bahkan laporan keuangan. Untuk mencegah
kesalahan dalam data entri maka dianjurkan sebelum di-record dicek

terlebih dahulu jurnal yang akan dihasilkan dengan menekan Ctrl-R.

Berdasarkan Kasus 3.1. UD Rasela Media Mandiri yang ada pada

‘Lembar Kerja Peserta Didik’, kerjakan tugas-tugas berikut ini !

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang
per kelompok.

2. Setiap peserta didik mengikuti langkah-langkah yang dijabarkan
dalam KB3 ini melalui kerjasama kelompok.

3. Tugas 1, Mencatat transaksi Pengeluaran Kas (2 transaksi)
Tugas 2, Mencatat transaksi Pengeluaran Kas Kecil (2 transaksi)
Tugas 3, Mencatat transaksi Penerimaan Kas (2 transaksi)
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@

A
v e. Tes Formatif
v

1. Tes Pengetahuan.

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b,
¢, d atau e dari setiap item soal pilihan ganda di bawah ini:

1.

Langkah untuk mengentri transaksi pengeluaran kas kecil untuk beban

operasi:

a. Banking > Petty Cash Out

b. Banking > Cash Payment > Set Account to Petty Cash
c. Banking > Petty Cash

d. Banking > Spend Money > Set Account to Petty Cash
e. Banking > Set Account to Petty Cash > Spend Money
Menu yang digunakan untuk mencatat transaksi pembayaran dalam MYOB
adalah :

a. Banking > Pay Bill

b. Banking > Spend Money

c. Banking > Money Out

d. Banking > Banking Register > Spend Money

e. Banking Register > Spend Money

Menu untuk mengentri transaksi pembayaran dengan Cek:

PO TR

Banking > Pay Bill > Pay from Account: Cash in Bank.

Banking > Spend Money > Pay from Account: Cash in Bank.
Banking > Money Out > Pay from Account: Cash in Bank.
Banking > Banking Register > Pay from Account: Cash in Bank.
Banking Register > Pay Bill > Pay from Account: Cash in Bank.

Sebelum me-record transaksi pembayaran, selalu dianjurkan untuk
menekan Ctrl-R. Tujuan langkah ini adalah untuk:

PoooTR

Menghindari kesalahan dalam pencatatan.
Membetulkan jika ada kesalahan dalam pencatatan.
Mengeliminir kesalahan dalam jurnal

Mengecek kebenaran jurnal sebelum diproses
Mengecek kebenaran jurnal sesudah diproses

Dalam MYOB klik Record terhadap pencatatan transaksi berarti:

a.

b.
c.
d
e

Memerintahkan komputer untuk memperoses jurnalnya.
Memerintahkan komputer untuk menghapus jurnalnya.

Memerintahkan komputer untuk membatalkan jurnalnya.
Memerintahkan komputer untuk memproses ulang jurnalnya.
Memerintahkan komputer untuk memproses jurnal dan posting ke buku
besar serta buku pembantu.
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6. Menu yang digunakan untuk mencatat transaksi penerimaan dalam MYOB
adalah :
Banking > Receive Payment
Banking > Money In
Banking > Receive Money
Banking > Banking Register > Receive Money
Banking Register > Receive Money

7. Menu untuk mengentri transaksi penerimaan berupa cek:

a. Banking > Receive Payment > Deposit to Account: Cash in Bank.

b. Banking > Money In > Deposit to Account: Cash in Bank.

c. Banking Register > Receive Money > Deposit to Account: Cash in
Bank.

d. Banking > Receive Money > Deposit to Account: Cash in Bank.

e. Banking Register > Receive Money > Deposit to Account: Cash in
Bank.

8. Jika ada transaksi penerimaan cek dari setoran pemilik untuk tambahan
investasi sebesar Rp. 300.000,- maka MYOB akan memproses jurnalnya:

Dr: Cash in Bank. Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,-

Dr: Owner’s Capital Rp. 300.000,- Cr: Cash in Bank. Rp. 300.000,-

Dr: Cash in Bank. Rp. 300.000,- Cr: Owner’s Capital Rp. 300.000,-

Dr: Bankcard Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,-

Dr: Cash Drawer Rp. 300.000,- Cr: Owner’s Capital Rp. 300.000,-

9. Menu untuk mengentri transaksi penerimaan berupa uang tunai:
a. Banking > Receive Payment > Deposit to Account: Cash in Bank
b. Banking > Receive Money > Deposit to Account: Cash Drawer
c. Banking > Money In > Deposit to Account: Cash Drawer
d. Banking Register > Receive Money > Deposit to Account. Cash oh
hand
e. Banking Register > Receive Money > Deposit to Account. Cash on
Hand
10. Dalam MYOB klik Record terhadap pencatatan transaksi yang masih
belum seimbang akan terjadi ....
a. Komputer akan memperoses jurnalnya.
b. Komputer akan menghapus jurnalnya.
c. Komputer akan membatalkan jurnalnya.
d. Komputer akan menolak pemprosesan jurnalnya.
e. Komputer akan akan memberi peringatan.

®ooow

©CoooTp

2. Tes Keterampilan.

Berdasarkan Kasus 3.1. UD Riola Media Mandiri yang ada pada ‘Lembar
Kerja Peserta Didik’, kerjakan tugas-tugas berikut ini!

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh peserta
didik secara berkelompok.

2. Pada akhir waktu tes diminta setiap peserta didik menyerahkan hasil
pekerjaannya dalam bentuk file.

3. Tugas 1, Mencatat transaksi Pengeluaran Kas (2 transaksi)

4. Tugas 2, Mencatat transaksi Pengeluaran Kas Kecil (2 transaksi).

5. Tugas 3, Mencatat transaksi Penerimaan Kas (2 transaksi)
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o/ f. Kunci Jawaban Tes Formatif
i
1. Kunci Tes Pengetahuan

1 d 6 C
2 b 7 d
3 b 8 c
4 d 9 b
5 e 10 e

2. Kunci Tes Keterampilan
Tugas 1, Mencatat transaksi Pengeluaran Kas (2 transaksi)

UD Riola Media Mandiri
JI. Pamulang Raya 17 PAMULANG
Tangerang Selatan

Cash Disbursements Journal

25/01/2013 To 26/01/2013

06/03/12014 Page 1
9:58:55
1D Acct# Account Name Debit Credit Job No.

CcD 2510112013 Pembayaran beban operasi

CP-009 1-1110 Cash In Bank p1.500.000,00

CP-009 1-1410 Supplies Inventory Rp650.000,00

CP-009 5-4500 Telephone Rp450.000,00

CP-009 6-4600 Water Rp150.000,00

CP-009 6-4300 Speedy- Internet Rp250.000,00
CcD 26/01/2013 Pembayaran beban operasi perusahaan

CP-010 1-1110 Cash In Bank p11.500.000,00

CP-010 6-5140 Other Employer Expenses Rp200.000,00

CP-010 6-5120 Wages & Salaries p2.500.000,00

CP-010 2-1600 Income Tax Payable p&a.275.000,00

CP-010 6-4650 Electricity Rp525.000,00

Grand Total:  p13.000.000,00 p13.000.000,00
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Tugas 2, Mencatat transaksi Pengeluaran Kas Kecil (2 transaksi)

UD Riola Media Mandiri
JI. Pamulang Raya 17 PAMULANG
Tangerang Selatan
Cash Disbursements Journal
27/01/2013 To 28/01/2013
06/03/12014 Page 1
10:00:19
1D Acct# Account Name Debit Credit Job No.
cD 27/01/2013  Pembayaran beban dengan petty cash
PC-001 1-1140 Petty Cash Rp&00.000,00
PC-001 6-4200 Paostage Rp100.000,00
PC-001 6-1400 Subscriptions Rp300.000,00
PC-001 6-3110 In-store Promotions Rp200.000,00
cD 28/01/2013  Pembayaran beban dengan petty cash
PC-002 1-1140 Petly Cash Rp700.000,00
PC-002 6-5110 Staff Amenities Rp200.000,00
PC-002 6-4700 Cleaning Rp200.000,00
PC-002 6-4100 Maintenance Rp200.000,00
Grand Total:  p1.300.000,00 p1.300.000,00
Tugas 3, Mencatat transaksi Penerimaan Kas (2 transaksi)
UD Riola Media Mandiri
JI. Pamulang Raya 17 PAMULANG
Tangerang Selatan
Cash Receipts Journal
29/01/2013 To 30/01/2013
0610312014 Page 1
10:01:34
1D Acct# Account Hame Debit Credit Job Ho.
CR 29i01/2013 Tambahan investasi pemilik
CR-009 1-1110 Cash In Bank p35.000.000,00
CR-009 3-1100 Rasela Marta’s Capital p35.000.000,00
CR 300101/2013 Tambahan investasi pemilik
CR-010 1-1110 Cash In Bank p15.000.000,00

CR-010 31100 Rasela Marta's Capital

Grand Total:  p50.000.000,00

p15.000.000,00

p50.000.000,00
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. g. Lembar Kerja Peserta Didik

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh

peserta didik di komputer melalui program MYOB versi 18.

Kasus 7.1 : Kasus UD Rasela Media Mandiri.

Entri Transaksi Pengeluaran Kas (Spend Money - Cash In Bank)

=
BuktiMo: 31
UD. RASEL MEDIA MANDIRI CASH PAYMENT
1l F'. | Rayal7 P | CASH CHEQUE
- amu a”g | :’: PEMUENG I hate 25 Januari 2013 25 Januari 2013
angerang seitan Doc CP-009 CP-009
CASH PAYMENT
Amount: Rp.1.500.000 -
Satu juta lima ratus ribu Rupigh
Details:
Mo Explanations Amount (Rph TAX
1 Supplies Inventory 650.000,- N.T
2 Telephone 450,000 - N.T
3 Water 150.000- | MNT
4 Speedy-Internet 250:000,- | MNT
Total Payment 1.500.000 -
Pemilik Perusahaan Cashier Teknizi Akuntansi
Rasela Marta Maya
BuktiNo: 32
UD. RASEL MEDIA MANDIRI CASH PAYMENT
1l F'. | Rayal7, P | CASH CHEQUE
- am a'”g | i‘: (PEMUENG TPt 26 Januari 2013 26 Januari 2013
angerang seitan Doc CP-010 CP-010
CASH PAYMENT
Amount: Rp.11.500.000,-
Sebelas juta lima ratus ribu Rupiah.
Details:
Mo Explanations Amaunt TAX
1 Other Employers Expenses 200,000 -
2 Wages and Salaries 2.500.000,-
3 Income Tax Payable 8.275.000 -
4 | Electricity 525.000,-
Tatal Payment 11.500.000, -
Pemilik Perusahaan Cashier Teknizi Akuntansi
Rasela Marta Maya
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Entri Transaksi Pengeluaran Kas Kecil (Spend Money - Petty Cash)

| BuktiNo: 33
UD. RASEL MEDIA MANDIRI PETTY CASH VOUCHER
JI. Pamulang Raya 17, Pamulang Date 27 Januari 2013
Tangerang Selatan NG PC-001
PETTY CASH VOUCHER
Armcunt: Rp. 600.000-
|Ermmmtus ribu Rupiah.
Details:
Mo Explanations Amount TAX
1 Postage 100.000,-
2 Subscriptions 300.000,-
3 In-Store Promation 200.000,-
Total Payment &00.000,-
Pemilik Perusahaan Petty Cashier Teknisi Akuntansi
Rasela Marta Yoyo
| BuktiNo: 34
UD. RASEL MEDIA MANDIRI PETTY CASH VOUCHER
Jl. Pamulang Raya 17, Pamulang Date 28 Januari 2013
Tangerang Selatan MO PC-002]
PETTY CASH VOUCHER
Amcunt: Rp.700.000-
| Tujuh rotus ribu Rupiah.
Details:
Mo Explanations Amount TAX
1 Staff Amenities 200.000,-
2 Cleaning Service 300.000,-
3 Maintenancs 200.000,-
Total Payment F00.000,-
Permilik Perusahaan Petty Cashier Teknisi Akuntansi
Rasela Marta Yoyo
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Penerimaan Kas (Receive Money)

| BuktiNo: 35
CASH RECEIPT
UD.RASEL MEDIA MANDIRI CASH CHEQUE
JIl. Pamulang Raya 17, Pamulang Date 29 Januari 2013 29 Januari 2013
Tangerang Selatan N CR-009 p-12
CA5H RECEIPT
Armount: Rp. 35.000.000,-
Tiga puluh lima jute Rupiah.
Details:
Mo Description Amount TAX
Rp.
1 Setoran modal dari pemilik perusahaan 35.000.000,- -
Total 35.000.000,- -
Pemilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya
| BuktiNo: 36
CASH RECEIPT
UD.RASEL MEDIA MANDIRI CASH CHEQUE
JI. Pamulang Raya 17, Pamulang Date 30 Januari 2013 30 Januari 2013
Tangerang Selatan N CR-010 X-10
CA5H RECEIPT
Armount: Rp. 15.000.000,-
Lima belas juta Rupiah.
Details:
Mo Description Amount TAX
Rp.
1 Setoran modal dari pemilik perusahaan 15.000.000,- -
Total 15.000.000,- -
Pemilik Perusahaan Cashier Teknisi Akuntansi
Rasela Marta Maya
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Kasus 7.2 : Kasus UD Riola Media Mandiri.

Entri Transaksi Pengeluaran Kas (Spend Money - Cash In Bank)

| BuktiNo : 31
CASH PAYMENT
\L‘IJIDF; RIDII_A M:I]lﬁ:i;’A:DIRlI CASH CHEQUE
- PAMUISNg MAYS 1, FamuiEng Date 25 Januari 2013 25 Januar 2013
Tangerang Selatan
Doc CP-00% CP-00%
CASH PAYMENT
Amaount: Rp.. 1.500.000.-
Saty juta ima ratus ribu Rupiah
Dietaile:
Mo Explanationz Amount {Rp). TAX
1 Supplies Imerntory 6R0000-1 NT
2 Telzphane 450000-1 NT
3 Water 150.000 - NT
4 Speedy-Intemet 200000-1 NT
Total Paymert 1.500.000 -
Pemilik Perusahaan Cashier Teknisi Akuntansi
Ricla Marta Maya
Buktino : 32
CASH PAYMENT
‘l.jlll]F., RIDII_A M:DIA:HTA;'IDIRII CASH CHEQUE
- ramuiang Rays 1, ramuiang Date 76 Januari 2013 76 Januari 2013
Tangerang Salatan
Doc CP-010 CP-010
CASH PAYMENT
Amaount: Rp. 11.500.000 -
Sebelas juta fima ratus ribu Rupiah.
Details:
Mo Explanationz Amount TAX
1 OtherEmployers Expanses 200000 -
2 Wages and Salanss 2500000 -
3 Income Tax Payabls 8.275.000 -
4 Electncity 525000 -
Total Payment 11.500.000 -
Pemilik Perusahaan Cashier Teknisi Akuntansi
Riola Marta Maya
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Entri Transaksi Pengeluaran Kas Kecil (Spend Money - Petty Cash)

| BuktiNo : 33
UD. RIOLA MEDIA MANDIRI PETTY CASH VOUCHER
JI. Pamulang Raya 17, Famulang Date 27 Januari 2013
Tangerang Selatan NG PC-00
PETTY CASH VOUCHER
Amount: Rp.. 600.000,-
|Enam ratus ribu Rupiah.
Details:
Mo Explanationz Amount TAX
1 Postage 100.000 -
2 Subscrptions 300.000 -
3 In-Store Promotion 200.000 -
Tatal Payment 600.000 -
Pemilik Perusahaan Petty Cashier Teknisi Akuntansi
Riola Marta Yoyo
| BuktiNo : 34
UD. RIOLA MEDIA MANDIRI PETTY CASH VOUCHER
JI. Pamulang Raya 17, Pamulang Date 28 Januari 2013
Tangerang Selatan NG PC-002
PETTY CASH VOUCHER
Amount; Rp.. 700.000, -
|Tujuh ratus ribu Rupiah.
Details:
Mo Explanations Amaunt TAX
1 Staff Amenites 200000 -
2 Clzaning Senvice 300000 -
3 Maintenance 200000 -
Tatal Paymert 700,000 -
Pemilik Perusahaan Petty Cashier Teknisi Akuntansi
Riola Marta Yoyo
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Transaksi Penerimaan Kas (Receive Money)

BuktiMo : 35
CASH RECEIPT
UD. RIOLA MEDIA MANDIRI CASH CHEQUE
JI. Pamulang Raya 17, Pamulang Date 29 Januari 2013 29 Januari 2013
Tangerang Selatan MO CR-008 P-12
CASH RECEIPT
Amount: Rp. 35.0:00.000 -
Tiga puluh fma juta Rupiah.
Dietails:
No Description A rg;“”‘ TAX
1 Setoran modal dar pemilk peruzahaan 35.0000000 - -
Tatal 35.000.000- -
Pemilik Perusshaan Cashier Teknisi Akuntansi
Riola Marta Maya
BuktiNo : 36
CASH RECEIPT
UD. RIOLA MEDIA MANDIRI CAsH CHEQUE
JI. Pamulang Raya 17, Famulang Date 30 Januari 2013 30 Januari 2013
Tangerang Selatan MO CR-010 ®-10
CASH RECEIPT
Amount; Rp. 15.000.000,-
Lima beias juta Rupiah.
Details:
No Description A ”R"L“"‘ TAX
1 Setoran madal dan pemilik perusahaan 15.000.000 - -
Total 15.000.000 - -
Pemilik Perusshaan Cashier Teknisi Akuntansi
Riola Marta Maya
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Kegiatan Belajar 8
Mengentri Transaksi Penyesuaian

r a. Tujuan Pembelajaran

Dengan diberikan kasus akuntansi perusahaan dagang, maka pada
akhir sesi ini diharapkan peserta didik dapat:

1. Mencatat transaksi penyesuaian untuk depresiasi aktiva tetap

2. Mencatat transaksi penyesuaian untuk beban supplies

3. Mencatat transaksi penyesuaian untuk kerusakan barang dagangan
4. Mencatat transaksi penyesuaian untuk rekonsiliasi akun Cash in Bank

\‘5\) b. Uraian Materi

Lingkup uraian materi pada kegiatan belajar 1 ini meliputi:

1. Entri transaksi penyesuaian untuk depresiasi aktiva tetap

2. Entri transaksi penyesuaian untuk beban supplies

3. Entri transaksi penyesuaian untuk kerusakan barang dagangan
4. Entri transaksi penyesuaian untuk rekonsiliasi akun Cash in Bank

Program MYOB menyediakan menu pilihan Record Journal Entry untuk mengentri
transaksi penyesuaian pada akhir periode akuntansi. Praktek entri transaksi
penyesuaian ini didasarkan pada Kasus UD. Rasel Media Mandiri.

[mvos] ACCOUNTS 2|
ek 1L R
Accounts Banking Sales Time B.iﬁng Purchases Payroll Inventory Card File

2 BASlink

.- MoneyContraoller .. 5

: : Record Journal Entry -« @ Company Data Auditor
-+ Transfer Money -* :
: .‘ Mézgr:;md (D
------------------------ @ Transaction Journal o Pl ol
ToDoList » Find Transactions w Reports w Analysis w

Gambar 2. 66 Menu Accounts - Record Journal Entry
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1. Entri Transaksi penyesuaian untuk depresiasi aktiva tetap

Hal-hal yang perlu diperhatikan:
a) Memeriksa hasil perhitungan depresiasi aktiva tetap di dokumen.
b) Dokumen sumber : Bukti No: 37

BuktiMo: 37
UD. RASEL MEDIA MANDIRI MEMORANDUM
JI, Pamulang Raya 17, Pamulang Date 31 Januari 2013
Tangerang Selatan Memo # MM-001
MEMORANDUM
KepadaBagian: 1. Teknisi Akuntansi Dari: Pemilik Perusahaan
Mo Explanaticns Arncunt (Rp.)
1 Depreasiasi Store Equipments—Jan 2013 800.000,-
2 Depreasiasi Demo Equipments—Jan 2013 300.000,-
3 Depreasiasi Cffice Equipments — Jan 2013 500.000,-
4 Depreasiasi Furniture Equipments—Jan 2013 600.000,-
5 Beban Cffice Supplies 1.200.000,-
] Beban Store Supplies 1.800.000.-
Pemilik Perusahaan | s Teknisi Akuntansi
Rasela Marta

1 Klik Command Centre Account > Record Journal Entry. Kemudian isi data
sesuai dengan dokumen sumber (Bukti No. 37) di atas.

(] Record Journal Entry === 1&

Display in GST [BAS] reparts as:  Sale (Supply)

@ Purchase (Acquisition) [ TaxInclusive

General Journal #: f M-001

Date: [31/0172013 |

/v Memo: | Entii penyesuaian

Acct # Name Debit Credit Job Memo Taxr
6-1300 |Depreciation Rp2.200.000,00 N-T -
12120 |Store Equip - Accum Dep'n RpB00.000,00 | N-T
/ 1-2320 }Demo Equip - Accum Dep'n Rp300.000,00 | N-T
1-2420 |Office Equip- Accum Dep'n Rp500.000,00 | N-T
1-2520 |Furniture Equip- Accum Dep'n RpE00.000,00 | N-T I
| | v

= 55900000 N0
Total Debit:| Rp2.200.000,00
Total Credit|  Rp2.200.000,00
Tax & Rp0,00

Out of Balance: | HpD,Ulj

(®) Save asRecuring | (&) Use Aecuring

Gambar 2. 67 Transaksi Depresiasi Aktiva Tetap
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2 cek Jurnal dengan cara klik Command Centre Acount > Transaction Journal.
Sesuaikan tanggal dari 1/1/2013 s.d. 31/1/2013.

(] Transaction Journal = B[]
| 4
General ' Disbursements ' Receipts t Sales I Purchases t Inventory t Al _
Dated From: |01/01/2013 To: [ 31/01/2013
1D From: [ To: [
Date  ID# Account Debit Credit Job _‘
o 31/01/2013 Enti penyesuaian depresiasi aktiva tetap
M-001 6-1300 Depreciation Rp2.200.000,00
h-001 1-2120  Store Equip - Accum Dep't Rp800.000,00
h-001 1-2320 Demo Equip - Accum Dep Rp300.000,00
MM-001 1-2420 Office Equip- Accum Dep't Rp500.000,00
h-001 1-2520  Furniture Equip- Accum De Rp600.000,00

7/.3-{)

Help F1 Print

Gambar 2. 68 Jurnal Transaksi Depresiasi Aktiva Tetap

2. Transaksi penyesuaian untuk beban supplies

Hal-hal yang perlu diperhatikan:
a) Memeriksa menghitung/memeriksa hasil perhitungan beban supplies
b) Dokumen sumber : Bukti No: 37

BuktiMo: 327
UD. RASEL MEDIA MANDIRI MEMORANDUM
JI. Pamulang Raya 17, Pamulang Date 31 Januari 2013
Tangerang Selatan Mermo# MM-001
MEMORANDUM
KepadaBagian: 1. Teknisi Akuntansi Dari: Permilik Perusahaan
Mo Explanaticns Armount (Rp)
1 Depreasiasi Store Equipments— Jan 2013 800.000.-
2 Depreasiasi Demo Equipments - Jan 2013 300.000.-
3 Depreasiasi Cffice Equipments — Jan 2013 500.000,-
4 Depreasiasi Furniture Equipments—Jan 2013 600.000,-
5 Beban Office Supplies 1,200,000, -
b Beban Store Supplies 1.800.000.-
Pemilik Perusahaan | e, Teknisi Akuntansi
Rasela Marta
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Praktekkan langkah-langkah berikut:

1 Klik Command Centre Account > Record Journal Entry. Kemudian isi data
sesuai dengan dokumen sumber (Bukti No. 37).

@RecordJoumal Entry [E=H ] @

Display in GST [BAS] reparts as:  Sale (Supply)
@ Purchase (Acquisition) [ TaxInclusive

General Journal #: { M-001
Date: [31/01/2013 |

Memo: | Penyesuaian beban supplies

Acct # Name Debit Credit Job Memo Taxr
61500 |Dffice Supplies Rp1.200.000,00 | N-T
6-4800 |Store Supplies Rp1.800.000,00 N-T
11410 |Supplies Inventory Rp3.000.000,00/| = N-T

T
Total Debit:|  Rp3.000.000,00

Total Credt:|  Rp3.000.000,00
Tax & Rp0,00
Out of Balance: | HpD,Dlj

(8) Save as Recuring | (4]

7. &

9w 5

Gambar 2. 69 Transaksi Beban Supplies

Cek Jurnal dengan cara klik Command Centre Acount > Transaction Journal.
Sesuaikan tanggal dari 1/1/2013 s.d. 31/1/2013.

=
(] Transaction Journal =[5 ]
| 4
General ' Disbursements ' Heceipﬁgrsﬁt Sales ' Purchases t Inyenloryir Al -
Dated From: |01/01/2013 To: [31 /0172013
1D From: [7 Te:|
Date ID# Account Debit Credit Job J
-
=] 31/01/2013 Entri penyesuaian depresiasi aktiva tetap
h-001 61300 Depreciation Rp2.200.000,00
h-001 1-2120  Store Equip - Accum Dep't Rp800.000,00
h-001 1-2320 Demo Equip - Accum Dep Rp300.000,00
hM-001 1-2420  Office Equip- Accum Dep't Rp500.000,00
hM-001 1-2520  Furniture Equip- Accum De Rp600.000,00
7. | =)
HelpF1 | Print

Gambar 2. 70 Jurnal Transaksi Beban Supplies
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3. Entri Transaksi penyesuaian untuk kerusakan barang dagangan
Hal-hal yang perlu diperhatikan:
a) Memeriksa cost dari item-item rusak dan akan dihapus.
b) Dokumen sumber : Bukti No: 38

]
|BuktiNo: 38
UD. RASEL MEDIA MANDIRI MEMORANDUM
NI, Pamulang Raya 17, Pamulang Date 31 Januari 2013
Tangerang Selatan Memo # | MM-002
MEMORANDUM

Kepada: 1. Teknisi Akuntansi
2. Gudang

I=i Memo:

Daris Pemilik Perusahaan

1. Selesaikan Bank Rekonsiliasi untuk akun CashIn Bank per 31 Januari 2013 [Rekening
Keorang terlampir)
2. Segeradiproses penghapusan untuk item-item berikut karena kerusakan fisik:

Kerusakan fisik untuk item-item berikut:

Item Mo Description Oty Cost/Unit Rp. Total Rp. TAX
1 COM-001 | HPProbook 44215 1 9,130,000, - 9.130.000, - -
2 PRM-002 | CanonBj-555 1 360.000 - 360.000 - -
Pemilik Perusahaan | e Teknisi Akuntansi
Rasela Marta
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Praktekkan langkah-langkah berikut:

1 Klik Command Centre Inventory > Adjustment Inventory. Kemudian isi data

sesuai dengan dokumen sumber. Untuk quantiti diawali dengan tanda “-“ (minus)
(8] Adjust Inventory = E=E
Inventory Journal Number: | MM-002Z |
Date: W
/ Memo: |Entii penyesuaiar|
Item Number Quantity Unit Cost Amount Account Job Memo
oCOM-001 -1| p9.180.000,00((Rp9.180.000,00) 6-4300 |
7| | |=rrn00z -1/ Rp360.000,00, (Rp360.000,00) 6-4300
|

DR =5

Gambar 2. 71 Transaksi Penghapusan Item Persediaan

2 Cek Jurnal dengan cara klik Command Centre Inventory > Transaction Journal.
Sesuaikan tanggal dari 1/1/2013 s.d. 31/1/2013.

@ Transaction Journal i’[ﬂ‘@

| 4
_Qeneral l V_D__i_sbursements ! Receip_gs t Sales I Egr_chases '

J/'Dated From: [01/01/2013 Ta: [3170172013

1D From: | To: |
Date ID# Account Debit Credit Job
= 31/01/2013 Entri penyesuaian _:J
M-002 6-4900 Merchandise Spoilage Fip9.540.000,00
M-002 11310 Inventory - Computers Fp9.180.000,00
M-002 11320  Inventory - Printers Rp360.000,00
v

7. =

Help F1 Print

Gambar 2. 72 Jurnal Transaksi Penghapusan ltem Persediaan
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4. Transaksi penyesuaian untuk rekonsiliasi akun Cash In Bank
Hal-hal yang perlu diperhatikan:
a) Rekening Koran dari Bank per tanggal 31/1/2013
b) Dokumen sumber : Rek. Koran Bank Mandiri.

BANK MANDIRI
STATEMENT OF ACCOUNT
FROM 01/01/2013 TO 31012013
ACCOUNT NAME RIOLA MEDIA MANDIRI
ACCOUNT NUMBER 48213457896
DATE DoC TRANS AMOUNT BALANCE
DEPOSITS WITHDRAWALS
01/01/2011 0o Rp 210.000.000
06/01/2011|CR-001 01 Rp  96.100.000 Rp 306.100.000
07/01/2011|CR-002 01 Rp  77.100.000 Rp 383.200.000
10/01/2011|CP-001 02 Rp  15.840000 | Rp 367.360.000
11/01/2011|CP-002 02 Rp 18.260.000 | Rp  349.100.000
12/01/2011|CR-003 01 Rp 209.000.000 Rp  552.100.000
12/01/2011|CR-004 01 Rp 66.000.000 Rp  624.100.000
13,/01/2011|CR-005 01 Rp 157.904.000 Rp  782.004.000
13/01/2011|CR-006 01 Rp 98.262.000 Rp  830.266.000
19/01/2011|CP-003 02 Rp  75.800.000 | Rp 204.466.000
20/01/2011|CP-004 02 Rp  89.100000 | Rp 715.366.000
21/01/2011|CR-007 01 Rp 10.821.250 Rp 726.187.250
22/01/2011|CR-008 01 Rp 12.716.000 Rp 738.903.250
23/01/2011|CP-005 02 Rp 110.000.000 | Rp £628.903.250
24/01/2011|CP-007 02 Rp 125.900.000 | Rp 435.003.250
24/01/2011|CP-008 02 Rp 244.279.000 | Rp 194.724.250
25/01/2011|CP-009 02 Rp 1.500.000 | Rp 193.224.250
29/01/2011|CR-009 01 Rp  35.000.000 Rp 228224250
31/01/2011|RK-123 03 Rp 1.750.000 | Rp 226.474.250
31/01/2011|RK-123 04 Rp 4.500.000 Rp 230.974.250
Kode Transaksi: Pamulang, 31 lanuari 2013
0o = Balance Kepala KCP MANDIRI PAMULANG
01 = Deposit
02 = Withdrawal
03 = Bank Charges
04 = Interest Geol Hutagalung

198 Direktorat Pembinaan SMK (2013)




Komputer Akuntansi Jilid 2
Praktekkan langkah-langkah berikut:

1 Klik Command Centre Banking > Reconcile Accounts. Pastikan bahwa Account:
1-1110 Cash In Bank. Kemudian ketik Saldo RK sebesar 230974250 di kolom New
Statement Balance dan ketik tanggal 31/1/2013 tekan [Enter].

Klik mouse di kolom paling kiri [ v] untuk jumlah-jumlah yang ada di catatan
perusahaan ( tercatat di komputer ) dan ada juga di rekening koran (catatan di

bank).
@ Reconcile Accounts =a S
Account: |1-1110 3| CashInBank New Statement Balance]3p230.974.250,00
ﬁgeconciled Date: Calculated Statem alance: Rp230.974.250,00
Bank Statement Date: Taﬂﬁﬁﬁﬁ* Out of Balance: Rp0,00

Mark All Cleared Transactions Deposits Withdrawals:
06/01/2013 COUNTER SALES for CR-001 Rp96.100.000,00
07/01/2013 COUNTER SALES for CR-002 Rp77.100.000,00
10/01/2013 COUNTER SALES Rp15.840.000,00
11/01/2013 COUNTER SALES Rp18.260.000,00
12/01/2013  Payment; Toko Ganesha Unaqul Rp209.000.000,00
12/01/2013  Payment; Toko Global Persada Rp6E.000.000,00
13/01/2013  Payment; Toko Ganesha Unaqul Rp157.904.000,00
13/01/2013  Payment; Toko Global Persada Rp98.262.000,00
19/01/2013  CASH PURCHASE Rp75.800.000,00
20/01/2013 CASH PURCHASE Fp89.100.000,00
21/01/2013 CASH PURCHASE: Debit from CR-007 Rp10.821.250,00
22/01/2013 CASH PURCHASE: Debit from CR-008 Rp12.716.000,00
23/01/2013  PT Merbabu Rava Rp110.000.000,00
23/01/2013  PT Merapi Abadi Rp77.000.000,00
24/01/2013  PT Merbabu Rava Rp183.900.000,00
24/01/2013  PT Merapi Abadi Rp244.279.000,00
25/01/2013  Pembayaran beban operasi Rp1.500.000,00
© CP-010  26/01/2013 Pembayaran beban operasi perusahaan Rp11.500.000,00
© CR-009  29/01/2013 Tambahan investasi pemilik Rp35.000.000,00
© CR-010  30/01/2013 Tambahan investasi pemilik Rp15.000.000,00
© SC310113 31/01/2013  Bank charges Rp1.750.000,00
© [E310113 31/01/2013  Interet Income Rp4.500.000,00

RS R S RS A SRS RIS ASAS A ()

rii | §9* Bank Entry [ \"Q\,Qek Statement Cleared: Rp767.403.250,00 3p746.429.000,00

7. = B | =9
HepF1 |  Pint Date D#

Gambar 2. 73 Proses Rekonsiliasi Bank
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2 Khusus untuk Bank Charges dan Interest Income dicatat melalui Bank Entry. Jadi
Klik Bank Entry dan lihat pencatatan untuk kedua beban tersebut di gambar
berikut ini

(i8] Bank and Deposit Adjustments

Account; [Cash In Bank ¥ Taxlnclusive
Service Charg
Amount: | Rp1.750.000,00 Tax Code: [N-T F| Tax =: Rp0,00
ID #:|SC310113 Job: =
Date: | 31/01/2013

Expense Account: | 6-1200 ¥/ Bank Charges

Memo: | Bank charges

Interest Eamed

Amount: | Rp4.500.000,00 Tax Code: |N-T | Tax o Rp0.00

~ D #:[IE30113 Job: B
Date: | 31/01/2013
Income Account: | 8-1000 5| Interest Income

Memo: [Interet Income]

?v Cancel '| Record I

Help F1 -

Gambar 2. 74 Transaksi Bank Charges dan Interest Income

3 Untuk memeriksa bahwa proses rekonsiliasi sudah benar maka pastikan bahwa
saldo Out of Balance = 0 (Nol). Jika saldonya bukan Nol maka berarti proses
pencatatan transaksi pengeluaran/penerimaan Cash in Bank yang anda kerjakan
masih ada yang salah. Cek ulang !
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c. Rangkuman

Pencatatan transaksi penyesuaian dilakukan di akhir periode
akuntansi. Jika perusahaan menggunakan periode bulanan maka
pada setiap akhir bulan, dan jika periode tahunan maka pada setiap
akhir periode, misalnya 31/12. Untuk kasus UD Rasela Media
Mandiri menggunakan periode tahunan, tetapi setiap bulan
diharapkan dapat membuat laporan keuangannya.

Tidak seperti dalam entri-entri sebelumnya seperti entri di Sales,
Purchases, atau di Banking dimana jurnal dibuat secara otomatis
oleh komputer. Untuk jurnal penyesuaian ini penentuan akun-akun
mana yang didebit atau dikredit dilakukan oleh petugas (teknisi
akuntansi) yang mengoperasikan MYOB.

// e

‘\,//, d. Tugas
Berdasarkan Kasus 3.1. UD Rasela Media Mandiri yang ada pada
‘Lembar Kerja Peserta Didik’, kerjakan tugas-tugas berikut ini !

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per
kelompok.

2. Setiap peserta didik mengikuti langkah-langkah yang
dijabarkan dalam KB3 ini melalui kerjasama kelompok.

3. Tugas 1, Mencatat transaksi penyesuaian untuk depresiasi aktiva
tetap.

Tugas 2, Mencatat transaksi penyesuaian untuk beban supplies.

5. Tugas 3,Mencatat transaksi penyesuaian untuk kerusakan barang
dagangan

6. Tugas 4, Mencatat transaksi penyesuaian untuk rekonsiliasi akun
Cash in Bank.

Direktorat Pembinaan SMK (2013) 201




Komputer Akuntansi Jilid 2

[N

v
v

v

1.

e. Tes Formatif

Tes Pengetahuan.

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b,
c, d atau e dari setiap item soal pilihan ganda di bawabh ini:

1.

Langkah untuk mengentri transaksi penyesuaian:

"o TR

Account > Record Journal Entry > Pilih akun-akun di debit dan dikredit
Account > Memorial > Pilih akun-akun di debit dan dikredit

Account > General Journal > Pilih akun-akun di debit dan dikredit
Account > Journal Entry > Pilih akun-akun di debit dan dikredit
Account > Record Journal > Pilih akun-akun di debit dan dikredit

Langkah untuk mengentri penghapusan item persediaan:

PO TR

Inventory > Delete Inventory > Pilih item-item yang dihapus (Minus)
Account > Record Journal > Pilih item-item yang dihapus (Minus)
Inventory > Adjust Inventory > Pilih item-item yang dihapus (Plus)
Inventory > Adjust Inventory > Pilih item-item yang dihapus (Minus)
Account > Record Journal > Pilih item-item yang dihapus (Plus)

Langkah untuk membuat rekonsiliasi bank:

P TR

Account > Reconcile Accounts
Banking > Adjust Bank Accounts
Banking > Reconcile Accounts
Account > Adjust Bank Accounts
Banking > Set bank Accounts

Dalam proses rekonsiliasi jumlah tertentu akan diklik [ v' ] apabila:

a.
b.
c.
d.
e.

Jumlah tersebut tercatat di komputer saja

Jumlah tersebut tercatat di komputer dan tidak di rekening koran
Jumlah tersebut tidak tercatat di komputer dan tapi di rekening koran
Jumlah tersebut tercatat di rekening koran saja

Jumlah tersebut tercatat di komputer dan juga di rekening koran

Khusus untuk transaksi bank charges dan interest income dicatat di:

P oTR

Bank Entry

Banking > Spend Money dan Receive Money
Banking > Receive Money

Banking > Spend Money

Account > Record Journal Entry

Pencatatan entri penyesuaian diperlukan agar :

a.

b
c.
d.
e

Saldo akun-akun menunjukkan jumlah yang sesuai.

Saldo akun-akun menunjukkan jumlah yang seimbang
Saldo akun-akun menunjukkan jumlah yang sama.

Saldo akun-akun menunjukkan jumlah yang sesungguhnya.
Saldo akun-akun menunjukkan jumlah yang setara.

ALY

Direktorat Pembinaan SMK (2013)



Komputer Akuntansi Jilid 2
7. Rekening Koran yang diterima dari BCA melaporkan bahwa ada Interest
Income dan Bank Charge sejumlah tertentu. Transaksi ini akan berakibat
penyesuaian terhadap akun:
a. Bank Loan
b. Account Payable

c. Expense
d. Cashin Bank
e. Income

8. Selama periode akuntansi telah terjadi pemakaian supplies tetapi belum
diadakan pencatatan. Transaksi ini akan berakibat penyesuaian terhadap
akun-akun:

Dr: beban supplies dan Cr: Persediaan barang

Dr: Persediaan supplies dan Cr: Persediaan barang

Dr: Beban supplies dan Cr: Persediaan Supplies

Dr: Beban supplies dan Cr: Beban operasional

Dr: Beban operasional dan Cr: Persediaan supplies

9. Penggunaan aset tetap dalam kegiatan operasi pada akhir periode akan
menyebabkan penyesuaian terhadap akun-akun:

Dr: Akun aset tetap dan Cr: Depresiasi aset tetap

Dr: Akun aset tetap dan Cr: Akum. depresiasi aset tetap

Dr: Depresiasi aset tetap dan Cr: beban operasi

Dr: Akum. depresiasi aset tetap dan Cr: beban operasi

Dr: Depresiasi aset tetap dan Cr: Akum. depresiasi aset tetap.

10. Beban salary bulan Januari akan dibayarkan di awal Pebruari. Transaksi
ini akan berakibat penyesuaian terhadap akun-akun:
a. Dr: Beban salary dan Cr: Utang beban
b. Dr: Beban operasi dan Cr: Utang salary
c. Dr: Beban salary dan Cr: beban operasi
d
e

PO TO

Po0oT O

Dr: Beban salary dan Cr: Utang salary
Dr: Beban operasi dan Cr: Utang operasi

2. Tes Keterampilan.
Berdasarkan Kasus 3.2. UD Riola Media Mandiri yang ada pada ‘Lembar
Kerja Peserta Didik’, kerjakan tugas-tugas berikut ini !

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh peserta
didik secara berkelompok.

2. Pada akhir waktu tes diminta setiap peserta didik menyerahkan hasil
pekerjaannya dalam bentuk file.

3. Tugas 1, Mencatat transaksi penyesuaian untuk depresiasi aktiva tetap.
4. Tugas 2, Mencatat transaksi penyesuaian untuk beban supplies.

5. Tugas 3, Mencatat transaksi penyesuaian untuk kerusakan barang
dagangan

6. Tugas 4, Mencatat transaksi penyesuaian untuk rekonsiliasi akun Cash in
Bank.
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f. Kunci Jawaban Tes Formatif

<3

“"1. Kunci Tes Pengetahuan

1 a 6 d
2 e 7 d
3 (o 8 (o
4 e 9 e
5 a 10 d

2. Kunci Tes Keterampilan

Tugas 1, Transaksi penyesuaian untuk beban supplies dan depresiasi aktiva

tetap.
UD Riola Media Mandiri
JI. Pamulang Raya 17 PAMULANG
Tangerang Selatan
General Journal
31/01/2013 To 31/01/2013
06/03/2014 Page 1
9:39:18
ID# Acct# Account Name Debit Credit Job No.
GJ 3012013 Penyesuaian beban supplies
MM-001 6-1500 Office Supplies p1.200.000,00
MM-001 6-4800 Store Supplies p1.800.000,00
MM-001 1-1410 Supplies Inventory p3.000.000,00
GJ 31/01/2013  Entri penyesuaian depresiasi aktiva tetap
MM-001 6-1300 Depreciation p2.200.000,00
MM-001 1-2120 Store Equip - Accum Dep'n Rp&00.000,00
MM-001 1-2320 Demo Equip - Accum Dep'n Rp300.000,00
MM-001 1-2420 Office Equip- Accum Dep'n Rp500.000,00
MM-001 1-2520 Furniture Equip- Accum Dep'n RpG00.000,00
Grand Total: p5.200.000,00 p5.200.000,00
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Tugas 3, Transaksi penyesuaian untuk kerusakan barang dagangan

UD Riola Media Mandiri
JI. Pamulang Raya 17 PAMULANG
Tangerang Selatan

Inventory Journal

31/01/2013 To 31/01/2013

06/03/2014 Page 1
9:43:07
1D Acct# Account Name Debit Credit Job No.
1] 31/01/2013  Entri penyesuaian
MM-002 £-4900 Merchandise Spoilage p9.540.000,00
MM-002 1-1310 Inventory - Computers p9.180.000,00
MM-002 1-1320 Inventory - Printers Rp360.000,00

Grand Total:  p9.540.000,00  p9.540.000,00

Tugas 4, Transaksi penyesuaian untuk rekonsiliasi akun Cash in Bank.

UD Riola Media Mandiri
JI. Pamulang Raya 17 PAMULANG
Tangerang Selatan

Cash Receipts Journal

31/01/2013 To 31/01/2013

06/03/2014 Page 1
9:44:30
ID# Acct# Account Name Debit Credit Job No.
CR 31/012013  Interet Income
IE310113  1-1110 Cash In Bank p4.500.000,00
IE310113  8-1000 Interestincome p4.500.000,00

Grand Total:  p4.500.00000  p4.500.00000

UD Riola Media Mandiri
JI. Pamulang Raya 17 PAMULANG
Tangerang Selatan

Cash Disbursements Journal

31/01/2013 To 31/01/2013

06/03/2014 Page 1
9:45:37
1D# Acct# Account Name Debit Credit Job No.
cD 31/01/2013 Bank charges
5C310113  1-1110 Cash In Bank p1.750.000,00
SC310113 6-1200 Bank Charges p1.750.000,00

Grand Total:  p1.750.000,00  p1.750.000,00
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g. Lembar Kerja Peserta Didik

-

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh

peserta didik di komputer melalui program MYOB versi 18.

Kasus 8.1 : Kasus UD Rasela Media Mandiri.

Entri transaksi penyesuaian untuk depresiasi aktiva tetap & beban supplies.

| BuktiNo: 37 |
UD. RASEL MEDIA MANDIRI MEMORANDURM
JI. Pamulang Raya 17, Pamulang Date 31 Januari 2013
Tangerang Selatan Memo# | MM-001
MEMORANDUM
Kepada Bagian : 1. Teknisi Akuntansi Dari: Pemilik Perusahaan
Mo Explanaticns Arcunt [Rp.)
1 Depreasiasi Store Equipments = Jan 2013 &00.000.-
2 Depreasiasi Demeo Equipments—Jan 2013 300.000.-
3 Depreasiasi Office Equipments — Jan 2013 =00.000.-
4 Depreasiasi Furniture Equipments—Jan 2013 &00.000,-
5 Beban Office Supplies 1.200.000.-
B Beban Store Supplies 1.800.000 -
Pemilik Perusahaan | s, Teknisi Akuntansi
Rasela Marta
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Entri transaksi penyesuaian untuk kerusakan barang dagangan

(4]
| BuktiNo: 38
UD. RASEL MEDIA MANDIRI MEMORAMNDLUM
JI. Parmulang Raya 17, Pamulang Date 31 Januari 2013
Tangerang Selatan Memc# | MM-002
MEMORANDUM

Kepada: 1. Teknisi Akuntansi
2. Gudang

I=i Memo:

Dari: Pemilik Perusahaan

1. Selesaikan Bank Rekonsiliasi untuk akun Cash In Bank per 31 Januari 2013 (Rekening
Kerang terlampir)
2. Segeradiproses penghapusan untuk item-item berikut karena kerusakan fisik:

Kerusakan fisik untuk item-item berikut:

Item Mo Description Oty | Cost/Unit Rp. Total Rp. TAX
1 COM-001 | HP Probook 44215 1 9.1230.000, - 9,120,000, - -
2 PRM-002 Canon Bj-555 1 360.000,- 360.000,- -
Pemilik Perusahaan | i Teknisi Akuntansi
Razela Marta
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Entri transaksi penyesuaian untuk rekonsiliasi akun Cash in Bank

BANK MANDIRI
STATEMENT OF ACCOUNT
FROM 01/01/2013 TO  31/01/2013
ACCOUNT NAME RASEL MEDIA MAMNDIRI
ACCOUNT NUMBER 48213457896
DATE ooc TRAMS AMOUNT BALANCE
DEPOSITS WITHDRAWALS
01,/01/2011 0o Rp  210.000.000
06,/01/2011|CR-001 01 Rp  96.100.000 Rp  306.100.000
07,/01/2011|CR-002 01 Rp  77.100.000 Rp 383.200.000
10,/01/2011|cP-001 02 Rp 15.840.000 | Rp  367.350.000
11,/01/2011|cP-002 02 Rp 18.260.000 | Rp  349.100.000
12,/01/2011|CR-003 01 Rp 209.000.000 Rp  558100.000
12,/01/2011|CR-004 01 Rp  656.000.000 Rp  £24.100.000
13,/01/2011|CR-005 01 Rp 157.904.000 Rp 782.004.000
13,/01/2011|CR-006 01 Rp 98.262.000 Rp  BB0.266.000
19,/01/2011|cP-003 02 Rp 75.800.000 | Rp  804.456.000
20,/01/2011 |CP-004 0z Rp £8.100.000 | Rp  715.366.000
21,/01/2011|CR-007 01 Rp  10.821.250 Rp  726.187.250
22,/01/2011|CR-008 01 Rp  12.716.000 Rp  738.903.250
23,/01/2011|cP-005 0z Rp 110.000.000 | Rp  628.903.250
24/01/2011|cP-007 02 Rp 189.900.000 | Rp  439.003.250
24,/01/2011|cP-008 02 Rp 244270000 | Rp  194.724.250
25,/01/2011|cP-009 0z Rp 1.500.000 | Rp  193.224.250
29,/01/2011|CR-009 01 Rp  35.000.000 Rp 228224250
31,/01/2011 |RK-123 03 Rp 1.750.000 | Rp  226.474.250
31,/01/2011|RK-123 04 Rp 4.500.000 Rp 230.974.250
Kode Transaksi: Pamulang, 31 Januari 2013
oo = Balance Kepala KCP MANDIRI PAMULANG
ol = Deposit
0z = Withdrawal
03 = Bank Charges
04 = Interest Geol Hutagalung i
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Kasus 8.2 : Kasus UD Riola Media Mandiri.

Entri transaksi penyesuaian untuk depresiasi aktiva tetap & beban supplies.

| BuktiNo : 37 |
UD. RIOLA MEDIA MANDIRI MEMORANDUM
JI. Pamulang Raya 17, Pamulang Date 31 Januari 2013
Tangerang Selatan Memo # MM-00
MEMORANDUM
Kepada Bagian : 1. Teknisi Akuntansi Dari: Pemilik Perusahaan

No Explanations Amount (Rp.)

1 Depreasiasi Store Equipments — Jan 2013 00.0:00 -

2 Depreasizsi Demo Equipments — Jan 2013 00.000 -

3 Depreasiasi Office Equipments - Jan 2013 500.000 -

£ Depreasiasi Furniture Equipments — Jan 2013 600.000 -

] Beban Office Supplies 1.200.000,-

i] Beban Store Supplies 1.800.000,-

Pemilik Perusahaan | Teknisi Akuntansi

Riola Marta

Entri transaksi penyesuaian untuk kerusakan barang dagangan

| BuktiNo : 38
UD. RIOLA MEDIA MANDIRI MEMORANDUM
JI. Pamulang Raya 17, Pamulang Date 31 Januari 2013
Tangerang Selatan Mamao # MIM-002
MEMORANDUM

Kepada: 1. Teknisi Akuntansi
2. Gudang

Isi Memo:

1. Selesaikan Bank Rekonsiiasi untuk akun Cash In Bank per 31 Januari 2013 (Rekening Korang terlampir)

2. Segeradiproses penghapusan untuk item-item berikut karena kerusakan fisik:

Dari: Pemilik Perusahaan

Keruzakan fisik untuk item-item berikut:

[tem Ma Deszcrption Qty Cost/Unit Bp. Total Rp. TAX
1 COM001 HP Probook 4421s 1 9.180.000 - 9.180.000 - -
2 PRHA00Z Canon Bp955 1 360.000 - 360.000 - -
Pemilik Perusshaan | Teknisi Akuntansi
Riola Marta
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Entri transaksi penyesuaian untuk rekonsiliasi akun Cash in Bank

BANK MANDIRI
STATEMEMNT OF ACCOUNT
FROM 010172013 TO 30203
ACCOUNT NAME RIOLA MEDIA MANDIRI
ACCOUNT NUMBER 43213457896
DATE DocC TRANS AMOUNT BALANCE
DEPOSITS WITHDRAWALS
01,/01/2011 0o Rp 210.000.000
06/01/2011|CR-001 o1 Ep 96.100.000 Ep  306.100.000
07/01/2011|CR-002 o1 BEp 77.100.000 Ep  323.200.000
10/01/2011|CP-001 o2 Bp 15.340000 | Rp  367.360.000
11/01/2011|CP-002 o2 Ep 18260000 | Rp  249.100.000
12/01/2011|CR-003 o1 Ep 209.000.000 Ep  558.100.000
12/01/2011|CR-004 o1 BEp 66.000.000 Bp  624.100.000
13/01/2011|CR-005 o1 Ep 157.904.000 Bp  722.004.000
13/01/2011|CR-006 o1 Ep 93.262.000 Bp  820.266.000
19/01/2011|CP-003 o2 Ep 75.800000 | Rp  204.466.000
20/01/2011|CP-004 o2 Ep £9.100000 | Rp  715.366.000
21/01/2011|CR-007 01 Ep 10.821.250 Bp  726.187.250
22/01/2011|CR-008 01 Rp 12.716.000 Rp 738.903.250
23/01/2011|CP-005 o2 Rp 110.000.000 | Rp  628.903.250
24/01/2011|CP-007 oz Rp 189.900.000 | Rp  439.003.250
24/01/2011|CP-008 oz Rp 244279000 | Rp  194.724.250
25/01/2011|CP-009 oz Bp 1500000 | Rp  193.224250
29/01/2011|CR-009 o1 BEp  35.000.000 Bp 228224250
31/01/2011|RK-123 03 Bp 1750000 | Rp  226.474250
31/01/2011|RK-123 04 Rp 4.500.000 Rp  230.974.250
Kode Transaksi: Pamulang, 31 lanuari 2013
00 = Balance Kepala KCP MANDIRI PAMULANG
01 = Deposit
02 = Withdrawal
03 = Bank Charges
04 = Interest Geol Hutagalung
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Kegiatan Belajar 9
Membuat Laporan Keuangan

@ a. Tujuan Pembelajaran
J Dengan diberikan kasus akuntansi perusahaan dagang, maka pada

akhir sesi ini diharapkan peserta didik dapat:

1. Menyiapkan Laporan Laba Rugi
. Menyiapkan Laporan Neraca
. Menyiapkan Laporan Arus Kas

. Menyiapkan Laporan Piutang
. Menyiapkan Laporan Utang
. Menyiapkan Laporan Persediaan

\.>\) b. Uraian Materi

Lingkup uraian materi pada kegiatan belajar 9 ini meliputi:

Laporan Laba Rugi
Laporan Neraca
Laporan Arus Kas
Laporan Piutang
Laporan Utang
Laporan Persediaan

Program MYOB menyediakan berbagai menu REPORTS untuk menampilkan
laporan berbagai keuangan perusahaan

oghrwNE

File Edit Lists Command Centres Setup |Reports| Window Help

A sting of all accounts and their balances.

Last Year Analysis -
Budget Analysis

udget

Profit & Loss
Proft & Loss [Accud] _j
Muli-Pericd Spreadshest
Multi-Period Budget Spreadsheet
Year to Date
Last Year
Percent Saes Analysis
Last Year Analsis
Budge! Analysis

Small Business Entity

| Account Transactions [Cash] ~|

& View Sample | i Custormse

Gambar 2. 75 Menu Reports
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1. Pembuatan Laporan Laba-Rugi

Hal-hal yang perlu diperhatikan:
a) Periode laporan Laba-Rugi yaitu 1/1/2013 s.d. 31/1/2013

b) Ada dua cara, ke-1 yaitu Reports > Index to Reports (posisi menu
diatas) atau Cara ke-2 Reports > Accounts > Accounts (posisi menu
di bawah.

Langkah-langkah:

1 Klik menu Reports > Index to Reports > Tab Accounts > Profit & Loss
(Accrual) > Customise

g e
File Edit Lists Command Centres Setup Window  Help

Index to Reports Ctri+1 s (
o Report Batches ?
(&) UD Rasela Media Mandiri - Command =R '€
?@ Index to Reports
| &
Accounts I Banking I s isr'(l .Yume T Puchases I Payrol T Inwertory
rd a8 4k
P>
A §isting of all accounts and their balances
Last Year An:&m
Budget Analysiz
Profit & Loss
/meu & Loss [Acciud] _]
Muti-Pencd Spreadshest

Muli-Period Budget Spreadshest

Yeaito Date
Last Year
Percent Sdes Analsis l
Last Year Anabsais
(st

Budge! Analyss

Small Business Entity
Account Transachons [Cash] .t l
& View Sample Customse

Gambar 2. 76 Menu Reports — Profit & Loss

2 Ketik periode 1/1/2013 to 31/1/2013, kemudian klik Display.
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Komputer Akuntansi Jilid 2

UD Rasela Media Mandiri
JI. Pamulang Raya 17 PAMULANG
Tangerang Selatan

Profit & Loss Statement

January 2013

Income
Sales
Sales - Computers
Sales - Printers
Freight Collected
Total Income

Cost of Goods Sold
COGS - Computer
COGS - Printer
Sales Discounts

Total Cost of Goods Sold

Gross Profit

Expenses
General & Administrative Exp
Bank Charges
Depreciation
Subscriptions
Office Supplies
Purchase Discounts
Freight Paid
Advertising & Pramotion Exp
In-store Promotions
Operating Expenses
Maintenance
Postage
Speedy - Internet
Telephone
Water
Electricity
Cleaning
Store Supplies
Merchandise Spoilage
Employment Expenses
Staff Amenities
Wages & Salaries
Other Employer Expenses
Total Expenses

Operating Profit
Other Incomes
Interest Income
Total Other Incomes
Other Expenses

Met Profit/ (Loss)

Rp317.000.000,00
Rp47.400.000,00
Rpa70.000,00
Rp264.770.000,00

Rp214.000.000,00

Rp31.800.000,00

Rp5.944.000,00
Rp251.844.000,00

Rp112.926.000,00

Rp1.750.000,00
Rp2.200.000,00
Rp300.000,00
Rp1.200.000,00

(Rp14.160.000,00)
Rp294.250,00

Rp200.000,00

Rp200.000,00
Rp100.000,00
Rp250.000,00
Rp450.000,00
Rp150.000,00
Rp525.000,00
Rp300.000,00
Rp1.300.000,00
Rp9.540.000,00

Rp200.000,00

Rp2.500.000,00

Rp200.000,00
Rp7.999.250,00

Rp104.926.750,00

Rp4.500.000,00
Rp4.500.000,00

Rp109.426.750.00

Gambar 2. 77 Profit & Loss Report
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2. Pembuatan Laporan neraca

Hal-hal yang perlu diperhatikan:
a) Pertanggal laporan Neraca yaitu 31/1/2013

b) Ada dua cara, ke-1 yaitu Reports > Index to Reports (posisi menu

diatas) atau Cara ke-2 Reports > Accounts > Accounts (posisi menu
di bawah.

Langkah-langkah:

1 Klik menu Reports > Index to Reports > Tab Accounts > Standard
Balance Sheet > Customise

m:rﬁm' s iir'fl I Sakes I gg; r Purchases I Payrol T Inveriory

Uzing an accrual accounting method calcudates
Accourts List Detal - ncome, cost of sakes. expenses, other income and

Account Transactions [Acciual]

Account History [Officelink] _
General Ledger [Summary]

General Ledger [Detal]

4 Standaid Balance Sheel
Muli-Pencd Spreadsheet
Muli-Peniod Budget Spreadshest

Last Year Analpsis
Budget Analyses

@ View Sample |

other expense valuss lof the selecled penod(s)

Gambar 2. 78 Report — Balance Sheet

2 Pilih periode Januari , Ketik tanggal 31/1/2013, kemudian klik Display.
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UD Rasela Media Mandiri
JI. Pamulang Raya 17 PAMULANG
Tangerang Selatan

Balance Sheet

Komputer Akuntansi Jilid 2

As of January 2013
06/03/12014
9:19:09
Assets
Current Assets
Cash On Hand
Cash In Bank Rp157 474 250,00
Petty Cash Rp3.700.000,00

Merchandise Inventory
Inventory - Computers
Inventory - Printers

Other Current Assets
Supplies Inventory

Fixed Assets
Store Equipment

Store Equip - at Cost

Store Equip - Accum Dep'n
Demonstration Equipment

Demo Equip - at Cost

Demo Equip - Accum Depn
Office Equipment

Office Equip - at Cost

(Office Equip- Accum Dep'n
Furniture & Fixtures

Furniture Equip - at Cost

Furniture Equip- Accum Dep'n
Motor Vehicles

Motor Vehicles - at Cost

Total Assets

Liabilities
Current Liabilities
Account Payable
PPM Liabilities
PPN Collected
PPN Paid
Income Tax Payable
Long Term Liabilities
Mandiri Loan
Total Liabilities

Met Assets

Equity
Rasela Marta's Equity
Rasela Marta's Capital
Current Year Eamnings
Total Equity

Rp602.220.000,00
Rp30.165.000,00

Rp1.950.000,00
Rp100.000.000,00
(Rp10.800.000,00)

Rp20.000.000,00
(Rp2.300.000,00)

Rp60.000.000,00
(Rp12.500.000,00)

Rp&0.000.000,00
(Rp16.600.000,00)

Rp380.000.000,00

Rp380.000.000,00
Rp36.440.000,00
(Rp53.582.500,00)
Rp25.000,00

Rp300.000.000,00

Rp1.393.309.250,00

Rp662.882.500,00

Rp730.426.750,00

Rp621.000.000,00

Rp109.426.7¥50.00

Rp730.426.750,00

Gambar 2. 79 Standar Balance Sheet Report

Direktorat Pembinaan SMK (2013)

215




Komputer Akuntansi Jilid 2
3. Pembuatan Laporan Arus Kas

Hal-hal yang perlu diperhatikan:
a) Pertanggal laporan Neraca yaitu 31/1/2013
b) Melalui menu Reports > Index to Reports > Tab Banking

Langkah-langkah:

1 Klik menu Reports > Index to Reports > Tab Banking > Customise

(& MYOS Accounting

File Edit Lists Command Centres Setup [Reports| Window Help
Index to Reports Ctrl+l
Report Batches

(&) UD Rasels Media Mandin - C d

l Accounts Inm' s Is*:l J;;T chha:esT Paytol T Invertory

The Statement of Cash Flow reports the changes n
Cheques and Deposits - cash and cash equvalents duning a penod.
Bank Regater
Bank Depost Slp
Undeposted Funds
Electronic Papments Register
Unprocessed Electrornc Papments
Reconciiation Repoit

Cash Flow Analysic
MYOB M-Powered bank statements
Bank Statemerts
Account Balances
Tranzaction Engury

i\ﬁewSamale J

Gambar 2. 80 Menu Report- Statement of Cash Flow

2 Pilih periode Januari 1/1/2013 to January 31/1/2013, kemudian klik Display.
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UD Rasela Media Mandiri
JI. Pamulang Raya 17 PAMULAMNG
Tangerang Selatan

Statement of Cash Flow

06/03/2014
9:18:26

January 2013

Cash Flow from Operating Activities
Met Income

Account Receivable
Inventory - Computers
Inventory - Printers
Supplies Inventory
Account Payable
PPM Collected
PPM Paid
Income Tax Payable
Met Cash Flows from Operating Activities

Cash Flow from Investing Activities
Store Equip - Accum Dep'n
Demo Equip - Accum Dep'n
Office Equip- Accum Dep'n
Furniture Equip- Accum Dep'n
Motor Yehicles - at Cost
Met Cash Flows from Investing Activities

Cash Flow from Financing Activities
Rasela Marta's Capital
Met Cash Flows from Financing Activities

Met Increase/Decrease for the period
Cash atthe Beqinning of the period
Cash atthe End ofthe period

109.426.750,00

275.000.000,00
280.220.000,00)
Rp9.835.000,00
Rp2.250.000,00
193.000.000,00
p36.440.000,00
p53.582.500,00)

Rp8.275.000,00)

Rp200.000,00
Rp300.000,00
Rp500.000.00
RpG00.000,00

380.000.000,00)

p50.000.000,00

273.974.250,00

377.500.000,00)

p50.000.000,00

53825 750,00)
215.000.000,00
T61.174.250,00

———

Gambar 2. 81 Statement of Cash Flow Report
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4. Pembuatan Laporan Piutang

Hal-hal yang perlu diperhatikan:
a) Pertanggal laporan piutang yaitu 31/1/2013
b) Melalui menu Reports > Index to Reports > Tab Cards

Langkah-langkah:

1 Klik menu Reports > Index to Reports > Tab Cards > Customise

Index to Reports Ctrl+1
Report Batches

sis‘t{ ISa!exI 87;;' Puchases ' Payrol r lngtrii Card
_ Neme 0 Alist of the cards in your card file.

Card List Detai
Addieszes
Card Tranzactions
Contact Log
|dentifiers
GIS Card File

To Do List
Ovesdue Contacts

J

& View Sample

Gambar 2. 82 Menu Card Report

2 Pilih Customers, kemudian klik Display.

UD Rasela Media Mandiri
JI. Pamulang Raya 17 PAMULANG
Tangerang Selatan

Card List [Summary]
250112013 Page 1
16:27:06
Name Phone Type Current Balance Identifiers
COUNTER SALES Customer Rp0,00
Toko Ganesha Unggul 0217431270 Customer Rp0,00
Toko Global Persada 0217431271 Customer Rp0,00

Gambar 2. 83 Card List Report - Customers
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5. Pembuatan Laporan Utang

Hal-hal yang perlu diperhatikan:
a) Pertanggal laporan piutang yaitu 31/1/2013
b) Melalui menu Reports > Index to Reports > Tab Cards

Langkah-langkah:

1  Klik menu Reports > Index to Reports > Tab Cards > Customise

fm Window Help
Index to Reports Ctrl+1
Report Batches

si?r’g |Sahx| BY;I_‘;I Puchases ' Payrol I Inxeﬁzv Card

—— Alist of the cards in your card fle.

" Conds
!

Card Let Sur

Card List Detai
Addiestes
Card Tranzactions
Contact Log
Identifiers
GIS Card File

To Do List
Overdue Contacts

o View Sample

Gambar 2. 84 Menu Card List - Suppliers

2 Pilih Suppliers, kemudian Klik Display.

UD Rasela Media Mandiri
JI. Pamulang Raya 17 PAMULANG
Tangerang Selatan

Card List [Summary]
25/01/2013 Page 1
16:27:50
Name Phone Type Current Balance Identifiers

CASH PURCHASE Supplier Rp0,00

PT AUTO 2000 0217433322 Supplier p380.000.000,00

PT Merapi Abadi 0212335577 Supplier Rp0,00

PT Merbabu Raya 021 4433000 Supplier Rp0,00

Gambar 2. 85 Card List Report — Suppliers
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6. Pembuatan Laporan persediaan

Hal-hal yang perlu diperhatikan:

a) Pertanggal laporan Neraca yaitu 31/1/2013

b) Melalui menu Reports > Index to Reports > Inventory

Langkah-langkah:

1 Klik menu Reports > Index to Reports > Tab Inventory > Customise

Index to Reports

Ctrl+l

Report Batches

l GST/
Sales Tay

| Pricing

Items List Detail

|tems Regeter Summany

Itemss Regeter Detal

Item Transachons

|rwentoey Value Reconciiaion
Analyse Inventory Summary
Analyze lrventory Detal
Auto-Buid

Inventoey Count Shest

Sales History [Dfficelink]

Displays your fems. nchuding the primary supphes, units
on hand. total value of tems in nventory and the
cutrent zeling price of the dem.

Gambar 2. 86 Menu Item List Report

2 Pilih All , kemudian klik Display.

UD Rasela Media Mandiri
JI. Pamulang Raya 17 PAMULANG
Tangerang Selatan

Items List [Summary]

Grand Total:  2.385.000,00

2610112013 Page 1
7:00:38

Item # Item Name Units On Hand Total Value Average Cost Current Price
COM-001 HP Pro Book 4421s 29 6.220.000,00 9.180.000,00 Rp0,00
COM-002 HP Pro Book 5530 30 6.000.000,00 1.200.000,00 Rp0,00
PRN-001 Canon Lj-215 30 9.725.000,00 p657.500,00 Rp0,00
PRN-002 Canon Bj-555 29 0.440.000,00 p360.000,00 Rp0,00

Gambar 2. 87 Items List Report
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c¢. Rangkuman

Program MYOB memproses laporan keuangan secara otomatis
didasarkan pada seluruh transaksi yang telah dientri ke dalam
komputer. Berbagai laporan dapat dibuat melalui pemilihan menu-
menu yang tersedia, tetapi dalam modul ini difokuskan pada enam
laporan pokok, yaitu laporan Laba-Rugi, Neraca, Laporan Arus Kas,
Laporan Saldo Piutang dan Utang, serta laporan saldo persediaan.

Untuk menampilkan laporan keuangan perlu diperhatikan bebarapa
kriteria, antara lain jenis laporan yang diinginkan, pemilihan menu
yang tepat dan penentuan periode atau tanggal laporan. Laporan
keuangan yang dihasilkan dapat ditampilkan di layar komputer,
dieksport ke program excell ataupun dicetak (hard copy). Dalam
pembelajaran kali ini difokuskan pada tampilan di layar komputer.

Berdasarkan Kasus 9.1. UD Rasela Media Mandiri yang ada pada ‘Lembar
Kerja Peserta Didik’, kerjakan tugas-tugas berikut ini !

1.

© N o g bk~ ®

Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per
kelompok.

Setiap peserta didik mengikuti langkah-langkah yang dijabarkan dalam
KB3 ini melalui kerjasama kelompok.

Tugas 1, Menyiapkan Laporan Laba Rugi
Tugas 2, Menyiapkan Laporan Neraca
Tugas 3, Menyiapkan Laporan Arus Kas
Tugas 4, Menyiapkan Laporan Piutang
Tugas 5, Menyiapkan Laporan Utang
Tugas 6, Menyiapkan Laporan Persedia
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@k
Y

v
v

e. Tes Formatif

1. Tes Pengetahuan.

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b,
c, d atau e dari setiap item soal pilihan ganda di bawah ini:

1.

Langkah untuk menampilkan laporan Laba-Rugi:

a. Reports > Index to reports > Tab Account > Profit & Loss (Accrual)
b. Account > Index to reports > Tab Account > Profit & Loss

c. Reports > Tab Account > Index to reports > Profit & Loss (Accrual)
d. Account > Tab Account > Profit & Loss

e. Reports > Index to reports > Profit & Loss (Accrual)

Langkah untuk menampilkan laporan Neraca:

a. Reports > Index to reports > Balance > Standard Balance Sheet

b. Account > Index to reports > Standard Balance Sheet

c. Reports > Index to reports > Standard Balance Sheet

d. Index to reports > Reports > Standard Balance Sheet

e. Reports > Index to reports > Tab Account > Standard Balance Sheet
Langkah untuk menampilkan laporan Arus Kas:

a. Account > Index to reports > Tab Banking > Statement of Cash Flow
b. Banking > Index to reports > Statement of cash Flow

c. Banking > Reports > Statement of Cash Flow

d. Reports > Index to reports > Tab Banking > Statement of Cash Flow
e. Banking > Statement of cash Flow

Langkah untuk menampilkan laporan Piutang dan Utang:

a. Account > Index to reports > Tab Card > Card List Summary

b. Reports > Tab Card > Card List Summary

c. Account > Tab Card > Card List Summary

d. Reports > Index to reports > Tab Card > Card List Summary

e. Reports > Index to reports > Card List Summary

Langkah untuk menampilkan laporan persediaan:

a. Accounts > Index to reports > Tab Inventory > Items List Summary
b. Reports > Index to reports > Tab Inventory > Items List Summary

c. Accounts > Tab Inventory > Items List Summary

d. Reports > Index to reports > Items List Summary

e. Accounts > Index to reports > Items List Summary

Laporan yang memperlihatkan perincian persediaan supplies selama

periode akuntansi tertentu:

a. Laporan Laba-Rugi

b. Neraca

C. Laporan perubahan modal
d. ArusKas

e.

Catatan atas Laporan Keuangan
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Laporan keuangan adalah laporan yang bersifat finansial. Pilih mana yang
tidak termasuk laporan keuangan di bawah ini:

a. Laporan pemakaian supplies tiap bulan.

b. Laporan depresiasi aset tetap perusahaan.

c. Laporan kerusakan mobil perusahaan.

d. Laporan bulanan penjualan jasa per wilayah.

e. Laporan pembayaran listrik bulanan.

Laporan yang menginformasikan posisi aset, kewajiban dan equitas
perusahaan pada periode tertentu adalah:

a. Laporan Laba-Rugi

b. Neraca

c. Laporan perubahan modal
d. Arus Kas

e.

Catatan atas Laporan Keuangan

Laporan yang menginformasikan suatu ikhtisar pendapatan dan beban dari
sebuah perusahaan dalam satu periode akuntansi:

a. Laporan Laba-Rugi

b. Neraca

C. Laporan perubahan modal
d. ArusKas

e.

Catatan atas Laporan Keuangan
Langkah untuk menampilkan Jurnal Umum:

a. Account > Index to reports > Tab Banking > General Journal
b. Reports > Index to reports > Tab Account > General Journal
c. Reports > Index to reports > General Journal

d. Reports > Reports > General Journal

e. Reports > General Journal

2. Tes Keterampilan.

Berdasarkan Kasus 3.2. UD Riola Media Mandiri yang ada pada ‘Lembar
Kerja Peserta Didik’, kerjakan tugas-tugas berikut ini !

1.

© N O koW

Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh peserta
didik secara berkelompok.

Pada akhir waktu tes diminta setiap peserta didik menyerahkan hasil
pekerjaannya dalam bentuk file.

Tugas 1, Menyiapkan Laporan Laba Rugi
Tugas 2, Menyiapkan Laporan Neraca
Tugas 3, Menyiapkan Laporan Arus Kas
Tugas 4, Menyiapkan Laporan Piutang
Tugas 5, Menyiapkan Laporan Utang
Tugas 6, Menyiapkan Laporan Persediaan
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o/ f. Kunci Jawaban Tes Formatif

.
1. Kunci Tes Pengetahuan

1 a 6 e
2 e 7 c
3 d 8 b
4 d 9 a
5 b 10 b

2. Kunci Tes Keterampilan

Tugas 3, Menyiapkan Laporan Arus Kas

UD Riola Media Mandiri
JI. Pamulang Raya 17 PAMULANG
Tangerang Selatan
Statement of Cash Flow
January 2013

06/03/2014
9:13:20
Cash Flow from Operating Activities
Met Income 109.426.750,00

Account Receivable 275.000.000,00

Inventary - Computers 290.220.000,00)

Inventary - Printers Rp9.835.000,00

Supplies Inventory Rp2.350.000,00

Account Payable 193.000.000,00

PPM Collected p36.440.000,00

PPM Paid p53.582.500,00)

Income Tax Payable Rp8.275.000,00)
Met Cash Flows from Operating Activities 273.974 250 00
Cash Flow from Investing Activities

Store Equip - Accum Dep'n Rp&800.000,00

Demo Equip - Accum Depn Rp300.000,00

Office Equip- Accum Depn Rpa00.000,00

Furniture Equip- Accum Depn Rp600.000,00

Mator Vehicles - at Cost 380.000.000,00)
Met Cash Flows from Investing Activities 377.800.000,00)
Cash Flow from Financing Activities

Rasela Marta's Capital p5&0.000.000,00
Met Cash Flows from Financing Activities p50.000.000,00
Met Increase/Decrease for the period p53.825.750,00)
Cash atthe Beginning ofthe period 215.000.000,00
Cash atthe End of the period 161.174.250,00
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Tugas 1, Menyiapkan Laporan Laba Rugi

UD Riola Media Mandiri
JI. Pamulang Raya 17 PAMULANG
Tangerang Selatan

Profit & Loss Statement

January 2013

06/032014
1707

Incame
Sales
Sales - Computers
Sales - Printers
Freight Collected
Total Income

Cost of Goods Sold
COGS - Computer
COGS - Printer
Sales Discounts

Total Cost of Goods Sold

Gross Profit

Expenses
General & Administrative Exp
Bank Charges
Depreciation
Subscriptions
Office Supplies
Purchase Discounts
Freight Paid
Advertizing & Promotion Exp
In-store Promaotions
Operating Expenses
Maintenance
Fostage
Speedy - Internet
Telephone
Water
Electricity
Cleaning
Store Supplies
Merchandise Spoilage
Employment Expenses
Staff Amenities
Wages & Salaries
Other Employer Expenses
Total Expenses

Qperating Profit
Other Incomes
Interest Income
Total Other Incomes
Other Expenses

Met Profit/ (Loss)

Rp317.000.000,00
Rp47.400.000,00
Rp370.000,00
Rp364.770.000,00

Rp214.000.000,00

Rp31.900.000,00

Rp5.944.000,00
Rp251.844.000,00

Rp112.926.000,00

Rp1.750.000,00
Rp2.200.000,00
Rp300.000,00
Rp1.200.000,00

(Rp14.160.000,00)
Rp294.250,00

Rp200.000,00

Rp200.000,00
Rp100.000,00
Rp250.000,00
Rp450.000,00
Rp150.000,00
Rp525.000,00
Rp300.000,00

Rp1.800.000,00

Rp9.540.000,00

Rp200.000,00

Rp2.500.000,00

Rp200.000,00
Rp7.999.250,00

Rp104.926.750.00

Rp4.500.000,00
Rp4.500.000,00

Rp109.426.750,00
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Tugas 2, Menyiapkan Laporan Neraca

UD Riola Media Mandiri
JI. Pamulang Raya 17 PAMULANG
Tangerang Selatan

Balance Sheet

As of January 2013

06/03/2014
9:16:18
Assets
Current Assets
Cash On Hand
Cash In Bank Rp157.474 250,00
Petty Cash Rp3.700.000,00

Merchandise Inventory
Inventory - Computers
Inventory - Printers

Other Current Assets
Supplies Inventory

Fixed Assets
Store Equipment

Store Equip - at Cost

Store Equip - Accum Dep'n
Demonstration Equipment

Demo Equip - at Cost

Demao Equip - Accum Dep'n
Office Equipment

Office Equip - at Cost

Office Equip- Accum Dep'n
Furniture & Fixtures

Furniture Equip - at Cost

Furniture Equip- Accum Dep'n
Motor Vehicles

Motor Vehicles - at Cost

Total Azsets

Liabilities
Current Liabilities
Account Payable
PPN Liabilities
PPN Collected
PPN Paid
Income Tax Payable
Lang Term Liabilities
Mandiri Loan
Total Liabilities

Met Assets

Equity
Rasela Marta's Equity
Rasela Marta's Capital
Current Year Earnings
Total Equity

Rp602.220.000,00
Rp30.165.000,00

Rp1.950.000,00
Rp100.000.000,00
(Rp10.800.000,00)

Rp20.000.000,00
(Rp2.300.000,00)

Rp60.000.000,00
(Rp12.500.000,00)

Rp30.000.000,00
(Rp16.600.000,00)

Rp380.000.000,00

FpT1.393.309.250,00

Rp380.000.000,00
Rp36.440.000,00
(Rp53.582.500,00)
Rp25.000,00

Rp300.000.000,00

Rp662.882.500,00

Rp730.426.750 00

Rp621.000.000,00
Rp109.426.750,00
Rp730.426.750,00
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Tugas 4, Menyiapkan Laporan Piutang

UD Riola Media Mandiri
JI. Pamulang Raya 17 PAMULANG
Tangerang Selatan

Card List [Summary]
06/03/2014 Page 1
9:26:59
Name Phone Type Current Balance ldentifiers
COUNTER SALES Customer Rp0,00
Toko Ganesha Unggul 021 7431270 Customer Rp0,00
Toko Global Persada 021 7431271 Customer Rp0,00

Tugas 5, Menyiapkan Laporan Utang

UD Riola Media Mandiri
JI. Pamulang Raya 17 PAMULANG
Tangerang Selatan

Card List [Summary]

06/03/2014 Page 1
9:27:53
Name Phone Type Current Balance |dentifiers
CASH PURCHASE Supplier Rp0,00
PT AUTC 2000 0217433322 Supplier p380.000.000,00
PT Merapi Abadi 021 2335577 Supplier Rp0,00
PT Merbabu Raya 021 4433000 Supplier Rp0,00

Tugas 6, Menyiapkan Laporan Persediaan

UD Riola Media Mandiri
JI. Pamulang Raya 17 PAMULANG
Tangerang Selatan

Iltems List [Summary]

06/03/2014 Page 1
9:28:59

Item # Item Name Supplier Units On Hand Total Value Average Cost Current Price
COM-001 HF Pro Book 44215 29 5.220.000,00 9.180.000,00 Rp0,00
COM-002 HF Pro Book 5530 30 5.000.000,00 1.200.000,00 Rp0,00
PRN-001 Canon Lj-215 30 9.725.000,00 p657.500,00 Rp0,00
PRN-002 Canon Bj-555 29 0.440.000,00 p360.000,00 Rp0,00

Grand Total:  2.385.000,00
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- g. Lembar Kerja Peserta Didik

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh

peserta didik di komputer melalui program MYOB versi 18.

Kasus 9.1 : Kasus UD Rasela Media Mandiri.

Sebagai Teknisi Akuntansi anda diminta untuk memproses data akuntansi
bulan Januari 2013 dengan program MYOB dan menyusun Laporan
Keuangan:

Tugas 1, Menyiapkan Laporan Laba Rugi
Tugas 2, Menyiapkan Laporan Neraca
Tugas 3, Menyiapkan Laporan Arus Kas
Tugas 4, Menyiapkan Laporan Piutang
Tugas 5, Menyiapkan Laporan Utang

o ok~ whR

Tugas 6, Menyiapkan Laporan Persediaan

Kasus 9.2 : Kasus UD Riola Media Mandiri.

Sebagai Teknisi Akuntansi anda diminta untuk memproses data akuntansi
bulan Januari 2013 dengan program MYOB dan menyusun Laporan
Keuangan:

Tugas 1, Menyiapkan Laporan Laba Rugi
Tugas 2, Menyiapkan Laporan Neraca
Tugas 3, Menyiapkan Laporan Arus Kas
Tugas 4, Menyiapkan Laporan Piutang

Tugas 5, Menyiapkan Laporan Utang

o 0k~ whPRE

Tugas 6, Menyiapkan Laporan Persediaan

228 Direktorat Pembinaan SMK (2013)




Komputer Akuntansi Jilid 2
Kegiatan Belajar 10
Membuat File Backup

r ‘] a. Tujuan Pembelajaran

Dengan diberikan kasus akuntansi perusahaan dagang, maka pada
akhir sesi ini diharapkan peserta didik dapat:

1. Membuat backup file
2. Me-restore file backup

\&\) b. Uraian Materi

Program MYOB menyediakan menu File > BACKUP untuk membuat file
cadangan dan menu File > RESTORE untuk membuka backup file yang telah
dibuat sebelumnya.

| MYOB ntin
Edit Lists C d Centres Setup Rep Window Help
New Cirl+N
Open File Ctrl+ O

Close Window Esc

Print... Ctrl+P
Print Setup...
Default Fonts...

Back Up...
Restore...

Verify Company File...
Optimise Company File

Purge

St New Y » b o
LR T e Reconcile Accounts Prepare Bank Deposit

Import Data »

Export Data . ’ v m-powered (1)
AccountantLink * 3s ... @ Transaction Joumnal o S"m."‘?"

Exit
. ToDolist w» Find Transactions w Reports w Analysis w

Gambar 2. 88 Menu File Backup/Restore
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1. Pembuatan Backup file

Hal-hal yang perlu diperhatikan:

a) Pilihan tentang kelengkapan data yang akan dibuat backupnya dan
perlu tidaknya pengecekan kemungkinan adanya kesalahan data.

b) File Bakup merupakan ZIP File.
c) Melalui Menu File > Backup dan File > Restore

Langkah-langkah:

1 Klik menu File > Backup

(File| Edit Lists Command Centres Setup Reports Window Help
New Ctri+N ' :
Open File Ctri+0

ad

Close Windaw Fer

Print... Ctrl=P
Print Setup...
Default Fonts.,,

/ Back UP...

Restore...

Venfy Company File...
Optimise Company File

.- Bank Register e Rec2

Du:ge P

3
Start 3 New Year : Reconcile Accounts Prepare
mport Data

P &JN.}:‘MN"J

Gambar 2. 89 Menu File-Backup

2 Klik untuk opsi backup file: Bacup Company file dan Check for file errors, klik
Continue.

Direktorat Pembinaan SMK (2013)
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& . e

MYOB can back up the folders and files that support your company file, including
customised templates , BASlink setup, and graphics. Altematively, you can
choose to back up the company file and M-Powered Services Centre only.

(" Back up all data
' Backup Company File and M-Powered Services Centre only
ad

You may check the data in your company file for errors now, or check it later by
choosing Yerify Company File from the File menu. Depending on the size of your
company file, the verification process may take a considerable amount of time.

P 4 ' Check Company File for erors
" Do not check Company File for errors

Help I Cancel |

Gambar 2. 90 Opsi File Backup

2 Pilih Folder untuk menyimpan backup file dan ketik nama filenya dan klik Save
untuk menyimpan backup file.

(& Back Up.

LRI > 5™ » My Documerts » Gacup » S5

Organize v New folder

y

@ Documents = Name Date modified Type
J’ Music

L‘gjﬂ New Library
[&5] Pictures

B Videos

B MYOBRMM-1Backup 06/01/201317:38  WinRAR ZIP archive

+& Homegroup =

1% Computer
&, Local Disk (C:)
ca data (E)
< " »
File nai akcu RMM1 v
Saveg (MYOB Backup File (*2IP) -

4 Hide Folders

Gambar 2. 91 Save Backup File
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2. Membuka Restore Backup File

Hal-hal yang perlu diperhatikan:

a) Menentukan folder dan nama file yang akan di-restore

b) Menyimpan file restore dengan nama dan folder tertentu.
Langkah-langkah:

1 Klik menu File > Restore

/y@m Lists € dCentres Setup Reports Window Help
New Ctri+N
Open File Ctrl+ 0

Close Window Esc

BANKING

Print... Ctrl-P
Print Setup... ey

Default Fonts.., ~) ﬂ ﬁ m
Invventoty

Back Up... Time Biling F\n‘.hm Papcll
Restore...

/ Venfy Company File,..
Optimise Company File

L AR A

Mo

.- Bank Ragister - @ Receiye Monay

Purge

E ~ v
Start 2 New Year » b

Reconcile Accounts Prapare Bank Dep

AT b AAA A A D A A0 G

Gambar 2. 92 Menu File - Restore

2 Pilih File yang akan di restore, kemudian klik Open.

Organize v New folder

Eﬂ Back-up = Name
| Documents

P 4 | Bakeup RMML

Music
& MYOBRMM-1Backup

&l New Library
|/ Pictures
Videos

No preview available.

& Homegroup

1% Computer
&, Local Disk (C:)
ca data (E)

6‘! Network ~ i

File name: Bakcup RMML ~  [MY0B Data (*zIP) -

Open l[ Cancel ]

Gambar 2. 93 Memilih File Backup
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2 Ketik nama file yang akan di restore, kemudian klik Save.
(Il | » SN » MyDocuments » Backip <[4 [l Seorchiacke 2|

Organize ¥ New folder =~ @

@ Documents = Name Date modified Type
J’ Music

r'éﬁ New Library
[&5] Pictures

B videos

__| RMM-1AMYO 26/01/2013 11:26 MYO File

& Homegroup

1% Computer
&, Local Disk (C:)
ca data (E:)

v <

File narge:
Save as type: [MYOB Data (*.MYQ)

o~ ..

4 Hide Folders

Gambar 2. 94 Pemberian Nama Restore File

3 Klik OK untuk menyimpan file yang telah direstore.

"AMM-1.MY0" and saved in the directory named
"C:AUsers\TRIALAD ocumentshB ackuph."

@ The restored company file will be named

Cancel |

Gambar 2. 95 Konfirmasi Pemberian Nama Restore File
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c. Rangkuman

Untuk menjaga keutuhan data dari bahaya virus atau bahaya
lainnya maka data akuntansi yang diproses perlu dibuatkan file
cadangan atau Backup File. Ini perlu dilakukan di setiap akhir
periode akuntansi (setiap akhir bulan atau setiap akhir tahun).

Bakcup file merupakan file yang telah dikompres atau ZIP file
dimana Sizenya menjadi jauh lebih kecil dari file aslinya.

Untuk membuka kembali backup file menjadi file aslinya, maka
diperlukan proses Restore. File yang telah di-restore ini dapat
disimpan dengan nama dan folder yang baru.

Berdasarkan Kasus 9.1. UD Rasela Media Mandiri yang ada pada ‘Lembar
Kerja Peserta Didik’, kerjakan tugas-tugas berikut ini !

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per
kelompok.

. Setiap peserta didik mengikuti langkah-langkah yang dijabarkan dalam
KB3 ini melalui kerjasama kelompok.

. Tugas 1, Membuat backup file
. Tugas 2, Me-restore file backup
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1. Tes Pengetahuan.

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b,

¢, d atau e dari setiap item soal pilihan ganda di bawah ini:

1.

Langkah untuk membuat backup file:

a.

b.
c.
d
e

File > Backup > Klik opsi backup > Ketik nama file > Save
Backup > Klik opsi backup > Ketik nama file > Save
Backup > File > Klik opsi backup > Ketik nama file > Save
File > Klik opsi backup > Backup > Ketik nama file > Save
File > Backup > Ketik nama file > Save

Backup file merupakan ZIP file artinya:

PO TR

Mempunyai size yang sama dengan file aslinya
Mempunyai size yang lebih besar dengan file aslinya
Mempunyai size yang lebih kecil dengan file aslinya
Mempunyai fungsi yang tidak sama dengan file aslinya
Tidak ada perbedaan dengan file aslinya

Alasan perlunya pembuatan backup file:

Po0oTR

Kelengkapan data
Kekurangan data
Kelebihan data
Keamanan data
Kelemahan data

Langkah untuk me-restore backup fle:

i

File > Backup > Pilih Bacup file > Open > Ketik nama file > Save
File > Pilih Bakcup file > Restore > Open > Ketik nama file > Save
File > Restore > Open > Ketik nama file > Save

File > Restore > Pilih Backup file > Save > Ketik nama file > Open
File > Restore > Pilih Backup file > Open > Ketik nama file > Save

Dalam restore file, alasan dianjurkannya memberikan nama file yang lain
dari nama file aslinya:

o

b
C.
d.
e. Agar tidak terjadi dua file yang berbeda nama tetapi isinya sama.

Agar tidak terjadi file kembar

. Agar nama file lebih bervariasi

Agar tidak terjadi tumpang-tindih (replace) file aslinya.
Agar tidak terjadi gabungan file
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6. Perbandingan backup file dan file aslinya dari segi size file:

10.

File asli = file backup
File backup > File asli
File asli < file backup
File backup < file asli
File asli =< file backup.

PO TR

Mengapa diperlukan backup file?

Untuk menjaga keamanan komputer

Untuk menjaga keamanan software

Untuk menjaga keamanan data

Untuk menjaga keamanan brainware

Untuk menjaga keamanan proses pengolahan.

P TR

. Alasan perlunya pembuatan backup file karena seringkali ....

Data terserang virus
Kerusakan komputer
Kerusakan software

Kerusakan harddisk

Kehilangan folder.

PO TR

Untuk menjaga keamanan file backup maka ...

File backup disimpan di folder yang sama dengan aslinya.
File backup disimpan di floopy disk

File backup disimpan di eksternal hard disk

File backup disimpan di folder yang berbeda

File backup disimpan di komputer.

PO TR

Restore file adalah proses...
Penyimpanan backup file
Pembersihan backup file
Penghapusan backup file
Pembukaan backup file
Penghancuran backup file

P o

2. Tes Keterampilan.

236

Berdasarkan Kasus 3.2. UD Riola Media Mandiri yang ada pada ‘Lembar
Kerja Peserta Didik’, kerjakan tugas-tugas berikut ini !

1.

Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh
peserta didik secara berkelompok.

Pada akhir waktu tes diminta setiap peserta didik menyerahkan hasil
pekerjaannya dalam bentuk file.

Tugas 1, Membuat backup file

Tugas 2, Me-restore file backup
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</ f. Kunci Jawaban Tes Formatif

1. Kunci Tes Pengetahuan

1 a 6 d
2 C 7 C
3 d 8 a
4 e 9 C
5 C 10 d

2. Kunci Tes Keterampilan
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g. Lembar Kerja Peserta Didik

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta

didik di komputer melalui program MYOB versi 18.

Kasus 10.1: Kasus UD Rasela Media Mandiri.
Sebagai Teknisi Akuntansi anda diminta untuk:
1. Tugas 1, Membuat backup file

2. Tugas 2, Me-restore file backup

Kasus 10.2 : Kasus UD Riola Media Mandiri.

Sebagai Teknisi Akuntansi anda diminta untuk:

1. Tugas 1, Membuat backup file
2. Tugas 2, Me-restore file backup

Direktorat Pembinaan SMK (2013)
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Bab Il

Evaluasi

L
A. Attitude Skills

Evaluasi terhadap sikap (Attitude Skill)

1. Teknik . Observasi
2. Bentuk instrumen : lembar observasi
3. Aspek-aspek . Motivasi Internal, Kejujuran, Disiplin,

4. Instrumen

Mata Pelajaran

Tanggung jawab, Santun, Responsif,
Proaktif.

LEMBAR OBSERVASI

: Komputer Akuntansi

Kelas/ Semester X1

Materi Pokok
Tanggal

: Membuat file data bisnis.

No. | Nama Peserta Didik

Aspek penilaian

Motivasi Internal
Kejujuran
Disiplin
Responsif
Proaktif
Kepedulian

Nilai Rerata

Tanggungjawab
Santun

O[NNI~ |WIN|F-

)
4

Petunjuk pensekoran:

Skor 4
Skor 3

Skor 2

Skor 1 =

selalu, apabila selalu melakukan sesuai pernyataan
sering, apabila sering melakukan sesuai pernyataan
dan Skor kadang-kadang tidak melakukan
kadang-kadang, apabila kadang-kadang melakukan
dan sering tidak melakukan

tidak pernah, apabila tidak pernah melakukan
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@™ it o
~ B. Kognitif Skills
v
v
Evaluasi terhadap kemampuan kognitif.

1. Teknik :Tes;
2. Bentuk instrumen : Uraian.
3. Kisi-kisi

Indikator Nomor soal

Menyiapkan data awal
Membuat daftar akun

Membuat Buku Pembantu
Meng-entry saldo awal
Mencatat Transaksi Penjualan
Mencatat Transaksi Pembelian
Mencatat Transaksi Kas-Bank
Mencatat entri penyesuaian
Menampilkan laporan keuangan
Membuat backup file

= Z
OLXOXINDOTAWN T
Boo~NouahrwNnrk

4. Soal-soal :

Soal 1.

Sebutkan minimal 3 (tiga) keuntungan yang bisa diperoleh dengan
adanya komputerisasi data akuntansi menggunakan MYOB
Accounting?

Soal 2.

Data apa saja yang perlu diisi dalam menentukan periode akuntansi
pada pembuatan data akuntansi baru pada MYOB Accounting?

Direktorat Pembinaan SMK (2013)
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Soal 3.

Tentukan nomor Kkategori akun-akun berikut pada MYOB
Accounting?

KATEGORI AKUN NOMOR
Expense .
CostofSales ...
Liability ...
Asset Ll
Other Income ...
Equity
Inhcome ..
Other Expense  ............

Soal 4.

Jenis pajak yang mana yang identik dengan PPN (Pajak
Pertambahan Nilai) pada MYOB Accounting?

Soal 5.

Dalam proses pencatatan saldo awal akun pada MYOB Accounting,
terjadi kondisi dimana Amount left to be allocated menunjukkan
angka (minus) — Rp. 550.000 atau (Rp.550.000,-) ? Apa artinya
kondisi ini:

Soal 6.

Jelaskan fungsi modul Banking > Spend Money pada MYOB
Accounting?
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Soal 7.

Jelaskan fungsi modul Banking > Receive Money pada MYOB
Accounting?

Soal 8.

Jelaskan modul yang digunakan untuk mencatat jurnal penyesuaian
pada MYOB Accounting dan data apa sajakah yang harus
dipersiapkan?

Soal 9.

Jelaskan menu yang digunakan untuk menampilkan laporan laba-
rugi pada MYOB Accounting dan data apa sajakah yang harus dientri

Soal 10.

Jelaskan mengapa perlu dibuat backup file dalam komputerisasi
akuntansi ?
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C. Psikomotorik Skills

4
Evaluasi terhadap kemampuan kognitif.
1. Teknik : Tes Praktek

2. Bentuk instrumen : Studi Kasus.
3. Kisi-kisi :

Indikator Nomor soal
Menyiapkan data awal
Membuat daftar akun
Membuat Buku Pembantu
Meng-entry saldo awal
Mencatat Transaksi Penjualan
Mencatat Transaksi Pembelian
Mencatat Transaksi Kas-Bank
Mencatat entri penyesuaian
Menampilkan laporan keuangan
Membuat backup file

= Z
OLXOXINDOTAWN T
Boo~NouahrwNnrk

4. Soal-soal

KASUS PERUSAHAAN DAGANG
UD. Virgo Media Digital (VMD)

Identitas Perusahaan dan Usaha pokok

Nama perusahaan : UD Virgo Media Digital

Alamat : JI. Pamulang Raya 170, Pamulang, Tang-Sel.
No Telepon/Faximile : 021 7434352

Alamat email : ud.vmd@yahoo.com

Bank : BCA KCP Pamulang

No Rekening : 048 213 457896

Sebagai Computer Dealer, perusahaan tsb. menjual beberapa macam barang
antara lain: Computer, Printer, Modem, Software dan Other Hardwares
(Perangkat keras lainnya). Pada awal Januari 2013 pemilik perusahaan Tn.
Suyoko ingin menerapkan sistem komputerisasi yang memproses data
akuntansi untuk perusahaannya secara otomatis. Anda diminta menjadi
Teknisi Akuntansi yang membantu Tn. Suyoko.

Kebijakan Komputerisasi Akuntansi

1. Menggunakan sistem berpasangan dangan dasar akrual basis.
2. Menggunakan sistem mata uang rupiah & pencatatan tanggal Indonesia.
3. Menggunakan Special Journal dan General Journal.
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4. Pada tahap setup untuk periode akuntansi dinyatakan sebagai berikut:
e Tahun akuntansi berjalan (Current Financial year) : 2013,
¢ Bulan akhir tahun akuntansi (Last month of the year) : December,
e Bulan perpindahan (Conversion Month): January, dan
¢ Jumlah bulan dalam periode akuntansi (Accounting Period): Twelve.
5. Pada tahap pembuatan daftar akun (Build your accounts list):
¢ Memanfaatkan daftar akun yang telah disediakan oleh MYOB:
® (I would like to start with one of lists provided by MYOB)
¢ Klasifikasi industri (Industri Classification): Retail dan
e Jenis bisnis (Type of Business): Computer Dealer.
6. Pada tahap pembuatan dan penyimpanan file data bisnis yang baru:
e Company file name: UD-VMD1 (Nama Anda) dan
¢ Folder penyimpanan file: Document atau My Document
Kode Pajak
7. GST (Good Services Tax) .
8. N-T (Non Reportable Tax).
e GST selanjutnya akan diedit menjadi PPN (Pajak Pertambahan Nilai).
e GST Collected diedit menjadi PPN Collected.
e GST Paid diedit menjadi PPN Paid.
Daftar Saldo Barang Dagangan Per awal Januari 2013
No Kode Nama Barang Kelompok  Jml Cost/Unit Harga Jual/
Unit Unit
1 COM-001 HP Pro book 4421s Computer 10 9.000.000,- 14.850.000,-
2 Ccom-002 HPProbook5530  computer 6 11.000.000,-  17.600.000,-
3 PRN-001  Canonlj-215 Printer 20 650.000,- 990.000,-
4 PRN-002 Canon Bj-555 Printer 20 345.000,- 660.000,-
5 MOD-001 3MUSBModemS6  Modem 20 250.000,- 440.000,-
6 MOD-002 SAT USBModem36 Modem 25 275.000,- 550.000,-
7 SOF-001  Window 7 Profs Software 10 800.000,-  1.320.000,-
8 SOF-002 Ms Office 10 Software 25 1.800.000,- 2.200.000,-
9 DMS-001  Mini Speaker 421 Other 30 100.000,- 220.000,-
Hardwares
10 DMS-002 Mini Speaker 103 Other 40 80.000,- 165.000,-
Hardwares

Catatan Penilaian Persediaan Barang.
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Sistem pencatatannya menggunakan sistem Perpetual.
Metode yang dipergunakan adalah metode rata-rata bergerak.
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Pembelian dan Penjaualan Barang Dagangan

e Setiap pembelian dan penjualan barang dagangan akan diperhitungkan
PPN 10%.

e Setiap retur pembelian dan retur penjualan barang dagangan akan
diperhitiungkan pengurangan atas nilai Utang/Piutang Dagang dan PPN
Masukan/Keluaran.

e Harga-harga yang tertulis di dalam faktur pembelian dan penjualan sudah
termasuk PPN 10% (tax Inclusive).

e Setiap potongan yang diperoleh dari pembelian atau potongan yang
diberikan atas penjualan tidak mengurangi PPN Masukan/Keluaran tetapi
mengurangi nilai Utang Dagang atau nilai Piutang Dagang.

Daftar Saldo Utang Dagang

Per awal Januari 2013

Kode Nama & Alamat Supplier Keterangan Faktur Jumlah (Rp.)
S-001 PT Crown Electindo Faktur Pembelian No. CE- 110.000.000,-
JI. Gajah Mada 177 Jakarta 12 tanggal 20-12-2012
Telp 0214430011 Termin 5/10, n/30
Denda Late payemnt 2%/bl.
Jumlah Total 110.000.000,-
Daftar Saldo Piutang Dagang
Per awal Januari 2013
Kode Nama & Alamat Customer Keterangan Faktur Jumlah (Rp.)
C-001 Toko Ramanda Computer Faktur Penjualan No. FP- 209.000.000,-
JI. Setia Budi 23, Pamulang 003 tanggal 27-12-2012
Telp 0217431271 Termin 3/10, n/30
Denda Late payemnt 2%/bl.
C-002 Toko Global Computer Faktur Penjualan No. FP-  66.000.000,-
JI. Cendana 11, Ciputat 005 tanggal 28-12-2012
Telp 0217431270 Termin 3/10, n/30
Denda Late payemnt 2%/bl.
Jumlah Total 275.000.000,-
Preferences

Pemilik perusahaan meminta bahwa sistem komputerisasi yang baru bisa:

¢ Meng-edit/men-delete transaksi yang telah dicatat di komputer.

o Menampakkan nomor dan nama akun pada dipilih.
¢ Mencatat sebagai Cash In Bank ketika perusahaan menerima uang karena
uang tersebut akan disetor juga pada hari yang sama.
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Modifikasi Daftar Akun

Hapus (DELETE) akun-akun berikut ini:

1-1130 Cash Drawer 2-1355 WET Payable

1-1150 Provision Account 2-1360 Import Duty Payable
1-1160 Investment Account 2-1370 Voluntry Withholding Payable
1-1950 Withholding Credits 2-1380 ABN Withholdings Payable
1-1960 Voluntary Withholding Credits 2-1390 Luxury Car Tax Payable
1-1970 ABN Withholding Credits 2-1400 Payroll Liabilities

1-2200 Leasehold Improvements 2-1420 PAYG Withholding Payable
1-2210 Improvements at Cost 4-9000 Fuel Tax Credits

1-2220 Improvements Amortisation 6-1050 Accounting Fees

2-1120 Diners Club 6-1100 Legal Fees

2-1130 MasterCard 6-5105 Fringe Benefits Tax
2-1140 Visa 6-5120 Superannuation

2-1350 Duel Tax Credits Accrued 6-5140 Workers' Compensation

Ubah (EDIT) akun-akun berikut ini:

1-1110 Cheque Account :> 1-1110 Cash in Bank

1-1200 Trade Debtors |:> 1-1200 Account Receivable
2-1200 Trade Creditors |:> 2-1200 Account Payable
2-1300 GST Liabilities :> 2-1300 PPN Liabilities
2-1310 GST Collected :> 2-1310 PPN Collected
2-1330 GST Paid |:> 2-1330 PPN Paid

3-1000 Owner's/Shareholder's Equity |:> 3-1000 Suyoko Equity
3-1100 Owner/Sharehldr Capital :> 3-1100 Suyoko Capital
3-1200 Owner/Sharehldr Drawings |:> 3-1200 Suyoko Drawings
4-1100 Hardware :> 4-1100 Hardware Sales
4-1200 Software |:> 4-1200 Software Sales
5-1100 Hardware - Purchase I:> 5-1100 Hardware Cost of Sales
5-1200 Software - Purchase :> 5-1200 Software Cost of Sales
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Akun Baru (NEW).

Nomor Nama Akun Kategori
1-1550 Inventory — Supplies Other Current Assets
2-1700 Income Tax Payable Other Current liability
6-6100 Income Tax Expense
UD Virgo Media Digital
Neraca Saldo Per 31 Desember 2012
No.
Akun Nama Akun Debit Kredit

1-1110 Cash In Bank 210.000.000

1-1140 Petty Cash 5.000.000

1-1200  Account Receivable 275.000.000

1-1310 Computers 156.000.000

1-1320 Printers 136.900.000

1-1330 Modems 11.875.000

1-1340 Other Hardwares 6.200.000

1-1350 Softwares 53.000.000

1-1550 Inventory-Store Supplies 4.300.000

1-2110 Store Equip at Cost 100.000.000

1-2120  Store Equip Accum Dep 10.000.000

1-2310 Demo Equip at Cost 20.000.000

1-2320 Demo Equip Accum Dep 2.000.000

1-2410 Office Equip at Cost 60.000.000

1-2420 Office Equip Accum Dep 12.000.000

1-2510  Furniture Equip at Cost 80.000.000

1-2520 Furniture Equip Accum 16.000.000
2-1200 zggount Payable 110.000.000
2-1700 Income Tax Payable 8.275.000
2-2100 Bank Loan 300.000.000
3-1100 Suyoko Capital 660.000.000

1.118.275.000

1.118.275.000
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Transaksi Keuangan dalam Bulan Januari 2013

Catatan:

Diasumsikan jumlah-jumlah sudah termasuk PPN 10% (Tax inclusive),
kecuali disebutkan secara khusus.

Kas yang diterima akan dicatat sebagai Cash In Bank karena akan disetor
ke Bank pada hari yang sama.

Metode pencatatan Petty Cash adalah Fluctuation System.

| BuktiNo: 01
UD. VIRGO MEDIA DIGITAL SALES ORDER
JI. Pamulang Raya 170, Pamulang ?] Date 3 Januari 2013
Tangerang Selatan @@® SO# S0O-001
Termin 3/10, n/30 Late Fees 2%
SALES ORDER
Sold to: Toko Ramanda Computer, JI. Setia Budi 23, Pamulang
Amount: Rp. 107.140.000,-
Seratus tujuh juta seratus empat puluh ribu Rupiah.
Details:
No Item No Description Qty Price/Unit Total Price TAX
Rp. Rp.
1 COM-001 HP Pro book 44215 4 14.850.000,- 59.400.000,- | PPN
2 COM-002 HP Pro book 5530 17.600.000,- 35.200.000,- | PPN
3 PRN-001 | CanonlLJ-215 b 990.000,- 5.940.000,- | PPN
4 PRMN-002 Canon BJ-555 10 660.000,- 6.600.000,- | PPN
Total 107.140.000,- | PPN
Pemilik Perusahaan Sales Teknisi Akuntansi
Suyokao Renata
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BuktiNo: 02
INVOICE
UD. VIRGO MEDIA DIGITAL Date 4 Januari 20132
JI. Pamulang Raya 170, Pamulang @@)ﬂ Invoice # | SL-001
Tangerang Selatan @ SO # $S0-001
Termin 3/10, n/30 Late Fees 2%
INVOICE
Sold to: Toko Ramanda Computer, JI. Setia Budi 23, Pamulang
Amount: Rp. 107.200.000,-
Seratus tujuh juta dua ratus ribu Rupiah.
Details:
L. Price/Unit Total Price
No Item No Description Qty TAX
Rp. Rp.
1 COM-001 | HP Pro book 44215 4 14.850.000,- 59.400.000,- | PPN
2 COM-002 | HP Pro book 5530 2 17.600.000,- 35.200.000,- | PPN
3 PRN-001 Canon LJ-215 6 990.000,- 5.940.000- | PPN
4 PRN-002 | CanonBJ-555 10 660.000.- 6.600.000,- | PPN
107.140.000,- | PPN
Freight Collected 60.000,- NT
Total 107.200.000,-
Pemilik Perusahaan Sales Teknisi Akuntansi
Suyoko Renata
BuktiNo: 03
UD. VIRGO MEDIA DIGITAL ]NVO.ICE
JI. Pamulang Raya 170, Pamulang @@%ﬂ Date > Januari 2013
Tangerang Selatan @ Invoice # | 5L-002
Termin 3/10, n/30 Late Fees 2%
INVOICE
Sold to: Toko Global Computer, JI. Cendana 11, Ciputat
Amount: Rp. 15.650.000,-
Lima belas juta enam ratus lima puluh ribu Rupiah
Details:
L. Price/Unit Total Price
Mo Item No Description Qty TAX
Rp. Rp.
1 MOD-001 | 3M USB Modem 56 12 440.000,- 5.280.000,- | PPN
2 MOD-002 | SATUSB Modem 36 5 550.000,- 2.750.000,- | PPN
3 SOF-001 Ms Windows 7 Profs 5 1.320.000,- 6.600.000,- | PPN
4 SOF-002 Ms Office 10 5 2.200.000,- 11.000.000,- | PPN
5 DMS-001 Mini Speaker 421 10 220.000,- 2.200.000,- | PPN
6 DMC-002 | MiniSpeaker 103 12 165.000,- 1.980.000,- | PPN
Total 29.810.000,- | PPN
Freight Collected 40.000,- NT
Total Tagihan 29.850.000,-
Pemilik Perusahaan Sales Teknisi Akuntansi
Suyoko Renata
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| BuktiNo: 04
UD. VIRGO MEDIA DIGITAL COUNTER SALES
JI. Pamulang Raya 170, Pamulang @(@ﬂ Date 6 Januari 2013
Tangerang Selatan @ CSales# Cs-001
Termin COD
COUNTER SALES
Sold to: Cash.
Amount: Rp 47.300.000,-
Empat puluh tujuh Juta tiga ratus ribu Rupiah
Details:
No Item No Description Qty Price/Unit Total Price TAX
Rp. Rp.
1 COM-001 | HPPro book 44215 2 14.850.000,- 29.700.000,- | PPN
2 COM-002 HP Pro bock 5530 1 17.600.000,- 17.600.000,- | PPN
Total 47.300.000,- -
Pemilik Perusahaan Sales Teknisi Akuntansi
Suyoko Renata
BuktiNo: 05
UD. VIRGO MEDIA DIGITAL COUNTER SALES
JI. Pamulang Raya 170, Pamulang @@ﬁ Date 7 Januari 2013
Tangerang Selatan @ CSales# C5-002
Termin COoD
COUNTER SALES
Sold to: Cash.
Amount: Rp 7.370.000,-
Tujuh Juta tiga ratus tujuh puluh ribu Rupiah
Details:
No Item No Description Qty Price/Unit Total Price TAX
Rp. Rp.
1 MOD-001 | 3MUSE Modem 56 4 440.000,- 1.760.000,- | PPN
2 MOD-002 | SATUSB Modem 36 550.000- 2.750000,- | PPN
3 DMS-001 Mini Speaker 421 4 220.000- 880.000- | PPN
4 DMC-002 Mini Speaker 103 12 165.000,- 1.980.000,- | PPN
Total PPN
Freight Collected - NT
Total Tagihan 7.370.000,-
Pemilik Perusahaan Sales Teknisi Akuntansi
Suyoko Renata
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BuktiNo: 06

CREDIT NOTE

UD. VIRGO MEDIA DIGITAL

JI. Pamulang Raya 170, Pamulang @@ﬁ Date 8 Januari 2013
@ Credit Note # | CN-001

Invoice/Date | SL-001/ 4 Januari 2013
CREDIT NOTE

Returned by: Toko Ramanda Computer, JI. Setia Budi 23, Pamulang
Amount: Rp 660.000,-

Enam ratus enam puluh ribu Rupiah

Tangerang Selatan

Returned due to damages

L Price/Unit Total Price
No Item No Description Qty TAX
Rp. Rp.
1 PRN-002 | CanonBJ-555 1 660.000,- 660.000,- -
Total 660.000,-
Pemilik Perusahaan Sales Teknisi Akuntansi
Suyoko Renata
| BuktiNo : 07
CASH PAYMENT
UD. VIRGO MEDIA DIGITAL
CASH CHEQUE
JIl. Pamulang Raya 170, Pamulang - -
Date 9 Januari 2013 9 Januari 2013
Tangerang Selatan
NO CP-001 CP-001
CASH PAYMENT
Supplier: Counter Sales
Amount: Rp. 880.000,-

Delapan ratus delapan puluh ribu Rupiah

Details: Cash Pay Back for Counter Sales Return.

L. Price/Unit Total Price
No Item No Description Qty TAX
Rp. Rp.
1 MOD-002 | SATUSB Modem 36 1 550.000,- 550.000,- PFN
2 DMC-002 Mini Speaker103 2 165.000,- 330.000,- FPMN
Total 880.000,- FPMN
Pemilik Perusahaan Cashier Teknisi Akuntansi

Suyoko Maya
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| BuktiNo: 08
UD. VIRGO MEDIA DIGITAL CASH RECHIPT
: CASH CHEQUE
JI. Pamulang Raya 170, Pamulang - -
Date 10 Januari 2013 10 Januari 2013
Tangerang Selatan
NO CR-001 Al21
CASH RECEIPT
Receive Payment ~ From:
Customer: Toko Ramanda Computer, JI. Setia Budi 23, Pamulang
Amount: Rp. 209.000.000,-
Dua ratus sembilan juta Rupiah
Details:
. Amount Discount Total Due
No Date Invoice#
Rp Rp Rp.
1 27/12/10 | FP-003 209.000.000,- - 209.000.000,-
Total 209.000.000,-
Late Fees -
Totat Receipt 209.000.000, -
Pemilik Perusahaan Cashier Teknisi Akuntansi
Suyoko Maya
| BuktiNo: 09
UD. VIRGO MEDIA DIGITAL CASH RECHIPT
’ CASH CHEQUE
JI. Pamulang Raya 170, Pamulang - -
Date 11 Januari 2013 11 Januari 2013
Tangerang Selatan
NO CR-002 B222
CASH RECEIPT
Receive Payment  From:
Customer: Toko Global Computer, JI. Cendana 11, Ciputat
Amount: Rp. 66.000.000,-
Enam puluh enam juta Rupiah
Details:
. Amount Discount Total Due
No Date Invoice#
Rp Rp Rp.
1 28/12/10 | FP-005 66.000.000,- - 66.000.000,-
Total 66.000.000,-
Pemilik Perusahaan Cashier Teknisi Akuntansi
Suyoko Maya
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‘ BuktiNo: 10
CASH RECEIPT
UD. VIRGO MEDIA DIGITAL
CASH CHEQUE

JI. Pamulang Raya 170, Pamulang - -

Date 12 Januari 2013 12 Januari 2013
Tangerang Selatan

NO CR-003 Al125

CASH RECEIPT

Receive Payment ~ From:

Suyoko

Maya

Customer: Toko Ramanda Computer, JI. Setia Budi 23, Pamulang
Amount: Rp. 103.324.000,-
Seratus tigajuta tiga ratus dua puluh empat ribu Rupiah

Details:

No Date Invoice# Amount Discount Total Due

Rp Rp Rp.
1 4/1/11 SL-01/1-11 106.540.000,- 3.216.000,- 103.324.000,-
Total 103.324.000,-
Pemilik Perusahaan Cashier Teknisi Akuntansi

| BuktiNo: 11

UD. VIRGO MEDIA DIGITAL

Tangerang Selatan

JI. Pamulang Raya 170, Pamulang @@@ﬂ

PURCHASE ORDER

Date 13 Januari 2013
PO# PO-001
Termin 5/10, n/30 Late Fees 2%

PURCHASE ORDER

Supplier: PT Crown Electindo, JI. Gajah Mada 177 Jakarta
Amount: Rp. 157.344.000,-
|Semtu5 lima puluh tujuh juta tiga ratus empat puluh empat ribu Rup.
Details:
No Item No Description Qty Price/Unit Total Price TAX
Rp. Rp.
1 COM-001 | HP Pro book 44215 6 10.120.000, - 60.720.000,- | PPN
2 COM-002 | HPPro book 5530 12.540.000,- 87.780.000,- | PPN
3 PRN-001 | CanonlJ-215 715.000- 4.290.000,- | PPN
4 PRN-002 | CanonBJ-555 12 379.500- 4.554.000,- | PPN
Total 157.344.000,- | PPN
Pemilik Perusahaan Purchases Teknisi Akuntansi
Suyoko Lisa
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BuktiNo: 12
INVOICE
PT. CROWN ELECTINDO Date 14 Januari 2013
JI. Gajah Mada no, 177 Invoice# CE-171
Jakarta. PO # PO-001
Term 5/10, n/30 Late Fees 2%
INVOICE
Customer: UD. Virgo Media Digital, JI. Pamulang Raya 170, Pamulang, Tang-Sel.
Amount: Rp. 157.400.000,-
Seratus lima puluh tujuh juta empat ratus ribu Rupiah.
Details:
No Item No Description Qty Price/Unit Total Price TAX
Rp. Rp.
1 COM-001 HP Pro book 4421s 5] 10.120.000,- 60.720.000,- | PPN
2 COM-002 | HPProbook 5530 7 12.540.000,- 87.780.000,- | PPN
3 PRN-001 Canon LJ-215 5] 715.000- 4.290.000- | PPN
4 PRN-002 Canon BJ-555 12 379.500- 4.554.000,- | PPN
Total 157.344.000,- | PPN
Freight Collected 56.000- | NT
Total Tagthan 157.400.000,-
Pemilik Perusahaan Purchases Teknisi Akuntansi
Suyoko Lisa
BuktiNo: 13
PT Crown Electindo INVOI_CE
Date 15 Januari 2013
JI. Gajah Mada 177 Jakarta Invoice # | CE-175
Telp 0214430011 Term 5/10, n/30 Late Fees 2%
INVOICE
Sold to: UD Virgo Media Digital, JI. Pamulang Raya 170, Pamulang
Amount: Rp. 10.400.000,-
Sepuluh juta empat ratus ribu Rupiah
Details:
No Item No Description Qty Price/Unit Total Price TAX
Rp. Rp.
1 MOD-001 | 3MUSBModem 56 16 286.000- 4.576.000- | PPN
2 MOD-002 | SATUSBModem 36 4 313.500- 1.254.000- | PPN
3 DM5-001 Mini Speaker 421 24 121.000- 2.904.000,- | PPN
4 DMC-002 | MiniSpeaker 103 18 90.200,- 1.623.600- | PPN
Total 10.357.600,- | PPN
Freight Collected 42.400,- | NT
Total Tagihan 10.400.000,-
Pemilik Perusahaan Sales Pembukuan
Senoaji Rika
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| BuktiNo: 14
CASH PAYMENT
UD. VIRGO MEDIA DIGITAL CASH CHEQUE
JI. Pamulang Raya 170, Pamulang | Date 16 Januari 2013 16 Januari 2013
Tangerang Selatan NO CP-002 CP-002
Inv# 917
CASH PAYMENT
Supplier: Cash Purchases
Amount: Rp. 22.000.000,-
Dua puluh dua juta Rupiah
Details:
L Price/Unit Total Price
No Item No Description Qty TAX
Rp. Rp.
SOF-001 Ms Windows 7 Profs 5 880.000,- 4.400.000,- | PPN
SOF-002 Ms Office 10 10 1.980.000,- 19.800,000,- | PPN
Total 24.200.000,- | PPN
Freight Collected - NT
Total Tagihan 24.200.000,-
Pemilik Perusahaan Cashier Teknisi Akuntansi
Suyoko Maya
BuktiNo: 15
PT Auto 2000 INVOICE
) Date 17 Januari 2013
JI. Cilandak 12, Jakarta Selatan Ivoice# | 12345
INVOICE
Sold to: UD Virgo Media Digital, JI. Pamulang Raya 170, Pamulang
Amount: Rp. 190.000.000,-
Seratus sembilan puluh juta Rupiah
Details:
L . . Total Price
No Description Qty | Price/Unit Rp. Rp TAX
1 Mobil Box — Toyota 2013 1 240.000.000,- 240.000.000,- -
Harga Mobil (On The Road) 240.000.000,- -
Uang Muka (DP) dibayar dengan Cek 50.000.000,- -
Sisa Pinjaman Diangsur 10 x 190.000.000,- -
Pemilik Perusahaan Sales Pembukuan
Lie Ban Piet Megah
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|BuktiNo: 16

CREDIT NOTE
Date 18 Januari 2013
Credit Note # | DT512
Inv.#/Date CE-171/ 14 Januari 2013

CREDIT NOTE

Returned by: UD Virgo Media Digital, JI. Pamulang Raya 170, Pamulang
Amount: Rp1.474.000,-
Satu juta empat ratus tujuh puluh empat ribu Rupiah

PT Crown Electindo
JI. Gajah Mada 177 Jakarta
Telp 0214430011

Returned due to damages

L Price/Unit Total Price
No Item No Description Qty TAX
Rp. Rp.
1 PRN-001 Canon LJ-215 1 715.000,- 715.000,- PPN
2 PRN-002 Canon BJ-555 2 379.500,- 759.000,- PPN
Total 1.474.000,- PPN
Pembeli Sales
BuktiNo: 17
PT Crown Electindo CREDIT NOTE
Date 19 Januari 2013

JI. Gajah Mada 177 Jakarta
Telp 0214430011

Credit Note # | DT520

Invi# / Date CE-175/ 15 Januari 2013

CREDIT NOTE

Returned by: UD Virgo Media Digital, JI. Pamulang Raya 170, Pamulang
Amount: Rp1.320.000,-
Satu juta tiga ratus dua puluh ribu Rupiah

Returned due to damages

L. Price/Unit Total Price
No Item No Description Qty TAX
Rp. Rp.
1 MOD-001 | 3M USB Modem 56 2 286.000,- 572.000,- PPN
1 DMS-001 Mini Speaker 421 2 121.000,- 242.000,- PPN
Total 814.000,- | PPN
Pembeli Sales
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BuktiNo: 18
CASH RECEIPT
UD. VIRGO MEDIA DIGITAL CASH CHEQUE
JIl. Pamulang Raya 170, Pamulang | Date 20 Januari 2013 20 Januari 2013
Tangerang Selatan NO CR-004 Al28
Inv#/Date | 917/ 16 Januari 2013
CASH RECEIPT
Supplier: Cash Purchases
Amount: Rp. 1.980.000,-
Satu juta sembilan ratus delapan puluh ribu Rupiah
Details: Cash Receipt Back for Cash Purchases Return
L Price/Unit Total Price
No Item No Description Qty TAX
Rp. Rp.
1 SOF-002 Ms Office 10 1 1.980.000,- 1.980,000,- | PPN
Total 1.980.000,- | PPN
Pemilik Perusahaan Cashier Teknisi Akuntansi
Suyoko Maya
| BuktiNo: 19
CASH PAYMENT
UD. VIRGO MEDIA DIGITAL
CASH CHEQUE
JI. Pamulang Raya 170, Pamulang - -
Date 21 Januari 2013 21 Januari 2013
Tangerang Selatan
NO CP-003 CP-003
CASH PAYMENT
Pay Bill to:
Supplier: PT Crown Electindo, JI. Gajah Mada 177, Jakarta
Amount: Rp. 148.056.000,-
Seratus empat puluh delapan juta lima puluh enam ribu Rupiah
Details:
. Amount Discount Total Due
No Date Invoice#
Rp Rp Rp.
1 14/1/11 | CE-171 155.926.000,- 7.870.000,- 148.056.00,-
Total 148.056.000,-
Pemilik Perusahaan Cashier Teknisi Akuntansi
Suyoko Maya
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| BuktiNo: 20
CASH PAYMENT
UD. VIRGO MEDIA DIGITAL
CASH CHEQUE
JI. Pamulang Raya 170, Pamulang - -
Date 22 Januari 2013 22 Januari 2013
Tangerang Selatan
Doc CP-004 CP-004
CASH PAYMENT
Amount: Rp. 8.275.000,-
Delapan juta dua ratus tujuh puluh lima ribu Rupiah.
Details:
No Explanations Amount (Rp). TAX
1 Income tax payable 8.275.000- [ NT
Total Payment 8.275.000,-
Pemilik Perusahaan Cashier Teknisi Akuntansi
Suyoko Maya
BuktiNo: 21
UD. VIRGO MEDIA DIGITAL CASH PAYMIENT
) CASH CHEQUE
JI. Pamulang Raya 170, Pamulang - -
Date 23 Januari 2013 23 Januari 2013
Tangerang Selatan
Doc CP-005 CP-005
CASH PAYMENT
Amount: Rp. 1.500.000,-
Satu juta lima ratus ribu Rupiah
Details:
No Explanations Amount (Rp). TAX
1 Inventory- Store Supplies 650.000- | N.T
2 Telephone 450.000- | N.T
3 Water 150.000-- N.T
4 Staff Amenities 250.000- | N.T
Total Payment 1.500.000,-
Pemilik Perusahaan Cashier Teknisi Akuntansi
Suyoko Maya
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| BuktiNo: 22
CASH PAYMENT
UD. VIRGO MEDIA DIGITAL
CASH CHEQUE
JI. Pamulang Raya 170, Pamulang - -
Date 25 Januari 2013 25 Januari 2013
Tangerang Selatan
Doc CP-006 CP-006
CASH PAYMENT
Amount: Rp. 2.700.000,-
Dua juta tujuh ratus ribu Rupiah.
Details:
No Explanations Amount TAX
1 Employment Expenses 200.000.-
2 Wages and Salaries 2.500.000,-
Total Payment 2.700.000,-
Pemilik Perusahaan Cashier Teknisi Akuntansi
Suyoko Maya
BuktiNo: 23
UD. VIRGO MEDIA DIGITAL PETTY CASH VOUCHER
JIl. Pamulang Raya 170, Pamulang Date 27 Januari 2013
Tangerang Selatan NO PC-001
PETTY CASH VOUCHER
Amount: Rp. 600.000,-
|Enam ratus ribu Rupiah.
Details:
No Explanations Amount TAX
Postage 100.000.-
Computer Magazine Subscriptions 300.000,-
In-Store Promotion 200.000,-
Total Payment 600.000,-
Pemilik Perusahaan Petty Cashier Teknisi Akuntansi
Suyoko Sena
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| BuktiNo: 24
CASH RECEIPT
UD. VIRGO MEDIA DIGITAL CASH CHEQUE
JI. Pamulang Raya 170, Pamulang | Date 28 Januari 2013 28 Januari 2013
Tangerang Selatan NO CR-005 S017
CASH RECEIPT
Amount: Rp. 50.000.000,-
Lima puluh juta Rupiah.
Details:
. Amount
No Description TAX
Rp.
1 Setoran modal dari pemilik perusahaan 50.000.000,- -
Total 50.000.000,- -
Pemilik Perusahaan Cashier Teknisi Akuntansi
Suyoko Maya
|BuktiNo: 25
UD. VIRGO MEDIA DIGITAL MEMORANDUM
JI. Pamulang Raya 170, Pamulang Date 31 Januari 2013
Tangerang Selatan Memo # MM-001
MEMORANDUM
Kepada Bagian : 1. Teknisi Akuntansi ; .
) Dari : Pemilik Perusahaan
Depreasiasi Aset Tetap bulan Januari 2013:
No Explanations Amount (Rp.)
1 Store Equipments 800.000,-
2 Demo Equipments 300.000,-
3 Office Equipments 500.000,-
4 Furniture Equipments 600.000,-
5 Motor Vehicles -
Pemilik Perusahaan | e Teknisi Akuntansi
Suyoko
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| BuktiNo: 26
UD. VIRGO MEDIA DIGITAL MEMORANDUM
JI. Pamulang Raya 170, Pamulang Date 31 Januari 2013
Tangerang Selatan Memo # | MM-002
MEMORANDUM

Kepada: 1. Teknisi Akuntansi

Dari : Pemilik Perusahaan
2. Gudang

Isi Memo:
Segera diproses penghapusan untuk item-item berikut karena kerusakan fisik:

No Item No Description Qty Cost/Unit Rp. Total Rp. TAX

1 MOD-002 | SATUSB Modem 36 1 277.000- 277.000- -

2 DMC-002 | Mini Speaker103 1 81.000.- 81.000.- -
Pemilik Perusahaan | Teknisi Akuntansi

Suyoko
BuktiNo: 27
UD. VIRGO MEDIA DIGITAL MEMORANDUM
JI. Pamulang Raya 170, Pamulang Date 31 Januari 2013
Tangerang Selatan Memo # | MM-003
MEMORANDUM

Kepada: 1. Teknisi Akuntansi

Dari : Pemilik Perusahaan
2. Gudang

Isi Memo:
Nilai Inventory — Supplies pada akhir Januari 2013 Rp. 1.950.000,-.
Beban Spplies dialokasikan untuk Office Supplies 40% dan Store Supplies 60%.

No Description Alokasi Total Rp. TAX
Beban Office Supplies 40% 1.200.000,- -
Beban Store Supplies 60% 1.800.000,- -

Pemilik Perusahaan | Teknisi Akuntansi

Suyoko
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BuktiNo: 28
UD. VIRGO MEDIA DIGITAL MEMORANDUM
JIl. Pamulang Raya 170, Pamulang Date 31 Januari 2013
Tangerang Selatan Memo # | MM-004
MEMORANDUM
Kepada: 1. Teknisi Akuntansi . .
Dari : Pemilik Perusahaan
Isi Memo:
Selesaikan Bank Rekonsiliasi untuk akun Cash In Bank per 31 Januari 2013.
Lihat Rekening Koran dari BCA per tanggal tersebut.
Transaksi yang belum dibukukan oleh perusahaan adalah:
No Description Total Rp. TAX
1 |Beban Administrasi Bank 720.000,- -
2 |PendapatanJasa Giro 2.200.000,- -
Pemilik Perusahaan | = Teknisi Akuntansi
Suyoko
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BANK BCA
STATEMENT OF ACCOUNT
FROM 01/01/2013
TO 31/01/2013
ACCOUNT NAME VIRGO MEDIA DIGITAL
ACCOUNT NUMBER 48213457896
AMOUNT
DATE TRANSACTIONS BALANCE
DEPOSITS WITHDRAWALS
01/01/2013 0o Rp 210.000.000
07/01/2013 01 Rp 47.300.000 Rp  257.300.000
08/01/2013 01 Rp  7.370.000 Rp  264.670.000
09/01/2013 02 Rp 280.000 | Rp  263.790.000
10/01/2013 01 Rp 209.000.000 Rp  472.790.000
11/01/2013 01 Rp 66.000.000 Rp  538.790.000
12/01/2013 01 Rp 103.216.000 Rp  642.006.000
15/01/2013 02 Rp  24.200.000 | Rp  617.806.000
17/01/2013 02 Rp 50.000.000 | Rp  567.806.000
21/01/2013 02 Rp 148.056.000 | Rp  419.750.000
25/01/2013 02 Rp  5.800.000 | Rp  409.950.000
28/01/2013 01 Rp 50.000.000 Rp  459.950.000
31/01/2013 03 Rp 720.000 | Rp  459.230.000
31/01/2013 04 Rp  2.200.000 Rp  461.430.000
Kode Transaksi: Pamulang, 31 Januari 2013
i) = Balance Kepala KCP
01 = Deposit
02 = Withdrawal
03 = Bank Charges
04 = Interest Geol Hutagalung
Tugas anda:

Sebagai Teknisi Akuntansi anda diminta untuk memproses data akuntansi
bulan Januari 2013 dengan program MYOB dan menyusun Laporan Keuangan:

1. Bank Rekosiliasi (Bank Rekonciliation) per 31 Januari 2013.

2. Neraca (Standard Balance Sheet) per akhir Januari 2013.

3. Laporan Laba-Rugi (Profit and Loss - Accrual) bulan Januari 2013.
4. Laporan Arus Kas untuk bulan Januari 2013.
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<"
)
/s F.

. Batasan waktu yang telah ditetapkan

Produk/Benda Kerja Sesuai Kriteria Standar

Kriteria Laporan keuangan yang dihasilkan hendaknya meliputi:

1. Laporan Laba-Rugi (Accrual) untuk periode 2013 yang disusun secara
rinci dengan format multi steps.

2. Laporan Neraca (Standard) per 31 Januari 2013 yang disusun secara
rinci dengan format staffel.

3. Laporan Arus kas untuk periode 1/1/2013 s.d. 31/1/2013 yang disusun
dengan metode tidak langsung.

1. Waktu yang tersedia untuk pelaksanaan evaluasi kemampuan kognitif
yaitu 2 x Jam Pelajaran @ 45 menit.

2. Waktu yang tersedia untuk pelaksanaan evaluasi kemampuan
psikomotor yaitu 4 x Jam Pelajaran @ 45 menit.

Kunci Jawaban

1. Jawaban soal untuk kemampuan kognitif:

Jawaban Soal 1

Proses kerja cepat.

Pencegahan kesalahan

Posting jurnal ke buku besar/buku pembantu secara otomatis.
Volume kerja lebih besar

Pencetakan laporan bisa berkali-kali.

Jawaban Soal 2

Current financial year (tahun periode akuntansi).

Last month of financial year (bulan terakhir dari tahun periode).
Conversion month (Bulan konversi)

Number of accounting period (Jumlah periode akuntansi)

Jawaban Soal 3

Expense

Cost of Sales
Liability

Asset

Other Income
Equity

Income

Other Expense

O~ wWoOEFRLNOUIO
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Jawaban Soal 4
Jenis pajak yang identik dengan PPN pada MYOB Accounting:
e GST (Goods and Services Tax) atau
o VAT (Value Added Tax)

Jawaban Soal 5

Amount left to be allocated: - Rp. 550.000,- atau (Rp. 550.000) artinya bahwa
jumlah debet lebih kecil Rp. 550.000,- dari jumlah kredit atau jumlah kredit
lebih besar Rp. 550.000,- dari jumlah debet..

Jawaban Soal 6

Modul Banking > Spend Money memberikan fasilitas untuk mencatat transaksi
pembayaran uang tunai melalui akun-akun Cash in Bank/ Petty Cash/
Bankcard yang tidak ada kaitannya dengan pembelian barang dagangan.

Jawaban Soal 7

Modul Banking > Receive Money memberikan fasilitas untuk mencatat
transaksi penerimaan uang tunai melalui akun-akun Cash in Bank/ Cash on
Hand yang tidak ada kaitannya dengan penjualan barang dagangan.

Jawaban Soal 8
Modul yang digunakan untuk mencatat jurnal penyesuaian adalah Account >
Record Journal Entry.

Data yang perlu dipersiapkan adalah nomor dan nama akun-akun yang didebet
beserta jumlahnya dan nomor dan nama akun-akun di kredit beserta jumlanya.

Jawaban Soal 9

Menu yang digunakan untuk menampilkan laporan Lab-rugi adalah Report >
Index to Report > Tab Account > Profit and Loss [Accrual] atau menggunakan
menu alternatif Report > Account > Profit and Loss [Accruall.

Data yang perlu dientri adalah periode akuntansi dari tanggal awal s.d. tanggal
akhir.

Jawaban Soal 10

Backup file dalam komputer akuntansi perlu dibuat untuk menjaga keutuhan
dan integritas data, apabila terjadi kerusakan pada file asli yang ada di
komputer karena akibat terkena virus atau sebab lainnya.
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2. Jawaban soal untuk kemampuan psikomotor
a. Laporan Laba-Rugi:

(5] Report Display =N R =)
Drated From: Te: |31£D1 2011 Redizplay Yigw | Print Preview hd
UD VIRGO MEDIA DIGITAL :‘
JI. Pamulang Raya 170 Pamulang
TANGERANG SELATAN
Profit & Loss 3tatement
January
0610312014
14:33:45
Income
Sales
Hardware Sales Rp156.800.000,00
Software Sales Rp16.000.000,00
Total Sales Rp172.800.000,00
Freight Collected Rp100.000,00
Total Income Rp172.900.000,00
Cost of Sales
Hardware - Cost of Sales Rp103.640.000,00
Software - Cost of Sales Rp13.000.000,00
Discounts Given Rp3.216.000,00
Total Cost of Sales Rp119.856.000,00
Gross Profit Rp53.044.000,00
Expenses
General & Administrative Exp
Bank Charges Rp720.000,00
Depreciation Rp2.200.000,00
Office Supplies Rp1.200.000,00
Discounts Taken (Rp7.154.800,00)
Freight Paid Rp98.400,00
Total General & Administrative Exp (Rp2.936.400,00)
Operating Expenses
Telephone Rp450.000,00
Water Rp150.000,00
Store Supplies Rp1.800.000,00
Shrinkage/Spoilage Rp358.000,00
Total Operating Expenses Rp2.758.000,00
Employment Expenses
Staff Amenities Rp250.000,00
Wages & Salaries Rp9.600.000,00
Total Employment Expenses Rp9.850.000,00
Total Expenses Rp9.671.600,00
Operating Profit Rp43.372.400,00
Other Income
Interest Income Rp2.200.000,00
Total Other Income Rp2.200.000,00
Other Expenses
MNet Profit/ (Loss) Rp45.572.400,00
K _| [
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@ Report Display

=N R =)

Az o Redizplay Wigw: |F'rint Presview |
UD VIRGO MEDIA DIGITAL :‘
JI. Pamulang Raya 170 Pamulang
TANGERANG SELATAN
Balance Sheet
. January
06/03/2014
14:42:43
Assets

Current Assets
Cash On Hand
Cash In Bank
Petty Cash
Total Cash On Hand
Account Receivable
Inventory - Retail
Computers
Printers
Modems
Other Hardware
Software
Total Inventory - Retail
Inventory - Supplies
Total Current Assets
Fixed Assets
Store Equipment
Store Equip - at Cost
Store Equip - Accum Dep'n
Total Store Equipment
Demaonstration Equipment
Demo Equip - at Cost
Demo Equip - Accum Depn
Total Demonstration Equipment
Office Equipment
Office Equip - at Cost
Office Equip - Accum Dep'n
Total Office Equipment
Furniture & Fixtures
Furniture Equip - at Cost
Furniture Equip- Accum Dep'n
Total Furniture & Fixtures
Motor Vehicles
Motor Vehicles - at Cost
Total Motor Vehicles
Total Fixed Assets
Total Assets

Rp403.943.000,00

Rp5.000.000,00
p4035.943.000,00
Rp29.850.000,00

Rp204.000.000,00
Rp136.595.000,00
Rp9.903.000,00
Rp6.855.000,00
Rp60.200.000,00
Rp417.553.000,00
Rp1.950.000,00

pE53296.000,00
Rp100.000.000,00
(Rp10.200.000,00)

£80.200.000,00

Rp20.000.000,00
(Rp2.300.000,00)
Rp17.700.000,00

Rp&0.000.000,00
(Rp12.500.000.00)
Rpd7.500.000,00

Rp80.000.000,00
(Rp16.600.000,00)

p63.400.000,00
Rp240.000.000,00
p240.000.000,00
Rp457.8600.000,00

pT1.376.096.000,00

Liabilities
Current Liabilities
Account Payable
PPM Liabilities
PPN Collected
PPN Paid
Total PPN Liabilities
Total Current Liabilities
Long Term Liabilities
Bank Loans
Total Long Term Liabilities
Total Liabilities

MNet Assets

Equity
Suyoko Equity
Suyoko Capital
Total Suyoko Equity
Current Year Earnings
Total Equity

4]
(A=
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Rp309.586.000,00

Rp17.280.000,00
(Rp16.342.400,00)
p937.600,00
Rp310.523.600,00

Rp300.000.000,00
Rp300.000.000,00
pET0.523.600,00

Rp705.572.400,00

=

Rp660.000.000,00
Rp6E60.000.000,00

Rp45.572.400,00
Rp705.572.400,00

S
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c. Laporan Arus Kas

(] Report Display =R A= =S
Dated From: To: |31 AtAz20m Redisplay Wiews: | Print Preview ]
UD VIRGO MEDIA DIGITAL :‘
JI. Pamulang Raya 170 Pamulang
TAMGERANG SELATAN
Statement of Cash Flow
January

06/03/2014
14:34:38
Cash Flow from Operating Activities
MNetIncome p45.572.400,00

Account Receivable 245150.000,00

Computers p48.000.000,00)

Printers Rp305.000,00

Modems Rp1.972.000,00

Other Hardware (Rp655.000,00)

Software Rp7.200.000,00)

Inventory - Supplies Rp2.350.000,00

Store Equip - Accum Dep'n Rp&00.000,00

Demo Equip - Accum Dep'n Rp300.000,00

Office Equip - Accum Dep'n Rp500.000,00

Furniture Equip- Accum Dep'n Rp&00.000,00

Motor Vehicles - at Cost 240.000.000,00)

Account Payable 199.586.000,00

PPN Collected p17.280.000,00

PPN Paid p16.342.400,00)

Income Tax Payable Rp8.275.000,00)
Met Cash Flows from Operating Activities 193.943.000,00
Cash Flow from Investing Activities
Met Cash Flows from Investing Activities Rp0,00
Cash Flow from Financing Activities
Met Cash Flows from Financing Activities Rp0,00
Met Increase/Decrease for the period 193.943.000,00
Cash atthe Beginning of the period 215.000.000,00
Cash atthe End of the period 408.943.000,00

Kl _| ﬂ_‘
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Bab IV Penutup

Setelah Laporan Keuangan pada akhir Januari diselesaikan dan sudah dibuat
backup file, maka proses akuntansi berikutnya akan diteruskan ke bulan Februari.
Tugas selajutnya adalah melaksanakan pencatatan transaksi bulan Februari.
Untuk itu tidak diperlukan lagi mengentri saldo-saldo awal akun buku besar atau
buku pembantu secara manual seperti yang dilakukan di awal bulan Januari.
Program MYOB akan secara otomatis mengakumulasi jumlah saldo dengan
jumlah penambahan/ pengurangan sebagai akibat dari transaksi bulan Pebruari.
Laporan keuangan yang nantinya akan ditampilkan di akhir Pebruari adalah hasil
akumulasi transaksi dalam dua bulan yaitu transaksi Januari dan Pebruari.
Demikian seterusnya sampai dengan akhir bulan Desember 2013.

Pada akhir bulan Desember 2013 (akhir periode akuntansi) Program MYOB
menyediakan menu untuk menutup semua akun-akun nominal (akun Laba-rugi)
dan akan memulai dengan akun-akun riil atau neraca awal Januari 2014. Menu ini
adalah File > Start a New Year > Start a New Financial Year.
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Gambar 11-1 Start a New Financial Year
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